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Įvadas

Šiuolaikinė statistika yra neatsiejama nuo kompiuterizuotos duomenų analizės. Tai padeda 
greitai ir efektyviai analizuoti įvairius statistinius duomenis, nes tiek profesionalių, tiek prade-
dančiųjų vartotojų darbą palengvina įvairūs programiniai paketai. Tačiau turint tik bendrą supra-
timą apie statistinius tyrimus, reikia gerai suvokti, kam yra skirti konkretūs statistiniai metodai, 
kokia jų taikymo sritis ir kaip vertinti gautus rezultatus.

Vienas iš tokių labiausiai paplitusių statistinės informacijos apdorojimo programų paketų yra 
SPSS (angl. – Statistical Package for the Social Sciences). Šis programų paketas apima įvairius 
šiuolaikinius statistinės analizės metodus ir duomenų analizės rezultatų vizualizavimo priemo-
nes. Jis puikiai tinka ir pradedančiajam vartotojui, nes lengvai įvaldoma dialoginė sąsaja. SPSS 
programų paketas taikomas pokyčiams socialinėje aplinkoje įvertinti ir prognozuoti, kokybės 
valdymo procese, psichologijoje, biologijoje, medicinoje, rinkodaroje ir t. t. 

Ši mokomoji knyga supažindins studentus su socialinės statistikos uždavinių sprendimu, 
kuris remiasi aprašomosios ir matematinės statistikos metodais: duomenų padėties ir sklaidos 
charakteristikomis, grafiniu duomenų vaizdavimu, koreliacija, hipotezių tikrinimu, regresi-
ne analize. Daugiausia dėmesio mokomojoje knygoje skiriama šių metodų panaudojimui ir 
gautų rezultatų interpretacijai. Visi taikomi metodai iliustruojami pavyzdžiais. Ši knyga pa-
dės išmokti SPSS programų paketo pradmenis: duomenų įvedimą ir redagavimą, duomenų 
transformavimą, perskaičiavimą ir t. t. Glaustai primenamos matematinės statistikos sąvo-
kos ir teiginiai, kuriuos būtina žinoti, norint suvokti taikomų metodų esmę ir sėkmingai dirb-
ti su SPSS programų paketu. Išsamesnių žinių apie statistinius tyrimo metodus galima rasti 
knygose: V. Čekanavičius ir G. Murauskas, I dalis, 2003; V. Čekanavičius ir G. Murauskas, 
II dalis, 2004. 

Ši mokomoji knyga skiriama Lietuvos karo akademijos socialinių mokslų srities bakalau-
ro ir studijų kariūnams, magistrantams, doktorantams, atliekantiems įvairius tyrimus anketavi-
mo metodu. Taip pat ja galės pasinaudoti visi, kurie savo tyrimų analizei taikys SPSS progra-
mų paketą. 

Mokomoji knyga „Duomenų analizės SPSS pagrindai“ sudaryta iš septynių skyrių. Pirmasis 
skyrius skirtas supažindinti su imties sudarymo ir informacijos rinkimo anketavimo meto-
du ypatumais. Antrajame skyriuje supažindinama su SPSS programų paketu ir duomenų, ap-
dorotų Microsoft Excel programa, bei tekstiniais redaktoriais, perkėlimu į SPSS darbalaukį. 
Trečiajame skyriuje aiškinama anketavimo duomenų įvedimo ir kintamųjų apibūdinimo spe-
cifika. Ketvirtasis skirtas įvestų į SPSS duomenų modifikacijų procedūroms, kurios taikomos 
atliekant įvairią statistinę analizę. Penktajame skyriuje trumpai paaiškinama aprašomoji sta-
tistika ir grafinis duomenų vizualizavimas. Šeštajame skyriuje aprašytas, praktikoje dažnai tai-
komas naujų kintamųjų kūrimas, kuris yra atliekamas siekiant išplėsti ar padaryti išsamesnius 
statistinius tyrimus. 
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Septintasis, plačiausias, mokomosios knygos skyrius skirtas statistinių metodų parinkimo ty-
rimui ir statistinių tyrimų taikymo, naudojant SPSS programų paketą, pavyzdžiams. Čia patei-
kiami įvairūs pavyzdžiai ryšiui tarp kintamųjų ir skirtumams tarp grupių tirti. Kiekvienas tyri-
mas pradedamas įvadu, kuriame apibūdinamas duomenų analizės metodas ir jo taikymo ypatu-
mai. Visi metodai aprašyti nenaudojant matematinių formulių, nes mokomoji knyga pirmiausia 
skirta socialinių mokslų studentams, kurių matematinis pasirengimas gali būti nepakankamas 
sudėtingesniam matematiniam tekstui suprasti. 

Statistinių tyrimų pavyzdžiai analizuojami naudojant hipotetinius duomenis. Šie duomenys 
pateikti tik su analizei reikalingais kintamaisiais, o imčių dydžiai specialiai parinkti gana dideli 
(imtyje daugiau nei 400 respondentų).

SPSS programų paketo duomenų analizės lentelės mokomojoje knygoje pateikiamos origina-
lios (anglų kalba) su antraštėmis. Tai padaryta tam, kad skaitytojas, atlikęs analizę, lengvai ge-
bėtų surasti šias lenteles SPSS programų paketo išvesties lange ir išmoktų analizuoti duomenis 
savarankiškai. Aprašant grafinį duomenų vizualizavimą ir tyrimų atlikimo procedūras, tekste yra 
vartojami paryškintu šriftu išskirti angliški terminai, kurie yra ne kas kita, o SPSS meniu, langų, 
mygtukų ir jungiklių pavadinimai.

Kiekvieno šios knygos skyriaus pabaigoje yra užduotys, skirtos tiek įgūdžiams lavinti, tiek 
įgytoms žinioms patikrinti. Šių užduočių tikslas buvo aprėpti kuo įvairesnius paaiškintų meto-
dų taikymo būdus. 

Autorė tikisi, kad mokomoji knyga „Duomenų analizės SPSS pagrindai“ bus naudinga vi-
siems, kurie nori įgyti praktinių darbo su SPSS programų paketu ir statistinės duomenų anali-
zės taikymo įgūdžių.
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1. Bendroji informacija

Šiame skyriuje rasite informaciją, kaip galima nustatyti apklausų imties dydį, suprasite anke-
tos sudarymo tikslus bei struktūrą, trumpai susipažinsite su kodavimo instrukcijomis, kuriomis 
naudositės konvertuodami surinktą informaciją iš kiekvieno klausimyno į formatą, kurį gali sup- 
rasti SPSS programų paketas. Skyriaus pabaigoje pateikiamos praktinės užduotys padės lavinti 
įgūdžius, kuriuos galėsite pritaikyti atlikdami savo tyrimus.

Imtis

Statistika – mokslas, kuris apibendrina surinktą informaciją ir pateikia išvadas. Vadinasi, sta-
tistika yra susijusi su duomenų rinkimu, surinktų duomenų apdorojimu ir statistinėmis išvadomis. 

Kad ir kokį tyrimą norėsite atlikti, pirma turėsite pasirinkti tyrimo objektų aibę (populiaciją) 
ir iš jos dalies (imties) surinkti informaciją. Populiaciją sudarys visi objektai, turintys požymį, 
kuris domina tyrėją. Todėl prieš pradedant tyrimą, reikia nuspręsti, kas sudarys imtį ir kokio dy-
džio imtis tyrimui bus naudojama. 

Visa populiacija tiriama labai retai, nes tai užimtų labai daug laiko ir būtų brangu. Populiacijos 
elementai į imtį atrenkami įvairiai, bet dažniausiai sudaroma visiškai atsitiktinė imtis. Labai 
svarbu, kad imtis būtų reprezentatyvi, o tai yra glaudžiai susiję su jos dydžiu. Sudarant imtį, rei-
kia atsižvelgti ne tik į jos dydį, bet ir į keletą kitų kriterijų: į būsimos analizės tipą, į norimą pa-
siekti įverčių tikslumą, į populiacijos sklaidą ir į pasirinktą statistinių išvadų patikimumą. Kaip 
nustatyti pakankamą imties dydį, galima surasti įvairiuose literatūros šaltiniuose, o apklausų im-
ties dydį galima pasirinkti pagal du kriterijus: populiacijos dydį ir imties paklaidą. Tokių lente-
lių galite rasti elektroniniuose ištekliuose. 

Jei populiacijos dydis yra žinomas, rekomenduojamą imties dydį galite apskaičiuoti pagal 
formulę (Schwarze, 1993):

čia: 

l	N – populiacijos dydis, 

l	skaičius 1,96 yra standartizuoto normaliojo skirstinio reikšmė, kai pasikliovimo lygmuo 
	 α=0,05; 

l	p yra numatoma įvykio tikimybė, kad požymis pasireikš tiriamoje populiacijoje (dažniau- 
	 siai pasirenkama p=0,5); 

l	q yra numatoma įvykio tikimybė, kad požymis nepasireikš tiriamoje populiacijoje  
	 (q=1–p=0,5); 
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l	ε yra pageidautinas tikslumas (dažniausiai ε =0,05).

Ši formulė gali būti taikoma paklaidos dydžiui nustatyti, kai žinomas populiacijos ir imties 
dydis. Pagal šią formulę galime apskaičiuoti ir paklaidos ε dydį. Kaip tai gali būti taikoma, pa-
aiškinsime pavyzdžiu. Tarkime, kad populiacijos dydis N=500, o apklausti 123 asmenys, paklai-
dos ε dydis, apskaičiavus pagal pateiktą formulę, apytiksliai yra 0,088, arba 8,8 proc. Ką mums 
tai sako? Jeigu atlikę tyrimą (apklausę 123 respondentus) tam tikrą būdingą savybę nustatytume 
70 proc. apklaustųjų (86 respondentams) su pasikliovimo lygmeniu α=0,05, tai galėtume teigti, 
kad ši savybė būdinga nuo 61,2 proc. (306 respondentams) iki 78,8 proc. (394 respondentams) 
tiriamos populiacijos. 

Pastaba. populiacijos dydis ne visada yra tiksliai žinomas, todėl siūloma imtis – 100–500 
respondentų. Kai jos būna didesnės, kyla pavojus, kad net menkiausias skirtumas bus pripa-
žintas statistiškai reikšmingu. Kai imtis labai maža (20–30 respondentų), net dideli skirtumai 
reikšmingais pripažįstami itin retai.

1.1. Anketavimas 

Pradedant planuoti savo statistinį tyrimą, reikia apsispręsti dėl keleto dalykų ir vienas iš jų 
yra informacijos šaltinių paieška. Statistinę informaciją, kurią dažniausiai renka valstybinės ins-
titucijos, rasite lengvai, bet jei norėsite organizuoti specialų statistinį tyrimą, jums teks pačiam 
surinkti informaciją, kurios nėra oficialiose ataskaitose.

Jei rinksite informaciją, kurios oficiali statistika neteikia, teks atlikti apklausą. Taikant šį in-
formacijos rinkimo metodą, per trumpą laiką galima apklausti tiriamos populiacijos reprezenta-
tyvios imties respondentus. 

Apklausos metodas lengvai formalizuojamas, o tai labai palengvina surinktų duomenų anali-
zę. Apklausti respondentus galime įvairiais būdais, tačiau galima išskirti tris pagrindinius: lais-
vas pokalbis, asmeninis interviu ir anketavimas, kuris yra plačiausiai taikomas.

Renkant informaciją anketavimo metodu, reikia paruošti anketą ir pateikti ją respondentams. 
Anketos sudarymas yra labai atsakingas darbas, reikalaujantis įgūdžių ir žinių. Taip pat jam yra 
keliami ir tam tikri reikalavimai. Anketą sudarančių klausimų skaičius ir išdėstymas priklauso 
nuo tyrimo tikslų. Tad prieš pradedant šį darbą reikia tiksliai žinoti, kokios informacijos jums 
reikia, ką norite išsiaiškinti. Sudarydamas klausimyną tyrėjas tikisi, kad jame surašyti klausimai 
atskleis tyrimo tikslus, bet nedarys įtakos respondentų nuomonei, neskatins rinktis kurį nors at-
sakymą. 

Anketos struktūra susideda iš šių dalių: įvadinės (rašomas trumpas keipimasis į responden-
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tus), padėties (socialinė-demografinė informacija), pagrindinės ir baigiamosios dalių. Pagrindinę 
anketos dalį sudaro pasirinkto tyrimo tematikos klausimai. Šie klausimai gali būti skirstomi į: di-
chotominius, uždaruosius ir atviro tipo klausimus.

Dichotominiai klausimai – tai tie, į kuriuos galima atsakyti tik „Taip“ arba „Ne“. Taip pat šie 
klausimai gali būti išplėsti papildomu klausimu: „Jei taip / ne, tai kodėl?“

Į atviruosius klausimus yra pateikiami laisvos formos atsakymai (respondentas pats suformu-
luoja atsakymą). Atsakymai į tokio tipo klausimus pateikia tyrėjui labai daug informacijos, ta-
čiau ją sunku analizuoti ir formalizuoti.

Uždarieji klausimai yra tie, kuriems jau paruošti atsakymų variantai, o respondentas renkasi 
jam labiausiai tinkamą. Rekomenduotina parinkti ne mažiau kaip penkis atsakymų variantus, jei 
naudojate Likert skalę nuomonei išreikšti. 

Kaip jau supratote, norėdami atlikti apklausą, kad ir labai nesudėtingą, neapsieisite be an-
ketos. Todėl trumpai paminėsiu, kokie pagrindiniai reikalavimai jai taikomi. Pirmas klausi-
myno puslapis paprastai skirtas trumpam kreipimuisi į respondentus. Tai yra tyrėjo paskuti-
nis šansas respondentams sukelti norą dalyvauti tyrime. Šis kreipimasis turėtų paaiškinti res-
pondentams:

ü	kodėl nusprendėte pradėti tyrimą,

ü	kas atlieka tyrimą,

ü	kodėl yra svarbu atsakyti į pateiktus klausimus,

ü	kiek laiko prireiks atsakyti į pateiktus klausimus,

ü	kokiu būdu ir iki kada užpildytas klausimynas turi būti sugrąžintas,

ü	kokie yra tyrėjo kontaktiniai duomenys,

ü	paminėti, kad jos / jo atsakymai bus tiriami anonimiškai, tai yra bus laikomasi konfiden- 
	 cialumo.

Pateiksiu pavyzdį anketos, skirtos atlikti karių ir tarnautojų integracijos į darbo rinką ap-
klausą. 
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Karių ir tarnautojų integracijos į darbo rinką anketos pavyzdys

Gerbiamas respondente,

Generolo Jono Žemaičio Lietuvos karo akademijos mokslininkai atlieka išeinančių ir išė-
jusių į atsargą karių nuostatų tyrimą. Juo siekiama nustatyti problemas, su kuriomis susiduria 
statutiniai darbuotojai ir kaip jie vertina KAS ir VRM parengtas priemones, padedančias in-
tegruotis į darbo rinką ir civilinį gyvenimą. Siekiant numatyti tinkamas paramos priemones ir 
patikrinti jų efektyvumą, svarbu išsiaiškinti Jūsų problemas bei poreikius. Nuoširdžiai atsaky-
dami į anketos klausimus, Jūs suteiksite reikiamą informaciją ir padėsite kurti tokią programą, 
kuri pagerintų buvusių karių ir civilių gyvenimo ir socialines sąlygas. 

Prašome nerašykite savo vardo ar kontaktinės informacijos klausimyne. 
Ši apklausa yra anoniminė, bus naudojami tik statistiškai apibendrinti anketos duomenys. 

Dėkojame už atsakymus.
Prašome atsakyti į klausimus pažymint pasirinktą atsakymą simboliu (X ).

Pavyzdys, kaip reikia atsakyti į pateiktus klausimus:
Lytis? (Jei esate moteris, žymėsite):
1. Vyras 

2. Moteris  X

1.	Kada pradėjote karo tarnybą? (PARAŠYKITE)  metais.

2.	Prieš pradėdamas karo tarnybą Jūs (PAŽYMĖKITE ATSAKYMUS KIEKVIENOJE  
	 EILUTĖJE):

Taip Ne
2.1 Studijavote 1 2
2.2 Turėjote specialybę 1 2
2.3 Turėjote vidurinį ar specialųjį išsilavinimą 1 2
2.4 Turėjote aukštąjį išsilavinimą 1 2
2.5 Dirbote 1 2
2.6 Neturėjote specialybės 1 2
2.7 Negalėjote rasti darbo 1 2
2.8 Kita (PARAŠYKITE)

3.	Kada išėjote į atsargą? (PARAŠYKITE)  metais.



Duomenų analizės SPSS pagrindai14

4.	Kodėl išėjote / išeisite į atsargą? (PAŽYMĖKITE TIK VIENĄ ATSAKYMĄ)
	 1.	Noriu / norėjau pakeisti darbą.
	 2.	Atėjo metas eiti į atsargą / pensiją pagal nustatytą tvarką.
	 3.	Turėjau išeiti į atsargą, nes taip nusprendė vadovybė.
	 4.	Kita (PARAŠYKITE) 

5.	Kada sužinojote, kad turite būti išleistas į atsargą? (PAŽYMĖKITE TIK VIENĄ  
	 ATSAKYMĄ)

	 1.	Prieš mėnesį iki išėjimo į atsargą.
	 2.	Prieš 2–3 mėnesius iki išėjimo į atsargą.
	 3.	Maždaug prieš pusę metų iki išėjimo į atsargą.
	 4.	Prieš metus ir daugiau iki išėjimo į atsargą.

6.	Ar sužinojęs, kad būsite išleistas į atsargą, ėmėtės kokių nors priemonių darbui  
	 susirasti?

	 1.	Taip
	 2.	Ne

7.	Kokių priemonių ėmėtės prieš išeidamas / išėjęs į atsargą darbui susirasti?
	 (PAŽYMĖKITE TINKAMĄ ATSAKYMĄ KIEKVIENOJE EILUTĖJE)

Taip Ne
7.1 Kreipiausi į pažįstamus dėl įdarbinimo 1 2
7.2 Ieškojau darbo internete 1 2
7.3 Išsiunčiau savo gyvenimo aprašymą į darbovietes 1 2
7.4 Išsiunčiau savo gyvenimo aprašymą į įdarbinimo agentūras 1 2
7.5 Pradėjau lankyti kursus ar studijuoti 1 2
7.6 Pradėjau domėtis darbo biržos pasiūlymais 1 2

8.	Ar prieš išeidamas į atsargą kreipėtės į personalo specialistą dėl dalyvavimo karių,  
	 išeinančių į pensiją, profesinio orientavimo programoje? (PAŽYMĖKITE TIK  
	 VIENĄ ATSAKYMĄ)

	 1.	Ne (PEREIKITE PRIE 9 KLAUSIMO)
	 2.	Taip (PEREIKITE PRIE 10 KLAUSIMO)

9.	Kodėl nesikreipėte į personalo specialistą dėl dalyvavimo Pareigūnų ir karių, išlei- 
	 džiamų į pensiją, socialinio prisitaikymo, medicininės reabilitacijos bei profesinio  
	 orientavimo į kitas veiklas programoje?

	 1.	Nežinojau apie tokią programą.
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	 2.	Žinau iš kitų, kad dalyvavimas šioje programoje neduoda jokios naudos.
	 3.	Tokia ir panašios programos man nereikalingos.
	 4.	Kita (PARAŠYKITE) 

TOLIAU ATSAKINĖTI Į 11 KLAUSIMĄ

10.	Įvertinkite Pareigūnų ir karių, išleidžiamų į pensiją, socialinio prisitaikymo, medi- 
		  cininės reabilitacijos bei profesinio orientavimo į kitas veiklos sritis programą?

Taip Ne
10.1 Buvau laiku (prieš 6 mėn.) informuotas raštu apie galimybę dalyvauti 

programoje
1 2

10.2 Personalo specialistas išsamiai informavo apie įstaigas, kuriose galiu 
gauti socialinio orientavimo paslaugas

1 2

10.3 Iš personalo specialisto gavau naudingų pasiūlymų apie galimus kursus 
(anglų, kompiuterių) ir kitas programas

1 2

10.4 Teritorinėje darbo biržoje gavau efektyvias konsultacijas dėl įsidarbinimo 1 2
10.5 Teritorinėje darbo biržoje man pasiūlė naudingus persikvalifikavimo ar 

kvalifikacijos kėlimo kursus
1 2

11.	Ar prieš išeinant į atsargą kėlė nerimą artėjantys gyvenimo pasikeitimai?  
		  (PAŽYMĖKITE TIK VIENĄ ATSAKYMĄ)

		  1.	Ne (PEREIKITE PRIE 12 KLAUSIMO)
		  2.	Taip (PEREIKITE PRIE 13 KLAUSIMO)

12.	Kas padėjo susidoroti su nerimu, nesaugumo jausmu žinant, kad reikės  
		  greitai išeiti iš kariuomenės? (PAŽYMĖKITE NE DAUGIAU KAIP 2 JUMS  
		  TINKAMUS ATSAKYMUS)

	 1.	Pats / pati susitvarkau.
	 2.	Šeima padeda.
	 3.	Giminės ir draugai padeda.
	 4.	Psichologas.
	 5.	Kita (PARAŠYKITE)  

13.	Ką ketinote veikti išėjęs į atsargą? (PAŽYMĖKITE IKI 5 ATSAKYMŲ)
		  1. Iškart ieškoti darbo.
		  2. Likti KAS.
		  3. Kurti savo verslą.
		  4. Nedirbti.
		  5. Skirti laiką sau (pataisyti sveikatą ir pan.).
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		  6. Pasimokyti ir pakeisti profesiją.
		  7. Išvykti padirbėti užsienyje.
		  8. Prieš išeidamas į atsargą apie tai negalvoju / negalvojau.
		  9. Kita (PARAŠYKITE) 

14.	Ar šiuo metu dirbate?
	 1.	Ne (PEREIKITE PRIE 15 KLAUSIMO)
	 2.	Taip (PEREIKITE PRIE 16 KLAUSIMO)

15.	Kaip Jūs manote, dėl kokių priežasčių nepavyko susirasti tokio darbo, kurio tikrai  
		  norėjote? (PAŽYMĖKITE NE DAUGIAU KAIP 3 ATSAKYMUS)

		  1.	Vyresnis amžius.
		  2.	Nepalankios siūlomos sąlygos.
		  3.	Nepalankus požiūris į kariuomenę.
		  4.	Nepalankūs įstatymai dėl dirbančių pensininkų.
		  5.	Sveikatos būklė.
		  6.	Tai, kad neturiu specialaus išsilavinimo (profesijos).
		  7.	Tai, kad neturiu aukštojo išsilavinimo.
		  8.	Tai, kad neturėjau darbo patirties.
		  9.	Kita (PARAŠYKITE) 

16.	Nurodykite, su kokiomis asmeninėmis problemomis dažniausiai susidūrėte ar  
		  susiduriate civiliniame gyvenime po to, kai išėjote į pensiją? (PAŽYMĖKITE TIK 
		  PO VIENĄ ATSAKYMĄ KIEKVIENOJE EILUTĖJE)

Nuolatos Dažnai Retai Niekada
16.1 Pasigendu kariuomenėje įprastos tvarkos 

ir disciplinos 1 2 3 4

16.2 Sunku pačiam priimti sprendimus 1 2 3 4
16.3 Nepakenčiu kitų vadovavimo 1 2 3 4
16.4 Sunku priprasti prie laisvo laiko 

pertekliaus 1 2 3 4

16.5 Nerandu / neradau tokio darbo, kokio 
norėčiau 1 2 3 4

16.6 Šeimoje prasidėjo nesutarimai, kurių 
anksčiau nebuvo 1 2 3 4

16.7 Pablogėjo gyvenimo kokybė 1 2 3 4
16.8 Sunku susidoroti su naujomis pareigomis 

darbe 1 2 3 4
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TOLIAU PILDO VISI (DIRBANTYS IR NEDIRBANTYS)

17. 	Maždaug kokios yra Jūsų asmeninės pajamos (skaičiuojant kartu pensiją, darbo  
		  užmokestį ir pan.) per mėnesį šiuo metu?

1. iki 200 € 4. 801–1100 €
2. 200–500 € 5. 1101–1400 €
3. 501–800 € 6. 1401 € ir daugiau

18.	Jūsų lytis
		  1.	Vyras 
		  2.	Moteris 

19.	Kiek Jums metų?  metų

20.	Jūsų šeiminė padėtis: (PAŽYMĖKITE TIK VIENĄ ATSAKYMĄ)
		  1.	Gyvenu be partnerės (-io).
		  2.	Vedęs.
		  3.	Išsiskyręs (-usi)
		  4.	Gyvenate neregistravęs (-usi) santuokos.

21.	Jūsų išsimokslinimas: (PAŽYMĖKITE TIK VIENĄ ATSAKYMĄ)
		  1.	Vidurinis.
		  2.	Aukštesnysis.
		  3.	Aukštasis neuniversitetinis (bakalauras).
		  4.	Aukštasis universitetinis (magistras).
		  5.	Kita (PARAŠYKITE) 

22.	Jūsų karinis laipsnis prieš išeinant į atsargą (PARAŠYKITE) 

23.	Gyvenamoji vieta: (PARAŠYKITE)  

Dėkojame už Jūsų atsakymus!

Šaltinis: Gružveskis B., Maslauskaitė A., Korsakienė R., Novagrockienė J., Smaliukienė R., Šakočius A. 2014. 
Pareigūnų ir karių antroji karjera. Monografija. V.: Gen. J. Žemaičio karo akademija, adaptuota autorės.
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Norėčiau atkreipti dėmesį į tai, kad nuo to, kaip respondentas suprato jam suformuluotą klau-
simą, gali priklausyti apklausos rezultatų tikslumas. Todėl sudarant klausimus, reikia vengti 
skirtingai vertinamų teiginių, tokių kaip: „kartais“, „retai“, „dažnai“. Jei vienam respondentui 
žodis „kartais“ reikš kartą per mėnesį, tai kitam – kartą per savaitę. Taigi netinkamai suformu-
luoti teiginiai suteiks visiškai skirtingą prasmę skirtingiems respondentams, o surinkti apklausos 
duomenys iškraipys tyrimo rezultatą. 

Sudarius anketą, yra siūloma ją patikrinti apklausiant tik keletą respondentų, kurie vėliau, 
užpildę anketą, išsako savo nuomonę apie pateiktus klausimus ir atsakymų variantus. Tokie ko-
mentarai padeda tyrėjui tobulinti tiek visą anketą arba tik kai kuriuos jos klausimus, tiek esamus, 
ar trūkstamus atsakymus.

Kitas šios mokomosios knygos poskyris skirtas anketavimo būdu surinktos informacijos koda-
vimui. 

1.2. Informacijos kodavimas

Specialiai organizuojami ir atliekami statistiniai tyrimai, kai reikia informacijos, kurios ofi-
ciali statistika neteikia. Atlikę apklausą ir surinkę informaciją pagal pateiktus klausimynus jūs 
jau turėsite duomenis, kuriuos apdoroję (užkodavę) galėsite atlikti tyrimą SPSS programų pa-
ketu. 

Visai nesvarbu, kokiu būdu bus gauta statistinė informacija, tačiau norėdami ja pasinaudoti ir 
atlikti išsamią analizę, jūs turėsite mokėti teisingai ją apdoroti statistine programa. Tam, kad ga-
lėtumėte lengviau ir be klaidų atlikti šią užduotį, trumpai susipažinsime su kodavimo instrukci-
jomis, kuriomis naudositės konvertuodami surinktą informaciją iš kiekvieno klausimyno į for-
matą, kurį gali suprasti SPSS programų paketas.

Duomenų kodavimą analizuosime panaudodami duomenų rinkmeną, kuri buvo specialiai tam 
sukurta. Klausimyno kopiją ir kodavimą, kuris buvo sukurtas šiam klausimynui, rasite šios mo-
komosios knygos priede.

Tokiu būdu galėsite susipažinti ir suvokti visą procesą nuo klausimyno iki galutinio duome-
nų rinkmenos sukūrimo, paruošto analizei atlikti su SPSS programų paketu. Kad suprastumėte 
duomenų kodavimo veiksmus ir svarbą, naudosime klausimyną, tačiau panašų procesą taip pat 
turėtume atlikti apdorodami surinktus eksperimentinių tyrimų duomenis. 

Kodavimas susideda iš surinktų anketų apdorojimo. Tai, kas anketoje buvo įvardijami 
kaip klausimai, SPSS programų pakete bus kintamieji. 1.1 poskyryje pateiktame „Karių ir 
tarnautojų integracijos į darbo rinką“ anketos pavyzdyje yra 23 klausimai, tačiau kai ku-
rie klausimai yra sudėtiniai, tad surinktus duomenis pateikus SPSS turėsime 67 kintamuo-
sius. Šitaip atsitinka todėl, kad kintamaisiais SPSS programų pakete tampa visi responden-
tų įvertinti teiginiai. Kaip pavyzdį pasiaiškinkime klausimą, kuriuo respondentas yra prašo-
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mas įvertinti 8 teiginius. 

Klausimas. „Nurodykite, su kokiomis asmeninėmis problemomis dažniausiai susidūrėte ar 
susiduriate civiliniame gyvenime po to, kai išėjote į pensiją? (PAŽYMĖKITE TIK PO VIENĄ 
ATSAKYMĄ KIEKVIENOJE EILUTĖJE)“: 

Nuolatos Dažnai Retai Niekada
1 Pasigendu kariuomenėje įprastos tvarkos ir disciplinos 1 2 3 4
2 Sunku pačiam priimti sprendimus 1 2 3 4
3 Nepakenčiu kitų vadovavimo 1 2 3 4
4 Sunku priprasti prie laisvo laiko pertekliaus 1 2 3 4
5 Nerandu / neradau tokio darbo, kokio norėčiau 1 2 3 4
6 Šeimoje prasidėjo nesutarimai, kurių anksčiau nebuvo 1 2 3 4
7 Pablogėjo gyvenimo kokybė 1 2 3 4
8 Sunku susidoroti su naujomis pareigomis darbe 1 2 3 4

Šaltinis: Gružveskis B., Maslauskaitė A., Korsakienė R., Novagrockienė J., Smaliukienė R., Šakočius A. 2014. 
Pareigūnų ir karių antroji karjera. Monografija. V.: Gen. J. Žemaičio karo akademija.

Taigi SPSS programų pakete bus sukurti 8 kintamieji, kuriuos bus galima analizuoti kaip ran-
gų skalėje išmatuotų kintamųjų bloką (apie tai plačiau 5.2.3 skyriuje), o tyrimo rezultatas padės 
išsiaiškinti respondentų problemas, su kuriomis jie susiduria civiliniame gyvenime.

Suformuluoti klausimai yra per ilgi, kad liktų kintamųjų pavadinimais SPSS, todėl jūsų lau-
kia pakankamai kruopštus darbas, nes privalėsite: 

l	suteikti kiekvienam kintamajam pavadinimą,

l	užkoduoti visus galimus kategorinių kintamųjų atsakymus.

Visa ši informacija turi būti išsaugota jums patogiu formatu, tai yra įrašyta į kompiuterio rin-
kmeną. Kodavimo informacija yra labai svarbi, nes atliekant tyrimą, nėra nieko blogiau, kai ne-
besusigaudote ką reiškia kintamųjų vardų santrumpos ir skaičiai. Todėl kartkartėmis teks grįžti 
prie užkoduotų duomenų aprašo.

Savo kodavimo dokumente turėtumėte išvardyti visus tyrime naudoto klausimyno kintamuosius 
(klausimus) ir sutrumpintus kintamųjų vardus, kuriuos naudosite SPSS. Taip pat kodavimo apraše 
yra nurodomas būdas, kuriuo bus užkoduoti atsakymai. 1.1 lentelėje pateikiamas pavyzdys, ilius-
truojantis klausimyno kodavimą. 



Duomenų analizės SPSS pagrindai20

1.1 lentelė. Kodavimo aprašo pavyzdys.

Kintamasis SPSS kintamojo 
vardas Kodavimo instrukcijos

Identifikacijos numeris ID Numeris priskiriamas kiekvienam klausimynui 
Lytis lytis 1 = Vyras

2 = Moteris
Amžius amzius Amžius metais
Šeiminė padėtis seima 1 = niekada nebuvo susituokęs; 

2 = gyvena susituokęs;
3 = oficialiai išsiskyręs (-usi);
4 = oficialiai neišsiskyrę, bet gyvena atskirai;
5 = našlys (-ė).

Optimizmo skalė nuo 1 iki 6 opt1 iki opt 6 Įrašomi skaičiai nuo 1 (kategoriškai nesutinku) iki 
5 (visiškai pritariu)

Pirmoje 1.1 lentelės skiltyje išvardyti kintamųjų vardai. Antroje skiltyje surašyti vardų trum-
piniai, kuriuos naudosime įrašydami kintamuosius į SPSS. Trečia skiltis skirta kintamųjų koda-
vimo instrukcijoms pažymėti.

Kitas šios mokomosios knygos poskyris skirtas kintamųjų vardų priskyrimo taisyklėms api-
būdinti.

1.2.1. Kintamųjų vardai

Kiekvienas klausimyno klausimas ar punktas turi turėti savo unikalų kintamojo pavadini-
mą. Iš kai kurių kintamųjų pavadinimų galima aiškiai nustatyti informaciją (pvz., lytis, amžius 
ir pan.). Klausimai, kurie sudaryti panaudojant skales, gali būti identifikuojami santrumpomis 
(pvz., opt1, opt2, opt3 yra naudojami siekiant nustatyti elementus, kurie sudaro optimizmo ska-
lę). SPSS programų paketas turi griežtas kintamųjų vardų priskyrimo taisykles, kurių reikia lai-
kytis.

Kintamųjų vardų priskyrimo taisyklės

Kintamųjų pavadinimai:

l	turi būti unikalūs (tai yra kiekvienas kintamasis duomenų rinkinyje turi skirtis pavadinimu);

l	gali turėti tik aštuonis ar mažiau simbolių;

l	turi prasidėti raide (ne skaičiumi);

l	negali būti tarpų ar kitų simbolių (, * „“?!);
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l	negali būti vartojami žodžiai, kuriuos SPSS programų paketas naudoja kaip komandas (all,  
	 no, eq, to, le, lt, by, or, gt, and, not, ge, with).

Pirmasis kintamasis bet kurių duomenų rinkinyje turėtų būti ID, tai yra unikalus numeris, ku-
ris identifikuoja kiekvieną atvejį (anketą). Prieš pradedant įrašyti duomenis, pirmiausia reikia ID 
numerį susieti su kiekviena anketa arba duomenų įrašu. Rašyti skaičius aiškiai ant pirmojo anke-
tos (klausimyno) lapo. Vėliau atliekant SPSS programų paketo pateiktų duomenų tikrinimą, su-
numeruotos anketos ar duomenų įrašai leis jums lengviau patikrinti ir rasti, iš kurios anketos įra-
šant duomenis įvyko klaida. 

Kitas šios mokomosios knygos poskyris skirtas respondentų atsakymų į klausimus kodavi-
mo taisyklėms apibūdinti.

1.2.2. Atsakymų kodavimas

Kiekvienam pateikto klausimo atsakymui, prieš jį įtraukiant į SPSS kintamųjų sąrašą, reko-
menduojama priskirti skaitmeninį kodą, jei atsakymas į klausimą matuojamas kokybinėje ska-
lėje. SPSS programų pakete galima naudoti ir simbolinius kintamuosius, pvz., vietoj ID galima 
įrašyti respondento vardą. Tačiau įrašant kategorinius kintamuosius, kurie yra aptariami žemiau, 
daug paprasčiau ir greičiau naudoti skaitmeninius kodus, nes kodą 1 surinkti 600 kartų bus daug 
lengviau, nei žodį puskarininkis. Bet jei pageidautumėte naudoti simbolinius kintamuosius, tai 
SPSS programų pakete tokia galimybė yra numatyta. 

Atliekant tyrimą dalis surinktos informacijos jau gali būti skaitmeninė (pvz., amžius metais), 
tačiau kitiems kintamiesiems, tokiems kaip lyties, turėsime priskirti skaičius patys (pvz., 1 = vy-
ras, 2 = moteris). Jei klausimų atsakymus ženklinate skaičiais, tai kodavimo procedūra yra gana 
paprasta. Jei ne, priimate sprendimą dėl atsakymų kodavimo po apklausos. Pavyzdžiui, pirmą 
atsakymą užkoduojate 1, o antrą – 2 ir t. t. Jei turime klausimą, kurio atsakymai nesunumeruo-
ti, pvz.:

Jūsų išsilavinimas? (prašome pažymėti): 
¨	vidurinis  
¨	profesinis
¨	aukštasis neuniversitetinis  
¨	aukštasis

tokio tipo klausimų atsakymus galime užkoduoti tokia tvarka: respondentas pažymėjo „viduri-
nis“, koduosime 1; jei pažymėjo „profesinis“, – 2; jei pasirinko „aukštasis neuniversitetinis“, – 
3; jei „aukštasis“, – 4.

Atvirų klausimų kodavimas aptariamas kitame poskyryje.
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1.2.3. Atvirų klausimų kodavimas

Atviro tipo klausimai neturi iš anksto numatytų galimų atsakymų, todėl jie suteikia galimy-
bę respondentams pateikti savo suformuluotus atsakymus. Dėl šios ypatybės jų kodavimas yra 
šiek tiek sudėtingesnis. 

Kaip pavyzdį paanalizuosime galimus atsakymus į atviro tipo klausimą: Kas yra pagrindi-
nis streso šaltinis jūsų gyvenime šiuo metu? Norint užkoduoti atsakymus į šį klausimą, jums 
reikia perskaityti visų apklausoje dalyvavusių respondentų atsakymus ir surasti bendrų atsaky-
mų variantus. Gali būti, kad daugelis respondentų streso šaltinį nurodys susijusį su: darbu, fi-
nansais, ryšiais, sveikata ar laiko stoka. Norėdami surinktą informaciją paversti duomenimis, 
tinkamais tolesnei analizei, savo kodavimo dokumente sukursime kintamąjį „stresas“, o paste-
bėtoms atsakymų grupėms priskirsime skaičius (darbas = 1, finansai = 2 ir t. t.). Jums taip pat 
reikės pridėti dar vieną skaitmeninį kodą atsakymų variantams, kurie nepateko į išvardytas ka-
tegorijas (kita = 9). 

Įkeliant duomenis į SPSS programų paketą, kiekvienam respondentui kintamojo streso kodas 
turės būti priskirtas pagal jūsų sukurtą kodavimą kintamųjų kodų dokumente. Kitaip tariant, jūs 
palyginsite kiekvieno respondento atsakymą su išvardytomis atsakymų grupėmis kodavimo do-
kumente ir įrašysite reikiamą skaičių į duomenų rinkinį.

Jei jau parengėte kodavimo dokumentą, tai esate pasirengę surinktus duomenis įkelti į SPSS 
programų paketą. Tačiau apie tai skaitykite kitame skyriuje.
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1.3. Užduotys

1 užduotis. Respondentų atsakymų į anketos nr. 1 klausimus pirminis apdorojimas. 
1 lentelėje pateikti respondentų atsakymai į anketos nr. 1 klausimus. Atlikite tokias užduotis:

1.	priskirkite kintamiesiems vardus;

2.	kategoriniams kintamiesiems priskirkite kodus;

3.	užkoduokite atvirus klausimus.

Anketa nr. 1

K1. Lytis:
¨	 vyras 
¨	 moteris

K3. Jūsų išsilavinimas: 

K2. Amžius: K4. Vietovę, kurioje gyvenate, apibūdintumėte kaip: 
¨	 kaimo
¨	 miesto

1 lentelė

ID K1 K2 K3 K 4 ID K1 K2 K3 K 4
1. vyras 65 profesinis kaimo 16. moteris 22 vidurinis kaimo
2. vyras 26 bakalauras miesto 17. moteris 34 profesinis kaimo
3. vyras 20 vidurinis miesto 18. vyras 26 bakalauras miesto
4. moteris 32 bakalauras kaimo 19. vyras 28 magistras miesto
5. moteris 24 profesinis kaimo 20. vyras 32 bakalauras miesto
6. vyras 27 magistras miesto 21. vyras 31 profesinis kaimo
7. vyras 58 vidurinis miesto 22. moteris 45 bakalauras kaimo
8. vyras 23 vidurinis miesto 23. moteris 31 vidurinis kaimo
9. moteris 50 vidurinis kaimo 24. vyras 35 bakalauras miesto
10. moteris 41 bakalauras kaimo 25. vyras 26 profesinis miesto
11. moteris 28 profesinis kaimo 26. moteris 32 magistras miesto
12. moteris 36 magistras kaimo 27. moteris 30 profesinis kaimo
13. moteris 26 bakalauras miesto 28. vyras 57 magistras miesto
14. vyras 22 vidurinis miesto 29. vyras 39 magistras miesto
15. vyras 25 profesinis kaimo 30. moteris 21 vidurinis miesto
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2 užduotis. Respondentų atsakymų į anketos nr. 2 klausimus pirminis apdorojimas. 
2 lentelėje pateikti respondentų atsakymai į anketos nr. 2 klausimus. Atlikite tokias užduotis:

1. priskirkite kintamiesiems vardus;

2. 	kategoriniams kintamiesiems priskirkite kodus;

3.	užkoduokite atvirus klausimus.

Anketa nr. 2

K1. Lytis:
¨	 vyras 
¨	 moteris

K3. Ar mėgstate savo darbą?
¨	 labai mėgstu
¨	 mėgstu
¨	 nežinau
¨	 nemėgstu
¨	 labai nemėgstu

K2. Amžius: 
¨	 nuo 20–30 metų 
¨	 nuo 31–50 metų
¨	 51 metai ir daugiau

K4. Ką mėgstate veikti laisvalaikiu?

2 lentelė

ID K1 K2 K3 K 4 ID K1 K2 K3 K 4
1. vyras 3 2 žvejoti, skaityti spaudą 16. moteris 1 5 megzti, skaityti
2. vyras 1 1 sportuoti 17. moteris 2 5 važinėti dviračiu, 

užsiimti joga
3. vyras 1 2 žaisti kompiuterinius 

žaidimus
18. vyras 1 4 šaudyti iš lanko, skaityti

4. moteris 2 1 megzti, skaityti 19. vyras 1 4 sportuoti, žiūrėti TV
5. moteris 1 1 aerobiką, naršyti 

internete
20. vyras 2 3 lankytis operos baleto 

teatre
6. vyras 1 1 sportuoti 21. vyras 2 3 klausyti muzikos
7. vyras 3 1 važinėti dviračiu 22. moteris 2 2 eiti į kiną, teatrą
8. vyras 1 4 skaityti 23. moteris 2 1 megzti
9. moteris 2 2 megzti, skaityti 24. vyras 2 3 skaityti, žiūrėti TV

10. moteris 2 4 kepti pyragus, žiūrėti TV 25. vyras 1 2 sportuoti
11. moteris 1 4 šokti, dainuoti 26. moteris 2 5 gaminti valgius
12. moteris 2 1 gaminti valgius 27. moteris 1 1 kepti pyragus
13. moteris 1 1 sportuoti, piešti 28. vyras 3 2 žvejoti, skaityti spaudą
14. vyras 1 1 žaisti kompiuterinius 

žaidimus, skaityti
29. vyras 2 5 medžioti, žvejoti

15.	 vyras 1 1 važinėti dviračiu, žaisti 
futbolą

30. moteris 1 5 gaminti valgius, skaityti



S P S S  p r o g r a m ų  p a k e t a s 25

2. SPSS programų paketas

Šiame skyriuje rasite informaciją apie SPSS programų paketo pagrindinius langus ir jų pa-
skirtį. Taip pat čia rasite paaiškinimą apie duomenų, apdorotų tiek Microsoft Excel programa, 
tiek tekstiniu redaktoriumi, panaudojimą atliekant statistines analizes SPSS. Skyriaus pabaigo-
je pateiktos praktinės užduotys padės lavinti įgūdžius, kuriuos galėsite pritaikyti atlikdami savo 
tyrimus.

SPSS – galingas, patogus vartotojui programinės įrangos paketas, skirtas duomenų statistinei 
informacijai apdoroti. Šis paketas tinka ir pradedančiajam vartotojui, nes lengvai įvaldoma dia-
loginė sąsaja. Taip pat SPSS programų paketas apima daug šiuolaikinių statistinių analizės me-
todų ir duomenų analizės rezultatų vizualizavimo priemonių.

Prieš pradedant dirbti su SPSS, reikia atkreipti dėmesį į keletą svarbių jo savybių. Viena jų − 
SPSS yra keli skirtingų paskirčių langai. Kita − galėsite atidaryti esamų duomenų rinkmenas, 
kurios yra tekstinės arba sukurtos Microsoft Excel programa. Šiame skyriuje rasite išsamiai pa-
aiškinta, kaip SPSS programų paketu pradėti ir baigti darbą, kaip atidaryti ir uždaryti esamas 
duomenų rinkmenas ir kaip sukurti naują duomenų rinkmeną. 

2.1. Darbo su SPSS pradžia

Yra keletas būdų pradėti darbą su SPSS programų paketu. Paprasčiausias būdas yra ieš-
koti SPSS piktogramos darbalaukyje (2.1 a pav.), tada žymekliu užeiti ant piktogramos ir du-
kart spustelėti. Taip pat galite pradėti darbą SPSS ir kitu būdu. Jums reikės atlikti tokius žings-
nius: pasirinkite START->All Programs->IBM SPSS Statistics-> IBM SPSS Statistics 20  
(2.1 b pav.).

a b

2.1 pav. SPSS programų paketo aktyvavimas: a) piktograma darbalaukyje; b) pasirinkimas  
START->All Programs->IBM SPSS Statistics-> IBM SPSS Statistics 20.
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Yra ir dar vienas būdas pradėti darbą su SPSS programų paketu. Šis būdas yra pats papras-
čiausias, nes jums tereikia pasirinkti ir aktyvuoti bet kurią šia programa sukurtą rinkmeną. 

2.2. Duomenų pateikimas SPSS 

Kaip jau supratote, visai nesvarbu, kurį būdą panaudosite aktyvuoti ir pradėti darbą su SPSS 
programų paketu, tai priklausys tik nuo jūsų. Tačiau panaudoję pirmus du būdus, turėtumėte 
kompiuterio ekrane pamatyti langą, panašų į tą, kuris yra 2.2 pav. Pirmu numeriu pažymėtame 
lange jūsų darbo pradžioje SPSS programų paketas vartotojui užduoda klausimą: „Ką jūs ruošia-
tės daryti?“ ir pasiūlo pasirinkti vieną iš išvardytų galimybių:

l	Pasimokyti dirbti su SPSS (Run the tutorial);

l	Suvesti duomenis (Type in data);

l	Atidaryti egzistuojančią užklausą (Run an existing query);

l	Sukurti naują užklausų duomenų bazę (Create new query using Database Wizard);

l	Atidaryti SPSS programų paketu sukurtą rinkmeną (Open an existing data source);

l	Atidaryti kita programa sukurtą duomenų rinkmeną (Open an another type of file).

2.2 pav. SPSS programų paketo darbo pradžios langai (1 ir 2).
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Pirmu numeriu pažymėtame lange yra galimybė jį išjungti pažymint „Don‘t show this dialog in 
the future“. Tuomet kitą kartą aktyvavę SPSS programų paketą mes išvysime tik langą, kuris pa-
žymėtas antru numeriu (2.2 pav.). Tokiu atveju darbo pradžioje jūs turėtumėte gauti tuščią skaičiuo-
klę, tiesiog laukiančią, kol įrašysite duomenis arba atidarysite duomenų rinkmeną. Norėdami atida-
ryti egzistuojančią (jau anksčiau sukurtą) rinkmeną programos lange, meniu juostoje galėsite pasi-
rinkti žingsnius: Fille-> Open-> Data, kaip parodyta 2.3 pav.

	

2.3 pav. Pirmame žingsnyje pasirinkta „Atidaryti jau sukurtą duomenų rinkmeną“.

Kad būtų aiškiau, išsamiau aptarsime anksčiau išvardytus SPSS programų pakete naudoja-
mus duomenų pateikimo būdus. Norėdami atlikti duomenų analizes, galėsime panaudoti duome-
nis, apdorotus tiek Microsoft Excel programa, tiek tekstiniu redaktoriumi. Tai labai patogu, nes 
taip palengvinsime, supaprastinsime ir pagreitinsime darbą, kurį atliekant įprastu būdu, suren-
kant duomenis patiems, užimtų daug laiko.

Tad jei turite duomenis, paruoštus Microsoft Excel programa, jums reikės jau pirmame žings-
nyje pasirinkti „Atidaryti egzistuojantį duomenų šaltinį“ (Open an existing data source) arba 
galėsite pasirinkti žingsnius: Fille-> Open-> Data, kaip parodyta 2.3 pav. 
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Po to atsidariusiame lange (2.4 pav.) pasirinksime mus dominančią rinkmeną, kurios plėtinys 
turi būti *.xls, *.xlsx , *.xlsm.

2.4 pav. Pasirenkame atidaryti jau Microsoft Excel programa sukurtą duomenų rinkmeną.

Atlikę šiuos žingsnius pamatysime langą, pavaizduotą 2.5 paveikslėlyje, kuriame galime pa-
sirinkti: 

l	Ar norime, kad būtų nuskaityti ir perkelti egzistuojantys kintamųjų vardai? Jei taip, tai  
	 kintamųjų stulpelių viršutinėje eilutėje esanti informacija bus viso stulpelio pavadinimas.  
	K adangi SPSS programų paketas turi tam tikras taisykles suteikdamas kintamiesiems vardus,  
	 jie bus konvertuojami į programai priimtinus. Tai matote 2.6 paveikslėlyje.

2.5 pav. Pasirenkame atidaryti jau Microsoft Excel programa sukurtą duomenų rinkmeną.
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2.6 pav. Informacija perkelta iš demo.xls rinkmenos nuskaitant kintamųjų vardus ir  
„Range“ laukelyje pasirenkant „A1:AB20“.

l	Turime ir kitą galimybę, kuri leidžia išrinkti analizei dalį duomenų, o ne visus. Tuo atve- 
	 ju privalome nurodyti laukelyje „Range“ tikslų langelių skaičių. Pavyzdžiui, nurodžius  
	 „A1:AB20“, analizei bus išrinkta tik 20 eilučių informacijos, iš kurių pirmoji bus skirta 
	 kintamųjų pavadinimams (2.6 pav.). 

2.2.1. Tekstinės informacijos įkėlimas į SPSS darbalaukį

Daugelis programų geba išsaugoti informaciją „*.txt“ formatu. Importuoti duomenis, apdo-
rotus tekstiniu redaktoriumi į kitoms programoms suprantamą formatą, nėra paprasta, bet SPSS 
programų pakete yra numatyta galimybė perkelti ir tokio tipo duomenis. Žinoma, tai nebus taip 
lengva kaip Microsoft Excel programa apdorotos informacijos siuntimas, todėl išsamiau anali-
zuosime, nuo ko reikėtų pradėti.

Taigi pasirinksime tekstinę rinkmeną „demo.txt“ (2.7 pav.), kurioje esančią informaciją perkelsi-
me į SPSS programų paketo darbalaukį, kad vėliau galėtume atlikti statistinę šių duomenų analizę.  

Pirmas žingsnis, kurį atliksime, bus pasirinkti „Atidaryti egzistuojantį duomenų šaltinį“ 
(Open an existing data source) arba pasirinkti žingsnius SPSS programų paketo meniu juostoje:  
Fille-> Open-> Read Text Data. 
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2.7 pav. Rinkmena demo.txt. 

Taip pat galime pasirinkti žingsnius SPSS programų paketo meniu juostoje: Fille-> Open-> 
Data, kaip parodyta 2.3 paveikslėlyje. Visais išvardytais būdais atidarysime SPSS programų pake-
to langą, pavaizduotą 2.4 paveikslėlyje, o tada pasirinksime rinkmeną, kurios plėtinys yra „*.txt“. 

2.8 pav. Šešių žingsnių duomenų perkėlimas iš tekstinės rinkmenos. Pirmas žingsnis.
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2.9 pav. Šešių žingsnių duomenų perkėlimas iš tekstinės rinkmenos. Antras žingsnis.

Šiuo atveju, kaip jau buvome minėję, kaip pavyzdį pasirinkome tekstinę rinkmeną demo.txt 
(2.7 pav.). Po šio pasirinkimo, atsivers programų langas, pavaizduotas 2.8 pav.

Tekstinėje rinkmenoje reikėtų atkreipti dėmesį į tai, kokiu būdu yra atskirti kintamieji (kab-
leliais, tarpais ar kitais ženklais). Rinkmenoje demo.txt kintamieji atskirti tarpais. Ši informa-
cija labai svarbi, nes perkeliant duomenis iš tekstinės rinkmenos, SPSS programų paketas juos 
sudėlioja į lentelę, be to, šešių žingsnių programos languose teks nurodyti šią informaciją taip, 
kaip nurodyta 2.9 pav. Kaip jau supratote, jūs pagal savo kompetenciją turite atsakyti į visus 
pateiktus klausimus, kurie bus užduodami perkeliant duomenis, o programa pagal jūsų nuro-
dymus atliks duomenų perkėlimą. Jums pateiktuose 2.8–2.13 paveikslėliuose yra atvaizduoti 
visi tekstinės rinkmenos duomenų perkėlimo žingsniai, kuriuos reikia atlikti. Taip pat reikė-
tų atkreipti dėmesį į visus klausimus, kurie yra apvesti raudona linija kiekviename iš langų  
(2.8−2.13 pav.). 

Trumpai aptarsime kiekvieną iš šešių žingsnių. Pradėkime nuo pirmo žingsnio, kitaip tariant 
nuo 2.8 pav., kuriame yra galimybė nurodyti pasirinktos tekstinės rinkmenos iš anksto apibūdin-
tą formatą, pasirenkant opciją „Yes“ ir nurodant jos buvimo vietą arba „No“. Šiame lange mes pa-
sirinkome „No“. Tačiau neskubėkite ir atkreipkite dėmesį į tai, kad šio lango (kaip ir visų pen-
kių likusių) apačioje tuoj po nuorodos „Text file : C:\ Program Files\ IBM \ SPSS \ Statistics\ 
20\ Samples\English\demo.txt“ į atidarytą demo.txt rinkmeną, matome jos fragmentą rėmely-
je su slankmačiais ir liniuote kairėje pusėje. Slankmačiai reikalingi tam, kad galėtume pamaty-
ti mums rūpimą informaciją, o liniuotė padės pasirenkant eilutę, nuo kurios bus įkelti duomenys. 
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Jeigu nepasirinkote kitaip, tai lango 2.8 pav. apatinėje dalyje, pirmoje eilutėje, matome tai, kas yra  
demo.txt rinkmenos (2.8 pav.) viršutinėje eilutėje. Susipažinus su pateikta informacija ir atsakius 
į užduotus klausimus belieka rinktis „Next“ ir pereiti prie kito žingsnio, kuris atvers kitą langą.

Atvėrę antrą langą (2.9 pav.), turime atsakyti į du svarbius klausimus, kurių pirmas lemia, 
kaip tekstinėje rinkmenoje yra atskirti kintamieji. Mums reikėtų atidžiai pažiūrėti į tekstinės rin-
kmenos fragmentą ir nuspręsti, ką pasirinkti iš siūlomų galimybių. Jei kintamieji atskirti tarpais, 
kableliais ar kokiais kitais specifiniais ženklais, tada reikia pasirinkti „Delimited“. Tekstinėje 
rinkmenoje duomenys gali būti išdėlioti ir fiksuoto pločio stulpeliais, tada reikia rinktis „Fixed 
width“. Rinkmenoje demo.txt duomenys atskirti tarpais, o ne surikiuoti į vienodo pločio stul-
pelius, tad renkamės „Delimited“.

Antras klausimas lange (2.9 pav.) yra užduodamas tam, kad nurodytume, ar kintamųjų vardai 
yra tekstinės rinkmenos viršutinėje eilutėje. Yra visokio tipo tekstinių rinkmenų, tad programa 
numato du pasirinkimus: „taip“ (Yes) ir „ne“ (No). Kaip jau supratote, kurią siūlomą opciją pa-
sirinkti, spręsime patys. Jums pateiktame pavyzdyje yra pasirinktas neigiamas atsakymas (No). 
Tai reiškia, kad atsiųsdama duomenis programa automatiškai neperkels kintamųjų vardų, o tai 
galėsime padaryti mes patys penktame duomenų perkėlimo žingsnyje. 

Kadangi programa yra labai lanksti ir patogi vartotojui, ji suteikia galimybę pakeisti anksčiau 
atliktus bet kuriuos pasirinkimus. Tad, jei nuspręsite ką nors keisti, pasinaudokite opcija „Back“. 
Tokiu būdu galėsite sugrįžti į bet kurį iš prieš tai buvusių programos langų ir galėsite atlikti pa-
keitimus. Jei jus viskas tenkina, tada renkatės mygtuką „Next“, kuris perkels į kitą tekstinės rin-
kmenos apdorojimo programos langą.

2.10 pav. Šešių žingsnių duomenų perkėlimas iš tekstinės rinkmenos. Trečias langas.
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Atsivėrus trečiam langui, kurį matote 2.10 paveikslėlyje, mūsų laukia naujos užduotys. 
Kadangi antrame lange (2.9 pav.) pasirinkome opciją, kuri nurodė, kad tekstinės rinkmenos pir-
moje eilutėje nėra kintamųjų pavadinimų, tai šiame lange atsakant į klausimą „Nuo kurios eilu-
tės perkelti duomenis?“ (The first case of data begins on which the number?), reikės įvesti 
tiesiog eilutės numerį ir atkreipti dėmesį, ar teisingai pasirinkote naujos rinkmenos pradžią. Tai 
galite stebėti Text Import Wizard - Delimited Step 3 of 6 lango apačioje pavaizduotame doku-
mento fragmente (2.10 pav.). Pavyzdyje pasirinkta antra eilutė (skaičius 2). Kairėje pusėje esan-
ti liniuotė rodo, kad pirmoje eilutėje jau yra kiti kintamieji, nei prieš tai buvę pirmame ir antra-
me lange (2.8–2.9 pav.).

Po to atsakysite į antrą klausimą „Kaip yra pateikti duomenys tekstinėje rinkmenoje?“ 
(How are your cases represented?). Perkeliant duomenis svarbu neiškraipyti turimos in-
formacijos. Kaip matote, pasirinkę perkelti duomenis eilutėmis, tvirtiname, kad kiekvie-
na perkeliamos rinkmenos duomenų eilutė taps SPSS duomenų eilute. Jei yra kitaip, gali-
me pasirinkti ir kitą būdą, kai tiesiog galėsime nurodyti, kiek kintamųjų taps SPSS duome-
nų eilute. Pavyzdyje pasirinkome, kad kiekviena rinkmenos duomenų eilutė taps SPSS duo-
menų eilute.

Trečias klausimas susijęs su duomenų kiekiu (How many cases do you want to import?), 
kurį norėtume atsisiųsti: visus, kažkuriuos pirmus (reikia nurodyti skaičiumi) ir atsitiktinai pa-
renkamus programos pagal procentais nurodytą duomenų skaičių. Kadangi pasirinkome atsisiųs-
ti visus duomenis, tai belieka pasirinkti opciją „Next“ ir pereiti į kitą langą.

 

2.11 pav. Šešių žingsnių duomenų perkėlimas iš tekstinės rinkmenos. Ketvirtas langas.
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Ketvirtame Text Import Wizard - Delimited Step 4 of 6 lange, kurį matote 2.11 paveiks-
lėlyje, turėtume atsakyti į klausimą „Kaip yra atskirti kintamieji?“ (Which delimiters appear 
between variables?) pasirinkdami vieną iš pasiūlytų opcijų. Jei tai specifinis kintamųjų atskyri-
mas, pasirinktumėte opciją „Other“, ir tada dar papildomai jums reikėtų nurodyti simbolį, kuris 
skiria tekstinėje rinkmenoje kintamuosius.

Šiame lange taip pat turime atsakyti į klausimą, kaip importuoti tekstinę informaciją, jei tokia 
atsirastų tarp kintamųjų (What is the text qualifier?). Tam ketvirtame lange yra pasiūlyta kele-
tas opcijų, tad taip pat galėtume nurodyti, kaip atsiųsti ir ne skaičiais išreikštus (pavyzdžiui, jei 
būtų miestų pavadinimai) kintamuosius. Pateiktame pavyzdyje tokių kintamųjų nėra, tad pasi-
renkame opciją „None“. Šiame lange atlikę visus veiksmus, pasirenkame opciją „Next“, ir pro-
grama perkelia mus į kitą langą.

2.12 pav. Šešių žingsnių duomenų perkėlimas iš tekstinės rinkmenos. Penktas langas.

Perėję prie penkto Text Import Wizard - Delimited Step 5 of 6 lango, pavaizduoto 2.12 
paveikslėlyje, užduoties, galėsime parinkti kintamiesiems vardus (Variable name) ir nurodyti 
kintamųjų pobūdį (Data format). Pavyzdyje parinkome pirmajam kintamajam vardą „Age“, 
o tipą nurodėme skaitmeninį (Numeric). Šiuos pakeitimus iš karto matome atverto lango apa-
čioje. Taigi penktame lange mes turime galimybę suteikti kintamiesiems vardus. Tai nėra bū-
tina, nes programa jiems automatiškai priskiria vardus „V1“, „V2“ ir t. t., kuriuos vėliau turė-
sime galimybę modifikuoti. Neparinkus kintamiesiems jų tipo, automatiškai jie bus traktuoja-
mi kaip skaitmeniniai, o jei yra kitaip, jūs turėsite vėliau nurodyti šių kintamųjų tipą. Kitaip 
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tariant, šiame lange jūs galite tiesiog pasirinkti opciją „Next“ ir pereiti prie paskutinio žings-
nio siunčiant duomenis iš tekstinės rinkmenos, tačiau visus neužbaigtus darbus turėsite atlik-
ti vėliau.

2.13 pav. Šešių žingsnių duomenų perkėlimas iš tekstinės rinkmenos. Šeštas langas.

Paskutiniame šeštame Text Import Wizard - Delimited Step 6 of 6 lange, kuris yra pavaiz-
duotas 2.13 paveikslėlyje, mes gauname informaciją, kad sėkmingai nustatėme tekstinės rin-
kmenos formatą (You have successfully defined the format of your text file), o pirmas klausi-
mas yra „Ar norėtumėte išsaugoti šį formatavimą vėlesniems naudojimams?“ (Would you like 
to paste the syntax?). Jei pageidaujate, galite suteikti atliktam formatavimui pavadinimą ir iš-
saugoti, jei to daryti nenorite, tiesiog rinkitės opciją „No“. Šiame lange yra pagal nutylėjimą pa-
žymėtos opcijos „No“ ir „Cache data localy“, tad siūlau jas ir palikti.
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2.14 pav. Informacija perkelta iš demo.txt rinkmenos, suteikiant kintamajam „V1“ vardą „Age“,  

o kitiems kintamiesiems palikti automatiškai SPSS programų paketo priskirti vardai.

Kadangi tai buvo paskutinis iš šešių informacijos perkėlimo langų, jame belieka pasirinkti myg-
tuką „Finish“ ir visi duomenys bus perkelti į SPSS programų paketo darbalaukį (2.14 pav.), kur  
galėsite atlikti tolesnį jų redagavimą. 

2.15 pav. Pasirenkame atidaryti SPSS programų paketu sukurtą duomenų rinkmeną.
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Jei SPSS programų paketą aktyvuosite pasirinkdami šia programa sukurtą rinkmeną (2.15 
pav.), tada kompiuterio ekrane pamatysite programinį langą, kaip parodyta 2.16 paveikslėlyje. 

2.16 pav. SPSS programa sukurto duomenų rinkmenoje vaizdas.

2.2.2. Naujos duomenų rinkmenos kūrimas

Kai aktyvuojame SPSS programų paketą, pirmiausia mums yra pateikiamas pasiūlymas su-
kurti naują duomenų rinkmeną (žr. 2.3 pav. 1 langą) patiems surenkant atliktos apklausos duo-
menis. Taigi, jei pasirinksite „Type in Data“, jums bus atvertas tuščias SPSS programų paketo 
darbalaukis, kuriame galėsite surašyti visus savo kintamuosius ir jų reikšmes. Kaip tai yra da-
roma ir ką jums reikia žinoti, paaiškinsime pateikdami labai paprastą pavyzdį. 2.1 lentelėje yra 
duomenys, kuriuos surinksite savarankiškai.

2.1 lentelė. Duomenys.

Vardas Gyvena Išsilavinimas Amžius
Jonas mieste aukštasis 30
Vilė kaime vidurinis 22
Ona kaime aukštasis 27
Marijonas mieste aukštasis 25
Rokas kaime aukštasis 54
Vladas kaime vidurinis 18
Julija mieste vidurinis 58
Eglė kaime aukštasis 43
Violeta mieste vidurinis 35
Eleonora mieste aukštasis 23
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Jei jau dirbate su SPSS ir norite sukurti naują duomenų rinkmeną, tuomet jums nereikia akty-
vuoti SPSS, belieka meniu juostoje pasirinkti: File -> New-> Data (žr. 2.17 pav.). 

Atlikus šiuos žingsnius, SPSS programų paketas atvers jums tuščią langą, kuriame privalė-
site surinkti savo informaciją, tokiu būdu sukurdami naują rinkmeną. Tačiau šis darbas parei-
kalaus iš jūsų tam tikrų žinių ir gali užimti ne mažai laiko (priklausomai nuo turimų duome-
nų kiekio).

2.17 pav. Naujos duomenų rinkmenos kūrimo būdas.

Todėl prieš pradedant savarankiškai kurti duomenų rinkmenas, reikia susipažinti su SPSS 
programų paketo darbiniais langais ir duomenų surinkimo specifika. Apie tai išsamiau galite per-
skaityti kitame poskyryje.

2.3. pagrindiniai SPSS programų paketo langai

Pagrindiniai SPSS programų paketo langai yra šie : 
1.	Duomenų redagavimo (Data Editor): 
	 1.1.	Duomenų surinkimo–redagavimo (Data View), 
	 1.2.	Duomenų aprašymo (Variable View). 
2.	Duomenų analizės išvesties (Viewer):
	 2.1.	Duomenų grafinio atvaizdavimo redagavimo (Chart Editor),
	 2.2.	Sintaksės redagavimo (Syntax Editor). 
Kai pradėsite analizuoti savo surinktus duomenis, jums teks vienu metu dirbti su keliais iš šių 

langų. Todėl detaliau aptarsime kiekvieną jų atskirai.

2.3.1. Duomenų redagavimo langas

Duomenų redagavimo lange yra surenkami ir aprašomi visi tyrimo metu surinkti duomenys. 
Taigi duomenų redaktoriaus lange yra rodomas jūsų rinkmenos duomenų turinys. Šį langą jūs 
naudosite esamai duomenų rinkmenai atidaryti, išsaugoti ir uždaryti. 

Kurdami naują duomenų rinkmeną, šiame lange įrašysite duomenis, taip pat galėsite keisti 
esamus. Jei norėsite padaryti bet kokius savo duomenų rinkmenos pakeitimus, redagavimą atlik-
site būtent duomenų reagavimo lange, kuris yra pavaizduotas 2.18 paveikslėlyje. 
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2.18 pav. Duomenų redagavimo langas „Data Editor“, kai pasirinktas  
duomenų įrašymo langas „Data View“. Stulpelis pažymėtas 1, o eilutė 2.

Dirbdami duomenų redagavimo lange, jūs galite lengvai pereiti nuo vieno lango prie kito, pa-
sinaudodami redagavimo lango apačioje esančiais mygtukais „Data View“ ir „Variable View“ 
(2.19 pav.). 2.19 paveikslėlyje raudonais kvadratėliais yra apibraukti abu duomenų redagavimo 
langai: duomenų įrašymo (Data View) ir duomenų aprašymo (Variable View). 

Pastebėsite, kad duomenų įrašymo lange 2.18 paveikslėlyje kiekvienas stulpelis ženklinamas 
„var“. Jūsų užduotis bus pakeisti „var“ į kintamųjų vardus, kurie yra nurodyti jūsų duomenų ko-
davimo lape. Šio lango kairėje pusėje yra sunumeruotos duomenų eilutės 1, 2, 3 ir t. t. SPSS pri-
skiria kiekvienam iš apklaustųjų, dalyvavusių tyrime, atskirą eilutę duomenims surinkti. Atliekant 
tyrimą respondentų anketos yra numeruojamos, taip atsiranda identifikaciniai anketų numeriai. 
Tačiau tai nėra tapatybės numeriai, nes respondentų skaičių galima keisti (jei, pavyzdžiui, jūs per-
tvarkote rinkmeną arba padalijate rinkmeną ir analizuojate sutrumpintus savo duomenis).

2.3.2. Kintamųjų langas „Variable View“

Norėdami apibūdinti kiekvieną iš kintamųjų, kurie sudaro jūsų duomenų rinkmeną, pirmiau-
sia turite spustelėti redagavimo lango ekrano apačioje skirtuką „Variable View“. Šiame lange 
(žr. 2.19 pav.) kintamieji yra išvardyti eilutėse nuo viršaus žemyn, o jų savybės išvardytos rin-
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kmenos viršutinėje dalyje (pavadinimas, tipas, plotis, ženklų skaičius po kablelio, etiketės ir 
kt.). Tyrėjo darbas yra apibūdinti kiekvieną iš savo kintamųjų, nurodant reikalaujamą informa-
ciją, kurią sukaupėte kintamųjų kodavimo dokumente. Jums reikės pateikti kintamojo pavadini-
mą tokį, kokį numatėte koduodami duomenis (jei nepateiksite, SPSS programa pati suteiks kin-
tamajam vardą tokį, kaip „VAR00001“, kuris nebus informatyvus. 

2.19 pav. Duomenų apibūdinimo langas „Variable View“.

Paprastai SPSS programų pakete yra automatiškai suteikiamos ir kitos numatytosios kinta-
mųjų vertės. Šios numatytosios vertės gali būti pakeistos, jei tai yra būtina. Pagrindinės kinta-
mųjų informacijos dalys, kurias reikia apibūdinti, yra pateiktos kaip stulpelių antraštės. Jums be-
lieka žingsnis po žingsnio surašyti informaciją apie kiekvieną kintamąjį. Jei kintamųjų savybės 
kartojasi, tada visą šį varginantį darbą galima atlikti paprasčiau, bet prieš tai reikia išsiaiškinti, 
kokią informaciją reikia pateikti kiekviename iš stulpelių.

Vardas (Name)
Šiame stulpelyje turėsite įrašyti kintamojo vardą, kurį jam jau priskyrėte kodavimo lape. 

Vardas turi būti unikalus ir atitikti SPSS programų paketo reikalavimus. Kintamųjų vardai turė-
tų būti ne per ilgi ir negali susidėti iš kelių žodžių. Tokius pavadinimus SPSS pertvarkys ir jums 
bus sunku surasti, kuris kintamasis aprašytas.

Tipas (Type)
Įrašius kintamojo vardą, SPSS programa automatiškai priskiria jam skaitmeninį tipą. Daugeliu 

atvejų tai gali būti būtent tai, ko jums reikia, tačiau jei automatiškai kintamajam priskirtas tipas 
neatitinka duomenų tipo, galima parinkti kitą iš SPSS programoje numatytų variantų. Tai galė-
site atlikti aktyvuodami langelį „Type“ – tiesiog spustelėkite dešinėje pusėje esančius tris taš-
kus, o po šio veiksmo atsidarys langas, kuris pasiūlys pasirinkimo galimybes (žr. 2.20 pav.). 
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SPSS programa numato kintamųjų plotį „Width“ (žr. 2.20 (3) pav.). Automatiškai numatytas 
plotis yra 8 (aštuonios pozicijos). Daugeliui duomenų tai yra pakankama, todėl galime palikti 
kaip yra. Jei kintamasis turi labai dideles vertes, gali prireikti pakeisti šią numatytąją vertę (pa-
didinti pozicijų skaičių). Taip pat labai svarbu yra nurodyti skaičių pozicijas po kablelio dešim-
tainiams trupmeniniams duomenims. Tai galima atlikti langelyje „Decimal Places“ (žr. 2.20 (2) 
pav.). „Decimal Places“ reikšmė gali būti lygi 0, jei kintamasis yra sveikasis skaičius. Reikia 
nepamiršti, kad „Decimal Places“ nurodo, kiek tikimės skaičių po kablelio iš visų pozicijų skir-
tų skaičiui, o ir pats kablelis užima vieną poziciją; pavyzdžiui, skaičiui 3,15 reikia 4 pozicijų, iš 
jų 2 yra po kablelio.

Atsižvelgdamas į kiekybinių bei kokybinių kintamųjų specifiką, SPSS programų paketas nu-
mato šiuos kintamųjų tipus:

l	Skaitmeninis (Numeric).
	K intamasis, kurio reikšmės yra skaičiai. Šių kintamųjų duomenų aibę sudarys realūs skai- 

	 čiai, išreiškiami skaitmenimis (pvz., 103, 15,2 ir pan.). Trumpuose aprašymuose tradiciškai,  
	 tam naudojama raidė F: duomens 103 formatas yra F3; duomens 15,2 formatas yra F3.1. 

l	Kableliais atskirtas (Comma).
	S kaitmeninis kintamasis, kurio reikšmės pateikiamos atskiriant kableliais kas tris pozicijas,  

	 rodomas su dešimtainiais skyrikliais. Duomenų redaktorius priima skaitines vertes kin- 
	 tamųjų su kableliais arba be jų ar užrašytas moksline išraiška. Kablelis kaip dešimčių indi- 
	 katorius negali būti kintamųjų dešinėje. 

2.20 pav. Kintamųjų tipai numatyti SPSS programoje (1); skaičiai po kablelio (2); kintamųjų plotis (3).
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l	Taškinis (Dot ).
	S kaitmeninis kintamasis, kurio reikšmės rodomos su laiko tarpais, apribotais kableliu, kaip 

	 dešimtainiu skyrikliu, kas tris pozicijas. Duomenų redaktorius priima skaitmenines vertes 
	 „dot“ kintamųjų su tarpais arba be jų. Dešimtainis indikatorius negali būti vertės dešinėje.

l	Mokslinis žymėjimas (Scientific notation).
	S kaitmeninis kintamasis, kurio reikšmės rodomos su įterptais E. Duomenų redaktorius 

	 priima skaitines vertes tokiems kintamiesiems su eksponentėmis arba be jų. Eksponentės  
	 rodiklis gali būti žymimas E arba D su pasirenkamu ženklu ar rašant vien ženklą, pavyz- 
	 džiui: 123, 1.23E2=1,23x102, o 1,23E-2 =1,23x10-2.

l	Data (Date).
	S kaitmeninis kintamasis, kurio reikšmės yra įrašomos kaip kalendorinės datos arba laikas 

	  pagal laikrodį. Jei turite tokio tipo kintamąjį, jums belieka pasirinkti iš sąrašo tinkamą formatą  
	 (žr. 2.21 a pav.).  

 a b
2.21 pav. SPSS programų paketo kintamųjų tipai: a) kintamieji, nurodantys datą ar laiką;  

b) skaitmeninis kintamasis, kurio priekyje rašomas dolerio ženklas.

Galite įrašyti datas, kai duomenys yra atskiriami pasvirais arba tiesiais brūkšneliais, kable-
liais arba tarpais. Žmogaus amžiaus dviejų skaitmenų verčių diapazonas nustatomas pagal jūsų 
nustatymų variantus. Nustatymo žingsniai prasideda lango „Data Editor“ pagrindinėje meniu 
juostoje pasirenkant „Edit“, tada atsidariusiame meniu pasirenkame „Options“, o programinia-
me lange reikia aktyvuoti „Data“. Kad būtų aiškiau, „Options“ langas yra pateiktas 2.22 pa-
veikslėlyje.
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2.22 pav. SPSS programų paketo Options-->Data langas.

l	Doleris (Dollar).
	S kaitmeninis kintamasis, kurio priekyje rašomas dolerio ženklas ($), kableliais atskiriant 

	 kas tris pozicijas. Šio tipo kintamųjų reikšmės gali būti įrašytos su dolerio ženklu arba be 
	 jo (žr. 2.21 b pav.).

l	Valiutų formatai (Custom currency). 
	S kaitmeninis kintamasis, kurio reikšmės rodomos vienu iš pasirinktu valiutos formatu  

	 (žr. 2.23 pav.), kurį jūs turite apibrėžti lango „Data Editor“ pagrindinėje meniu juosto- 
	 je pasirinkę „Edit“, tada meniu – „Options“ ir atsidariusiame dialogo lange – valiutų skir- 
	 tuką „Currency“ (žr. 2.22 pav.). Apibrėžti pasirinktiniai valiutos simboliai negali būti 
	 naudojami įrašant duomenis, bet bus rodomi duomenų redaktoriaus lange „Data Editor“.

l	Simboliniai (String).
	K intamasis, kurio reikšmės ne skaitmeninės, todėl negalima atlikti aritmetinių veiksmų. 

	 tai kokybiniai kintamieji. Jų reikšmės gali turėti bet kokius simbolius iki SPSS programų 
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	 pakete nurodyto ilgio (pvz., pašto kodai LT-30214). Šiuose kintamuosiuose skirtingais 
	 simboliais laikysime esančias didžiąsias ir mažąsias raides. Simbolinis duomenų tipas taip 
	 pat tinka raidiniais simboliais išreikštiems kintamiesiems (įvairūs gyvūnų, augalų, gamtos 
	 reiškinių pavadinimai ir t. t.).

 a b

2.23 pav. SPSS programų paketo kintamųjų tipai: a) kintamųjų tipas, susijęs su valiutų formatais;  
b) simbolinis duomenų tipas taip pat tinka raidiniais simboliais išreikštiems kintamiesiems.

Plotis (Width)
Kintamųjų aprašymo lange tai yra trečias langelis. Įvedus kintamąjį jam automatiškai numa-

tytas plotis yra 8 (aštuonios pozicijos) (2.19 pav.). Daugeliui duomenų tai yra pakankama, to-
dėl galime palikti kaip yra. Jei kintamasis turi labai dideles vertes, gali prireikti pakeisti šią nu-
matytąją vertę (padidinti pozicijų skaičių). Taip pat labai svarbu yra nurodyti skaičių pozicijas 
po kablelio dešimtainiams trupmeniniams duomenims. Tai galima atlikti langelyje „Decimel 
Places“ (žr. 2.20 (2) pav.). „Decimel Places“ reikšmė gali būti lygi 0, jei kintamasis yra svei-
kasis skaičius. 

Dešimtosios (Decimals)
Šiame stulpelyje yra apibrėžiama numatytoji kintamųjų vertė po kablelio. Jei kintamasis nėra 

išreikštas sveikaisiais skaičiais, turi ir trupmeninę dalį, kad atitiktų kintamojo struktūrą ir tyrėjo 
poreikius, reikia tai nurodyti. Jei visi jūsų kintamieji turi trupmeninę dalį, pakeitimą galima at-
likti automatiškai pagal „Options“ (Edit->Options; naudojant skirtuką „Data“). Šiuo būdu su-
taupysite daug laiko, nes rankiniu būdu keisti nereikės (2.24–2.25 pav.).
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2.24 pav. SPSS programų paketo langai: kelias nuo „Edit“ iki „Options“.

2.25 pav. SPSS programų paketo langai: SPSS automatinių pakeitimų langas.
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Etiketė (Label)
Tai vieta, kur SPSS programų paketas leidžia užrašyti aiškesnį ilgesnį kintamojo aprašy-

mą, nei kintamojo vardas, kuris labai dažnai sutrumpinamas iki kelių simbolių, kurie neatsklei-
džia kintamojo esmės. Pagal nutylėjimą SPSS programų paketas, atlikęs analizę, pateiks išves-
ties lange reikšmes ir aiškų ilgą kintamojo pavadinimą. Tačiau visada galima konfigūruoti SPSS 
taip, kad išvestų vardą arba vardą ir aprašymą. Pavyzdžiui, kintamajam „Išsilavinimas“ suteiksi-
te vardą „Q1“, o paaiškinime užrašysite „Respondento išsilavinimas“ (2.26 pav.).

2.26 pav. SPSS programos „Data Editor“ langas.

Dydžiai (Values)
„Values“ stulpelis yra skirtas aprašyti kategorinius (vardinius ir rangų) kintamuosius, pri-

skiriant pseudo skaičius ir jų paaiškinimus. Šie skaičiai turi atitikti tyrėjo numatytą kintamų-
jų kodavimą. Kaip pavyzdį galime toliau nagrinėti kintamąjį „Išsilavinimas“, kuriam buvo su-
teiktas vardas „Q1“, o paaiškinimas – „Respondento išsilavinimas“. Šis kintamasis yra kate-
gorinis, tad jo kategorijoms reikės priskirti skaičius (2.27 pav.).

2.27 pav. Kategorinių kintamųjų paruošimas analizei.
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Dydžių priskyrimas kintamajam „Respondento išsilavinimas“ (Q1)

1 	 „Values“ stulpelio langelyje paspauskite tris taškus, esančius dešinėje pusėje, atsidarys 
		  „Value Label“ dialogo langą.

2 	T ada langelyje „Value“ įrašykite 1.
3 	L angelyje „Value Label“ įrašykite „nebaigtas vidurinis“.
4 	S pustelėkite „Add“. Pamatysite suvestinėje laukelį: 1 = „nebaigtas vidurinis“.
5 	 Pakartokite trečią ir ketvirtą žingsnį visoms kintamojo reikšmėms apibūdinti:

				    vidurinis: „Value“ įrašykite 2, „Value Label“: įrašykite „vidurinis“;
				    profesinis: „Value“ įrašykite 3, „Value Label“: įrašykite „profesinis“;
				    aukštasis: „Value“ įrašykite 4, „Value Label“: įrašykite „aukštasis“.

6 		 Baigę nustatyti visas galimas vertes (kaip numatyta jūsų kodavimo apraše), spustelėkite „OK“.

Jei teisingai atlikote procedūrą, duomenys bus aprašyti taip, kaip parodyta 2.27 pav.

Praleistos reikšmės (Missing)
Tyrėjai gali priskirti konkrečias vertes vietoj trūkstamų reikšmių, kai respondentai neatsako 

į visus pateiktus klausimus ar ką nors tiesiog praleidžia. Kadangi SPSS programa reaguos tiek į 
tuščią langelį, tiek į priskirtą specifinę reikšmę vietoj trūkstamos, tai galite praleisti šį stulpelį ir 
nieko jame nežymėti (2.28 pav.).

2.28 pav. Praleistų reikšmių apibūdinimas „Missing“ stulpelyje.
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Tarptautiniuose tyrimuose dažniausiai praleistos reikšmės naudojamos norint sužinoti, ko-
dėl respondentas neatsakė. Blogai, kai daug respondentų neatsako, nors turėtų atsakyti. Tai rodo, 
kad kažkas negerai klausimyne. Kita vertus, jeigu respondentui klausimas nėra skirtas, tai jis į 
jį ir neturi atsakyti. Tarkime, jeigu į klausimą „kiek vaikų norėtumėte turėti“ neatsakė 80 iš 100 
respondentų, tai dar gali ir nereikšti, kad klausimynas blogas. Tiesiog tarp apklaustųjų yra 70 
vienuolių. Tipiniai neatsakymų kodai: NAP (not applicable – klausimas respondentui netaiky-
tinas), DK (don‘t know – atsakytų, bet nežino; pvz., į klausimą, kiek metų mokėsi respondento 
mama, tikrai ne visi žino atsakymą), NA (not available – neaišku, kodėl neatsakė). Įprastai pra-
leistoms reikšmėms koduoti naudojami labai nuo kitų kodų besiskiriantys skaičiai – 9, 99, 999 ir 
pan. Lietuvoje apklausose praleistos reikšmės naudojamos itin retai. 

Stulpeliai (Columns)
Pagal nutylėjimą SPSS programa stulpelio plotį nurodo 8 pozicijų. Daugumai duomenų to 

pakanka, jei reikia, kad tilptų daugiau pozicijų užimantys duomenys, tai galite nurodyti būtent 
čia, padidindami nurodytą skaičių iki jums reikiamo. Norėdami, kad ekrane tilptų daugiau kin-
tamųjų, galite sumažinti stulpelio plotį (2.29 pav.).

2.29 pav. Praleistų reikšmių apibūdinimas „Missing“ stulpelyje.

Lygiuoti (Align)
„Data View“ lange duomenys stulpeliuose yra lygiuojami paprastai laikantis dešinės „Right“ 

(2.29 pav.). Nėra būtina pakeisti šio nustatymo, nes duomenų analizei nedaroma jokia įtaka.

Matavimas (Measure)
Šiame stulpelyje nurodomas kintamojo matavimas. SPSS naudoja kelias statistinių duome-

nų matavimo skales: vardinę arba pavadinimų (Nominal), rangų (Ordinal) ir intervalų (Scale). 
Renkantis kurią nors vieną skalę iš išvardytų, reikia atsižvelgti į duomenų matavimo būdą, todėl 
kiekvieną iš jų aptarsime kiek išsamiau.

Vardinė ar pavadinimų skalė skirta kokybiniams kintamiesiems, todėl šioje matavimo skalėje 
kintamojo reikšmės klasifikuojamos pagal kokybinius kriterijus, kurie negali būti lyginami kie-
kybine prasme, tai yra kintamųjų reikšmės nei lygios, nei didesnės viena už kitą. Tai būtų duo-
menys, kurie klasifikuojami pagal požymius ir gali būti koduojami skaičiais, bet šie skaičiai ne-
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turi tikrinių verčių ar natūralios tvarkos. Tai reiškia, jog jie tiesiog etiketės. Pavyzdžiui: automo-
bilių spalva, filmų ar pomėgių sąrašas, tautybė, lytis. 

Koduojant vardinės skalės kintamuosius, reikia nepamiršti, kad kiekvienas kintamasis turi tu-
rėti jam tinkamą kategoriją (pvz., kintamajam „hobiai“ nepakaks kategorijų „sportas“, „muzi-
ka“, „kulinarija“ – turėsime dar vieną „kita“) ir visos kategorijos turi aiškiai skirtis, kad kinta-
mieji būtų aiškiai suskirstyti ir pakliūtų tik į vieną iš pateiktų kategorijų. 

Analizuojant vardinės skalės kintamuosius, galima įvertinti bendrą objektų (savybių) skai-
čių arba kurių objektų yra daugiau ar mažiau. Atliekant statistinį tyrimą, vardinius kintamuosius 
klasifikuojame arba grupuojame taip, kad visą imtį suskirstome pagal šių kintamųjų kategori-
jas. Tokiu būdu gautoms dalinėms imtims taikomi vienodi statistiniai testai, o jų rezultatai lygi-
nami tarpusavyje.

Rangų skalė skirta kintamųjų vietai nustatyti pagal pasirinktą kiekybinį arba kokybinį po-
žymį vienos rūšies objektų (reiškinių) grupėje. Pagal ranginių kintamųjų reikšmes objektus ne 
tik suskirstome į klases, bet jas dar ir išrikiuojame. Ranginiai kintamieji, taip pat kaip ir vardi-
niai, neturi skaitmeninių reikšmių, todėl tyrėjai objektus išrikiuoti į eilę gali pagal požymio skir-
tumus. Kaip pavyzdį galime panagrinėti choro užimtą vietą konkurse (pvz.: 1 = pirma vieta,  
2 = antra vieta, 3 = trečia vieta), studentų pomėgį skaityti (pvz.: 1 = nemėgsta skaityti, 2 = skai-
to retkarčiais, 3 = labai daug skaito), karinius laipsnius (pvz.: 1 = leitenantas, 2 = kapitonas,  
3 = majoras) ir t. t. Šiai skalei priklauso taip pat kintamieji, gauti grupuojant duomenis, pvz., pa-
gal pinigines įplaukas (pvz.: 1 = iki 1500 Є, 2 = iki 3000 Є, 3 = per 3000 Є). 

Jei kintamieji matuojami rangų skalėje, mes galime atlikti daugiau statistinių operacijų nei su 
vardiniais kintamaisiais. Tirdami rangų skalėje išmatuotus kintamuosius, įvertinsime dažnį, ap-
skaičiuosime medianą, rangų koreliacijos koeficientą, palyginsime atskiras imtis naudodami ne-
parametrinius testus.

Intervalų skalė skirta ne tik klasifikuoti, tvarkyti, bet ir kiekybiškai įvertinti skirtumus. 
Intervaliniai kintamieji visada yra skaitmeniniai. Todėl šios skalės kintamųjų reikšmių skirtu-
mai yra kiekybiniai ir išreiškiami matavimo vienetais: metrais, sekundėmis, laipsniais, taškais. 
Skirtumas tarp dviejų kintamojo reikšmių rodo, kiek matuojamojo požymio yra viename ele-
mente, lyginant su kitu. Kintamųjų skirtumai gali būti tarp atskirų intervalų arba nuo kurio nors 
pasirinkto atskaitos taško. Nulinis taškas intervalų skalėje parenkamas laisvai, t. y. nulinė reikš-
mė dar nereiškia, kad tiriamasis požymis visai nepasireiškia, o tiktai, kad jis nesiskiria nuo 
sąlyginio atskaitos nulio. Pavyzdžiui, turime dvi temperatūros matavimo skales – Celsijaus ir 
Farenheito. Šiose skalėse yra skirtingi matavimo vienetai ir šių skalių nuliniai taškai skiriasi 
(Celsijaus 0 = 0 oC, o Farenheito 0 = 32 oC), bet abi jos pateikia vienodai informacijos. Šiai mata-
vimų skalei priklausytų kintamieji: temperatūros matavimai, kalendorinis laikas, intelekto koe-
ficiento vertinimai. Taip pat rangų skalės (kokybiniai) kintamieji, turintys ne mažiau kaip 10 ga-
limų reikšmių, gali būti tiriami kaip intervaliniai. 
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Statistiškai apdorojant intervalų skalės duomenis galima be apribojimų taikyti visus statisti-
kos metodus.

Santykių skalės kintamųjų matavimas skiriasi nuo intervalų skalės tik tuo, kad joje nulinis 
taškas yra griežtai apibrėžtas ir visiškai atitinka dydžio nebuvimą. SPSS programų pakete skir-
tumas tarp šių kintamųjų matavimų skalių neišskiriamas. 

Matavimo priskyrimo procedūra yra paprasta. Automatiškai programa gali priskirti „Scale“, 
bet tyrėjo pareiga priskirti kintamajam tinkamą matavimo skalę. Jei kintamasis susideda iš ka-
tegorijų (pvz., „Respondento išsilavinimas“), tada spustelėkite stulpelio „Measure“ langelį ir 
iš atsidariusio meniu pasirinkite „Ordinal“, nes šis kintamasis yra išmatuotas rangų skalėje. 
Kintamajam, išmatuotam vardinėje skalėje, parinkite „Nominal“ matavimo skalę, o parametri-
niams kintamiesiems galėsite priskirti „Scale“ (2.29 pav.).

2.3.3 Kintamųjų aprašymo peržiūra

SPSS programų paketas pagal standartinį nustatymą meniu naudoja kintamųjų aprašymus, 
t. y. „etiketes“. Be to, kintamieji išdėstyti taip, kaip rinkmenoje, bet tai ne visada patogu. Ypač 
kai rinkmena didelė. Tai galima pakeisti, nes matyti kintamojo pavadinimą „educ“, o ne pusę 
sakinio „kiek daugiausia metų respondentas mokėsi“ bus patogiau. Be to, kintamųjų vardus 
galime išdėstyti abėcėlės tvarka. Jei pageidaujate pasinaudoti šia SPSS programų paketo ga-
limybe, t. y. meniu matytųsi stulpelių pavadinimai, o ne aprašymai, atlikite tokią procedū-
rą. Norint pamatyti informaciją apie kintamuosius, visai nebūtina atidaryti langą Variable View. 
 
Tam užtenka paspausti piktogramą .

2.30 pav. SPSS programų paketo meniu matyti kintamųjų aprašymai.
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Pagal standartinį SPSS programų paketo nustatymą kairėje pusėje pateikiami ne kintamųjų 
vardai, o jų aprašymai (etiketės), kaip parodyta 2.30 pav. Be to, kintamieji išdėstyti tokia pat eile, 
kaip yra suvesti rinkmenoje (pagal stulpelių eilę). Dešinėje pusėje yra informacija apie kiek- 
vieną kintamąjį.

Stulpelių pavadinimų (kintamųjų vardų) sąraše nematome, todėl toks kintamųjų pateikimas  
ne itin patogus.

 a b

2.31 pav. SPSS galimybės: a) pakeitimai atliekami Options lange;  
b) meniu matyti stulpelių pavadinimai, o ne aprašymai.

Tačiau, nesunku sukonfigūruoti SPSS programų paketą taip, kad visada matytume kintamų-
jų vardus, o jų sąrašas būtų sudarytas pagal abėcėlę. Tam reikia iš meniu juostos pasirinkti  
Edit -> Options->General ir pažymėti opcijas Display names ir Alphabetical (2.31 a pav.). 
Po to paspausti Apply ir dukart OK. Po tokio konfigūravimo kintamųjų sąrašas atrodo taip, kaip 
parodyta 2.31 b pav.

2.3.4. Duomenų analizės išvesties langas

SPSS programų paketo išvesties langas Viewer yra padalytas į dvi dalis. Dešinėje lango pu-
sėje yra pateikiamas statistinės analizės rezultatas: statistinės lentelės, diagramos ir tekstiniai pa-
aiškinimai apie atliktą analizę. Kairėje lango pusėje yra detalizuotai atlikta analizė, kuri turi me-
džio tipo struktūrą (2.30 pav.)

Pavyzdžiui, norime atlikti dviejų kintamųjų (amzius ir lytis) pradinę duomenų anali-
zę. Kintamąjį amzius analizuosime vykdydami komandą Descriptives, o kintamąjį lytis – 
Frequencies. Pasirinkę paminėtas SPSS komandas išvesties lange pamatysime tai, kas parody-
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ta 2.32 pav. Informacija išvesties lango kairėje pusėje išdėstyta „medžio“ struktūra. Jei palieka-
te (-), tai nurodote „išsišakoti“ (parodyti dešinėje pusėje) į išvesties lenteles, pavadinimus ir kitą 
svarbią informaciją. Jei norite paslėpti pateiktą informaciją, spustelėkite ženklą (-) ir jis pasikeis 
į (+), o visa informacija dešinėje pusėje išnyks. Spustelėjus bet kurį „medžio“ elementą kairėje 
lango dalyje, automatiškai jis bus išryškintas dešinėje lango dalyje. 

2.32 pav. SPSS programų paketo išvesties langas Viewer.

Informaciją išvesties lange gali būti ne tik paslėpta ar rodoma, bet ir kopijuojama, ir trinama. 
Taip pat galite išsaugoti visą išvesties informaciją. Jei to prireiktų, SPSS išsaugos jūsų rinkme-
ną su plėtiniu *.spo. Tokiu plėtiniu išsaugotą rinkmeną bus galima atidaryti SPSS programų pa-
keto meniu juostoje pasirinkus File - >Open -> Output.
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2.3. Užduotys

1 užduotis. Naujos duomenų rinkmenos kūrimas SPSS. 1 lentelėje pateikti respondentų atsa-
kymai į anketos nr. 1 klausimus, išsaugokite juos SPSS pavadinimu darbasA.sav.

Apibūdinkite kintamuosius pagal šiuos klausimus:

1.	Kurie iš šių kintamųjų yra kiekybiniai, kurie kokybiniai?

2.	Kokioje skalėje išmatuoti kintamieji?

3.	Paaiškinkite, kurie požymiai kiekybiniai, rangų, nominalieji. Kodėl?

Anketa nr. 1

K1. Jūsų lytis:
¨	 vyras 
¨	 moteris

K3. Ar sužinojęs, kad būsite išleistas į atsargą ėmėtės ko-
kių nors priemonių darbui susirasti?
¨	 TAIP 
¨	 NE

K2. Jūsų amžius: K4. Kokių priemonių ėmėtės prieš išeidamas / išėjęs į atsargą  
darbui susirasti?
1.	K reipiausi į pažįstamus dėl įdarbinimo
2.	I eškojau darbo internete
3.	 Pradėjau domėtis darbo biržos pasiūlymais

1 lentelė

ID K1 K2 K 3 K4 ID K1 K2 K3 K4
1 vyras 45 TAIP 1 16 moteris 36 NE 2
2 vyras 46 TAIP 2 17 moteris 34 TAIP 3
3 vyras 40 TAIP 2 18 vyras 56 TAIP 2
4 moteris 45 NE 3 19 vyras 58 TAIP 2
5 moteris 34 NE 3 20 vyras 42 NE 2
6 vyras 37 TAIP 1 21 vyras 31 NE 2
7 vyras 50 TAIP 1 22 moteris 45 NE 1
8 vyras 23 TAIP 2 23 moteris 31 TAIP 3
9 moteris 50 NE 2 24 vyras 35 TAIP 2
10 moteris 51 NE 2 25 vyras 46 TAIP 2
11 moteris 51 NE 2 26 moteris 32 NE 3
12 moteris 46 NE 2 27 moteris 30 TAIP 3
13 moteris 46 TAIP 3 28 vyras 57 NE 1
14 vyras 42 TAIP 3 29 vyras 39 NE 1
15 vyras 35 NE 2 30 moteris 41 NE 2



Duomenų analizės SPSS pagrindai54

2 užduotis. Naujos duomenų rinkmenos kūrimas SPSS. 2 lentelėje pateikti respondentų atsa-
kymai į anketos nr. 2 klausimus. Išsaugokite juos SPSS pavadinimu darbasB.sav. 

Apibūdinkite kintamuosius pagal šiuos klausimus:

1.	Kurie iš šių kintamųjų yra kiekybiniai, kurie kokybiniai?

2.	Kokioje skalėje išmatuoti kintamieji?

3.	Paaiškinkite, kurie požymiai kiekybiniai, rangų, nominalieji. Kodėl?

Anketa nr. 2

K1. Jūsų lytis:
¨	 vyras 
¨	 moteris

K3. Kokios maždaug yra Jūsų asmeninės pajamos  
(skaičiuojant pensiją, darbo užmokestį ir pan.) per metus? 
(išlaidų suma eurais) 

K2. Jūsų amžius: 
1.	 nuo 30–40 metų 
2.	 nuo 41–50 metų
3.	 51 metai ir daugiau

K4. Ar šiuo metu dirbate tokį darbą, kurio norėjote?
1 – TAIP
2 – NE

2 lentelė

ID K1 K2 K3 K 4 ID K1 K2 K3 K 4
1 vyras 3 12000 TAIP 16 moteris 1 6000 NE
2 vyras 1 8500 TAIP 17 moteris 2 4000 NE
3 vyras 1 15000 TAIP 18 vyras 1 9000 TAIP
4 moteris 2 10000 NE 19 vyras 1 15000 TAIP
5 moteris 1 9000 NE 20 vyras 2 16000 TAIP
6 vyras 1 12000 TAIP 21 vyras 1 4500 NE
7 vyras 3 15000 TAIP 22 moteris 1 1800 NE
8 vyras 1 10000 TAIP 23 moteris 2 20000 NE
9 moteris 2 12500 NE 24 vyras 2 26000 TAIP
10 moteris 2 15000 NE 25 vyras 1 10000 TAIP
11 moteris 1 9000 NE 26 moteris 2 25000 TAIP
12 moteris 2 15000 NE 27 moteris 3 30000 NE
13 moteris 1 10000 TAIP 28 vyras 3 8500 TAIP
14 vyras 1 12000 TAIP 29 vyras 2 5500 NE
15 vyras 1 18000 NE 30 moteris 1 6500 NE
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3 užduotis. Tekstinės informacijos įkėlimas į SPSS darbalaukį. Respondentų atsakymus į an-
ketos nr. 3 klausimus rasite rinkmenoje darbasC.txt. Išsaugokite juos SPSS programų paketui 
suprantamu formatu ir pavadinkite darbasC1.sav. 

Apibūdinkite kintamuosius pagal šiuos klausimus:

1.	Kurie iš šių kintamųjų yra kiekybiniai, kurie kokybiniai?

2.	Kokioje skalėje išmatuoti kintamieji?

3.	Paaiškinkite, kurie požymiai kiekybiniai, ranginiai, nominalieji. Kodėl?

Anketa nr. 3

K1. Jūsų lytis:
¨	 vyras 
¨	 moteris

K3. Ar sužinojęs, kad būsite išleistas į atsargą, ėmėtės kokių 
nors priemonių darbui susirasti?
¨	 Taip
¨	 Ne

K2. Jūsų amžius: 
¨	 nuo 30–40 metų 
¨	 nuo 41–50 metų 
¨	 51 metai ir daugiau

K4. Jei Jūs dirbote / dirbate, kiek darbo vietų pakeitėte po 
išėjimo į atsargą? 
¨	 išėjęs į atsargą niekada nedirbau
¨	 dirbu toje pačioje darbo vietoje 
¨	 vieną
¨	 dvi
¨	 tris ir daugiau

4 užduotis. Tekstinės informacijos įkėlimas į SPSS darbalaukį. Respondentų atsakymus į an-
ketos nr. 4 klausimus rasite rinkmenoje seimaT.txt. Išsaugokite juos SPSS programų paketui su-
prantamu formatu ir pavadinkite seimaT.sav. 

Apibūdinkite kintamuosius pagal šiuos klausimus:

1.	Kurie iš šių kintamųjų yra kiekybiniai, kurie kokybiniai?

2.	Kokioje skalėje išmatuoti kintamieji?

3.	Paaiškinkite, kurie požymiai kiekybiniai, ranginiai, nominalieji. Kodėl?
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5 užduotis. Microsoft Excel programa sukurtos duomenų rinkmenos įkėlimas į SPSS darba-
laukį. Respondentų atsakymus į anketos nr. 4 klausimus rasite rinkmenoje seima.xls. Išsaugokite 
juos SPSS programų paketui suprantamu formatu ir pavadinkite seima.sav. 

Apibūdinkite kintamuosius pagal šiuos klausimus:

1.	Kurie iš šių kintamųjų yra kiekybiniai, kurie kokybiniai?

2.	Kokioje skalėje išmatuoti kintamieji?

3.	Paaiškinkite, kurie požymiai kiekybiniai, ranginiai, nominalieji. Kodėl?

Anketa nr. 4

K1. Jūsų lytis:
¨	 vyras 
¨	 moteris

K3. Kiek žmonių nuolatos gyvena Jūsų namų ūkyje 
įskaitant Jus patį / pačią ir vaikus? 

K2. Jūsų amžius: 
¨	 nuo 20–30 metų 
¨	 nuo 31–50 metų
¨	 51 metai ir daugiau

K4. Kokia yra Jūsų dabartinė oficiali šeiminė padėtis? 
(TIK VIENAS ATSAKYMAS)
¨	 Vedęs / ištekėjusi (V)
¨	 Gyvename atskirai, nors oficialiai nesame išsiskyrę (A)
¨	 Oficialiai išsiskyręs / išsiskyrusi (I)
¨	 Našlys / našlė (N)
¨	 Niekada nebuvau vedęs / ištekėjusi (NV)
¨	 Atsisakau atsakyti (AA)

6 užduotis. Tekstinės informacijos įkėlimas į SPSS darbalaukį. Respondentų atsakymus į an-
ketos nr. 3 klausimus rasite rinkmenoje darbas A.txt. Išsaugokite juos SPSS programų paketui 
suprantamu formatu ir pavadinkite darbas A.sav. 

Apibūdinkite kintamuosius pagal šiuos klausimus:

1.	Kurie iš šių kintamųjų yra kiekybiniai, kurie kokybiniai?

2.	Kokioje skalėje išmatuoti kintamieji?

3.	Paaiškinkite, kurie požymiai kiekybiniai, ranginiai, nominalieji. Kodėl?
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3. Anketavimo duomenų paruošimas tyrimui

Šiame skyriuje aiškinama kintamųjų reikšmių surinkimo SPSS programų paketui ir pačių 
kintamųjų apibūdinimo specifika. Kadangi ši procedūra užima nemažai laiko, gali būti ilga ir net 
varginanti, ypač jei yra daug kintamųjų. Šiame skyriuje rasite patarimų, kaip palengvinti ir kar-
tu paspartinti darbą. Čia duota pavyzdžių, kaip aprašyti grupę naujų kintamųjų, turinčių tuos pa-
čius požymius, kaip galima panaudoti tuos pačius atributus tokio pat tipo kintamiesiems (tipas, 
plotis, dešimtosios dalys po kablelio ir t. t.). 

Skyriaus pabaigoje pateiktos praktinės užduotys padės lavinti įgūdžius, kai reikia įrašyti kin-
tamųjų duomenis ir aprašyti kintamuosius pagal jų matavimų skales ir SPSS programų paketo 
reikalavimus.

3.1. atskirų vieno kintamojo požymių priskyrimas kitiems kintamiesiems

Atskirų vieno kintamojo požymių priskyrimas kitiems kintamiesiems pagreitina rinkmenos 
kūrimo procesą, tad žemiau pateikiama procedūra, paaiškinanti, kaip teisingai atlikti reikiamus 
veiksmus. Kaip pavyzdį atliksime užduotį. 3.1 lentelėje pateiktus respondentų atsakymus į an-
ketos nr. 3.1 klausimus išsaugosime SPSS pavadinimu rukymas.sav. SPSS programų paketo 
Variable View lange: 

l	sukursime kintamuosius: K1 (lytis), K2 (amžius), K3 (rūkymas), K4 (vairuotojo pažymė- 
	 jimas);

l	kategorinio kintamojo K3 (rūkymas) matavimų skalę (1 – TAIP; 2 – NE) priskirsime kitam 
	 kintamajam K4 (vairuotojo pažymėjimas).

Anketa nr. 3.1

K1. Lytis:
¨	 vyras 
¨	 moteris

K3. Ar rūkote?
¨	 TAIP 
¨	 NE

K2. Jūsų amžius: K4. Ar turite vairuotojo pažymėjimą? 
¨	 TAIP
¨	 NE
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3.1 lentelė

ID K1 K2 K 3 K4 ID K1 K2 K3 K4
1 vyras 65 TAIP TAIP 16 moteris 22 NE TAIP
2 vyras 26 TAIP TAIP 17 moteris 34 TAIP NE
3 vyras 20 TAIP NE 18 vyras 26 TAIP NE
4 moteris 32 NE TAIP 19 vyras 28 TAIP TAIP
5 moteris 24 NE NE 20 vyras 32 NE NE
6 vyras 27 TAIP TAIP 21 vyras 31 NE TAIP
7 vyras 58 TAIP TAIP 22 moteris 45 NE NE
8 vyras 23 TAIP NE 23 moteris 31 TAIP NE
9 moteris 50 NE NE 24 vyras 35 TAIP TAIP

10 moteris 41 NE NE 25 vyras 26 TAIP NE
11 moteris 28 NE NE 26 moteris 32 NE NE
12 moteris 36 NE TAIP 27 moteris 30 TAIP TAIP
13 moteris 26 TAIP TAIP 28 vyras 57 NE TAIP
14 vyras 22 TAIP TAIP 29 vyras 39 NE TAIP
15 vyras 25 NE NE 30 moteris 21 NE TAIP

Procedūra

1 	 Variable View lange, kuriame jau turite aprašytą kintamąjį K3 (rūkymas), pasirinkite 
	  	specifinį jo atributą (pvz., Values), kurį norite priskirti kitam kintamajam K4 (turi vairuo- 
		  tojo pažymėjimą), pažymėkite langelį, kuris turi atributą. 

2 	M eniu juostoje pasirinkite Edit ir Copy.
3 	 Pažymėkite to paties atributo langelį kintamojo, kuriam norite priskirti tokį pat atributą.
4 	M eniu juostoje pasirinkite Edit ir Paste.

3.1 pav. Kintamojo atributų 1 – kopijavimas ir 2 – priskyrimas.

Kitame poskyryje yra paaiškinta, kaip palengvinti ir paspartinti darbą aprašant grupę kinta-
mųjų, turinčių tuos pačius požymius.
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3.2. Kelių naujų kintamųjų su tais pačiais požymiais aprašymas

Aprašant grupę naujų kintamųjų, turinčių tuos pačius požymius (išmatuotus toje pačioje ma-
tavimų skalėje) jums reikės: 1) tiesiog sukurti šių kintamųjų grupę, 2) visus naujus kintamuo-
sius apibrėžti vienu metu.

Kaip pavyzdį atliksime užduotį. Optimizmą matuojančiai klausimų grupei (pateikta žemiau), 
sudarytai iš šešių teiginių, kurie matuojami toje pačioje matavimų skalėje, automatiniu būdu su-
kursime kintamuosius. 

Perskaitykite jums pateiktus teiginius ir nuspręskite, kiek su jais sutinkate arba ne. 
Savo sprendimą pažymėkite: 1 – visiškai nesutinku, 2 3 4 5 – visiškai sutinku.
Kiekvienas teiginys turi būti įvertintas skaičiumi nuo 1 iki 5.

Teiginiai Nuomonė
1 Kaip įprasta, aš visada patiriu tik geriausia
2 Jei kas nors gali atsitikti blogo, tai man būtinai nutiks
3 Aš visada optimistiškai mąstau apie ateitį
4 Labai retai įvykiai klostosi man palankiai
5 Bendrai gyvenime patiriu daugiau gerų dalykų nei blogų
6 Labai retai kas nors gero nutinka man

Šaltinis: sudaryta autorės, remiantis Scheier, Carver & Bridges (1994).

Detaliau aprašyta tokių kintamųjų kūrimo procedūra yra pateikta žemiau. Šiam darbui atlik-
ti panaudoti šeši optimizmą apibūdinantys elementai, kuriems bus priskirta ta pati pavadinimo 
pradžia (opt1, opt2, opt3, opt4, opt5, opt6).

Naujų kintamųjų automatinio kūrimo procedūra

1 	K intamajam opt1 Variable View lange priskirsime atributus pagal instrukcijas, pateiktas 
		  anksčiau (3.2 pav.). Kadangi šis kintamasis yra išmatuotas rangų skalėje ir turi Likert tipo  
		  matavimą, jo reikšmes užkoduosime: 1 = visiškai nesutinku, 2 = nesutinku, 3 = nežinau, 
		  4 = sutinku, 5 = visiškai sutinku. 
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3.2 pav. Kintamojo opt1 atributų priskyrimas.

2 	 Variable View lange pažymėkite visą eilutę, kurioje aprašėte opt1 kintamąjį.
3 	M eniu juostoje pasirinkite Edit ir Copy (3.3 pav.).
4 	 Pažymėkite Variable View lange tiek tuščių eilučių, kiek norite aprašyti naujų kintamųjų.

3.3 pav. Kintamojo opt1 atributų kopijavimas: 1) pažymime; 2) kopijuojame.

5 	M eniu juostoje pasirinkite Edit ir Paste Variables. Tada Paste Variables lange nurody- 
		  kite naujų kintamųjų skaičių (5) ir vardus (pradžią, kuri sutaps, ir papildomai skaičių,  
		  kuris išskirs kintamuosius). SPSS programų paketo langas pavaizduotas 3.4 pav.
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3.4 pav. Kintamojo op1 atributų kopijavimas kitiems naujiems kintamiesiems: 1) pažymime reikiamą skaičių kintamųjų;   
2) pasirenkame Paste Variables; 3) vienu metu 5 kintamiesiems priskiriame vienodus atributus.

7 	 Paste Variables lange parinkus priešdėlį (opt) ir skaičių, nuo kurio prasidės kintamieji 
		  (šį kartą tai – 2), ir paspaudus OK bus automatiškai sukurti nauji kintamieji (opt2, opt3, 
		  opt4, opt5 ir opt6), kaip yra parodyta 3.5 pav.

3.5 pav. Kintamųjų opt2–opt6 automatinis kūrimas.

Norėdami automatiškai aprašyti visus kitus tokio tipo kintamuosius, tiesiog pakartokite ap-
rašytą kintamųjų procedūrą iš optimizmo skalės. Yra tik vienintelis reikalavimas norint pakarto-
ti šią procedūrą – visų kintamųjų atributai ir matavimo skalės turi sutapti. Priešingu atveju auto-
matiškai kurti ir priskirti atributus keliems kintamiesiems iš karto negalima. Pavyzdžiui, jei yra 
vardinis kintamasis, o kitas intervalinis arba kintamųjų kodavimo vertės skirtingos.
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3.3. Duomenų surinkimas

Variable View lange aprašę visus kintamuosius ir priskyrę jiems visus atributus, jūs esate pa-
sirengę surašyti SPSS programų pakete savo turimus duomenis. Vėl reikės pasinaudoti jau su-
kurtu duomenų kodavimo aprašu ir atskirai apdoroti kiekvieną anketą. 

Duomenų surinkimo procedūra

1 		A ktyvuokite SPSS programų paketo Data View langą. Šiame lange atsidarys lentelė, kurios 
	  	stulpeliai bus pavadinti prieš tai aprašytų (Variable View lange) kintamųjų vardais. Tai yra 
		  pavaizduota 3.6 pav.

3.6 pav. Data View lange kintamųjų vardai sukuri Variable View lange.

2 	K intamųjų reikšmes reikia surašyti tokia tvarka. Kiekviena anketa yra skirta tik vienam  
		  respondentui, tad Data View lange reikia užpildyti visą eilutę iki galo, kad surašytumėte 
		  vieno respondento atsakymus. Duomenis reikia surinkti atidžiai, nes klaidos gali iškrai- 
		  pyti tyrimo rezultatus. Principinis SPSS programų paketo reikalavimas – vienam respon- 
		  dentui skirta viena eilutė. Taigi kiekvienas klausimynas užima tik vieną eilutę, užtat stul- 
		  pelių (kintamųjų) gali būti daug. 

3 	S urinkus vieno respondento duomenis, reikės grįžti atgal, tad paspauskite klaviatūroje 
	  	Home klavišą. Žymekliu pereikite prie antros eilutės ir surinkite kito respondento  
		  duomenis. 
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Pastaba. Renkant duomenis eilutėmis, dažnai rekomenduojama naudoti klavišą Tab, o ne 
klavišus su rodyklėmis. Tada pasibaigus stulpeliams, automatiškai atsiduriama naujos eilutės 
pradžioje. 

4 	J eigu suklydote įrašydami kintamojo vertę ir tai pastebėjote, galite iš karto aktyvavę  
		  langelį pataisyti, nes įrašytas skaičius atsiras lentelės viršuje, kur galėsite atlikti pakeiti- 
		  mus. Kintamųjų reikšmių koregavimas Data View lange parodytas 3.7 pav.

3.7 pav. Kintamųjų reikšmių koregavimas Data View lange.

3.8 pav. Kintamųjų reikšmės Data View lange.
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Surašius Data Editor lange visas kintamųjų reikšmes, jis turėtų atrodyti panašiai kaip paro-
dyta 3.7 pav. Arba galite pasinaudoti dar viena galimybe ir paspausti meniu juostoje piktogramą 

, kuri kategorinių kintamųjų užkoduotas reikšmes skaičiais pakeis į tiems skaičiams priskir-
tus pavadinimus. Tada lango vaizdas bus panašus į 3.8 pav.

3.4. Rinkmenų išsaugojimas ir paieška

Jei sukuriate naują rinkmeną arba atliekate pakeitimus jau esančioje, pavyzdžiui, sukuria-
te naujus kintamuosius, jūs turite nepamiršti išsaugoti šią informaciją. SPSS programų paketas  
automatiškai to neatlieka, tačiau uždarant rinkmeną jis pasiūlys išsaugoti atlikus pakeitimus. Jei 
per klaidą neišsaugosite atliktų pakeitimų, tada prarasite visą informaciją, kurią taip stropiai su-
rinkote. Todėl būkite atidūs ir stebėkite SPSS dialogo langus.

Norėdami išsaugoti rinkmeną, kurią sukūrėte ar modifikavote, meniu juostoje pasirinkite 
File->Save. Tą patį galite padaryti pagrindinėje SPSS meniu juostoje tiesiog pasirinkę pikto- 
 

gramą  arba vienu metu nuspauskite klavišus „Ctrl+S“. Jei tai yra nauja rinkmena, turėsi-
te nurodyti jos vardą ir vietą, kur ji bus išsaugota. SPSS programų paketu sukurta rinkmena turi 
plėtinį „*.sav“, kurio keisti nerekomenduojama.

Norėdami dirbti su kita rinkmena, atidarykite ją prieš uždarydami tą, su kuria darbą jau bai-
gėte. Priešingu atveju uždarysite ne tik rinkmeną, su kuria dirbote, bet ir SPSS.

Sukūrus duomenų rinkmeną gali tekti ją keisti. Tai atsitinka gana dažnai, kai norima pridėti, 
ištrinti arba perkelti kintamuosius, arba pridėti, arba pašalinti iš tyrimo analizės tam tikrus res-
pondentus. 

Taip pat tyrimo metu tenka rūšiuoti duomenų rinkmeną tam tikra tvarka arba, norint anali-
zuoti tam tikras grupes atskirai, reikia padalyti rinkmeną. Su duomenų modifikacijų procedūro-
mis supažindinsime išsamiau ketvirtame skyriuje.
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3.5. Užduotys

1. užduotis. Susipažinkite su žemiau pateiktais pasitenkinimą gyvenimu nusakančiais teigi-
niais, kurie matuojami toje pačioje matavimų skalėje, ir sukurkite automatiniu būdu penkis kin-
tamuosius. 

Užduotį atlikite tokia tvarka:
SPSS programų paketo Variable View lange: 

l	sukurkite kintamąjį pasgiv1 ir priskirkite jam būdingus atributus; kadangi šis kintamasis 
	 yra išmatuotas rangų skalėje, jo reikšmes užkoduokite: 1 – visiškai nesutinku, 2 3 4 7 –  

	 visiškai sutinku;

l	automatiniu būdu sukurkite kintamuosius: pasgiv2, pasgiv3, pasgiv4, pasgiv5.

l	stulpelyje Label apibūdinkite kiekvieną kintamąjį.

Perskaitykite jums pateiktus teiginius ir nuspręskite, kiek su jais sutinkate arbe ne. 
Savo sprendimą pažymėkite: 1 – visiškai nesutinku, 2 3 4 7 – visiškai sutinku.
Kiekvienas teiginys turi būti įvertintas skaičiais nuo 1 iki 7.

Teiginiai Nuomonė
1 Daugeliu atvejų mano gyvenimas yra idealus
2 Mano gyvenimo kokybė yra puiki
3 Aš esu patenkintas savo gyvenimu
4 Labai seniai iš gyvenimo gavau tai, ko norėjau
5 Jei galėčiau nugyventi savo gyvenimą iš naujo, nieko nekeisčiau

Šaltinis: sudaryta autorės, remiantis Diener, E., Emmons, R. A., Larson, R. J. & Griffin, S. (1985).

2. užduotis. Susipažinkite su žemiau pateikta anketa. Pagal ją surinkti duomenys yra surašy-
ti lentelėje. Sukurkite duomenų rinkmeną pavadinimu skaitymas.sav SPSS programų paketu. 

Užduotį atlikite tokia tvarka:

1. 	SPSS programų paketo Variable View lange: 

	 l		sukurkite kintamuosius: ID, lytis, amzius, skaite, nuomone;

	 l		kategoriniams kintamiesiems pagal jų matavimų skales priskirkite kodus;

	 l		visiems kintamiesiems nurodykite matavimo skalę.

2. 	SPSS programų paketo Data View lange:

	 l		įrašykite kintamųjų duomenis pagal SPSS reikalavimus.
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ANKETA

K1. Lytis:
¨	 vyras 
¨	 moteris

K3. Kiek knygų esate perskaitę? 
¨	 nuo 1 iki 5 
¨	 nuo 6 iki 20 
¨	 nuo 21 iki 50 
¨	 51 ir daugiau

K2. Amžius (metais) K4. Jūsų nuomonė apie knygų skaitymą 
¨	 Laiko švaistymas (LŠ)
¨	 Tie, kas skaito, neturi ką veikti (NKV)
¨	 Skaitymas nuobodu (SN)
¨	 Skaitymas įdomu (SĮ)
¨	 Skaitymas labai įdomu (SLĮ)

Lentelėje pateikti atsakymai į anketos klausimus:

ID K1 K2 K3 K4 ID K1 K2 K3 K4
1. vyras 65 51 ir daugiau SLĮ 16. moteris 22 iki 20 SĮ
2. vyras 26 iki 5 LŠ 17. moteris 34 51 ir daugiau SLĮ
3. vyras 20 iki 5 LŠ 18. vyras 26 iki 50 NKV
4. moteris 32 iki 50 SLĮ 19. vyras 28 iki 20 SĮ
5. moteris 24 iki 20 NKV 20. vyras 32 iki 50 SLĮ
6. vyras 27 iki 50 SLĮ 21. vyras 31 iki 5 SN
7. vyras 58 iki 20 SĮ 22. moteris 45 iki 50 SLĮ
8. vyras 23 iki 5 SN 23. moteris 31 iki 50 SLĮ
9. moteris 50 iki 50 SLĮ 24. vyras 35 iki 20 SĮ
10. moteris 41 51 ir daugiau SLĮ 25. vyras 26 iki 50 SLĮ
11. moteris 28 iki 50 SLĮ 26. moteris 32 iki 50 NKV
12. moteris 36 iki 50 SLĮ 27. moteris 30 iki 20 NKV
13. moteris 26 iki 20 SĮ 28. vyras 57 51 ir daugiau SLĮ
14. vyras 22 iki 50 SLĮ 29. vyras 39 iki 20 SĮ
15. vyras 25 51 ir daugiau SLĮ 30. moteris 21 iki 5 SN
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3. užduotis. Susipažinkite su žemiau pateikta anketa. Pagal ją surinkti duomenys yra sura-
šyti lentelėje. Sukurkite duomenų rinkmeną pavadinimu patenkintas.sav SPSS. Užduotį atliki-
te tokia tvarka:

1.	SPSS programų paketo Variable View lange: 

	 l		sukurkite kintamuosius: ID, lytis, amzius, nuomone;

	 l		kategoriniams kintamiesiems pagal jų matavimų skales priskirkite kodus;

	 l		visiems kintamiesiems nurodykite matavimo skalę.

2.	SPSS programų paketo Data View lange:

	 l		surašykite kintamųjų duomenis pagal SPSS reikalavimus.

ANKETA

K1. Lytis:
¨	 vyras 
¨	 moteris

K3. Aš patenkintas (-a) savo gyvenimu: 
¨	 tikrai sutinku (TS)
¨	 sutinku 
¨	 nesutinku
¨	 tikrai nesutinku (TN)

K2. Amžius (metais);

Lentelėje pateikti atsakymai į anketos klausimus:

ID K1 K2 K3 ID K1 K2 K3
1. vyras 29 sutinku 16. moteris 22 nesutinku
2. vyras 26 sutinku 17. moteris 34 sutinku
3. vyras 30 TN 18. vyras 26 TS
4. moteris 33 sutinku 19. vyras 28 TS
5. moteris 33 sutinku 20. vyras 32 TS
6. vyras 35 sutinku 21. vyras 31 sutinku
7. vyras 23 nesutinku 22. moteris 32 sutinku
8. vyras 29 sutinku 23. moteris 31 TN
9. moteris 33 sutinku 24. vyras 35 TS

10. moteris 26 nesutinku 25. vyras 26 sutinku
11. moteris 27 nesutinku 26. moteris 32 nesutinku
12. moteris 24 sutinku 27. moteris 30 TS
13. moteris 24 sutinku 28. vyras 57 sutinku
14. vyras 27 TS 29. vyras 39 TS
15. vyras 27 nesutinku 30. moteris 30 sutinku
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4. užduotis. Susipažinkite su žemiau pateiktais pasitenkinimą gyvenimu nusakančiais teigi-
niais, kurie matuojami toje pačioje matavimų skalėje, ir sukurkite automatiniu būdu penkis kin-
tamuosius. 

Užduotį atlikite tokia tvarka: 

SPSS programų paketo Variable View lange:

l	sukurkite kintamąjį vert1 ir priskirkite jam būdingus atributus; kadangi šis kintamasis yra 
	 išmatuotas vardinėje skalėje, jo reikšmes užkoduokite: 1 = Taip, 2 = Ne;

l	automatiniu būdu sukurkite kintamuosius: vert2, vert 3, vert 4, ..., vert13;

l	stulpelyje Label apibūdinkite kiekvieną kintamąjį.

Kokios, Jūsų nuomone, asmeninės savybės būdingos vadui lyderiui? Pasirinkite tik pačias svar-
biausias savybes.

Savybė Taip Ne Savybė Taip Ne
Patriotizmas Ištikimybė
Pasiaukojimas Sąžiningumas 
Drąsa Pagarba kitam
Garbingumas Nuoširdumas
Principingumas Pasitikėjimas savimi
Darbštumas Kūrybingumas
Lankstumas Išradingumas
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4. Anketavimo duomenų modifikavimas

Šiame skyriuje aptarsime SPSS programų paketu atliekamus jau sukurtos rinkmenos pakeiti-
mus. Čia rasite aiškinimą, kaip atlikti, tyrimo metu dažnai naudojamą, rinkmenos duomenų rū-
šiavimą tam tikra tvarka, arba kaip padalyti rinkmeną, kai reikia atskirai analizuoti tik tam tikras 
grupes. Taip pat susipažinsite ir su duomenų filtravimo procedūra, kuri skirta paaiškinti, kaip iš-
rinkti (įtraukti į tyrimą arba ne) duomenis. Taigi, šiame skyriuje aiškinamas turimos rinkmenos 
modifikavimas, leidžiantis suformuoti specifinę duomenų aibę, ir visų atliktų pakeitimų panai-
kinimas, leidžiantis sugrąžinti rinkmenos pradinę sudėtį. Skyriaus pabaigoje pateikiamos prak-
tinės užduotys, skirtos įgūdžiams lavinti.

4.1. Atvejo pašalinimas iš analizės

Šalinant kurį nors atvejį (respondentą) iš rinkmenos, reikės šalinti eilutę, tad suraskite numa-
tytą pašalinti atvejį ir pažymėkite kairiuoju pelės klavišu. Tada meniu juostoje pasirinkite Edit 
meniu ir Cut (Ctrl+X). Arba pažymėję norimą pašalinti eilutę ir dešiniuoju pelės klavišu atida-
rę papildomą langą galite atlikti šį veiksmą, kaip parodyta respondento, pažymėto identifikavi-
mo kodu 341 ir jo duomenų, suvestų į 7 eilutę, šalinimo procedūra Data View lange (4.1 pav.).

4.1 pav. Eilutės šalinimo procedūra Data View lange.
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Tokiu būdu pašalinus eilutę, jūsų duomenų rinkmena bus pakeista, tad SPSS programų pake-
to pagrindinio meniu juostoje pamatysite paryškintą diskelio piktogramą. Jei tikrai norite atlikti 
šį pakeitimą, spustelėkite piktogramą. Tokiu būdu galite šalinti eilutes iš sukurtos rinkmenos, ta-
čiau kartais reikia atlikti ir rinkmenos papildymą arba grąžinti tai, ką pašalinote. Kaip atlikti rin-
kmenos papildymą, skaitykite kitame poskyryje.

4.2. Rinkmenos papildymas po sukūrimo

Dėl įvairių priežasčių kartais prireikia padidinti respondentų skaičių jau sukurtoje duomenų 
rinkmenoje. SPSS programų paketas tai leidžia labai lengvai atlikti. Data View lange jums rei-
kės pažymėti žymekliu eilutę, virš kurios norite įterpti naują (papildomą) eilutę. Spustelėkite pa-
grindiniame SPSS programų paketo meniu juostoje Edit ir pasirinkite Insert Cases. Tuščia ei-
lutė bus įterpta, ir jūs galėsite įrašyti duomenis.

 a b

4.2 pav. SPSS programos meniu juostos pasirinkimas Edit -> Insert Cases: a) eilutės įterpimo procedūra;
b) rezultatas – sukurta nauja eilutė.

Tai galima padaryti ir dar paprasčiau. Pažymėkite eilutę, virš kurios norite įterpti nau-
ją (naujas) eilutę, po to pagrindiniame SPSS programų paketo meniu juostoje paspauskite 
 
piktogramą  tiek kartų, kiek eilučių norite papildyti savo sukurtą rinkmeną. Po šių veiksmų 
Data Editor lange atsiras papildomos tuščios (be duomenų) eilutės.
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Kaip jau supratote, dirbant su SPSS programų paketu, yra pakankamai nesudėtinga tiek paša-
linti, tiek įtraukti respondentus į jau sukurtą rinkmeną. Tačiau kartais reikia iš jau sukurtos rin-
kmenos pašalinti arba įtraukti kintamąjį. Apie tai skaitykite 4.3 ir 4.4 skyriuose. 

4.3. Kintamųjų šalinimas 

Jei jau tikrai atsitiko taip, kad nusprendėte pašalinti kintamąjį, jums reikės šalinti sukurtos 
rinkmenos stulpelį, jei tai yra Data View langas, jei esate Wariable View lange, tada šalinsite ei-
lutę. Abiem atvejais pirma pasirinkite kintamąjį, kurį norite pašalinti, tada pagrindiniame SPSS 
programų paketo meniu rinkitės Edit ir Clear/ Delete, kaip tai parodyta 4.3 a pav.

 a b

4.3 pav. SPSS programos meniu juostos pasirinkimas Edit -> Clear/ Delete: a) pašalina kintamąjį „vaikai“;  
b) rezultatas – pašalina kintamojo „vaikai“ reikšmes. 

Jei pageidaujate pašalinti tik kintamojo duomenis, o ne kintamąjį konkrečiai, galite tai pada-
ryti atlikę komandą Edit -> Clear/ Delete, bet šiuo atveju pažymėti reikia tik kintamojo reikš-
mes. Tai pavaizduota pavyzdyje 4.3 b pav., bus pašalinti kintamojo vaikai duomenys.

4.4. Rinkmenos papildymas kintamaisiais

Atlikus anketinę apklausą, yra surenkama labai daug informacijos, tad tyrėjas, kurdamas 
duomenų rinkmeną analizei, gali pasirinkti kuriuos kintamuosius įtraukti, o kurių ne, nes jis turi 
galimybę bet kada papildyti kintamaisiais jau sukurtą rinkmeną.

Norint papildyti rinkmeną, reikės SPSS programų paketo Data View lange pasirinkti kinta-
mojo stulpelį ir pažymėti jį. Tada pagrindinėje meniu juostoje pasirinkite Edit, kurio pateikta-
me galimų pasirinkimų sąraše rinkitės Insert Variable arba tiesiog spustelėkite SPSS programų  
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paketo pagrindiniame meniu piktogramą  (4.4 pav. a). Po šio veiksmo jūsų rinkmena bus pa-
pildyta vienu tuščiu stulpeliu (kintamuoju), kuriam automatiškai bus suteiktas vardas VAR00002  
(4.4 b pav.).  

 a b

4.4 pav. SPSS programų paketo meniu juostos pasirinkimas Edit -> Insert Variable:  
a) sukuria naują kintamąjį; b) rezultatas – naujas kintamasis VAR00002.

Sukūrus naują kintamąjį, jums reikės apibūdinti jį SPSS programų paketo Variabe View lan-
ge priskiriant jam būdingus atributus, o Data View lange įrašyti jo reikšmes. Žemiau aprašyta 
kintamojo vietos keitimo procedūra taip pat palengvina tyrėjo darbą.

4.5. Kintamojo vietos keitimas

SPSS programų paketas leidžia ne tik kurti naujus kintamuosius, bet ir perkelti jau sukurtus 
kintamuosius į kitą vietą. Tai labai patogu, nes lange matomų kintamųjų skaičius yra ribotas. Be 
to, atliekant tyrimą yra sukuriama daug naujų papildomų kintamųjų, kuriuos SPSS programų 
paketas pagal nutylėjimą surašo kintamųjų eilės gale. Kintamojo perkėlimo iš galo į priekį pro-
cedūra yra labai nesudėtinga. Norint tai atlikti, jums tiesiog reikia Data View lange pasižymėti 
stulpelį (kintamąjį), kurio poziciją norite keisti, ir pele perkelti jį į pageidaujamą vietą. Jei kinta-
masis, kurį norite perkelti į priekį, yra 122-asis jūsų kintamųjų sąraše, tuomet pele vilkti jį iš vie-
no galo į kitą bus nepatogu. Tuo atveju sukurkite jam vietą, kaip jau yra paaiškinta 4.4 poskyry-
je, ir nukopijuokite duomenis į šią vietą (4.4 b pav.).

Jei jau susitvarkėte savo rinkmeną ir prieš tyrimą norite ją surūšiuoti, tai galėsite atlikti susi-
pažinę su duomenų rūšiavimo procedūra, aprašyta kitame poskyryje.
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4.6. Rinkmenos duomenų rūšiavimas

Prieš atliekant tyrimo analizę, kartais, kai duomenys buvo modifikuoti (pvz., panaudotas fil-
travimas, aprašytas 4.8 skyriuje), yra patogu surūšiuoti surinktų duomenų rinkmeną ir taip vizua-  
liai patikrinti, ar tikrai analizei atrinkote jums būtinus duomenis. Tad norėdami atlikti šią proce-
dūrą, jūs galite tai padaryti pagal pasirinkto kurio nors vieno kintamojo vertes. Žemiau pateik-
tas rinkmenos Streso tyrimas.sav rūšiavimo pavyzdys, kai duomenų rinkmena bus surūšiuota 
pagal kintamąjį lytis.

Duomenų rūšiavimas 

1 	S PSS programų paketo pagrindiniame meniu pasirinkite Data->Sort Cases. 
2 	A tsidariusiame Sort Cases lange, į laukelį Sort by įkelkite kintamąjį lytis;
3 	 Sort Cases lango bloke Sort Order galite pasirinkti rūšiavimo tipą Ascending (didėjančia  

		  eile) arba Descending (mažėjančia eile). Šiuo atveju turime kokybinį kintamąjį, kurio 
	  	reikšmės: vyrai – 1, moterys – 2. Rūšiavimui pasirinkime Ascending tvarką ir spaudžia- 
		  me OK (4.5 pav.).

4.5 pav. SPSS programų paketo meniu juostos pasirinkimas Data -> Sort Cases. 
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SPSS programų paketas surūšiuos automatiškai. Šiuo konkrečiu atveju pirmiausia bus iš-
rikiuojami vyrai, o po to – moterys. Rinkmenos rūšiavimo rezultato fragmentas pavaizduotas  
4.6 a pav. 

 a b

4.6 pav. SPSS programų paketo meniu juostos pasirinkimas Data -> Sort Cases,  
kai rūšiuojama pagal: a) kintamąjį lytis; b) kintamąjį ID.

Ką daryti, jei jau turite kitokių poreikių? Pavyzdžiui, norite grįžti į pradinę duomenų rūšiavi-
mo tvarką. Jei duomenų rinkmena buvo surinkta pagal anketų ID numerius, tokiu atveju pakar-
tokite duomenų rūšiavimo procedūrą ir Sort by laukelyje įkelkite kintamąjį ID. Rezultatas yra 
atvaizduotas (4.6 b pav.).

Duomenų rūšiavimas dar ne viskas, ką tyrėjas gali panaudoti atlikdamas statistinę duome-
nų analizę. Norėdami atlikti tyrimą atskiroms grupėms, turėsite prieš tai padalyti rinkmeną. 
Apie tai skaitykite toliau.

4.7. Rinkmenos padalijimas

SPSS programų paketas leidžia padalyti duomenų rinkmeną, kai atliekant duomenų anali-
zę būtinai jums reikia atskirai pakartoti tam tikrų grupių analizę (pvz., rūkantys ir nerūkantys). 
Norėčiau pabrėžti, kad po šios procedūros rinkmena nebus pakeista neatkūriamai ir jūs tikrai 
neprarasite savo taip kruopščiai surinktų duomenų. Pasinaudoję šia procedūra, galite vėl grą-
žinti savo duomenis į pradinę rinkmenos struktūrą, pvz., kai šie duomenys buvo išrūšiuoti pa-
gal ID.
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Duomenų rinkmenos padalijimas 

1 	S PSS programų pakete atidarykite Data Editor langą.
2 	 Pagrindinio meniu juostoje pasirinkite Data, tada Split File (4.7 pav.).
3 	A tsidariusiame Split File lange pasirinkite Compare groups, o į Goups Based on įkel- 

		  kite kintamąjį, pagal kurį norite padalyti (pvz., lytis), tai parodyta 4.8 a pav. 
4 	K ai atliksite visus nurodymus, rinkitės OK.

4.7 pav. SPSS programų paketo meniu juostos pasirinkimas Data -> Split File.

Po šio rinkmenos padalijimo atliekant statistines analizes, abi grupės (šiuo atveju – vyrų ir 
moterų) bus analizuojamos atskirai. Atlikus analizę, jums reikia grįžti į pradinę rinkmenos struk-
tūrą ir sujungti visus duomenis į vientisą rinkmeną, kaip yra nurodyta kitoje procedūroje 
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Rinkmenos duomenų sujungimas 

1 	A tidarykite Data Editor langą.
2 	 Pagrindinėje meniu juostoje pasirinkite Data, tada Split File.
3 	A tsidariusiame Split File lange pasirinkite Analyze all cases do not create groups  

		  (4.7 b pav.).
4 	K ai atlikote visus nurodymus, rinkitės OK.

 a b

4.8 pav. SPSS programos meniu juostos pasirinkimas Data -> Split File,  
kai rinkmena padalijama pagal: a) kintamąjį lytis; b) atkūriama pradinė rinkmenos struktūra.

Norėdami atlikti statistinį atskirų grupių su specifiniais požymiais tyrimą, turėsite atlikti rin-
kmenos duomenų filtravimą. Apie tai skaitykite toliau.

4.8. Duomenų išskyrimas analizei

SPSS programų paketas leidžia išskirti tam tikrus atvejus iš duomenų rinkmenos. Šia galimy-
be atlikdamas tyrimą pasinaudoja tyrėjas, kai jam būtinai reikia išsiaiškinti, kas vyksta tik tam tik- 
rose grupėse (pvz., tik vyrų grupėje). Labai svarbu, kad šia procedūra pakeitę rinkmenos struk-
tūrą, jūs tikrai neprarasite įrašytų duomenų, o atlikę statistinę analizę vėl galėsite grąžinti duo-
menų rinkmenai pradinę jos sudėtį.

Kad būtų aiškiau, atliksime duomenų išrinkimo procedūrą, kai iš rinkmenos Streso tyrimas.sav  
pasirinksime tik vyrus ir tik tuos kurie yra 30-ties metų arba vyresni. Šią specifinę duomenų 
aibę sudarysime išrinkę visus atvejus pagal iškeltus reikalavimus toliau aprašyta veiksmų atli-
kimo tvarka. 
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Duomenų išskyrimas 

1 	S PSS programų paketu atidarykite rinkmeną Streso tyrimas.sav.  
2 	 Pagrindinėje Data Editor lango meniu juostoje pasirinkite Data, tada Select Cases. Tai  

		  yra parodyta 4.9 pav.

4.9 pav. SPSS programų paketo meniu juostos pasirinkimas Data -> Select Cases.

3 	A rba pagrindiniame meniu galite pasirinkti piktogramą . Abiem būdais bus atidary- 
		  tas langas Select Cases, kuriame pasirinkite If condition is satisfied, kaip parodyta  
		  4.10 pav.
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4.10 pav. SPSS programų paketo Select Cases langas.

4 	K itas žingsnis – reikia rinktis mygtuką IF ...
5 	A tsidariusiame lange Select cases: If pasirinkite kintamąjį, kuris charakterizuoja jums  

		  reikalingą grupę (pvz., lytis). (žr. 4.11 pav.).
6 	J ums reikės įkelti kintamąjį į apibūdinimo langą, kur kintamųjų vardai yra sujungiami  

		  aritmetiniais ir loginiais veiksmais, kuriuos galėsite nurodyti pasirinktinai iš jau paruoš- 
		  tos lentelės. Šiuo atveju reikės:

		  1.	Renkamės ( ), tada įkeliame kintamąjį lytis; 

		  2.	Renkamės = ir 1 (jei vyrus savo rinkmenoje kodavote būtent 1);

		  3.	Renkamės & (atitinka ir, galima rašyti ir angliškai and), tai išplės galimybę papil- 
			   domiems požymiams nusakyti;

		  4.	Renkamės ( ), tada įkeliame kintamąjį amzius; 

		  5.	Renkamės >= ir 30.

		  6.	Atlikę visus nurodymus, patikrinkite, ar tikrai nėra klaidų. Po šių veiksmų Select  
			   cases: If lange turėtų būti užrašyta: (lytis = 1)&(amzius >= 30). 

		  7.	Pagaliau rinkitės Continue, tada OK.
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4.11 pav. SPSS programų paketo Select Cases: If langas.

Programa pagal šį reikalavimą išrinks iš jūsų duomenų (pvz., Streso tyrimas.sav) tik vyrus, 
kurių amžius bus 30 ir daugiau, kaip tai yra parodyta 4.12 pav. Šiuo atveju SPSS programų pa-
keto Data View lange yra paliktos aktyvios tik tos duomenų eilutės, kurios atitinka duomenų iš-
rinkimo sąlygą, kiti atvejai yra perbraukti. Atliekant statistinį tyrimą „išbrauktos“ eilutės nebus 
įtraukiamos. Norėdami tuo įsitikinti, po duomenų filtravimo atlikite jų analizę grafiniu būdu. Šį 
kartą SPSS programų paketas analizuos tik išrinktus duomenis, tai aiškiai pamatysime nubrėž-
dami sklaidos diagramą

4.12 pav. SPSS programų paketo Data View lango fragmentas po duomenų išrinkimo.
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Atlikę šį pakeitimą, galite atlikti pirminę duomenų analizę grafiniu būdu. Šį kartą SPSS prog-
ramų paketas analizuos tik išrinktus duomenis. Kad tai pailiustruotume, nubrėšime sklaidos di-
agramą (plačiau apie sklaidos diagramų braižymą rasite 5.4.3 skyriuje), kuri atvaizduos kaip 
30-mečiai ir vyresni vyrai reaguoja į patiriamą stresą (4.13 pav.).
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4.13 pav. Trisdešimtmečių ir vyresnių vyrų reakcija į patiriamą stresą sklaidos diagramą.

Reikėtų atkreipti dėmesį į tai, kad pasirenkant tik tam tikrus duomenis, iškeltas reikalavimas 
taikomas kiekvienam rinkmenos atvejui (respondentui). Tai reiškia, kad yra patikrinama kiek-
viena rinkmenos eilutė ir paliekamos „neišbrauktos“ tik tos, kurios atitinka duomenų išrinkimo 
sąlygą. Tai patogu ir dažnai naudojama socialiniuose tyrimuose, kai reikia išsiaiškinti tik tam tik- 
ros socialinės grupės požiūrį, pritarimą ar pomėgius.

Kadangi jau išnagrinėtas vienas atvejų – išrinkimo procedūros pavyzdys, tad 4.1 lentelėje yra 
pateikti dar keli filtravimo pavyzdžiai (naudojama rinkmena Streso tyrimas.sav), kurie padės 
aiškiau suprasti aritmetinių ir loginių ženklų panaudojimą išrenkant reikalingus duomenis iš rin-
kmenos. Jei jums kyla papildomų klausimų, kodėl yra parinkti tam tikri skaičiai 4.1 lentelės ap-
rašytuose pavyzdžiuose, pasitikrinkite jų reikšmes kintamųjų kodavimo apraše, kuris yra patei-
kiamas priede. 
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4.1 lentelė. Atvejų išrinkimo pavyzdžiai

Ką išrinkti? Aritmetiniai ir loginiai veiksmai
vyrus su viduriniu išsilavinimu (lytis = 1) & (mokslai = 2)
vyrus su viduriniu išsilavinimu, 
vyresnius nei 40-ties metų

(lytis = 1 & mokslai = 2 & amzius > 40)

vyrus su viduriniu išsilavinimu arba 
moteris su aukštuoju bakalauro 
išsilavinimu

(lytis = 1 & mokslai = 2)|(lytis = 2 & mokslai = 3) 

visus atvejus, išskyrus: 11; 234 ir 302 ($Casenum~= 11) & ($Casenum~= 234) & ($Casenum ~= 302)

Išrenkant duomenis, dažniausiai naudojamas filtras, kuriame yra keletas sąlygų, kaip paro-
dyta 4.1 lentelėje. Tokiu atveju visos sąlygos jungiamos ženklais „arba“ (žymima |) bei „ir“ 
(žymima &). Kurią jungtį naudoti, sprendžia tyrėjas. Pavyzdžiui, baltas ir pūkuotas duos visai 
kitą atrankos rezultatą, nei baltas arba pūkuotas. Jeigu sąlygų daug, galima jas skliausti. Beje, 
skliaustai ne visada būtini, tai yra filtras (lytis = 1) & (mokslai = 2) veiks taip pat puikiai, kaip ir 
lytis = 1 & mokslai = 2. SPSS programų pakete reikalaujama kiekvieną sąlygą pradėti kintamuo-
ju (stulpelio vardu). Tarkime, užrašius sąlygą 1 = lytis, jau bus klaida ir filtras neveiks. Jeigu kin-
tamasis įgyja simbolinę reikšmę, tai būtinos kabutės, pvz., country = ‘Lithuania’. 

Atvejų išrinkimo procedūra yra labai patogi atliekant tam tikrų duomenų grupės tyrimą, bet 
norėdami tęsti visų surinktų duomenų analizę, privalėsite grąžinti rinkmenos duomenis į pradi-
nę struktūrą. Reikalingų veiksmų seka yra aprašyta toliau.

Duomenų struktūros atstatymas 

1  	SPSS programų paketu atidarykite rinkmeną Streso tyrimas.sav. 
2  	Pagrindinėje Data Editor lango meniu juostoje pasirinkite Data, tada Select Cases.
3 	A tsidariusiame Select Cases lango bloke Select, pasirinkite All cases (4.14 pav.).
4 	A tlikę visus nurodymus, rinkitės OK.
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4.14 pav. SPSS programų paketo Select Cases langas.

Štai taip paprastai SPSS programų paketas suteikia galimybę manipuliuoti rinkmenos duo-
menimis. Kad galėtumėte pasitikrinti, ar teisingai supratote, kaip reikia atlikti aprašytas proce-
dūras, atlikite šio skyriaus gale pateiktas užduotis.
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4.9. Užduotys

1 užduotis. Naudodami duomenų rinkmeną skaitymas.sav atlikite tokius veiksmus:

l	surūšiuokite pagal kiekvieną iš kintamųjų: ID, lytis, amzius;

l	padalykite rinkmeną pagal vieną iš kategorinių kintamųjų;

l	po to atstatykite skaitymas.sav pradinę struktūrą;

l	tyrimui išrinkite vyrus ir neįtraukite 10 atvejo (lytis = 1 & $Casenum ~= 10);

l	po to atstatykite skaitymas.sav pradinę struktūrą.

2 užduotis. Naudodami duomenų rinkmeną skaitymas.sav atlikite tokius veiksmus:

l	surūšiuokite pagal kiekvieną iš kintamųjų: amzius, skaite, nuomone;

l	padalykite rinkmeną pagal vieną iš kategorinių kintamųjų;

l	po to atstatykite skaitymas.sav pradinę struktūrą;

l	tyrimui išrinkite moteris ir neįtraukite 15 atvejo (lytis = 1 & $Casenum ~= 15);

l	po to atstatykite skaitymas.sav pradinę struktūrą.

3 užduotis. Naudodami duomenų rinkmeną nuomone.sav atlikite tokius veiksmus:

l	surūšiuokite pagal kiekvieną iš kintamųjų: ID, lytis, amzius;

l	padalykite rinkmeną pagal vieną iš kategorinių kintamųjų;

l	po to atstatykite nuomone.sav pradinę struktūrą;

l	tyrimui išrinkite moteris ir neįtraukite 5 ir 30 atvejų: 
	 (lytis = 1 & $Casenum ~= 5& $Casenum ~= 30);

l	po to atstatykite nuomone.sav pradinę struktūrą.

4 užduotis. Naudodami duomenų rinkmeną nuomone.sav šiuos veiksmus:

l	surūšiuokite pagal kiekvieną iš kintamųjų: ID, amzius, nuomone;

l	padalykite rinkmeną pagal vieną iš kategorinių kintamųjų;
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l	po to atstatykite nuomone.sav pradinę struktūrą;

l	tyrimui išrinkite moteris, vyresnes nei 20-ies metų, ir vyrus, vyresnius nei 50-ies metų  
	 (lytis = 2 & amzius > 20) | (lytis = 1 & amzius > 30);

l	po to atstatykite nuomone.sav pradinę struktūrą.

5 užduotis. Naudodami duomenų rinkmeną vado vaidmuo.sav atlikite tokius veiksmus:

l	surūšiuokite pagal kiekvieną iš kintamųjų: issilavinimas, amzius, seim_pad;

l	padalykite rinkmeną pagal vieną iš kategorinių kintamųjų;

l	po to atstatykite vado vaidmuo.sav pradinę struktūrą;

l	tyrimui išrinkite respondentus, kurių amžius yra nuo 26 iki 30 metų, ir neįtraukite tų, kurie yra  
	 išsiskyrę, turi nebaigtą aukštąjį išsilavinimą (amzius = 2 & seim_pad < 3 & issilavinimas = 4);

l	po to atstatykite vado vaidmuo.sav pradinę struktūrą.

6 užduotis. Naudodami duomenų rinkmeną vado vaidmuo.sav atlikite tokius veiksmus:

l	surūšiuokite pagal kiekvieną iš kintamųjų: issilavinimas, lytis, amzius;

l	padalykite rinkmeną pagal vieną iš kategorinių kintamųjų;

l	po to atstatykite vado vaidmuo.sav pradinę struktūrą;

l	tyrimui išrinkite vyrus, kurių amžius yra nuo 20 iki 25 metų, išsilavinimas – vidurinis ir 
	 neįtraukite 12 atvejo (lytis = 1 & amzius = 1) | (issilavinimas = 1 & $Casenum ~= 12);

l	po to atstatykite vado vaidmuo.sav pradinę struktūrą.

7 užduotis. Naudodami duomenų rinkmeną vado vaidmuo.sav atlikite tokius veiksmus:

l	surūšiuokite pagal kiekvieną iš kintamųjų: issilavinimas, seim_pad, tarn_stazas;

l	padalykite rinkmeną pagal vieną iš kategorinių kintamųjų;

l	po to atstatykite vado vaidmuo.sav pradinę struktūrą;

l	tyrimui išrinkite respondentus, kurių tarnybos stažas nuo 16 iki 20 metų, turi aukštąjį  
	 universitetinį išsilavinimą, šeiminė padėtis „vedęs“ ir užima būrio vado pareigas  
	 (tarn_stazas = 4 & issilavinimas = 6) | (seim_pad = 1 & pareigos = 30);

l	po to atstatykite vado vaidmuo.sav pradinę struktūrą.



A p r a š o m o j i  s t a t i s t i k a  s u  S P S S 85

5. Aprašomoji statistika su SPSS

Šiame skyriuje aptarsime SPSS programų paketu atliekamą aprašomąją surinktų kintamųjų 
duomenų analizę, šių kintamųjų dažnių lentelių sudarymą bei kintamųjų normalumo nustatymo 
sąlygas, kurios yra svarbios renkantis parametrinių hipotezių tikrinimo kriterijų. Čia rasite aiš-
kinimą, kaip kintamojo reikšmes patikrinti dėl išskirčių, planuojant atlikti parametriniais krite-
rijais paremtą statistinę analizę. Taip pat šiame skyriuje paaiškinta, kaip atlikti grafinę duomenų 
analizę, kuri gali atskleisti duomenų savybes sunkiai įvertinamais kitais metodais. Skyriaus pa-
baigoje pateikiamos praktinės užduotys, skirtos įgūdžiams, kuriuos galėsite pritaikyti atlikdami 
pradinę anketinių duomenų analizę, lavinti.

Surinktų duomenų statistinės analizės pradžia yra ypatinga tuo, kad kiekvieną kintamąjį 
arba požymį reikia nagrinėti atskirai. Dėl šios priežasties statistinė analizė yra vienmatė (kiek-
vienas kintamasis nagrinėjamas atskirai). Vienmatei analizei atlikti taikomi aprašomosios sta-
tistikos metodai, kuriuos sudaro duomenų grupavimas, dažnių lentelės, statistinių charakteris-
tikų (duomenų padėties ir sklaidos charakteristikų) skaičiavimas ir grafinis stebėjimų vaizda-
vimas.

Taigi taikant aprašomosios statistikos metodą yra sudaromos kintamųjų reikšmių dažnių lente-
lės, kuriose pateikiami nominalinėje arba (esant nedideliam kategorijų skaičiui) rangų skalėje išma-
tuotų kintamųjų dažniai.

Pradinei duomenų analizei, be grupinių dažnių lentelių, dažnai dar sudaromos porinės (ir 
daugiau kintamųjų) dažnių lentelės. Porinės dažnių lentelės atskleidžia tarp kintamųjų egzistuo-
jančius ryšius. Tokios dažnių lentelės paprastai sudaromos vardiniams ir ranginiams kintamie-
siems su santykinai mažu stebimų reikšmių (kategorijų) skaičiumi. Porinėms lentelėms sudaryti 
nenaudojami kiekybiniai kintamieji. Jeigu į tokią lentelę būtina įtraukti kiekybinį kintamąjį (pa-
jamas ir pan.), tai pirmiausia šio kintamojo reikšmes reikia suskirstyti į keletą intervalų (mažos 
pajamos, vidutinės, didelės, labai didelės).

Aprašomoji statistika leidžia sutvarkyti ir apibendrinti tiriamas imtis. Taip pat apibrėžia pa-
grindinius statistinius parametrus (vidurkį, dispersiją, modą, medianą, asimetriją ir ekscesą). 
Priklausomai nuo kintamųjų tipų (gali būti kokybiniai ir kiekybiniai) aprašomoji statistika tyri-
mui taiko skirtingus metodus. 

Vardinius (nominaliuosius) kintamuosius tiriame jiems pritaikytais metodais, tai yra duome-
nis sutvarkome pasinaudodami dažnių lentelėmis, o grafiškai šiuos kintamuosius galime vaiz-
duoti diagramomis. Ranginiams kintamiesiems ir kiekybiniams kintamiesiems, išmatuotiems in-
tervalų ar santykių skalėse, bet neturintiems normaliojo skirstinio, šalia dažnių lentelių ir dia-
gramų dažniausiai dar skaičiuojama vidutinė (centrinė) atsitiktinio dydžio reikšmė (mediana) ir 
kvartiliai.

Kvartiliais vadinami skaičiai, dalijantys variacinę eilutę (variacinė eilutė – duomenų eilutė, 
išdėstyta didėjimo tvarka) į keturias maždaug lygias dalis. Parametriniai kintamieji, išmatuo-
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ti intervalų ar santykių skalėse ir turintys normalųjį skirstinį, grupuojami į intervalus, nustatant 
grupavimo intervalų skaičių, plotį ir intervalų kraštinius taškus. Kiekybiniams kintamiesiems 
skaičiuojami dažniai, braižomos diagramos (histogramos, linijinės diagramos ir pan.) ir skai-
čiuojamos centro bei sklaidos charakteristikos.

5.1. Kintamųjų dažnių analizė

Surinktų kintamųjų duomenų analizė pradedama nuo šių kintamųjų dažnių lentelių sudary-
mo. Ranginiams ir nominaliesiems (vardiniams) kintamiesiems galime sudaryti vienmates daž-
nių lenteles. Sudarę tokias lenteles, mes jau galėtume analizuoti, kaip atskiro kintamojo įgyja-
mos reikšmės pasiskirsčiusios imtyje, parinktoje tyrimui atlikti. Kadangi apklausoje dalyvauja 
tiek vyrai, tiek ir moterys, o jų amžius, išsilavinimas ir šeiminė padėtis labai įvairi, šios duome-
nų dažnių lentelės padeda išsiaiškinti pradinę informaciją, kuri parodo tyrime dalyvavusių vyrų 
ir moterų skaičių ir visą kitą socialinę informaciją.

Aprašomąją statistiką SPSS programų paketu atliekame tam numatytais metodais. Tai reiškia, 
kad SPSS lango meniu juostoje (5.1 pav.) turime pasirinkti Analyze-> Descriptive Statistics-> 
Descriptives arba kitas siūlomas galimybes, kurių yra keletas: Ferquencies, Explore, Crosstabs.  

5.1 pav. SPSS programų paketo meniu juostos pasirinkimas Analyze->Descriptive Statistics.

SPSS programų paketo taikymą duomenų analizėms atlikti pradėsime nuo kokybinių kinta-
mųjų, kurie dar kitaip vadinami kategoriniais kintamaisiais.
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5.1.1. Kategorinių kintamųjų analizė

Kategorinių kintamųjų pradinė duomenų analizė yra atliekama pasirinkus Analyze-> 
Descriptive Statistics-> Frequencies. Analizei atlikti naudosime kokybinius kintamuosius iš 
rinkmenos Streso tyrimas.sav. Procedūros atlikimo žingsniai paaiškinti toliau.

Kategorinių kintamųjų procedūra

1 	S PSS programų paketu atidarykite rinkmeną Streso tyrimas.sav. Pagrindinėje SPSS  
		  meniu juostoje pasirinkite Analyze-> Descriptive Statistics-> Frequencies. 

2 	A tsidariusiame lange pasirinkite kategorinius, pavyzdžiui, kintamąjį Lytis, ir perkelkite į  
		  Variables langą.

3 	 Pasirinkite Frequencies lange Statistics mygtuką. Atsidariusio lango skyriuje Dispersion  
		  pažymėkite Minimum ir Maximum. Tada Continue ir OK.

SPSS programų paketo išvesties lange bus pateiktos dvi lentelės. 5.1 lentelėje Statistics yra 
pateikiami kintamojo Lytis statistiniai duomenys: atvejų skaičius (Valid – 439), respondentų, 
neatsakiusių į šį klausimą, skaičius (Missing – 0), bei kintamojo Lytis mažiausia (Minimum – 
1) ir didžiausia (Maximum – 2) reikšmės.

5.1 lentelė. Kintamojo Lytis statistiniai duomenys.

Statistics
Lytis

N
Valid 439
Missing 0

Minimum 1
Maximum 2

5.2 lentelė. Kintamojo Lytis skirstinys.

Lytis
Frequency Percent Valid Percent Cumulative Percent

Valid 1 185 42,1 42,1 42,1
2 254 57,9 57,9 100,0

Total 439 100,0 100,0

5.2 lentelės skiltyse yra pateikiamas kintamojo Lytis reikšmių dažnių pasiskirstymas 
(Frequency), reikšmių procentai (Percent), galiojančių reikšmių procentai (Valid Percent) bei 
sukauptieji reikšmių procentai (Cumulative Percent). Analizuotasis kintamasis Lytis įgyja tik 
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dvi skirtingas reikšmes, kurių skirstinių duomenys surašyti eilutėse.

Gautos informacijos interpretacija

Atlikę pradinę kintamojo Lytis statistinę analizę, sužinojome, kad apklausoje dalyvavo 185 
vyrai (42,1 proc.) ir 254 moterys (57,9 proc.), iš viso 439 respondentai. Yra svarbu žinoti respon-
dentų grupių dydį, nes atliekant statistines analizes, tokias kaip ANOVA, jums reikės apytikriai 
vienodo dydžio grupių. Jei grupių dydžiai labai skiriasi ir respondentų skaičius apskritai yra ne-
didelis, jūs būsite apriboti rinkdamiesi tyrimų metodus.

5.1.2. Neparametrinių kintamųjų bloko analizė

Labai dažnai atliekant tyrimą tenka analizuoti tam tikrus populiacijoje vyraujančius požy-
mius užduodant klausimus, kurie pateikiami blokais. Tokio tipo klausimai turėtų tenkinti du kri-
terijus. Pirma, klausimai turėtų jums padėti surinkti reikalingus duomenis, antra, šiuos duomenis 
turite gauti tokiu formatu, kurį mokėtumėte analizuoti. 

Bloke klausimų atsakymai matuojami toje pačioje skalėje. Tai reiškia, kad visiems bloke 
esantiems klausimams bus taikoma ta pati matavimo skalė. Tokiu atveju gali būti penkių pasi-
rinkimų Likerto skalė arba intervalų skalė, arba visi klausimai gali būti išmatuoti dvireikšmėje 
skalėje, kai reikia tiesiog pasirinkti „Taip“ arba „Ne“. 

Formuluojant klausimų bloką labai svarbu, kad jūs žinotumėte, kaip jums analizuoti gautą 
informaciją. Jei tyrime suformuluojate klausimus, į kuriuos atsakymai bus „Taip“ / „Ne“, ar pa-
žymėti Likerto skalėje, tai surinkti duomenys bus neparametriniai, dar paprasčiau jie yra vadi-
nami kategoriniais. Nors abiem atvejais surinksite neparametrinius duomenis, savo prigimtimi 
duomenys skirsis, nes atsakymai „Taip“ / „Ne“ bus matuojami vardinėje (nominalioje) skalėje, 
o duomenys, išreiškiantys nuomonę, bus ranginiai. 

5.1.2.1. Kintamieji, išmatuoti vardinėje skalėje

Anketose dažnai pasitaiko ir dichotominių (dvireikšmių) klausimų, kurie turi tik du atsaky-
mų variantus (tik dvi kategorijas). Tokio tipo klausimais galėtų būti, pavyzdžiui, klausimas apie 
respondento lytį (norime sužinoti respondentų lytį: vyras ar moteris) arba klausimas apie respon-
dento rūkymo įpročius (rūko ar ne). 

Žinoma, ne visi kategoriniai kintamieji yra dvireikšmiai. Labai dažnai tyrėjai suformuluoja 
klausimus, kuriuose yra penkios ir daugiau kategorijų. Šiuo atveju respondentui reikia nurodyti, 
kelis atsakymo variantus jis gali rinktis. Tokio tipo pavyzdžiu galėtų būti:
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Klausimas. Kokiose sporto varžybose dalyvavote? (pažymėkite tik vieną);
1.	Krepšinis
2.	Kovos menai
3.	Boksas
4.	Futbolas
5.	Kita

Kategorija „Kita“ yra naudinga, jei apklausiate didelę respondentų imtį. Ši pasirinkimo gali-
mybė padės atskleisti papildomas kategorijas, kurios nebuvo paminėtos klausime, ir suteiks nau-
dingos informacijos tyrėjui. 

Tas pats klausimas gali būti pateiktas panašiai, bet išplėstos atsakymų galimybės, kai respon-
dentui siūloma pažymėti visus tinkamus. Pavyzdžiui, gali būti: 

Klausimas. Kokiose sporto varžybose dalyvavote? (pažymėkite visus tinkamus);
1.	Krepšinis
2.	Kovos menai
3.	Boksas
4.	Futbolas
5.	Kita

Šį kartą respondentui reikia pažymėti visas varžybas, kuriose jis dalyvavo. Tokius duomenis 
yra sudėtingiau analizuoti. Tačiau šis klausimas turi pranašumą prieš tą, kuriame respondentai 
galėjo rinktis tik vieną atsakymą, nes, apklausę respondentus, galėsime įvertinti tam tikrų sporto 
šakų populiarumą tarp įvairių sporto rūšių be diskriminacijos. Jei kas iš respondentų kultivuoja 
kelias sporto šakas ir dalyvavo keliose sporto varžybose, pvz., ne vien tik bokso rungtynėse, bet 
ir futbolo, tai galės pažymėti savo atsakyme.

Kategoriniai kintamieji, išmatuoti vardinėje skalėje, gali būti dichotominiai arba ne, respon-
dentai gali rinktis tik vieną atsakymą arba pažymėti visus jiems tinkamus, tačiau šių duomenų 
interpretavimas yra pakankamai ribotas. Tyrėjęs, atlikęs duomenų, išmatuotų vardinėje skalėje, 
analizę, galės apskaičiuoti respondentų pasirinktų atsakymų dažnį arba dažnio procentinį pasi- 
skirstymą. Kaip reikėtų analizuoti duomenis, išmatuotus rangų skalėje, skaitykite kitame skyriuje.

5.1.2.2. kintamieji, išmatuoti rangų skalėje 

Anketose taip pat pateikiami klausimai, kuriais surinkti duomenys išmatuoti skaičių eile, pa-
gal kurią yra išrikiuojami tam tikra tvarka. Šie duomenys yra ranginiai ir skiriasi vienas nuo kito, 
tačiau nustatyti, kiek konkrečiai arba kiek kartų jie skiriasi, negalime. Rangų skalėje išmatuotų 
duomenų pavyzdžiais galėtų būti klausimai, kuriuose atsakymus reikia pažymėti skalėje nuo 1 



Duomenų analizės SPSS pagrindai90

iki 5 ar daugiau. Tokio tipo skalės pavyzdžiu galėtų būti klausimas, kuriuo respondentas yra pra-
šomas išrikiuoti kategorijas pagal jam labiausiai patinkančią. Pavyzdžiui:

Klausimas. Kokiose sporto varžybose dažniausiai dalyvaujate? 
Pažymėkite visus tinkamus, kai:1 – dažniausiai, 2, 3, 4, 5 – rečiausiai.
1.	Krepšinio
2.	Kovos menų
3.	Bokso
4.	Futbolo
5.	Kitose

Taip gausime rangų skalėje išmatuotas kategorijas, kurios bus išrikiuotos nuo mėgstamiau-
sios iki mažiausiai mėgstamos. Šie duomenys padės surinkti daugiau informacijos apie respon-
dentų pomėgius ir panašius dalykus.

Atlikę duomenų, išmatuotų rangų skalėje, analizę, galima apskaičiuoti respondentų pasirink-
tų atsakymų dažnį arba dažnio procentinį pasiskirstymą bei medianą. Kaip apskaičiuoti pagrin-
dines kintamųjų charakteristikas, panaudojant SPSS programų paketą, skaitykite toliau.

5.2. Kintamųjų analizė SPSS

Aprašomąją statistiką galime atlikti su SPSS programų paketu ir taikyti visos populiacijos 
duomenims analizuoti, nes ji skirta koncentruotai užrašyti informaciją, esančią dideliuose duo-
menų masyvuose. Tai yra aprašomoji statistika, skirta sisteminti ir grafiškai atvaizduoti duomenis. 

Taigi SPSS programų paketu galime analizuoti kintamuosius ir apskaičiuoti jų pagrindines 
charakteristikas, tokias kaip duomenų padėties, sklaidos ar dažnių skirstinių formų charakteris-
tikas. Tačiau reikėtų nepamiršti, kad kintamieji pagal savo prigimtį gali būti kiekybiniai arba 
kokybiniai, todėl jiems reikėtų taikyti skirtingus analizės metodus. Tad apie tai, kaip analizuo-
ti kiekybinius kintamuosius, kurie parodo, kiek tiriamojo požymio turi populiacijos elementas, 
arba kokybinius kintamuosius, kurie nusako dydžius, nevertinamus skaičiais, skaitykite toliau.

5.2.1. Klausimų analizė „pažymėkite tik vieną“

Atliksime analizę duomenų, surinktų pateikus respondentams klausimą Kokiose sporto var-
žybose dalyvavote? (pažymėkite tik vieną). Šis klausimas yra pateiktas 5.1.2 skyriuje. Apklausus 
respondentus, jų duomenys buvo surinkti SPSS programų pakete ir išsaugoti pavadinimu spor-
tas 1.sav. Šiuo konkrečiu atveju buvo sukurtas kintamasis sportas, kurio reikšmės apima visas 
penkias kategorijas. 
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5.2 pav. Klausimų bloko analizė, kai pasirenkamas tik vienas iš pasiūlytų variantų:  
a) Value Labels lange skaičiais nuo 1 iki 5 užkoduoti duomenys; b) Data View lange įrašyti apklausos duomenys.

Taigi apklausos duomenys apdoroti SPSS, sukuriant tik vieną kintamąjį, nes respondentai 
galėjo rinktis tik vieną iš penkių kategorijų pagal nurodymą pažymėkite tik vieną. Kaip matote, 
iškelta sąlyga nulėmė kintamojo aprašymą SPSS, kiekvienai kategorijai Variable View lange, 
stulpelyje Value Labels priskirti skaičiai nuo 1 iki 5, nes priklausomai nuo respondentų pomė-
gių, jie rinkosi 1 iš 5 variantų (5.2 a pav.). 

Šis kintamasis yra kategorinis, aprašomąją statistinę analizę atliksime su SPSS programų pa-
ketu. Pasinaudoję SPSS, išsiaiškinsime kintamojo skirstinį ir atliksime grafinę duomenų analizę 
(nubrėšime juostinę diagramą). Veiksmus atliksime pagal nurodymus, pateiktus žemiau.

Kintamojo „pažymėkite tik vieną“ tyrimas

1 	S PSS programų paketo meniu pasirinkite Analyze->Descriptive Statistics->Frequencies. 
2 	F requencies lange kokybinį kintamąjį sportas rodykle įkelkite į Variable(s) lauką ir  

		  pasirinkite opciją Display frequency tables (5.3 pav.).
3 	F requencies lange pasirinkite mygtuką Charts. 
4 	A tsidariusiame Frequencies: Charts lange, bloke Chart type, rinkitės Bar charts, o  

		  bloke Chart Values – Frequencies. 
5 	T ada rinkitės Continue ir OK. 
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5.3 pav. Kintamojo sportas analizė renkantis Analyze->Descriptive Statistics->Frequencies.

Po šių žingsnių bus atlikta aprašomoji kokybinio kintamojo analizė. SPSS programų paketo 
išvesties lange kintamojo sportas skirstinys bus pateiktas lentele (5.3 lentelė) bei stulpelinė diag- 
rama bus atlikta grafinė duomenų vizualizacija (5.4 pav. ).
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5.4 pav. Kintamojo sportas tyrimo rezultatas – stulpelinė diagrama.
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5.3 lentelė. Kintamojo sportas skirstinys.

Sportas
Frequency Percent Valid Percent Cumulative Percent

Valid

krepsinis 4 44,4 44,4 44,4
kovos menai 4 44,4 44,4 88,9
boksas 1 11,1 11,1 100,0
Total 9 100,0 100,0

Kaip pastebėjote, grafinė duomenų analizė atkartoja kintamojo sportas skirstinį, aprašytą 5.3 
lentelėje. Plačiau apie stulpelines diagramas skaitykite 5.5.2 skyriuje.

Išsiaiškinome, kaip analizuoti klausimus, kuriuose respondentai žymi tik vieną iš pasirinki-
mų. Toliau analizuosime, kaip apdoroti ir analizuoti duomenis, gautus respondentams pateikus 
klausimą, į kurį atsakydami jie gali rinktis visus tinkamus atsakymus. 

5.2.2. Klausimų analizė „pažymėkite visus tinkamus“

Atliksime analizę duomenų, surinktų pateikus respondentams klausimą Kokiose sporto var-
žybose dalyvavote? (pažymėkite visus tinkamus). Šis klausimas yra pateiktas 5.1.2.1. skyriuje. 
Apklausos duomenys buvo surinkti SPSS programų pakete ir išsaugoti pavadinimu sportas 2.sav. 
Šiuo konkrečiu atveju buvo sukurti penki kintamieji: sport1 – krepšinis, sport2 – kovos menai, 
sport3 – boksas, sport4 – futbolas, sport5 – kita. Kintamųjų reikšmės apima visas penkias kate-
gorijas. Taigi atsakymai į šį klausimą suskaidomi į penkis klausimus (kintamuosius), o kiekvie-
no iš jų atsakymas yra koduojamas: 1 = Taip ir 0 = Ne. Variable View langas parodytas 5.5 pav.

5.5 pav. Variable View langas po kintamųjų aprašymo.

Analizuoti šios struktūros klausimus yra ne taip paprasta, kaip tuos, kai respondentas gali 
rinktis tik vieną atsakymą, nes mums reikės išsiaiškinti bendrą pasirinkimų skaičių kiekvienam 
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iš klausime buvusių variantų. Tyrimą atliksime pagal nurodymus, pateiktus toliau.

Kintamųjų bloke pažymėkite visus, tinkamus tyrimui

1 	S PSS programų paketo meniu pasirinkite Analyze->Descriptive Statistics->Frequencies. 
2 	 Frequencies lange kokybinius kintamuosius nuo sport1 iki sport5 rodykle įkelkite į 

		  Variable(s) lauką ir nesirinkite opcijos Display frequency tables (5.6 pav.).
3 	F requencies lange pasirinkite mygtuką Statistics. 
4 	A tsidariusiame Frequencies: Statistics lange, bloke Central Tendency, rinkitės tik Sum  

		  (5.7 pav.). Ši charakteristika padės išsiaiškinti, kiek kartų respondentai pasirinko  
		  kiekvieną iš pasiūlytų galimybių.

5 	T ada rinkitės Continue ir OK. 

Po šių žingsnių bus atlikta aprašomoji kokybinių kintamųjų bloko analizė. SPSS programų 
paketo išvesties lange kintamųjų skirstinys bus pateiktas lentelėje. Šiuo konkrečiu atveju tyri-
mo rezultatai atskleis sportavimo pomėgių įvairovę, kuri yra pateikta 5.3 lentelėje. Gautas re-
zultatas rodo, kad apklaustieji respondentai labiausiai mėgsta kovos menus (iš 9 pasirinko 7), 
tada antroje vietoje renkasi krepšinį arba boksą (iš 9 pasirinko 5), o trečioje vietoje pagal popu-
liarumą yra futbolas (iš 9 pasirinko 4), taip pat respondentai atsakyme pažymėjo ir kategoriją 
„kita“ (iš 9 pasirinko 1), o tai parodo, kad klausimyne įvardytų sporto šakų nepakako. 

5.6 pav. Klausimų bloko analizė renkantis Analyze->Descriptive Statistics->Frequencies.
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5.7 pav. Frequencies: Statistics lange renkamės Sum.

5.4 lentelė. Sportavimo pomėgių įvairovės analizės rezultatas.

Statistics
krepsinis kovos menai boksas futbolas kita

N
Valid 9 9 9 9 9
Missing 0 0 0 0 0

Sum 5 7 5 4 1

Norėdami šiuos duomenis pavaizduoti grafiškai, turėsime pasiremti statistinės lentelės duo-
menimis. Grafikui nubrėžti reikės atlikti šią procedūrą.

1 	S PSS programų paketo išvesties lange pasirinkite lentelę Statistics (5.4 lentelė). 
2 	K airiuoju pelės klavišu aktyvuokite ją ir pažymėkite eilutės Sum duomenis.
3 		 Dešiniuoju pelės klavišu iškvieskite papildomą meniu, skirtą apdoroti duomenis lentelėse.
4 	Š iame meniu rinkitės Create Graph, tada Bar. 
5 	I švesties lange bus nubrėžta stulpelinė diagrama, kuri yra parodyta 5.8 pav.
6 	 Papildykite stulpelinę diagramą informacija ir pakeiskite, jei pageidaujate į 3D formatą, 

kaip tai yra parodyta (5.9 pav.).
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5.8 pav. Grafiko braižymas išvesties lange pasinaudojant lentelės informacija.
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5.9 pav. Grafiko (5.8 pav.) papildymas informacija.
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Kadangi analizavome visus kintamuosius, sujungę į vieną bloką, tai nesirinkome opcijos 
Display frequency tables, kuri pagal nutylėjimą jau būna pažymėta Frequencies lange. Taip 
pat nubrėžti kintamųjų bloko grafiką teko kiek kitaip, nei analizuojant vieną kokybinį kintamąjį. 

Toliau analizuosime rangų skalėje išmatuotus kintamuosius, kurie pagal savo prigimtį irgi 
priskiriami kokybiniams.

5.2.3. Rangų skalės kintamųjų bloko analizė

Atliksime analizę duomenų, surinktų pateikus respondentams klausimą Kokiose sporto var-
žybose dalyvavote? (Pažymėkite visus tinkamus, kai: 1 – dažniausiai, 2, 3, 4, 5 – rečiausiai). Šis 
klausimas yra pateiktas 5.1.2.2 skyriuje. Apklausos duomenys buvo surinkti SPSS programų pa-
kete ir išsaugoti pavadinimu sportas 3.sav. Šiuo konkrečiu atveju buvo sukurti penki kintamie-
ji: sport1 – krepšinis, sport2 – kovos menai, sport3 – boksas, sport4 – futbolas, sport5 – kita. 
Sukurti kintamieji apibūdina visas penkias kategorijas, o kiekvieno kintamojo atsakymas yra iš-
matuotas rangų skalėje ir koduojamas penkiomis galimomis reikšmėmis: 1 = dažniausiai, 2, 3, 
4, 5 = rečiausiai. Variable View langas parodytas 5.10 a pav.

 a b

5.10 pav. Rangų skalėje išmatuotų kintamųjų bloko analizė:  
a) skaičiais nuo 1 iki 5 užkoduoti duomenys; b) Data View lange suvesti apklausos duomenys.

Analizuodami rangų skalėje išmatuotų kintamųjų bloką rasime panašumų į vardinėje skalėje 
išmatuotų kintamųjų bloko analizę, tik šį kartą respondentas pateikia penkis atsakymus su įvai-
riais pasirinkimo dažnumo lygiais. Šiuo atveju duomenų reikšmės varijuoja nuo 1 iki 5 (Data 
View langas 5.10 b pav.). Tyrimą atliksime pagal tokius nurodymus.



Duomenų analizės SPSS pagrindai98

Ranginių kintamųjų bloko tyrimas

1 	S PSS programų paketo meniu pasirinkite Analyze->Descriptive Statistics->Frequencies. 
2 	F requencies lange kokybinius kintamuosius nuo sport1 iki sport5 rodykle įkelkite į 

		  Variable(s) lauką ir nesirinkite opcijos Display frequency tables (5.11 pav.).
3 	F requencies lange pasirinkite mygtuką Statistics. 
4 	A tsidariusiame Frequencies: Statistics lange, bloke Central Tendency, rinkitės tik  

		  Moda (5.11 pav.). Ši charakteristika padės išsiaiškinti, kokią reikšmę respondentai  
		  rinkosi dažniausiai.

5 	T ada rinkitės Continue ir OK. 

Po šių žingsnių bus atlikta aprašomoji ranginių kintamųjų bloko analizė. SPSS programų pa-
keto išvesties lange kintamųjų skirstinys bus pateiktas lentelėje (5.5 lentelė). Šiuo konkrečiu 
atveju tyrimo rezultatai padės lengvai išsiaiškinti respondentų įpročius renkantis sporto šaką. 

5.11 pav. SPSS programų paketo langai vaizduoja „žingsnius“ statistinei lentelei gauti.
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5.5 lentelė. Sportavimo pomėgių analizės rezultatas.

Statistics
krepšinis kovos menai boksas futbolas kita

N
Valid 9 9 9 9 9
Missing 0 0 0 0 0

Mode 1 1 3 3a 5
a. Multiple modes exist. The smallest value is shown
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5.12 pav. Stulpelinė diagrama – rangų kintamųjų bloko analizės rezultatas.

Analizuojant gautą statistinės analizės rezultatą, reikia nepamiršti, kokioje skalėje buvo 
koduojamas respondento atsakymas. Šį kartą rinkomės 1 = dažniausiai, o 5 = rečiausiai. 
Remdamiesi pasirinkta skale ir gautu rezultatu, galime teigti, kad respondentai dažniausiai da-
lyvauja krepšinio ir kovos menų varžybose, o kitų sporto šakų varžybose labai retai. Grafikas, 
kuris yra pateiktas 5.12 pav., yra nubraižytas tuo pačiu būdu, kaip ir tas, kai analizavome klau-
simų bloką „pažymėkite visus tinkamus“. Pasinaudokite jau aprašyta procedūra ir patys nubrėž-
kite Median grafiką. 

Susipažinus su kokybinių kintamųjų analize, reikia nepamiršti ir kiekybinių kintamųjų, kurie 
parodo, kiek tiriamojo požymio turi populiacijos elementas. Šių kintamųjų aprašomosios anali-
zės specifika yra pateikta kitame skyriuje. 



Duomenų analizės SPSS pagrindai100

5.2.4. Parametrinių kintamųjų analizė SPSS

Parametrinių kintamųjų pradinė duomenų analizė yra atliekama pasirinkus Analyze-> 
Descriptive Statistics-> Descriptives. 

5.13 pav. SPSS programų paketo meniu juostos pasirinkimas Analyze->Descriptive Statistics-> Descriptives.

Parametrinių kintamųjų (pvz., amžius) pradinė analizė yra išsamesnė, nes jiems jau gali-
te suskaičiuoti padėties ir sklaidos charakteristikas. Kintamiesiems, išmatuotiems intervalų ar 
santykių skalėmis, SPSS programų pakete yra daug galimybių skaičiuojant duomenų charak-
teristikas (5.13 pav.). Tačiau atlikdami pradinę kintamojo analizę, galime apsiriboti viena cen-
tro charakteristika (vidurkiu arba mediana), keliomis sklaidos charakteristikomis (minimumu, 
maksimumu ir standartiniu nuokrypiu) ir kintamojo skirstinio normalumą parodančiomis cha-
rakteristikomis (asimetrijos ir eksceso koeficientais). Toliau parametrinių kintamųjų analizei 
pailiustruoti naudosime rinkmeną Streso tyrimas.sav. Tyrimą atliksime pagal nurodymus, pa-
teiktus toliau.

Parametrinių kintamųjų tyrimas 

1 	 Pagrindinėje SPSS programų paketo meniu juostoje pasirinkite 
		  Analyze-> Descriptive Statistics->Descriptives. 
2 	A tsidariusiame lange pasirinkite parametrinius kintamuosius (pvz., amzius, rukymo 

		  dazn, Bopt (bendras optimizmas)) ir perkelkite į Variables langą.
3 	 Pasirinkite Descriptives lange mygtuką Options. Atsidariusiame lange pažymėkite:  

		  Mean, Std. deviation, Minimum, Maximum, Skewness ir Kurtosis (5.14 pav.).
4 	T ada Continue ir OK.
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5.14 pav. SPSS programų paketo Descriptives langai.

Atlikus šiuos veiksmus, SPSS programų paketo išvesties lange bus pateikta lentelė 
Descriptive Statistics (5.6 lentelė). Šioje lentelėje SPSS programų paketas pateikia tyrėjui 
aprašomają informaciją apie tris parametrinius kintamuosius. Į ką reikėtų atkreipti dėmesį 
analizuojant tokio tipo lentelę, yra paaiškinta toliau. 

5.6 lentelė. Pradinė parametrinio kintamojo analizė.

Descriptive Statistics
N Minimum Maximum Mean Std. Deviation Skewness Kurtosis

Statistic Statistic Statistic Statistic Statistic Statistic Std. 
Error Statistic Std. 

Error
amzius 439 18 82 37,44 13,202 ,606 ,117 -,203 ,233
Surukytų cigarečių 
kiekis per savaitę

360 0 280 16,59 44,901 3,097 ,129 9,413 ,256

Bendras 
Optimizmas

435 7 30 22,12 4,429 -,494 ,117 ,214 ,234

Valid N (listwise) 357
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Gautos informacijos interpretavimas

Po procedūros išvesties lange gavome statines kiekvieno parametrinio kintamojo reikšmes. 
Pavyzdžiui, atlikę pradinę kintamojo amzius statistinę analizę sužinojome, kad apklausoje daly-
vavo 439 respondentai, kurių amžius išsidėsto intervale nuo 18 iki 82 metų. Jauniausias respon-
dentas buvo 18 metų, o vyriausias – 82 metų. Respondentų amžiaus vidurkis yra 37,44 metų, o 
standartinis nuokrypis, kuris rodo duomenų sklaidą apie vidurkį, – 13,20. Tai reiškia, kad dau-
gelis tyrime dalyvavusių respondentų yra tarp 24 (tiksliau 37,44 – 13,20 = 24,24) ir 50 (tiksliau 
37,44 + 13,20 = 49,64) metų amžiaus. Šiaip jau, jeigu duomenys normalūs, tai šiame intervale 
yra apie 60 proc. visų amžių.

Informaciją apie kintamojo skirstinį galime sužinoti iš dviejų reikšmių, tai yra asimetrijos ir 
eksceso koeficientų. Asimetrijos koeficientu (Skewness) matuojama, ar duomenų išsidėstymas 
skiriasi nuo simetrinio išsidėstymo. Jeigu duomenys pasiskirstę normaliai, tai asimetrijos koe- 
ficientas bus lygus nuliui. Jeigu asimetrijos koeficiento reikšmė aiškiai skiriasi nuo nulio, tai 
duomenų skirstinys nėra normalus. Kai asimetrijos koeficientas didesnis už nulį, asimetrija tei-
giama, kai mažesnis, – neigiama. Asimetrijos koeficientas yra duomenų normalumo rodiklis. 
Eksceso koeficientas (Kurtosis) rodo, ar histograma yra aukšta, duomenys susikoncentravę apie 
vidurkį, ar plokščia, duomenys išsisklaidę. Kai duomenų skirstinys yra normalusis, eksceso koe-
ficientas yra lygus nuliui.

Duomenų normalumo sąlyga yra svarbi renkantis parametrinių hipotezių tikrinimo krite-
rijų. Tad parametrinių duomenų normalumo tikrinimas neapsiriboja vien asimetrijos ir eksce-
so koeficientų skaičiavimu. Šiems duomenims brėžiama histograma su normaliąja kreive (pla-
čiau skaitykite 5.5.1 skyriuje) ir papildomai atliekama kita analizė, apie kurią bus kalbama ki-
tame skyriuje.

5.3. Duomenų normalumo tikrinimas

Parametrinių kintamųjų duomenų normalumo tyrimas gali būti SPSS programų paketu atlik-
tas „iš akies“, pasirinkus Analyze-> Descriptive Statistics-> Explore. Šios procedūros atliki-
mo žingsniai ir gautas rezultatas aptariami šiame skyriuje. Parametrinių kintamųjų analizei nau-
dosime rinkmeną Streso tyrimas.sav. Tyrimą atliksime pagal šiuos nurodymus.

Duomenų normalumo tikrinimas 

1 	S PSS programų paketo pagrindiniame meniu pasirenkame 
		  Analyze-> Descriptive Statistics-> Explore.
2 	A tsidariusiame Explore lange parametrinius kintamuosius, kurių normalumą norite  

		  tikrinti, įkelkite į Dependent List langą. Tirti galima vieną ar daugiau kintamųjų. Šiuo 
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		  konkrečiu atveju atliksime vieno kintamojo Bpats (bendras patiriamas stresas) tyrimą  
		  (5.15 pav.).

3 	 Papildomai pasirinkite nepriklausomąjį kategorinį kintamąjį (pvz., lytis). Šį kintamąjį  
		  įkelkite į Factor List langą. Tai reiškia, kad tyrimą atliksite atskirai vyrams ir moterims  
		  (5.15 pav.).

4 	 Pasirinkite Display skyrelyje Both. Pasirinkus Both, išvesties lange bus sugeneruotos ir 
		  lentelės, ir grafikai.

5.15 pav. SPSS programų paketo meniu juostos pasirinkimas Analyze->Descriptive Statistics->Explore.

5 	 Pasirinkite Plots. Atsidariusiame Explore Plots lange, bloke Descriptive, pasirenkame  
		  tik Histogram, tada renkamės Continue.

6 	 Pasirinkite Options skyrelį. Atsidariusiame lange Missing, skyrelyje Values, pasirenkame  
		  Exclude cases pairwise.

7 	R enkamės Continue, tada OK.

Po šios procedūros SPSS programų paketo išvesties lange bus pateiktos lentelės ir grafikai, 
kurias nagrinėsime detaliau. Lentelėje Case Processing Summary (5.7 lentelė) yra pateikiama 
kiekybinė informacija apie vyrus ir moteris, dalyvavusius tyrime. 
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5.7 lentelė. Kintamojo Bendras patiriamas stresas duomenų apžvalga.

Case Processing Summary

Lytis
Cases

Valid Missing Total
N Percent N Percent N Percent

Bendras patiriamas 
stresas

Vyrai 184 99,5 % 1 0,5 % 185 100,0 %
Moterys 249 98,0 % 5 2,0 % 254 100,0 %

Kaip matote, duomenų rinkmena yra padalyta į dvi dalis, nes Explore lange į Factor List 
langą buvo įkeltas kintamasis Lytis. Taip pat šioje lentelėje yra nurodyta, kad 1 iš 184 vyrų ir 5 
iš 249 moterų nenurodė informacijos apie patiriamą stresą. 

Lentelėje Descriptives (5.8 lentelė) rasite išsamų kintamojo Bendras patirtas stresas sta-
tistinių charakteristikų aprašymą. Informacija šioje lentelėje yra padalyta į dvi dalis dėl tos pa-
čios priežasties, kaip jau buvo paminėta aptariant lentelę Case Processing Summary. 

5.8 lentelė. Kintamojo Bendras patiriamas stresas duomenų pagrindinės charakteristikos.

Descriptives
Lytis Statistic Std. Error

Bendras 
patiriamas 
stresas

Vyrai

Mean 25,79 ,399

95 % Confidence Interval for Mean Lower Bound 25,00
Upper Bound 26,58

5% Trimmed Mean 25,74
Median 25,00
Variance 29,315
Std. Deviation 5,414
Minimum 13
Maximum 46
Range 33
Interquartile Range 8
Skewness ,271 ,179
Kurtosis ,393 ,356

Moterys

Mean 27,42 ,384

95 % Confidence Interval for Mean Lower Bound 26,66
Upper Bound 28,18

5 % Trimmed Mean 27,35
Median 27,00
Variance 36,793
Std. Deviation 6,066
Minimum 12
Maximum 44
Range 32
Interquartile Range 7
Skewness ,173 ,154
Kurtosis ,074 ,307
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Statistinė reikšmė 5 % Trimmed Mean yra dar viena reikšmė, kuri parodo informaciją apie 
kintamojo skirstinį. SPSS programų pakete ši vertė apskaičiuojama iš kintamojo duomenų in-
tervalo pradžios ir pabaigos pašalinus 5 proc. duomenų. Jei 5 % Trimmed Mean reikšmė labai 
skiriasi nuo matematinio vidurkio (Mean), tai reiškia, kad imtyje yra išskirčių, ir tuomet reikia 
tirti kintamojo išskirtis. Kintamojo Bendras patiriamas stresas matematinis vidurkis yra 25,79 
ir beveik sutampa su 5 % Trimmed Mean reikšme, kuri yra 25,74. 

Lentelėje Descriptives (5.7 lentelė) taip pat rasite asimetrijos ir eksceso koeficientų reikš-
mes, suskaičiuotas atskirai vyrams ir moterims. Abu koeficientai absoliučiuoju dydžiu yra artimi 
nuliui, o tai rodo, kad kintamojo Bendras patirtas stresas duomenys yra pasiskirstę normaliai.

Po šios procedūros SPSS programų paketas nubraižė keletą grafikų, kurie taip pat padeda anali-
zuojant kintamojo duomenų normalumą. Histogramos yra pavaizduotos be Gauso normaliosios krei-
vės, bet duomenų išsidėstymas rodo, kad kintamojo skirstiniai yra artimi normaliajam (5.16 pav.). 
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5.16 pav. Parametrinio kintamojo Bendras patiriamas stresas grafinis duomenų vaizdavimas histograma.

SPSS programų paketo išvesties lange taip pat yra pateikiama ir abiejų kategorijų stačiakam-
pės diagramos (5.14 pav.). Tai leidžia palyginti vyrų ir moterų duomenis. Pažiūrėję į šias diagra-
mas galime pasakyti, kad moterų imtyje yra daugiau sąlyginių išskirčių, nei vyrų. SPSS progra-
mų paketas šias išskirtis žymi specialiais simboliais – skrituliukais, taip pat pažymi išskirties ei-
lutės numerį. Statistiniai tyrimai yra jautrūs išskirtims, todėl vengiant iškraipyti tyrimų rezulta-
tus, išskirtis reikia pašalinti iš tyrimo.
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5.17 pav. Parametrinio kintamojo Bendras patiriamas stresas  
grafinis duomenų vaizdavimas stačiakampe diagrama.

Parametrinio kintamojo Bendras patiriamas stresas normalumo tyrimo grafiniai rezulta-
tai aiškiai parodė, kad kintamasis turi išskirčių, kurias reikia tirti. Kaip tai atlikti, skaitykite ki-
tame skyriuje.

5.4. Išskirčių tyrimas SPSS

Atliekant statistinę analizę, remiantis parametriniais kriterijais, kintamojo reikšmių tikrini-
mas dėl išskirčių yra ypač svarbus, tad kintamųjų duomenų vertės, kurios gerokai viršija arba 
yra gerokai mažesnės už kitas imtyje, turi būti išaiškintos ir pašalintos. Parametrinių kintamų-
jų analizei naudosime rinkmeną Streso tyrimas.sav. Išskirčių tyrimą atliksime pagal šiuos nu-
rodymus.

Išskirčių tyrimas

1 	S PSS programų paketo pagrindiniame meniu pasirenkame 
		  Analyze-> Descriptive Statistics-> Explore.
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5.18 pav. SPSS programų paketo Explore lange pasirinkimas Statistics.

2 	A tsidariusiame Explore lange parametrinį kintamąjį (pvz., Bpats (bendras patiriamas  
		  stresas) rodykle įkeliame į Dependent List langą (5.18 (1) pav.).

3 	 Explore lange pasirinkite kintamąjį id ir įkelkite jį į Label cases laukelį, kad programa  
		  nurodytų išskirčių identifikavimo numerį (5.18 (2) pav.).

4 	 Explore lange pasirinkite mygtuką Statistics, o atsidariusiame lange palikite jau  
		  pažymėtą Descriptives ir tyrimo tikslumą Confidence Interval for Mean 95 % (5.18  
		  (3) pav.), tada rinkitės Outliers (5.18 (4) pav.). 

5 	 Explore lange pasirinkite mygtuką Plots, atsidariusiame lange rinkitės Histogram, papil- 
		  domai galite rinktis siūlomą Stem and Leaf, kuris yra dar vienas grafinis duomenų atvaiz- 
		  davimas.

6 	 Explore lange pasirinkite mygtuką Options, atsidariusiame lange rinkitės 
		  Exclude cases pairwise, tada Continue ir OK.

Atlikus aukščiau nurodytus veiksmus, SPSS programų paketas sugeneruos pakankamai 
tiek grafinės, tiek skaitmeninės informacijos, kuri aiškiai parodys, ar imtyje yra išskirčių ar 
ne. Po šios procedūros atkreipkite dėmesį į sugeneruotą histogramą, kuri esant normaliai pa-
siskirsčiusiems duomenims, kuriuose nėra išskirčių, turėtų būti aiškios „varpo“ formos (5.19 
pav.). Jei yra duomenų, kurie aiškiai išsiskiria, tai šie duomenys „kirs“ ir iškraipys „varpo“ 
formos grafiką.
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5.19 pav. SPSS programų paketu kintamojo Bendras patiriamas stresas duomenys pavaizduoti histograma.

5.9 lentelė. Ekstremalių reikšmių lentelė.

Extreme Values
Case Number id Value

Bendras patiriamas stresas

Highest

1 24 24 46
2 130 157 44
3 55 61 43
4 6 6 42
5 123 144 42a

Lowest

1 311 404 12
2 5 5 12
3 239 301 13
4 106 127 13
5 103 119 13

a. Only a partial list of cases with the value 42 are shown in the table of upper extremes.

Taip pat pažiūrėkite į stačiakampę diagramą (5.20 pav.). SPSS programų paketas visas sąlygi-
nes išskirtis žymi joje mažais apskritimais su numeriu, kuris yra išskirties atvejo identifikavimo 
numeris. SPSS parodo išskirtis skrituliukais, jei kintamojo reikšmė viršija 1,5 karto interkvarti-
linį plotį (1,5IQR), jei viršija 3IQR, tokia reikšmė žymima žvaigždute *. Stačiakampėje diagra-
moje nėra žvaigždute pažymėtų reikšmių, tačiau yra dvi sąlyginės išskirtys: ID numeriai 24 ir 
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157. Jei atlikę grafinę duomenų analizę, stačiakampėje diagramoje matote reikšmių, kurios yra 
išskirtys, jums, kaip tyrėjui, reikės nuspręsti, ką su jomis daryti.
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5.20 pav. SPSS programų paketu kintamojo Bendras patiriamas stresas  
duomenys pavaizduoti stačiakampe diagrama.

Jei norite surasti ir pašalinti išskirtis, padės lentelė, kurią rasite išvesties lange. Ji yra pava-
dinta Extreme Values (5.9 lentelė). 

Ši lentelė padalyta į dvi dalis, kuriose surašytos didžiausios ir mažiausios kintamojo išskirtys. 
Čia taip pat yra nurodytas kiekvienos tokios išskirties ID numeris ir skaitinė reikšmė. Tai pade-
da gana lengvai surasti rinkmenoje konkretų atvejį, kuris pagal tyrimo duomenis yra išskirtis ir, 
jei reikia, galima pašalinti jį iš tolesnio tyrimo. 

Po 5.9 lentele yra pateikiama papildoma informacija apie atlikto tyrimo rezultatą. Šiuo atve-
ju yra informuojama, kad lentelėje paminėtų išskirčių, viršijančių Q3 (kvartilį 3-čią), sąraše yra 
pateikta tik dalis atvejų, kurių reikšmės yra lygios 42, o tai reiškia, kad tokių kintamųjų yra ir 
daugiau.

Kaip matote, lentelėse esanti statistinė informacija padeda nustatyti pagrindines statistines kin-
tamojo charakteristikas, tačiau atliekant aprašomąją statistinę analizę, grafinis duomenų vizua- 
lizavimas labai palengvina tyrėjo darbą. Tad kaip charakterizuoti kintamuosius grafiškai, skai-
tykite kitame skyriuje.
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5.5. Grafinis duomenų vaizdavimas

Grafikai naudojami duomenims charakterizuoti. Nors skaitinė duomenų analizė puikiai nusa-
ko duomenų charakteristikas, tačiau atlikti grafinę duomenų analizę yra labai naudinga, nes gra-
fikas gali atskleisti duomenų savybes, sunkiai įvertinamas kitais metodais.

SPSS programų paketas suteikia galimybę pavaizduoti duomenis tokiais grafikais: 

l	Histogramomis su normaliąja kreive;

l	Skritulinėmis diagramomis;

l	Stulpelinėmis diagramomis;

l	Sklaidos diagramomis;

l	Stačiakampėmis diagramomis; 

l	Linijų diagramomis.

Analizuosime skirtingus duomenis grafiniu būdu. Analizei naudosime rinkmenos Streso ty-
rimas.sav duomenis.

5.5.1. Histograma

Histogramos skirtos charakterizuoti vieno tolydaus kintamojo skirstinį. Histogramomis gali-
me pamatyti sklaidą duomenų, išsidėsčiusių varpo forma, taip pat galima nubrėžti ir Gauso krei-
vę (normaliąją kreivę).

5.21 pav. SPSS programų paketo meniu juostos pasirinkimas Graphs.
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Analizuodami duomenis SPSS programų paketu, jūs turėsite labai didelį pasirinkimą gra-
fiškai vaizduoti duomenis. Norint grafiškai analizuoti surinktus parametrinius duomenis, 
jums reikės pasirinkti SPSS programų paketo pagrindinėje meniu juostoje Graphs grafiko 
tipą Histogram (5.21 pav.) ir atlikti grafiko brėžimo procedūrą, kaip tai yra nurodyta toliau.

Histogramos braižymas

1 	S PSS programų paketo pagrindiniame meniu pasirenkame 
		  Graphs->Legacy Dialogs-> Histogram (5.16 pav.).
2 	A tsidariusiame Histigram lange kintamąjį įkeliame į Variable laukelį. Kintamasis turi 

		  būti tolydus (pvz., Bendras patiriamas stresas). Parodyta 5.22 a pav.
3 	 Histigram lange pasirenkame Display normal curve. Šis pasirinkimas leis paprasčiau 

	  	charakterizuoti tolydaus kintamojo skirstinį, nes histograma bus nubrėžta su teorine Gauso 
	  	kreive. 

4 	 Brėžiamam grafikui galite suteikti pavadinimą aktyvavę Titles ir atsidariusiame lange 
	  	įrašę pavadinimą (pvz., Bendrai patiriamo streso histograma). Parodyta 5.22 b pav.

5 	 Pasirinkite Continue, po to OK.

Po atliktų veiksmų duomenų grafinis vaizdavimas bus pateiktas SPSS programų paketo iš-
vesties lange. Histogramos forma suteikia pakankamai tikslią informaciją apie tolydaus kinta-
mojo skirstinį.

Atliekant statistinius duomenų tyrimus yra reikalaujama, kad duomenys turėtų normalųjį 
skirstinį, nes daugelis statistinių prielaidų remiasi prielaida, kad atsitiktinis kintamasis dydis yra 
normaliai pasiskirstęs. Histograma dažnai braižoma su teorine normaliąja (Gauso) kreive, kuri 
ir parodo, kaip duomenys būtų pasiskirstę, jei turėtų normalųjį skirstinį. Kintamųjų normalumą 
svarbu ištirti todėl, kad visa klasikinė statistika sukurta normaliems arba nedaug nuo jų besiski-
riantiems kintamiesiems analizuoti.
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5.22 pav. SPSS programų paketo meniu juostos pasirinkimas Graphs->Legacy Dialogs->Histogam:  
a) kintamųjų pateikimo langas; b) grafiko pavadinimo suteikimo langas.
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5.23 pav. SPSS programų paketu nubrėžta kintamojo Bendras patiriamas stresas histograma su normaliąja Gauso kreive.
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Histogramos interpretavimas

Šiame pavyzdyje kintamojo Bendras patiriamas stresas reikšmės yra pasiskirsčiusios apy-
tikriai normaliai. Didžioji kintamojo reikšmių aibė yra išsidėsčiusi ties centru, čia taip pat mato-
me, kad smailėjanti duomenų dalis yra virš Gauso kreivės (5.23 pav.).

Socialiniuose tyrimuose gana dažnai pasitaiko, kad kintamieji paprastai nėra pasiskirstę nor-
maliai. Tokių kintamųjų duomenys gali būti pasislinkę į dešinę (dešinioji asimetrija) arba į kairę 
(kairioji asimetrija), o kartais būna, kad duomenys išdėstyti stačiakampio forma.

5.5.2. Stulpelinės diagramos

Stulpelinė diagrama ir histograma atrodo panašios, tačiau jos yra skirtos vaizduoti skirtingo 
tipo duomenis. Stulpelinė diagrama skirta vaizduoti kategorinius diskrečius kintamuosius.

Stulpelinės diagramos gali:
1 	V aizduoti tam tikrų kategorijų grafiką arba gali vizualizuoti vieno tolydaus kintamojo  

		  skirtingų kategorijų rezultatą.
2 	 Būti paprastos arba labai sudėtingos, priklausomai nuo to, kiek kintamųjų norite įtraukti  

		  į grafiką.

Nesudėtingam grafikui nubrėžti reikės dviejų kintamųjų. Vienas turės būti kategorinis (išma-
tuotas rangų arba vardinėje skalėje), o kitas kintamasis – tolydusis. Jei norite nubrėžti kiek sudė-
tingesnį grafiką, galite pasirinkti daugiau nei du kintamuosius. Taip pat galėsite nubrėžti vis kitą 
grafiką keisdami kategorinius kintamuosius. 

Kaip nubrėžti stulpelinę diagramą, kai turite vieną parametrinį ir du kategorinius kintamuo-
sius, paaiškina procedūra, kuri aprašyta toliau.

Stulpelinės diagramos braižymas 

1 	S PSS programų paketo pagrindiniame meniu pasirenkame 
		  Graphs->Legacy Dialogs->Bar.
2 	A tsidariusiame lange Bar Charts pasirenkame vieną iš siūlomų galimybių – Clustered.
3 	L ango Bar Charts bloke Data in Chart Are renkamės Summaries for groups of cases.  

		T  ada renkamės Define (5.24 pav.).
4 	A tsidariusiame lango Define Clustered Bar: Summaries for Groups of Cases bloke

		  Bars Represent renkamės Other statistic(e.g. mean).



Duomenų analizės SPSS pagrindai114

5.24 pav. SPSS programų paketo meniu juostos pasirinkimas Graphs->Legacy Dialogs->Bar.

5 	 Pasirenkame tolydųjį kintamąjį (pvz., Bendras patiriamas stresas). Įkeliame šį kinta- 
		  mąjį į laukelį Variable: Mean (Bendras patiriamas stresas). Po šios procedūros kinta- 
		  mojo Bendras patiriamas stresas skalės vidurkis bus pavaizduotas skirtingoms  
		  grupėms.

6 	 Pasirenkame kategorinį kintamąjį 3 amžiaus grupės (amgr3). Įkeliame šį kintamąjį į 
	  	Category axis laukelį, kaip parodyta 5.25 pav. Kintamasis amgr3 juostas suskirstys į  
		  kategorijas pagal tris amžiaus grupes, jo reikšmės bus paskirstytos ant X ašies.

7 	 Pasirenkame kitą kategorinį kintamąjį (pvz., lytis). Įkeliame šį kintamąjį į Define 
	  	Clusters by: laukelį. Šis kintamasis bus aprašytas legendoje ir grafike bus vaizduojamos 
		  skirtingomis spalvomis skirtingos kategorijos. Šį kartą turėsime dvi kategorijas: vyrai ir 
	  	moterys.
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5.25 pav. Stulpelinio grafiko braižymo procedūros langai.

8 	Pasirenkame Options. Pašaliname pasirinkimą Display groups defined by missing values. 
9 	 Pasirenkame OK.

Tyrimo rezultatas bus pateiktas SPSS programų paketo išvesties lange. Grafinės duomenų 
analizės rezultatas yra pateikiamas 5.26 paveikslėlyje.
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5.26 pav. SPSS programų paketu nubrėžta stulpelinė diagrama.

Stulpelinės diagramos interpretavimas

Nubrėžę stulpelinę diagramą, galėsite analizuoti tam tikrų požymių paskirstymą tarp katego-
rijų, šiuo atveju vyrų ir moterų iš įvairių amžiaus grupių, taip pat galėsite apibendrinti.

SPSS programų paketu nubrėžta stulpelinė diagrama (5.26 pav.) parodė, kad moterys pakelia 
didesnį stresą nei vyrai visose trijose amžiaus grupėse. Taip pat grafikas rodo, kad šis skirtumas 
yra ryškiausias tarp vyresnio amžiaus vyrų ir moterų grupių. Tuo tarpu amžiaus grupėje nuo18 
iki 29 skirtumas tarp vyrų ir moterų, tiriant patiriamo streso dydį, yra labai mažas.

Interpretuoti stulpelines diagramas reikia labai atsakingai. Todėl nepamirškite atkreipti dė-
mesį į keletą svarbių detalių:

l	visada reikia teisingai įvertinti Y, vertikaliąją ašį, nes dalydami Y ašį į daugiau padalų su- 
	 mažiname vizualų stulpelių aukštį. Taip pat atkreipkite dėmesį į Y ašies pradžią, nes padalos  
	 gali būti atidėtos ne nuo nulio, o nuo kito skaičiaus, kas labai iškraipo realią informaciją.  
	 Žinoma, tokiu būdu labai patogu užmaskuoti nuostolius, augimo tempus, nestabilumą.

l	Y ašies padalų skaičius parodo skirtumus, tačiau kartais tai, kas grafike, atrodo, turi labai 
	 didelius skirtumus, iš tikrųjų yra kelios padalos skalėje ir yra visiškai nereikšminga. 

Šiuos pastebėjimus galime pritaikyti analizuodami grafiką, kur kintamojo Bendras patiriamas 
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stresas skalės vidurkis yra vaizduotas Y ašyje (5.26 pav.). Matome, kad skirtumai tarp grupių yra labai 
nedideli (nereikšmingi), jei norėtume juos paryškinti, tiesiog reikėtų padidinti Y ašies padalų skaičių. 

5.5.3. Sklaidos diagrama

Sklaidos diagrama naudojama tiriant ryšį tarp dviejų tolydžių kintamųjų (pvz., amzius ir ru-
kymodazn). Prieš tiriant koreliaciją (ryšį) tarp dviejų kintamųjų, reikėtų nusibrėžti sklaidos dia-
gramą, kuri aiškiai parodys:

l	Ar pasirinkti kintamieji koreliuoja.

l	Ar tai yra tiesinis ar kreivinis ryšys. 

Jei jūsų kintamieji susieti tiesiniu ryšiu, tai šį ryšį pakankamai lengvai galėsite apibūdinti vien 
tik nusibrėžę sklaidos diagramą. Koreliacinio ryšio grafinei analizei atlikti naudosime Streso ty-
rimas.sav duomenis. Pasirinksime kintamuosius Bendras patiriamas stresas ir Bendra streso 
kontrolė. Taip pat pasirinksime ir kategorinį kintamąjį lytis (vyrai ir moterys). Tokiu būdu dvi 
grupės bus vaizduojamos vienoje sklaidos diagramoje tik skirtingomis spalvomis. Grafinę anali-
zę atlikite pagal toliau aprašytą procedūrą. 

Sklaidos diagramos braižymas 

1 	S PSS programų paketo pagrindiniame meniu pasirenkame 
		  Graphs->Legacy Dialogs, tada Scatter/Dot (5.27 pav).

5.27 pav. SPSS programų paketo meniu juostos pasirinkimas Graphs->Legacy Dialogs-> Scatter/Dot.
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2 	A tsidariusiame naujame Scatter/Dot lange, pasirenkame Simple, tada Define.
3 	 Simple Scatterplot lange pasirenkame priklausomąjį kintamąjį (pvz., Bendras  

		  patiriamas stresas). Įkeliame šį kintamąjį į Y Axis laukelį. Tai Y vertikalios ašies kinta- 
		  masis (5.28 a pav.).

4 	 Simple Scatterplot lange pasirenkame kitą kintamąjį (pvz., Bendra streso kontrolė) ir 
		  įkeliame į X Axis laukelį. Tai horizontalios ašies kintamasis (5.28 a pav.).

5.28 pav. SPSS programų paketo meniu juostos pasirinkimas Graphs->Legacy Dialogs-> Scatter/Dot:  
a) kintamųjų parinkimo langas; b) grafiko pavadinimo suteikimo langas.

5 	S PSS programų pakete yra numatyta galimybė atskirti kintamųjų priklausomybę katego- 
		  rijai (pvz., lytis). Simple Scatterplot lange pasirenkame kintamąjį lytis ir įkeliame šį 
		  kintamąjį į Set Markers by laukelį. Tai atvaizduos kintamuosius skirtingomis spalvomis.

6 	 Braižomam grafikui galite priskirti pavadinimą aktyvavę Titles ir atsidariusiame lange 
	  	įrašę pavadinimą, kaip yra parodyta 5.28 b pav.

7 	A tlikę visus būtinus žingsnius, pasirinkite Continue, tada OK.

Po atliktų veiksmų koreliacinio ryšio grafinė analizė bus atlikta SPSS programų paketu, o 
gautas rezultatas (grafikas) bus pateiktas išvesties lange, jis yra parodytas 5.29 pav. Ką galime 
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spręsti apie dviejų kintamųjų ryšį, skaitykite sklaidos diagramos interpretacijoje.
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5.29 pav. Koreliacinio ryšio grafinės analizės rezultatas, atliktas SPSS programų paketu.

Sklaidos diagramos interpretavimas

Atlikę grafinę analizę, galime teigti, kad ryšys tarp kintamųjų Bendras patiriamas stresas ir 
Bendra streso kontrolė yra vidutinio stiprumo, nes kintamųjų reikšmės yra išsibarsčiusios vi-
dutinio pločio juostoje (5.29 pav.). Taip pat grafikas rodo, kad koreliacija yra neigiama. 

l	Respondentai turi aukštą streso kontrolės lygį (X ašis, arba horizontali ašis), o žemą savi- 
	 kontrolės lygį (Y ašis, arba vertikali ašis). Žmonės, kurie turi žemą streso kontroliavimo 
	 lygį, gali greičiau patirti stresą. 

l	Šiame grafike (5.29 pav.) nėra bendrą vidutinę kintamųjų priklausomybę rodančios  
	 tiesės, todėl būtų tikslinga apskaičiuoti šių dviejų kintamųjų Pearson koreliaciją. Tiesa, ga- 
	 lima grafike tiesę nubrėžti patiems. Tam pakanka ant grafiko nustačius žymeklį porą kartų 
	 spustelėti kairįjį pelės klavišą. Atsidarys naujas Chart Editor langas, kurio pagrindinia- 
	

	 me meniu reikia tiesiog spustelėti piktogramą , ir sklaidos diagramoje atsiras vadina- 
	 moji regresinė tiesė, atitinkanti Pearson koreliaciją. Be to, pateikiama jos matematinė  
	 išraiška, tinkanti prognozėms daryti. Pakeitimai išliks ir uždarius Chart Editor langą  
	 (5.30 pav.).
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5.30 pav. Koreliacinio ryšio grafinės analizės rezultatas, atliktas SPSS programų paketu.

Tačiau reikėtų įsidėmėti, kad duomenų sklaidos diagrama nepateikia galutinių atsakymų. 
Todėl reikia atlikti ir atitinkamus statistinius skaičiavimus, apie kuriuos skaitykite plačiau 7.4.3 
skyriuje.

5.5.4. Stačiakampė diagrama

Stačiakampę diagramą pasiūlė amerikietis mokslininkas Džonas Tjukis 1977 m. Ji vaizduoja 
kintamojo reikšmių skaitines charakteristikas. 

Kaip parodyta 5.31 pav., stačiakampę diagramą sudaro stačiakampis, kuris apima kintamojo 
duomenų intervalą nuo pirmojo kvartilio X0,25 iki viršutinio kvartilio X0,75, yra padalytas į dvi da-
lis ties mediana X0,50. Nuo stačiakampio eina linijos, kurios tęsiasi iki mažiausios reikšmės Xmin 
į vieną pusę ir iki didžiausios reikšmės Xmax į kitą. Reikšmės, kurios viršija linijų ilgį, yra išskir-
tys. Išskirtis – tai išsiskirianti iš bendros visumos duomenų reikšmė, kuri yra nenatūraliai dides-
nė arba mažesnė už kitas duomenų reikšmes. SPSS programų paketu galime patikrinti, ar duo-
menyse yra išskirčių. Ši procedūra yra aprašyta 5.3 skyriuje.
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5.31 pav. Stačiakampės diagramos schema su paaiškinimu.

Stačiakampė diagrama yra naudojama, kai norime palyginti kintamųjų reikšmių pasiskirsty-
mą. Galime tirti vieno tolydaus kintamojo skirstinį (pvz., Bendras teigiamas efektas) arba tirti 
kelių skirtingų grupių (pvz., amgr3) skirstinius. Norėdami atlikti lyginamąją analizę taip pat ga-
lime prijungti papildomą kategorinį kintamąjį (pvz., lytis) ir palyginti vyrus ir moteris.

Grafiškai tirsime kintamojo reikšmių pasiskirstymą atspindintį vyrų ir moterų patiriamas tei-
giamas emocijas. Tyrimui naudosime rinkmenos Streso tyrimas.sav duomenis. Pasirinksime 
kintamuosius Bendras teigiamas efektas ir lytis. Grafinę analizę atliksime pagal toliau aprašy-
tą procedūrą.

Stačiakampės diagramos braižymas 

1 	S PSS programų paketo pagrindiniame meniu pasirenkame Graphs, tada Box plot.
2 	 Pasirinkite Simple. Tada Data in Chart Are lange renkamės Summaries for groups of 

	  	cases. Tada Define.
3 	 Pasirenkame tolydųjį kintamąjį (pvz., Bendras teigiamas efektas). Įkeliame jį į Variable  

		  laukelį.
4 	 Pasirenkame kategorinį kintamąjį (pvz., lytis). Įkeliame jį į Category axis laukelį.
5 	 Pasirenkame kintamąjį ID ir įkeliame jį į Label cases laukelį. Tai leis jums identifikuoti  

		  reikšmių, kurios bus išskirtys, ID numerius.
6 		 Pasirenkame Options. Atsisakome pasirinkimo Display groups defined by missing values. 
7 	 Pasirenkame Continue, po to OK.

Po šių veiksmų SPSS programų paketo išvesties lange bus nubrėžtos abiejų grupių (vyrų ir 
moterų) stačiakampės diagramos, kaip tai yra parodyta 5.32 pav. 
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5.32 pav. Stačiakampė diagrama, atspindinti vyrų ir moterų patiriamas teigiamas emocijas.

Šioje diagramoje (5.32 pav.) SPSS programų paketas pažymi išskirtis, jei tokių yra. Išskirtys 
žymimos žvaigždute *, jei yra nutolusios daugiau kaip 3 kartus nuo Q3 arba reikšmė yra 3 kartus 
mažesnė už Q1. Tokių reikšmių šiame grafike (5.32 pav.) nėra. Atlikę kintamojo Bendras teigia-
mas efektas grafinę analizę, matome abiejose kategorijose (tiek vyrų, tiek moterų) keletą išskir-
čių žemiau pirmojo kvartilio (Q1), kurios pažymėtos skrituliukais, o tai reiškia, kad šios reikš-
mės yra sąlyginės išskirtys.

Stačiakampė diagrama leidžia susipažinti su lyginamų grupių skirstiniais ir vizualiai pamaty-
ti skirtumus. Tačiau kintamojo Bendras teigiamas efektas grafinė analizė rodo, kad tiek vyrų, 
tiek moterų duomenys pasiskirstę labai panašiai. 

5.5.5. Linijinė diagrama

Linijinis grafikas leidžia patikrinti skirtingų tolydžiojo kintamojo duomenų vidurkio reikš-
mes atsižvelgiant į kategorinį kintamąjį (pvz., 1 kartą, 2 kartą, 3 kartą). Linijų diagrama labai aiš-
kiai perteikia kitimą laike ir gali pavaizduoti daug taškų. Ši diagrama taip pat naudojama grafi-
niam duomenų tyrimui, kai atliekame vienfaktorinę ar dvifaktorinę dispersinę analizę (ANOVA). 

Atliksime vyrų ir moterų patiriamų teigiamų emocijų pasiskirstymą pagal amžiaus grupes 
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grafinį duomenų tyrimą. Tyrimui naudosime rinkmeną Streso tyrimas.sav. Veiksmus atliksime 
pagal toliau aprašytą procedūrą. 

Linijinės diagramos braižymas

1 	S PSS programų paketo pagrindiniame meniu pasirenkame Graphs, tada Line.
2 	 Pasirinkite Multiple. Tada Data in Chart Are lange renkamės Summaries for groups of 

		  cases. Tada Define. 
3 	 Lines represent lange renkamės Other summary function. Pasirenkame tolydųjį  

		  kintamąjį (pvz., Bendras pasitenkinimas gyvenimu). Įkeliame jį į Variable laukelį.
4 	 Pasirenkame kategorinį kintamąjį (pvz., amgr3). Įkeliame jį į Category axis laukelį. Šis  

		  kintamasis bus išsidėstęs ant X ašies.
5 	 Pasirenkame kategorinį kintamąjį (pvz., lytis). Įkeliame jį į Define Lines by laukelį. 

	  	Kintamasis bus aprašytas legendoje.
6 	 Pasirenkame Options. Nesirenkame Display groups defined by missing values. 
7 	 Pasirenkame Continue, tada OK.
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5.33 a pav. Linijinė kintamojo Bendras pasitenkinimas gyvenimu diagrama. kategorinis kintamasis amgr3.



Duomenų analizės SPSS pagrindai124

5 amziaus grupes

Lytis 
Vyrai
Moterys

M
ea

n 
Be

nd
ra

s p
as

ite
nk

in
im

as
 g

yv
en

im
u 

21

18 - 24 25 - 32 33 - 40

22

23

24

20

41 - 49 50+

5.33 b pav. Linijinė kintamojo Bendras pasitenkinimas gyvenimu diagrama: kategorinis kintamasis amgr5.

Linijinės diagramos interpretavimas

Nubrėžtos linijinės diagramos (5.33 a ir b pav.) apibūdina vyrų ir moterų patiriamų teigiamų 
emocijų pasiskirstymą pagal amžiaus grupes. Šios diagramos taip pat apibūdina kiekvienos iš ly-
čių atskirai amžiaus įtaką patiriamų teigiamų emocijų suvokimui.

Galime teigti, kad daugiausia teigiamų emocijų patiria vyriausio amžiaus vyrai ir moterys, 
bet visose amžiaus grupėse laimingesnės yra moterys nei vyrai.

Teigiamų emocijų moterų amžiaus grupių skirtumas yra neryškus. Tik nuo 25 iki 32 metų am-
žiaus moterys yra šiek tiek daugiau patenkintos gyvenimu nei kitų amžiaus grupių. 

Taip pat galite aptarti skirtumus tarp vyrų ir moterų. Apskritai vyrai, atrodo, mažiau patenkin-
ti gyvenimu nei moterys. Nors amžiaus grupėse (amgr5) tarp jauniausių 18–24 metų amžiaus ir 
41–49 metų amžiaus skirtumai yra tikrai maži, tačiau vyresnio amžiaus grupėse skirtumas yra 
pakankamai didelis. Norint nustatyti, ar pastebėti skirtumai yra statistiškai reikšmingi, reikia at-
likti vienfaktorinę dispersinę analizę (ANOVA), apie kurią skaitykite 7.4.9 skyriuje.
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5.5.6. Grafinis redaktorius Chart Editor

Kintamųjų grafinė analizė SPSS programų pakete atliekama pasirinkus Graphs pagrindi-
nėje meniu juostoje. Taip pat grafiką galime nubrėžti ir pagrindinėje meniu juostoje pasirinkę 
Analyze. Po to, kai jau diagrama yra nubrėžta, ją galima patobulinti. Kartais reikia ją keisti arba 
papildyti, pakeisti į trimatį pavidalą ar pridėti pavadinimą, taip pat galima keisti spalvas, simbo-
lius, linijų stilius, modelius, teksto šriftą ir dydį.

SPSS programų pakete yra numatyta galimybė tai padaryti išvesties lange, aktyvuojant dia-
gramą. Norėdami modifikuoti savo grafiką, tiesiog spustelėkite jį pelės kairiuoju klavišu dukart 
ir redaktoriaus Chart Editor langas bus aktyvuotas. Grafinis redaktorius turi savo meniu ir įran-
kių juostą.
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5.34 pav. Modifikuotas ir papildytas informacija 5.26 pav. grafikas.

Pateiksime tokį pavyzdį. Papildysime informaciją ir pakeisime jau nubrėžtą SPSS programų 
paketu juostinę diagramą (5.26 pav.), kuri parodė, kad moterys pakelia didesnį stresą nei visų tri-
jų amžiaus grupių vyrai. Atliksime tokius pakeitimus:

1 	S uteiksime pavadinimą „Patiriamas stresas“;
2 	 Pakeisime į 3-D pavidalą;
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3 	V yrų kategorijos stulpeliai bus baltos spalvos su juostelėmis, moterų stulpelių spalvos  
		  nekeisime, bet uždėsime juosteles.

4 	G rafike bus parodytas abiejų kategorijų patiriamo streso dydis.

Kad atliktume šiuos pakeitimus, turėsime:
1 	 Pagrindinėje Chart Editor lango meniu juostoje rinktis Options, tada Title.   

		A  tsidariusiame Title dialogo lange įrašysime pavadinimą „Patiriamas stresas“.
2 	 Pakeisime į 3-D pavidalo grafinį vaizdą. Pagrindinio Chart Editor lango meniu juos- 

		  toje renkamės Edit->Properties, tada Depth& Angle.
3 	 Pažymime koreguojamas juostas, Chart Editor lango meniu juostoje renkamės  

		  Edit->Properties, tada keičiame spalvą ir papildomai uždedame raštą.
4 	 Pažymime koreguojamas juostas, Chart Editor lango meniu juostoje renkamės  

		  Elements-> Data Label Mode. Šitaip paprastai galima papildyti grafiką informacija apie 
		  patiriamą stresą.

Visi pakeitimai yra pavaizduoti 5.34 pav. grafike.



A p r a š o m o j i  s t a t i s t i k a  s u  S P S S 127

5.6. užduotys

1 užduotis. Atlikite pradinę duomenų analizę su SPSS.

Tyrimą atlikite tokia tvarka:

1. 	Atidarykite SPSS programų paketo lange hipotetinių duomenų rinkmeną aflatoxin.sav. 
 	T ai duomenys, susiję su kukurūzų pasėlių apdorojimu aflatoksinu. Tiriama, kaip šių pesti- 
	 cidų koncentracija svyruoja tarp kukurūzų derlių. Tiriama 16 grūdų mėginių iš 8 derlių ir 
	 išmatuotų aflatoksino lygių dalių vienam milijardui (PPB – parts per billion).

2. 	Pasirinkite Explore procedūrą:
		  a)	pasirinktajam kiekybiniam santykių skalės kintamajam sudarykite dažnių skirstinį;
		  b)	pavaizduokite šio kintamojo reikšmių skirstinį grafiškai;
		  c)	pasirinkite du kokybinius ir vieną kiekybinį kintamuosius ir pavaizduokite grafiškai.

2 užduotis. Atlikite pradinę duomenų analizę su SPSS.

Tyrimą atlikite tokia tvarka:

1. 	Atidarykite SPSS programų paketo lange hipotetinių duomenų rinkmeną ceramics.sav.  
	T ai duomenys, susiję su gamintojo pastangomis nustatyti, ar naujas lydinys turi didesnį  
	 atsparumą šilumai nei standartinis lydinys. Kiekvienas atvejis registruoja atskirą kiekvie- 
	 no lydinio šilumos testą.

2. 	Pasirinkite Explore procedūrą:
		  a)	pasirinktajam kiekybiniam santykių skalės kintamajam sudarykite dažnių skirstinį;
		  b)	pavaizduokite šio kintamojo reikšmių skirstinį grafiškai;
		  c)	pasirinkite du kokybinius ir vieną kiekybinį kintamuosius ir pavaizduokite grafiškai.

3 užduotis. Atlikite pradinę duomenų analizę su SPSS.

Tyrimą atlikite tokia tvarka:

1.	Atidarykite SPSS programų paketo lange hipotetinių duomenų rinkmeną aflatoxin.sav.  
	T ai duomenys, susiję su kukurūzų pasėlių apdorojimu aflatoksinu. Tiriama, kaip šių pesti- 
	 cidų koncentracija svyruoja tarp kukurūzų derlių. Tiriama 16 grūdų mėginių iš 8 derlių ir 
	 išmatuotų aflatoksino lygių dalių vienam milijardui (PPB – parts per billion).

2.	Pasirinkite Explore procedūrą:
		  a)	pasirinktajam kiekybiniam santykių skalės kintamajam sudarykite dažnių skirstinį;
		  b)	pavaizduokite šio kintamojo reikšmių skirstinį grafiškai;



Duomenų analizės SPSS pagrindai128

		  c)	naudodami Kolmogorovo-Smirnovo ir Shapiro-Wilko kriterijų nustatykite, ar kinta- 
			   mųjų skirstinys artimas normaliajam;

		  d)	nustatykite, ar yra išskirčių;
		  e)	pasirinkite du kokybinius ir vieną kiekybinį kintamuosius ir pavaizduokite grafiškai.

4 užduotis. Atlikite pradinę duomenų analizę su SPSS.

Tyrimą atlikite tokia tvarka:

1.	Atidarykite SPSS programų paketo lange hipotetinių duomenų rinkmeną ceramics.sav.  
	T ai duomenys, susiję su gamintojo pastangomis nustatyti, ar naujas lydinys turi didesnį  
	 atsparumą šilumai nei standartinis lydinys. Kiekvienas atvejis registruoja atskirą kiekvie- 
	 no lydinio šilumos testą.

2.	Pasirinkite Explore procedūrą:
		  a)	pasirinktajam kiekybiniam santykių skalės kintamajam sudaryti dažnių skirstinį;
		  b)	pavaizduokite šio kintamojo reikšmių skirstinį grafiškai;
		  c)	naudodami Kolmogorovo-Smirnovo ir Shapiro-Wilko kriterijų nustatykite, ar kintamųjų 

			   skirstinys artimas normaliajam;
		  d)	nustatykite, ar yra išskirčių;
		  e)	pasirinkite du kokybinius ir vieną kiekybinį kintamuosius ir pavaizduokite grafiškai.

5 užduotis. Atlikite pradinę duomenų analizę su SPSS.

Tyrimą atlikite tokia tvarka:

1.	Atidarykite SPSS programų paketo lange hipotetinių duomenų rinkmeną bankloan.sav.  
	T ai duomenys, susiję su banko pastangomis mažinti negrąžintų paskolų normą. Faile yra  
	 finansinė ir demografinė informacija apie 850 esamų klientų. Pirmieji 700 atvejų yra  
	 vartotojai, kuriems jau buvo suteiktos paskolos. Likę 150 atvejų yra potencialūs klientai,  
	 kuriuos bankas turi klasifikuoti pagal kredito riziką kaip patikimus arba ne.

2.	Pagal duomenų tipus parinkite tinkamas procedūras kokybiniams ir kiekybiniams kinta- 
	 miesiems:

		  a)	apskaičiuokite: aritmetinį vidurkį, medianą, dispersiją, standartinį nuokrypį;
		  b)	pavaizduokite šio kintamojo reikšmių skirstinį grafiškai;
		  c)	naudodami Kolmogorovo-Smirnovo ir Shapiro-Wilko kriterijų nustatykite, ar kinta- 

			   mųjų skirstinys artimas normaliajam;
		  d)	nustatykite, ar yra išskirčių;
		  e)	pasirinkite du kokybinius ir vieną kiekybinį kintamuosius ir pavaizduokite grafiškai.
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6 užduotis. Remdamiesi 1 lentelėje pateiktais respondentų atsakymais į anketos nr. 1 klausi- 
mus sukurkite rinkmeną knygu skaitymas.sav. Po to atlikite tokias užduotis:

	 l		 pagal duomenų tipus parinkite tinkamas procedūras. Apskaičiuokite: aritmetinį vidurkį,  
			   medianą, dispersiją, standartinį nuokrypį;

	 l		 sugrupuokite duomenis dažnių lentelėje;

	 l		 nubraižykite histogramas, linijines, stulpelines ar skritulines diagramas.

Anketa nr.1

K1. Lytis:
¨	 vyras
¨	 moteris

K3. Kiek knygų esate perskaitę? 
¨	 nuo 1 iki 5 
¨	 nuo 6 iki 20 
¨	 nuo 21 iki 50 
¨	 daugiau nei 50

K2. Amžius (metais): K4. Jūsų nuomonė apie knygų skaitymą 
1.	L aiko švaistymas (LŠ)
2.	T ie, kas skaito, neturi ką veikti (NKV) 
3.	S kaitymas nuobodu (SN)
4.	S kaitymas įdomu (SĮ)
5.	S kaitymas labai įdomu (SLĮ)

1 lentelė

ID K1 K2 K3 K4 ID K1 K2 K3 K4
1. vyras 65 daugiau nei 50 SLĮ 16. moteris 22 iki 20 SĮ
2. vyras 26 iki 5 LŠ 17. moteris 34 daugiau nei 50 SLĮ
3. vyras 20 iki 5 LŠ 18. vyras 26 iki 50 NKV
4. moteris 32 iki 50 SLĮ 19. vyras 28 iki 20 SĮ
5. moteris 24 iki 20 NKV 20. vyras 32 iki 50 SLĮ
6. vyras 27 iki 50 SLĮ 21. vyras 31 iki 5 SN
7. vyras 58 iki 20 SĮ 22. moteris 45 iki 50 SLĮ
8. vyras 23 iki 5 SN 23. moteris 31 iki 50 SLĮ
9. moteris 50 iki 50 SLĮ 24. vyras 35 iki 20 SĮ
10. moteris 41 daugiau nei 50 SLĮ 25. vyras 26 iki 50 SLĮ
11. moteris 28 iki 50 SLĮ 26. moteris 32 iki 50 NKV
12. moteris 36 iki 50 SLĮ 27. moteris 30 iki 20
13. moteris 26 iki 20 SĮ 28. vyras 57 daugiau nei 50 SLĮ
14. vyras 22 iki 50 SLĮ 29. vyras 39 iki 20 SĮ
15. vyras 25 daugiau nei 50 SLĮ 30. moteris 21 iki 5 SN
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6. Naujų kintamųjų kūrimas

Šiame skyriuje susipažinsite su naujų kintamųjų kūrimu, kuris yra atliekamas siekiant statis-
tinį tyrimą padaryti išsamesnį. Šis procesas yra glaudžiai susijęs su kintamųjų matavimo skale. 
Išmoksite keliais būdais sukurti naują kintamąjį: 

l	 suskaičiuodami bendrą balą kelių kintamųjų, kurie išmatuoti toje pačioje skalėje. Prieš tai 
	 reikės perkoduoti neigiamai užkoduotus kintamuosius (atlikti vertinimų skalės reversą);

l	 parametrinius kintamuosius sugrupuodami į kategorijas.

6.1. Kelių kintamųjų jungimas į vieną

Prieš pradedant šį procesą svarbu, kad kintamieji, kurių skaičiuosite bendrą vertę (reikšmių 
suma), būtų užkoduoti teisingai ir išmatuoti toje pačioje skalėje. Pavyzdžiui, buvo tiriamas res-
pondentų optimizmas ir jie buvo paprašyti įvertinti šešis teiginius, kurie yra pateikiami žemiau:

Prašome perskaityti išvardytus teiginius ir nuspręsti, kiek jūs sutinkate ar nesutinkate su kiek- 
vienu. Savo nuomonę išreikšite skaičiumi, kuris geriausiai rodo, ką manote. Skaičių skalė:

Visiškai nesutinku 	 1	 2	 3	 4 	 5 	 visiškai sutinku

Teiginiai Rangas
1. Paprastai visada tikiuosi geriausio 1 2 3 4 5
2. Jei kažkas gali atsitikti blogo, tai man būtinai nutiks 1 2 3 4 5
3. Aš visada optimistiškai galvoju apie savo ateitį 1 2 3 4 5
4. Labai retai reikalai klostosi man palankiai 1 2 3 4 5
5. Tikiuosi, man atsitiks daugiau gerų dalykų nei blogų 1 2 3 4 5
6. Labai retai galiu tikėtis man nutinkančių gerų dalykų 1 2 3 4 5

Šaltinis: sudaryta autorės, remiantis Scheier, M. F.,Carver, C. S., & Bridges, M. W. 1994.

Norėdami suskaičiuoti bendrą šių kintamųjų vertę privalėsite perkoduoti kai kuriuos iš jų, 
kad rangų skalės vertinimai matuotų tą patį. 1-as kintamasis suformuluotas teigiama linkme (di-
džiausias skaičius rodo aukštą optimizmą). 2-as, 4-as ir 6-as kintamieji yra suformuluoti neigia-
mai (didžiausias skaičius rodo žemą optimizmą). Skaičiuodami bendras reikšmes turime užti-
krinti, kad visi kintamieji būtų vienodai išmatuoti (didžiausias skaičius rodo didžiausią vertę), 
todėl reikia perkoduoti 2-ą, 4-ą ir 6-ą kintamuosius. Optimizmas buvo matuojamas penkių lygių 
Likert tipo skale, todėl kiekvieno kintamojo balai gali svyruoti nuo 1 (visiškai nesutinku) iki 5 
(visiškai sutinku), kintamiesiems buvo suteikti vardai opt1–opt6. Šešių rangų skalės kintamų-
jų kodų pakeitimus atliksime su duomenimis iš rinkmenos amzius.sav pagal procedūrą, aprašy-
tą kitame skyriuje. 
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6.1.1. Kintamųjų skalės kodų pakeitimas

Kaip jau minėjau ankstesniame skyriuje, kategoriniai kintamieji gali būti viename bloke iš-
matuoti vienoda rangų skale, tačiau ši skalė ne visada parodo tą pačią kintamojo reikšmę. Jei tu-
rite tokių kintamųjų bloką, juos reikia perkoduoti. Atliksime kintamųjų opt2, opt4 ir opt6 ska-
lės kodų pakeitimus pagal procedūrą, aprašytą žemiau.

Skalės kodo keitimas

1 	 Pagrindiniame SPSS programų paketo Data Editor lango meniu pasirinkite Transform,  
		  tada Recode into Same Variables.

6.1 pav. SPSS programų paketo pagrindinio meniu juostoje pasirinkimas Transform.

2 	A tsidariusiame Recode into Same Variables lange kintamuosius opt2, opt4 ir opt6 per- 
		  kelkite į Variables langą (6.2 1 pav.), tada rinkitės Old and New Values.

6.2 pav. SPSS programų paketo langai, kai atliekami 2–4 procedūros žingsniai.
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3 	 Old Value laukelyje įrašykite 1, o New Value laukelyje įrašykite 5. Tada rinkitės Add.  
		L  ange Old -->New pamatysite užrašą 1-->5.

4 	K adangi skalė yra penkių lygių (1, 2, 3, 4 ir 5), tai procedūrą teks tęsti, kol pakeisime  
		  visas reikšmes. Tiesiog teks surinkti kitą informaciją į Old Value ir New Value langus, 
		  kaip parodyta:

		  Old value – įrašyti 2, o New Value – įrašyti 4, Add

		  Old value – įrašyti 3, o New Value – įrašyti 3, Add

		  Old value – įrašyti 4, o New Value – įrašyti 2, Add

		  Old value– įrašyti 5, o New Value – įrašyti 1, Add
5 	 Patikrinkite, ar atlikote visus reikalingus pakeitimus. Jei baigėte reikšmių pakeitimą,  

		  rinkitės Continue ir OK.

Po šios procedūros kintamųjų opt2, opt4 ir opt6 matavimo skalė bus apsukta, kaip parodyta 6.2 
pav. Dabar visi „optimizmo“ bloke esantys kintamieji išmatuoti taip, kad didžiausias skalės rangas 
(5) rodo visų kintamųjų aukščiausią vertę. Suvienodinę skales, galėsite sujungti visus šešis rangų 
skalėje išmatuotus kintamuosius į vieną tolydųjį. Kaip tai padaryti, detaliai paaiškina kita procedūra.

6.1.2. Kelių ranginių kintamųjų jungimas į vieną

Respondentų optimizmui tirti buvo panaudoti rinkmenos amzius.sav šeši rangų skalės kinta-
mieji (opt1, opt2, opt3, opt4, opt5, opt6), kurie buvo suformuluoti tiek teigiama, tiek ir neigia-
ma linkme. Norėdami sujungti visus šešis rangų skalėje išmatuotus kintamuosius, suvienodino-
me jų matavimo skalę. Tad reikėjo sukurti tolydųjį kintamąjį, kurio šiaip tyrime nebuvo. Tai at-
liksime pagal nurodymus, pateiktus toliau.

Kelių ranginių kintamųjų jungimas į vieną

1 	 Pagrindiniame SPSS programų paketo Data Editor lango meniu pasirinkite Transform,  
		  tada Compute Variable.

2  	Atsivėrusiame Compute Variable lango laukelyje Target Variable įrašykite naują  
		  kintamojo vardą, prieš tai pasitikrinę kintamųjų kodavimo apraše, ar tokiu pat vardu nėra 
		  kintamojo sąraše.

3 	R inkitės Type & Label mygtuką, čia Label laukelyje parašysime „Optimizmas“, o Type  
		  paliksime Numeric. Tada renkamės Continue.
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6.3 pav. pagrindinėje SPSS programų paketo meniu juostoje pasirinkimas Transform--> Compute Variable.

4 	I š kintamųjų pasirinkimo lango suraskite kintamąjį opt1 ir perkelkite jį rodykle į Numeric 
		  Expression langą, tada paspauskite mygtuką + , o po to suraskite kintamąjį opt2 ir įkel- 
		  kite į Numeric Expression langą ir vėl paspauskite mygtuką +. Taip kartokite tol, kol 
		  Numeric Expression lange (6.4 pav.) bus užrašyta:

opt1+opt2+opt3+opt4+opt5+opt6

6.4 pav. SPSS programų paketo Compute Variable lange atliekamos procedūros.

5 	 Patikrinkite, ar visus kintamuosius sukėlėte į Numeric Expression langą ir ar visi jie  
		  sujungti + ženklu. Jei taip, tada spauskite OK.
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Po šios procedūros rinkmenoje padaugės vienu kintamuoju optimizmas, o šis kintamasis bus 
traktuojamas kaip parametrinis kintamasis.

Kaip jau supratote, tyrime esančius kokybinių kintamųjų blokus visada galėsite panaudoti 
kurdami naujus kiekybinius kintamuosius. Tačiau atliekant tyrimus, kartais reikia atlikti atvirkš-
tinį pakeitimą, tai yra iš kiekybinio kintamojo sukurti kokybinį. Kaip tai atliekama SPSS progra-
mų paketu, skaitykite kitame skyriuje.

6.2. Tolydaus kintamojo skaidymas į grupes

Daugelyje anketinių apklausų yra surenkama informacija apie respondentų amžių. Šis kin-
tamasis yra matuojamas intervalų skalėje ir savo prigimtimi yra kiekybinis, bet yra tyrimų, kai 
reikia išsiaiškinti įvairių amžiaus grupių tam tikrus požymius, be to, reikia, kad tų grupių imtys 
būtų lygios (pvz., ANOVA). 

Kaip pakeisti intervalų skalės kintamąjį į rangų skalėje išmatuotą kintamąjį, paaiškins toliau 
aprašyta procedūra. Šią procedūrą atliksime iš rinkmenos amzius3gr.sav pasirinkę tolydųjį kin-
tamąjį amzius, kurį suskirstysime į tris lygias dalis, tai yra bus trys grupės: 1 = jauniausia, 2 = 
vidutinio amžiaus, 3 = vyriausia. Ši užduotis susideda iš dviejų dalių. Pirma, turime sužinoti pro-
centiliams priskiriamas reikšmes, antra, remdamiesi informacija, turime sukurti naują kintamą-
jį. Tad pradėsime nuo pirmos užduoties, o tada tęsime toliau. 

Tolydaus kintamojo skaidymas lygiomis dalimis 

1 	 Pagrindiniame SPSS programų paketo Data Editor lango meniu pasirinkite 
		  Analyze->Descriptive Statistics->Frequencies.
2  	Lange Frequencies tolydųjį kintamąjį amzius įkelsime į Variables langą, tada pasirink- 

		  sime Statistics.
3  	Percentile Values bloke pasirinkite Cut Points for  equal groups ir įrašykite 3.  

		T  ada rinkitės Continue ir OK (6.5 pav.).

Po šios procedūros SPSS programų paketo išvesties lange bus pateikta lentelėse statistinė in-
formacija.
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6.5 pav. SPSS programų paketo Frequencies Statistics lange nurodome padalyti kintamąjį į 3 dalis.

Lentelė, kurioje yra reikalinga informacija, vadinama Statistics. Reikia atkreipti dėmesį į 
Percentiles reikšmes. Tolydųjį kintamąjį padalijome į tris lygias dalis, todėl 6.1 lentelėje rasime 
33.33 procentilio (28,00) ir 66.67 procentilio (42,00) reikšmes. Šios reikšmės padės kintamojo 
amzius imtį padalyti į tris lygias dalis. Taigi į jauniausią grupę bus priskiriamos visos reikšmės 
iš intervalo nuo 0 iki 28; vidutinio amžiaus grupėje bus nuo 29 iki 42 ir vyriausiai grupei bus pri-
skirti tie, kuriems 43 metai ir daugiau.

6.1 lentelė. Kintamojo amzius dalijimo į tris dalis statistinė informacija.

Statistics
amzius

N
Valid 423
Missing 0

Minimum 18
Maximum 69

Percentiles
33,33333333 28,00
66,66666667 42,00

Išsiaiškinę grupių intervalus, galime padalyti kintamąjį amzius. Veiksmus atlikite nuosekliai, 
kaip paaiškinta procedūroje toliau.
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Tolydaus kintamojo skaidymo lygiomis dalimis procedūros tęsinys

1 	 Pagrindiniame SPSS programų paketo Data Editor lango meniu pasirinkite Transform,  
		  tada Recorde into Different Variables.

6.6 pav. SPSS programų pakete pasirinkimas Recorde into Different Variables.

2 	A tsidariusiame Recorde into Different Variables lange kintamąjį amzius perkelsime į  
		  Input Variables-->Output Variables langą, tada bloke Output Variable laukelyje Name 
		  suteiksime kintamajam vardą amgr3, o laukelyje Label užrašysime „Trys amžiaus  
		  grupės“, po to Change ir Old and new values (6.7 pav.).

6.7 pav. SPSS programų paketo Recorde into Different Variables langas.
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3 	L ange Recorde into Different Variables: Old and new values:  

	 	l	aktyvuosime Range, Lowest through value: ir įrašysime 33.33 procentilio reikšmę 28, 
		   	 o bloke New Value įrašysime 1 (pirmos grupės kodas). Tada renkamės Add.

			L   ange Old-->New pamatysite užrašą „Lovest thru 28-->1“;

	 	l	aktyvuosime Range, tada įrašysime 29 ir throug laukelyje įrašysime 66.67 procenti- 
			   lio reikšmę 42. Bloke New Value įrašysime 2 (antros grupės kodas). Tada renka- 
			   mės Add. Lange Old -->New pamatysite užrašą „29 thru 42-->2“; aktyvuosime  
			   Range, value through HIGHEST: ir įrašysime 43, o bloke New Value įrašysime  
			   3 (trečios grupės kodas). Tada renkamės Add. Lange Old-->New pamatysite užrašą „43  
			   thru Highest -->3“.

			   Po šių žingsnių lange Old -->New (6.7 pav.) pamatysite:
Lovest thru 28-->1
29 thru 43-->2
44 thru Highest -->3

4 	G aliausiai renkamės Continue ir OK.

Po to, kai sukūrėme naują kintamąjį amgr3, reikia atsidaryti SPSS programų paketo Variable 
View langą ir Values stulpelyje priskirti sukurtoms grupėms kodus, kurie buvo numatyti, pvz.:

1 bus priskirtas grupei „18–28“ (nes minimalus yra 18); 2 bus grupei „29–42“ ir 3 bus grupei 
„43–69“ (nes maksimalus yra 69), kaip tai yra parodyta 6.9 pav.

6.8 pav. Kintamojo amzius padalijimas į 3 lygias grupes.
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6.9 pav. Kintamojo amzius padalijimas į 3 lygias grupes.

Po šios procedūros bus sukurtas naujas kintamasis amgr3, kurio trys grupės yra kiekybine 
prasme lygios, o tai labai svarbu taikant tam tikrus statistinės analizės metodus, kurie yra gana 
jautrūs kiekybiniams imčių skirtumams (pvz., ANOVA).
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6.3. Užduotys

1 užduotis. Atidarykite SPSS programų paketo lange hipotetinių duomenų rinkmeną afla-
toxin.sav, kurios duomenys susiję su kukurūzų pasėlių apdorojimu aflatoksinu. Po to atlikite to-
kias užduotis:

l	 pasirinkite kiekybinį kintamąjį ir padaliję jį į tris lygias grupes sukurkite naują kategorinį  
	 kintamąjį;

l	 atlikite naujo kintamojo grafinę analizę.

2 užduotis. Atidarykite SPSS programų paketo lange hipotetinių duomenų rinkmeną cera-
mics.sav, kurios duomenys susiję su gamintojo pastangomis nustatyti, ar naujas lydinys turi di-
desnį atsparumą šilumai nei standartinis lydinys. Kiekvienas atvejis registruoja atskirą kiekvie-
no lydinio šilumos testą. Po to atlikite tokias užduotis:

l	 pasirinkite kiekybinį kintamąjį ir padaliję jį į tris lygias grupes sukurkite naują kategorinį  
	 kintamąjį;

l	 atlikite naujo kintamojo grafinę analizę.

3 užduotis. Atidarykite SPSS programų paketo lange hipotetinių duomenų rinkmeną ban-
kloan.sav. Tai duomenys, susiję su banko pastangomis mažinti negrąžintų paskolų normą. Faile 
yra finansinė ir demografinė informacija apie 850 esamų klientų. Pirmieji 700 atvejų yra varto-
tojai, kuriems jau buvo suteiktos paskolos. Likę 150 atvejų yra potencialūs klientai, kuriuos ban-
kas turi klasifikuoti pagal kredito riziką kaip patikimus arba ne.

l	 pasirinkite kiekybinį kintamąjį ir padaliję jį į tris lygias grupes sukurkite naują kategorinį  
	 kintamąjį;

l	 atlikite naujo kintamojo grafinę analizę.

4 užduotis. Remdamiesi 1 lentelėje pateiktais respondentų atsakymais į anketos nr. 1 klausi-
mus, sukurkite rinkmeną knygu skaitymas.sav. Po to atlikite tokias užduotis:

l	 kategoriniams kintamiesiems priskirkite kodus;

l	 padaliję kiekybinį kintamąjį K2 (amžius) į tris lygias grupes, sukurkite naują kokybinį  
	 kintamąjį;



Duomenų analizės SPSS pagrindai140

l	 perkoduokite kintamojo K4 skalę priskirdami respondentų nuomonėms tokius kodus:  
	 1 – SLĮ, 2 – SĮ, 3 – SN, 4 – NKV, 5 – LŠ. Išsaugokite naują kintamąjį vardu K5;

l	 grafiškai pavaizduokite kintamuosius K4 ir K5.

Anketa nr. 1

K1. Lytis:
¨	 vyras
¨	 moteris

K3. Kiek knygų esate perskaitę? 
¨	 nuo 1 iki 5 
¨	 nuo 6 iki 20 
¨	 nuo 21 iki 50 
¨	 daugiau nei 50 

K2. Amžius (metais): K4. Jūsų nuomonė apie knygų skaitymą 
1.	L aiko švaistymas (LŠ)
2.	T ie, kas skaito, neturi ką veikti (NKV)
3.	S kaitymas nuobodu (SN) 
4.	S kaitymas įdomu (SĮ)
5.	S kaitymas labai įdomu (SLĮ)

1 lentelė

ID K1 K2 K3 K4 ID K1 K2 K3 K4
1. vyras 65 daugiau nei 50 SLĮ 16. moteris 22 iki 20 SĮ
2. vyras 26 iki 5 LŠ 17. moteris 34 daugiau nei 50 SLĮ
3. vyras 20 iki 5 LŠ 18. vyras 26 iki 50 NKV
4. moteris 32 iki 50 SLĮ 19. vyras 28 iki 20 SĮ
5. moteris 24 iki 20 NKV 20. vyras 32 iki 50 SLĮ
6. vyras 27 iki 50 SLĮ 21. vyras 31 iki 5 SN
7. vyras 58 iki 20 SĮ 22. moteris 45 iki 50 SLĮ
8. vyras 23 iki 5 SN 23. moteris 31 iki 50 SLĮ
9. moteris 50 iki 50 SLĮ 24. vyras 35 iki 20 SĮ
10. moteris 41 daugiau nei 50 SLĮ 25. vyras 26 iki 50 SLĮ
11. moteris 28 iki 50 SLĮ 26. moteris 32 iki 50 NKV
12. moteris 36 iki 50 SLĮ 27. moteris 30 iki 20
13. moteris 26 iki 20 SĮ 28. vyras 57 daugiau nei 50 SLĮ
14. vyras 22 iki 50 SLĮ 29. vyras 39 iki 20 SĮ
15. vyras 25 daugiau nei 50 SLĮ 30. moteris 21 iki 5 SN
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5 užduotis. Remdamiesi 2 lentelėje pateiktais respondentų atsakymais į anketos nr. 2 klausi-
mus, sukurkite rinkmeną knygu skaitymas.sav. Po to atlikite tokias užduotis:

l	 kategoriniams kintamiesiems priskirkite kodus;

l	 padaliję kiekybinį kintamąjį K2 (amžius) į tris lygias grupes, sukurkite naują kokybinį  
	 kintamąjį;

l	 perkoduokite kintamojo K3 skalę priskirdami respondentų nuomonėms tokius kodus:  
	 1 – VS, 2 – N, 3 – S, 4 – VNS. Išsaugokite naują kintamąjį vardu K4. Užduotį atlikite, 
	 pagrindiniame SPSS programų paketo Data Editor lango meniu pasirinkę Transform, po  
	 to Automatic Recode. Perkodavimą pasirinkite Recode Starting from Lowest value;

l	 atlikite grafinę kintamųjų analizę K3 ir K4.

Anketa nr. 2

K1. Lytis:
¨	 vyras
¨	 moteris

K2. Amžius (metais): K3. Aš patenkintas (-a) savo gyvenimu: 
1 – visiškai sutinku (VS)
2 – sutinku (S)
3 – nesutinku (N)
4 – visiškai nesutinku (VNS)

2 lentelė

ID K1 K2 K3 ID K1 K2 K3
1. vyras 29 2 16. moteris 22 3
2. vyras 26 2 17. moteris 34 2
3. vyras 30 4 18. vyras 26 1
4. moteris 33 2 19. vyras 28 1
5. moteris 33 2 20. vyras 32 1
6. vyras 35 2 21. vyras 31 2
7. vyras 23 3 22. moteris 32 2
8. vyras 29 2 23. moteris 31 4
9. moteris 33 2 24. vyras 35 1
10. moteris 26 3 25. vyras 26 2
11. moteris 27 3 26. moteris 32 3
12. moteris 24 2 27. moteris 30 1
13. moteris 24 2 28. vyras 57 2
14. vyras 27 1 29. vyras 39 1
15. vyras 27 3 30. moteris 30 2
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6 užduotis. Remdamiesi rinkmenoje vado vaidmuo.sav pateiktais kintamųjų kl_12.1, 
kl_12.2, kl_12.3, kl_12.3, kl_12.4, kl_12.5, išmatuotų rangų skalėje nuo 1 iki 5 (1 – visiškai ne-
sutinku, 2 – nesutinku, 3 – neturiu nuomonės, 4 – sutinku, 5 – visiškai sutinku), duomenimis at-
likite tokias užduotis:

l	 perkoduokite kintamųjų nuo kl_12.1 iki kl_12.5 skalę priskirdami respondentų nuomo- 
	 nėms tokius kodus: 1 – visiškai sutinku, 2 – sutinku 3 – neturiu nuomonės, 4 – nesutinku,  
	 5 – visiškai nesutinku. Naujus kintamuosius išsaugokite vardais K_12.1, K_12.2, K_12.3,  
	 K_12.4, K_12.5. Užduotį atlikite pagrindiniame SPSS programų paketo Data Editor  
	 lango meniu pasirinkę Transform, po to – Automatic Recode. Perkodavimui pasirinkite 
	 Recode Starting from Highest value;

l	 sukurkite naują kiekybinį kintamąjį sujungdami į vieną ranginius kintamuosius nuo  
	 kl_12.1 iki kl_12.5. Šį kintamąjį pavadinkite Bvadg1. Užduotį atlikite pagrindinia-  
	 me SPSS programų paketo Data Editor lango meniu pasirinkę Transform, po to –  
	 Compute Variable;

l	 sukurkite naują kiekybinį kintamąjį sujungdami į vieną ranginius kintamuosius nuo  
	 K_12.1 iki K_12.5. Šį kintamąjį pavadinkite Bvadg2. Užduotį atlikite pagrindi- 
	 niame SPSS programų paketo Data Editor lango meniu pasirinkę Transform, po to –  
	 Compute Variable;

l	 atlikite grafinę kintamųjų Bvadg1 ir Bvadg2 analizę, nubrėžkite jiems histogramas bei  
	 stačiakampes diagramas.

7 užduotis. Rinkmenoje Streso tyrimas.sav pateikti kintamieji mast1, mast2, mast3, mast4, 
mast5, mast6, mast7. Visi septyni kintamieji nusako respondento profesionalumą, be to, jie iš-
matuoti rangų skalėje nuo 1 iki 4 (1 – visiškai nesutinku, 2, 3, 4 – visiškai sutinku). Remdamiesi 
duomenimis, sukurkite naują kiekybinį kintamąjį sujungdami į vieną ranginius kintamuosius. 

Užduotį atlikite tokia tvarka:
l	 skaičiuodami bendras reikšmes turime užtikrinti, kad visi kintamieji būtų vienodai  

	 išmatuoti, todėl perkoduokite kintamųjų mast1, mast3, mast4, mast5, mast6, mast7  
	 skalę, priskirdami respondentų nuomonėms tokius kodus : 1 = 4, 2 = 3, 3 = 3, 4 = 1. Užduotį 
	 atlikite pagrindiniame SPSS programų paketo Data Editor lango meniu pasirinkę 
	 Transform, po to – Recode into Same Variables;

l	 sukurkite naują kiekybinį kintamąjį Bprof sujungdami į vieną ranginius kintamuosius nuo 
	 mast1 iki mast7. Užduotį atlikite pagrindiniame SPSS programų paketo Data Editor  
	 lango meniu pasirinkę Transform, po to – Compute Variable.
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7. Statistinių metodų parinkimas tyrimui

Šiame skyriuje aptarsime, kaip teisingai pasirinkti SPSS programų pakete statistinį metodą, 
kai reikia nustatyti: ar kintamieji priklauso vieni nuo kitų (ar yra koreliacinis ryšys tarp jų); ar 
galime priklausomo kintamojo reikšmes prognozuoti pagal nepriklausomą kintamąjį (ar yra tie-
sinis regresinis ryšys tarp kintamųjų); ar kelių grupių duomenys yra panašūs ar skirtingi. Šiame 
skyriuje yra susieti klausimai su statistiniais metodais, tinkamais jiems analizuoti, ir paaiškinta, 
kokius duomenis turėdami kokią analizę galite atlikti. Skyriaus pabaigoje pateikiamos praktinės 
užduotys, skirtos įgūdžiams lavinti.

Viena iš sunkiausių ir kebliausių tyrimo dalių yra parinkti tinkamą statistinį metodą surink-
tų duomenų analizei atlikti. Nors daugelis statistikos kursų moko, kaip apskaičiuoti koreliacijos 
koeficientą arba atlikti vienfaktorinę dispersinę analizę, tačiau apie metodų pasirinkimą kalba-
ma ne daug. Labai svarbu yra išmokti pasirinkti analizės metodą, kuris padės jums atsakyti į tam 
tikrus rūpimus tyrimo klausimus. Be to, atliekant tyrimus tikėtina, kad jums reikės taikyti gana 
įvairius statistinius metodus, priklausomai nuo jūsų duomenų prigimties (nuo klausimo struktū-
ros). Todėl reikia turėti bendrą supratimą jau sudarant klausimyną pasirinktai problemai aiškin-
tis, nes įvairūs statistiniai metodai kelia tam tikrų reikalavimų analizuojamiems kintamiesiems. 

Tolydžiųjų kintamųjų analizei svarbus jų skirstinys, todėl reikia patikrinti reikšmių paskirstymą 
dėl normalumo ir asimetriškumo. Jei kintamasis yra kategorinis (pvz., vyrai / moterys), reikia patik-
rinti, kiek respondentų patenka į kiekvieną kategoriją. Tikrinti reikia, ar grupės yra lygios, ar labai 
skiriasi, o gal yra tuščių kategorijų? Visa ši informacija padės pasirinkti statistinius analizės metodus. 

Kaip jau buvo minėta, statistinių metodų įvairovė yra gana didelė, tačiau čia bus paaiškinti tik 
keli statistiniai metodai ryšiui tarp kintamųjų ir skirtumams tarp grupių tirti.

7.1. Ryšio tarp kintamųjų tyrimo metodai

Tyrimams, kurie skirti atskleisti ryšio tarp kintamųjų stiprumą, prognozuoti rezultatus ir įver-
tinti patikimumą, yra taikomi įvairūs statistiniai metodai. Prie šių metodų galima būtų priskirti:

l	koreliaciją, kuri tiria ryšį tarp priklausomų intervalinių kintamųjų;
l	binarinę regresinę analizę, kuri padeda prognozuoti vieno intervalinio kintamojo reikšmes  

	 pagal kito intervalinio kintamojo reikšmes; 
l	daugianarę tiesinę regresinę analizę, kuri nuo binarinės regresijos skiriasi tik tuo, kad  

	 prognozėse reikia atsižvelgti į kelis nepriklausomus kintamuosius; 
l	faktorinė analizė, kuri skirta identifikuoti susijusių kintamųjų, sudarančių grupę, struktūrą; 
l	Chi kvadrato kriterijus, kai reikia nustatyti, ar stebimi kokybiniai kintamieji yra nepriklau- 

	 somi ar priklausomi.
Čia nagrinėsime tik keletą iš jų.
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7.1.1. Chi kvadrato kriterijus 

Požymių nepriklausomumo tikrinimas yra susijęs su priklausomybės tarp vardinių ir rangų 
skalės kintamųjų analize. Vienas populiariausių ir plačiausiai taikomų neparametrinių kriterijų 
yra Chi kvadrato (  kriterijaus reikšmė) kriterijus, kuris yra naudojamas hipotezėms apie kin-
tamojo skirstinį populiacijoje tikrinti, dviejų kintamųjų nepriklausomumui (vienoje populiacijo-
je stebima kintamųjų pora), kintamojo homogeniškumui (keliose populiacijose stebimas vienas 
ir tas pats kintamasis) nustatyti (Sakalauskas, 2003).

Chi kvadrato kriterijus labai dažnai naudojamas anketinių apklausų duomenų analizei. Jei 
reikia nustatyti, ar stebimi kokybiniai kintamieji yra nepriklausomi ar priklausomi, galime tai-
kyti šį kriterijų, kuris padės atsakyti į klausimą. 7.1 lentelėje yra pateiktas tyrėjui rūpimas klau-
simas ir duomenys, reikalingi tyrimui atlikti, be to, rekomenduojamas statistinis metodas, kuris 
tiktų. 7.3.1 skyriuje yra pateiktas analizės pavyzdys su SPSS.

7.1 lentelė. Požymių nepriklausomumo tikrinimas.

Kas tiriama? Ar yra ryšys tarp vyrų ir moterų rūkymo žalos sveikatai vertinimų?
Kokių duomenų reikia? l	Vieno kategorinio nepriklausomo kintamojo (pvz., lytis: vyrai / moterys);

l	Vieno kategorinio priklausomo kintamojo (pvz., nuomonė:  
1 – Visiškai pritariu; 2 – Nežinau; 3 – Visiškai nepritariu)

Parametriniai kriterijai: Nėra
Neparametriniai kriterijai:

 kriterijus

7.1.2. Pirsono koreliacija

Pirsono koreliacija taikoma nustatyti ryšio tarp dviejų intervalinių kintamųjų stiprumui, ku-
rio skaitmeninė išraiška svyruoja nuo 0 – nėra koreliacijos iki ±1 – puiki koreliacija (nereikia 
turėti iliuzijų, kad neigiama koreliacija yra silpna, -1 tai labai stipri atvirkštinė priklausomybė). 
Koreliacijos koeficientas rodo dvi kintamųjų ryšio savybes: tai ryšio stiprumą ir ryšio kryptį. 

Ryšio stiprumas rodo, kaip vienas požymio kitimas priklauso nuo kito požymio. Ryšio kryptis 
gali būti teigiama (pvz., tarp žinių ir pažymio) arba neigiama (pvz., tarp paskaitų nelankymo ir pa-
žymio). Teigiama koreliacija rodo, kad požymiai kinta viena kryptimi. Neigiama koreliacija rodo, 
kad vieno požymio reikšmėms didėjant, kito požymio reikšmės mažėja, ir atvirkščiai. 

Koreliacijos koeficiento absoliutinio dydžio (modulio) reikšmės (Williams, Monge, 2001):
l	nuo 0 iki 0,2 – labai silpna koreliacija (ryšio nėra); 
l	nuo 0,2 iki 0,4 – silpna koreliacija (silpnas ryšys);
l	nuo 0,4 iki 0,7 – vidutinė koreliacija (vidutinis ryšys); 
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l	nuo 0,7 iki 0,9 – stipri koreliacija (stiprus ryšys); 
l	daugiau nei 0,9 – labai stipri koreliacija. 
Statistikoje koreliacija naudojama dviejų (gali būti ir daugiau) parametrinių kintamųjų tiesi-

nei priklausomybei išmatuoti. 7.2 lentelėje yra paaiškinta, koks klausimas rūpi tyrėjui ir kokie 
duomenys reikalingi tyrimui atlikti, be to, pateikiami statistiniai metodai (parametriniai ir ne), 
kuriais reikėtų tokį ryšį tirti. 7.4.3 skyriuje rasite analizės su SPSS pavyzdį.

7.2 lentelė. Ryšio tarp kintamųjų tyrimas.

Kas tiriama? Ar yra ryšys tarp amžiaus ir patiriamo streso? Ar patiriama daugiau streso 
esant vyresnio amžiaus?

Kokių duomenų reikia? Dviejų intervalų skalėje išmatuotų kintamųjų (pvz., amzius ir bendras 
patiriamas stresas)

Parametriniai kriterijai: Pirsono koreliacijos koeficientas
Neparametriniai kriterijai: Spirmeno koreliacijos koeficientas

7.1.3. Tiesinė regresinė analizė

Tiesinės priklausomybės tarp kintamųjų stiprumą parodo koreliacijos koeficientas, o regre-
sinė analizė nustato, kaip keisis priklausomo kintamojo vidutinės reikšmės nuo nepriklausomo 
(priežasties) kintamojo reikšmių. 

Regresijos modeliai dažnai taikomi prognozei. Regresinės analizės prognozės yra kiekybinės. 
Regresijos funkcija aprašomas priklausomo kintamojo vidurkio priklausomumas nuo priežasties 
kintamojo reikšmių kitimo. Svarbiausias regresinės analizės pranašumas yra tas, kad kintamųjų ry-
šys aprašomas matematine formule, leidžiančia prognozuoti priklausomo kintamojo reikšmes.

 
7.3 lentelė. Regresinės analizės taikymas.

Kas tiriama? Tiriama, kaip pasitenkinimą gyvenimu lemia amžius? Ką galime 
prognozuoti apie pasitenkinimą gyvenimu 30-mečiams?

Kokių duomenų reikia? l	 Vieno priklausomo intervalų skalėje išmatuoto kintamojo (pvz., 
pasitenkinimas gyvenimu);

l	 Vieno nepriklausomo intervalų skalėje išmatuoto kintamojo (pvz., 
amzius)

Parametriniai kriterijai: Tiesinė regresinė analizė
Neparametriniai kriterijai: Nėra

7.3 lentelėje yra paaiškinta, koks klausimas rūpi tyrėjui ir kokie duomenys reikalingi tyrimui 
atlikti, be to, pateikiami statistiniai metodai (parametriniai ir ne), kuriais reikėtų tokį ryšį tirti. 
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7.4.4 skyriuje yra pateiktas analizės su SPSS pavyzdys.

7.1.4. Daugialypė regresinė analizė

Daugialypė regresinė analizė taikoma tada, kai nepriklausomų intervalinių kintamųjų yra 
daugiau nei vienas. Iš anksto turime nuspręsti, kurį intervalinį kintamąjį prognozuosime (jis bus 
priklausomas kintamasis) ir pagal kuriuos intervalinius kintamuosius (jie bus nepriklausomi).

Taip pat reikėtų atkreipti dėmesį į regresinės analizės grėsmes:

l	Multikolinearumas, kai nepriklausomi kintamieji yra labai susiję, šis ryšys gali būti labai  
	 iškreiptas. Tai parodo VIF (variance inflation index): turi būti <4 arba tolerancija >0,25.  
	Š ią problemą galima išspręsti pašalinus vieną iš susijusių kintamųjų arba reikia didinti imtį.

l	Autokoreliacija, kai tiriama, ar kintamasis susijęs su prieš tai ėjusiu. Durbin-Watson  
	 kriterijus taikomas autokoreliacijai tarp kintamųjų patikrinti. Autokoreliacija aktuali tik  
	 tiriant laikinus duomenis – kasdienį biržos indekso kitimą, savaitinį kraujospūdį vartojant 
	  paskirtus vaistus ir pan.

l	Liekamųjų paklaidų analizė. Liekamosios paklaidos turi būti nepriklausomos. 
	 Homoskedastiškumo prielaida (tam tikra duomenų tolygumo charakteristika) tikrinama 
	 White testu.

7.4 lentelėje yra paaiškinta, koks klausimas rūpi tyrėjui ir kokie duomenys reikalingi tyrimui 
atlikti, be to, rekomenduojamas statistinis metodas, kuris tiktų. 7.4.5 skyriuje yra pateiktas ana-
lizės su SPSS pavyzdys.

7.4 lentelė. Daugialypės regresinės analizės taikymas.

Kas tiriama? Tiriama, kaip pasitenkinimą gyvenimu lemia patiriamas stresas, 
amžius, optimizmas? Kuris iš šių kintamųjų geriausiai tinka prognozuoti 
pasitenkinimą gyvenimu?

Kokių duomenų reikia? l	Vieno priklausomo intervalų skalėje išmatuoto kintamojo (pvz., 
pasitenkinimą gyvenimu);

l	 Dviejų ar daugiau nepriklausomų intervalų skalėje išmatuotų kintamųjų 
(pvz., patiriamas stresas, amžius, optimizmas)

Parametriniai kriterijai: Daugialypė regresinė analizė
Neparametriniai kriterijai: Nėra
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7.2. Skirtumų tarp grupių tyrimo metodai

Statistinė analizė gali būti naudojama, kai reikia nustatyti, ar yra statistiškai reikšmingas skir-
tumas tarp kelių grupių. Dauguma šių analizių lygina grupių vidurkius. Keli metodai yra trum-
pai aprašyti šiame skyriuje.

7.2.1. Stjudento t kriterijus nepriklausomoms imtims 

T-testai yra naudojami, kai turite dvi grupes (pvz., vyrų ir moterų) arba du duomenų rinkinius 
(prieš ir po) ir norite palyginti tolydžiojo kintamojo vidurkius. Yra du pagrindiniai t-testų tipai: 

l	Poriniai t-testai (pakartotiniai) yra naudojami, kai tiriami tos pačios imties pokyčiai įverti- 
	 nant ją pirmą kartą, o tada antrą kartą po tam tikro įsikišimo. Tyrimo duomenys poriniai,  
	 nes tyrime dalyvauja tie patys respondentai.

l	Nepriklausomi t-testai yra naudojami analizei, jei yra dvi skirtingos (nepriklausomos)  
	 grupės (pvz., vyrų ir moterų) ir reikia jas lyginti. Šiuo atveju tiriama informacija vienam  
	 atsitiktiniam dydžiui, bet dviem skirtingoms grupėms. Stjudento t kriterijus taikomas  
	 nepriklausomoms imtims, kai norime palyginti dviejų nepriklausomų grupių vidurkius.

7.5 lentelėje yra paaiškinta, koks klausimas rūpi tyrėjui ir kokie duomenys reikalingi tyrimui 
atlikti, be to, rekomenduojami statistiniai metodai (parametriniai ir ne), kuriais reikėtų tokį ryšį 
tirti. 7.4.7 skyriuje yra pateiktas analizės su SPSS pavyzdys.

7.5 lentelė. Stjudento t kriterijus nepriklausomoms imtims.

Kas tiriama? Tiriama ar vyrai labiau patenkinti gyvenimu nei moterys?
Kokių duomenų reikia? l	 Vieno nepriklausomo kategorinio (tik dvi grupės) kintamojo (pvz., lytis: 

vyrai / moterys);
l	 Vieno priklausomo intervalų skalėje išmatuoto kintamojo  

(pvz., pasitenkinimas gyvenimu)
Parametriniai kriterijai: Stjudento t kriterijus
Neparametriniai kriterijai: Mann-Whitney testas

7.2.2. Vienfaktorinė dispersinė analizė ANOVA

Vienfaktorinė dispersinė analizė – tai Stujdento t kriterijaus apibendrinimas keletui nepri-
klausomų imčių. Taigi, jei turite kelias (arba keliolika) nepriklausomas grupes (nepriklausomi 
kintamieji) ir norite patikrinti, kaip skiriasi šios grupės viena nuo kitos tik pagal vieną požymį 
(priklausomą kintamąjį), reikės taikyti vienfaktorinę dispersinę analizę, kuri sutrumpintai daž-
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nai užrašoma ANOVA (ANalysis Of VAriance). ANOVA padės išsiaiškinti, ar grupių vidurkiai 
statistiškai reikšmingai skiriasi, tačiau ji neparodys, kurių grupių skirtumas yra reikšmingas (ar 
gr1 ir gr3, gr1 ar gr3 ir t. t.). Tuomet reikės atlikti post-hoc palyginimus (daugkartinį lyginimą), 
kurie parodo, kurios grupės reikšmingai skiriasi viena nuo kitos. ANOVA procedūra galima: pa-
tikrinti hipotezę apie dispersijų lygybę, gauti ANOVA lentelę ir statistinius rezultatus, grafiškai 
pavaizduoti grupių vidurkius (vidurkių trendai).

7.6 lentelėje yra paaiškinta, koks klausimas rūpi tyrėjui ir kokie duomenys reikalingi tyrimui 
atlikti, be to, rekomenduojami statistiniai metodai (parametriniai ir ne), kuriais reikėtų tirti, ar 
grupių vidurkiai statistiškai reikšmingai skiriasi. 7.4.9 skyriuje yra pateiktas analizės su SPSS 
pavyzdys. 

7.6 lentelė. Vienfaktorinės dispersinės analizės taikymas.

Kas tiriama? Tiriama, ar pasitenkinimas gyvenimu trijose amžiaus grupėse 
(jaunimas, vidutinio amžiaus ir pagyvenę) yra skirtingas?

Kokių duomenų reikia? l	 Vieno nepriklausomo kategorinio kintamojo  
(pvz., amgr3: 1 – jaunimas, 2 – vidutinio amžiaus ir 3 – pagyvenę);

l	 Vieno priklausomo intervalų skalėje išmatuoto kintamojo 
	 (pvz., pasitenkinimas gyvenimu)

Parametriniai kriterijai: ANOVA
Neparametriniai kriterijai: Kruskal-Wallis testas

Pastaba. Kam reikalinga ANOVA, jeigu visus grupių vidurkius galima palyginti poromis 
t-testu? Problema ta, kad visos statistinės išvados yra ne šimtaprocentinės, o tik labai tikėti-
nos (95 proc.). Taigi atliekant kiekvieną tyrimą, visada yra nedidelis šansas apsirikti. Kai ty-
rimų daug, galimos tikimybės klaidos kaupiasi ir šansas bent kartą priimti klaidingą sprendi-
mą didėja. Todėl geriau viena ANOVA penkiems vidurkiams palyginti, nei 9 lyginimai t-testu.
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7.3. Užduotys

Parinkite tyrimui statistinį metodą 

1 užduotis. Medikas, rašantis disertaciją, tyrė trijose ligoninėse, kaip pacientai gydomi po 
vienodų operacijų. Pirmoje ligoninėje pacientai po operacijos vidutiniškai praleidžia savaitę 
ir gydymas yra visiškai baigtas, antroje vidutiniškai praleidžia šešias dienas ir pacientui rei-
kia grįžti patikrai, trečioje vidutiniškai praleidžia dvi dienas ir toliau gydomasi ambulatoriškai. 
Pacientai gydymą vertino balais. Kaip nustatyti, ar kuris nors gydymas davė statistiškai reikš-
mingai daugiau naudos nei kiti?

2 užduotis. Gamykla, gaminanti ginklus, nori išsiaiškinti, kaip kariai vertina (pagal 100 balų 
skalę) povandenius automatus APS. Penkioms skirtingoms karių grupėms buvo pasakytos skir-
tingos kainos. Kaip nustatyti, ar kainai didėjant, karių nuomonė apie ginklus gerėja (brangus – 
vadinasi, geras)?

3 užduotis. Matuojamas laikas reikalingas specialiai karinei užduočiai atlikti. Tirti keturi bū-
riai. Pirmas būrys prieš užduotį tobulino šaudymo įgūdžius, antras būrys tobulino taktiką, tre-
čias tobulino taktiką ir šaudymo įgūdžius, ketvirtas nusprendė pailsėti ir pataupyti jėgas užduo-
čiai atlikti. Kaip nustatyti, ar kuris nors pasiruošimas karinei užduočiai atlikti davė statistiškai 
reikšmingai daugiau naudos?

4 užduotis. Medikai tyrė kraujo spaudimo ir insulto rizikos balo priklausomybę. Kaip galima 
prognozuoti pacientui, kurio kraujo spaudimas 190, insulto rizikos balą?

5 užduotis. Banko vadovai ištyrė skirtingų banko klientų praleistą laiką tvarkant panašius fi-
nansinius verslo reikalus trijuose skirtinguose banko filialuose. Kaip nustatyti, ar banko kliento 
praleistas laikas tvarkant finansinius verslo reikalus yra susijęs su banko filialu?

6 užduotis. Ištyrus šeimas dėl bendro patiriamo streso, buvo surinkti duomenys. Tyrime da-
lyvavo šeimos, kuriose buvo vaikų ir kuriose jų nebuvo. Kaip nustatyti, ar šeimos, kurios turi 
vaikų, ir tos, kurios jų neturi, patiria skirtingai streso?

7 užduotis. Šešiasdešimt karių buvo suskirstyti į dvi grupes, visiems buvo vesti standartiniai 
mokymai su 5,45 mm automatu AKSU-74. Papildomai 1-a grupė buvo mokoma rengiant speci-
alias pratybas poligone; 2-a grupė atliko papildomas užduotis be papildomų priemonių. Po kur-
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sų abi grupės buvo egzaminuojamos ir vertinamos. Kaip nustatyti, ar mokymai davė skirtingą 
rezultatą?

8 užduotis. Sveikatos ministerija tyrė, kaip vyrai ir moterys vertina rūkymo žalą sveikatai. 
Respondentai išreiškė savo nuomones apie rūkymą Laikerto skalėje (1 – visiškai nepritariu, 2, 
3, 4, 5 – visiškai pritariu). Kaip nustatyti, ar vyrai skiriasi nuo moterų vertindami rūkymo žalą?

9 užduotis. Per karines pratybas instruktoriai kariams duoda įvairių šaudymo užduočių, ku-
rias atlikdami kariai patiria vis didesnį stresą. Kaip nustatyti, ar yra ryšys tarp pataikymų skai-
čiaus ir patiriamo streso? 

10 užduotis. Vyksta plaukimo varžybos, kuriose dalyvauja jaunuoliai, turintys skirtingus 
plaukimo įgūdžius. Kaip nustatyti, ar pasiekiami geresni plaukimo rezultatai esant geresniems 
plaukimo įgūdžiams?

11 užduotis. Būrio vadas tyrė karių pratybose praleisto laiko ir šaudymo balo priklausomybę. 
Kaip galima prognozuoti kariui, kuris pratybose praleido 30 valandų, šaudymo balą?

12 užduotis. Viename iš Lietuvos kariuomenės padalinių buvo atliktas vado lyderio vaid-
mens tiksliniame vadovavime tyrimas. Kaip nustatyti, ar pasiekiami geresni vadovavimo rezul-
tatai esant ilgesniam tarnybos stažui?

13 užduotis. Viename iš Lietuvos kariuomenės padalinių buvo atliktas vado lyderio vaid-
mens tiksliniame vadovavime tyrimas. Tyrime dalyvavo skyrių, būrių ir kuopų vadai. Kaip nu-
statyti, ar pasiekti geresni vadovavimo rezultatai yra susiję su užimamomis pareigomis?

14 užduotis. Viename iš Lietuvos kariuomenės padalinių buvo atliktas tyrimas, kurio tiks-
las – išsiaiškinti, kaip būrių ir kuopų vadai vertina profesinių įgūdžius vykdant karines užduotis. 
Respondentai reiškė savo nuomones apie profesinę patirtį pagal Laikerto skalę (1 – visiškai ne-
pritariu, 2, 3, 4, 5 – visiškai pritariu). Kaip nustatyti, ar būrių vadai skiriasi nuo kuopų vadų ver-
tindami įgūdžius, tiesiogiai susijusius su darbu?



S t a t i s t i n i ų  m e t o d ų  p a r i n k i m a s  t y r i m u i 151

7.4. Statistinių tyrimų taikymo su SPSS pavyzdžiai

Šiame skyriuje rasite statistinių tyrimų, atliktų su SPSS programų paketu, taikymo pavyz-
džių. Suprasite Chi kvadrato kriterijaus, koreliacijos, tiesinės regresinės analizės, nepriklauso-
mų imčių Stjudento t kriterijaus irANOVA taikymo tikslus. Susipažinsite su statistinėmis len-
telėmis ir grafine duomenų analize, kurią pateiks SPSS programų paketas. Išmoksite analizuoti 
gautas lenteles ir daryti statistines išvadas. Skyrius yra labai didelis, tad kiekvieno poskyrio pa-
baigoje pateikiamos praktinės užduotys, kurios padės lavinti įgūdžius, kuriuos galėsite pritaiky-
ti atlikdami savo tyrimus.

7.4.1. Požymių dažnių lentelių naudojimas

Išnagrinėkime Chi kvadrato kriterijaus taikymą statistiniuose tyrimuose, kaip vieną iš dauge-
lio statistinių metodų požymių ryšiui nustatyti. Šiuo kriterijumi nereikėtų remtis, kai stebėjimų
skaičius yra mažesnis nei 30, nes analizės rezultatai gali būti nepatikimi.  kriterijų galima tai-
kyti ir 2×2, ir didesnėms lentelėms. 

7.7 lentelė. Anketos pavyzdys.

Anketa
 
Anketos numeris  (pildo tyrėjas)

1. Lytis (užbraukite reikalingą kvadratą)
	 ¨	 Vyras
	 ¨	 Moteris
2. Ar pritariate, kad rūkymas kenkia sveikatai?
	 ¨	 Visiškai pritariu
	 ¨	 Neturiu nuomonės
	 ¨	 Visiškai nepritariu

Išnagrinėsime pavyzdį. Tirsime, kaip vyrai ir moterys vertina rūkymo žalą sveikatai, ir at-
sakysime į tyrėją dominantį klausimą: „Ar vyrai skiriasi nuo moterų vertindami rūkymo žalą?“ 
(Tą patį klausimą galima suformuluoti ir šitaip: „Ar požiūris į rūkymo žalą priklauso nuo res-
pondento lyties?“) 

Chi kvadratas yra kriterijus, kuris padės ištirti, ar toks pats procentas vyrų ir moterų rinkosi 
atitinkamą atsakymą. Jeigu ne, tai prasideda interpretacijos – va, matote, vyrai skiriasi nuo mote-
rų. Tai yra požiūris į rūkymą susijęs su atsakinėjusiojo lytimi (lytis ir požiūris priklausomi). Bet 
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čia tik procentų nesutapimo interpretacija ir nieko daugiau. 
Jei nėra jokio ryšio tarp lyties ir rūkymo žalos sveikatai vertinimų, reikėtų tikėtis, kad tiek 

neigiamą nuomonę išreiškusių, tiek teigiamą nuomonę pasirinkusių vyrų ir moterų procentai 
(arba dalys) bus maždaug vienodi. 

Suformuluokime hipotezę. Hipotezė Ho teigia, kad vyrai ir moterys vienodai vertina rūky-
mo žalą sveikatai. Alternatyva H1 – kad vyrai ir moterys nevienodai vertina rūkymo žalą svei-
katai.

Hipoteze Ho: rūkymo žalos vertinimas sveikatai nepriklauso nuo lyties;

Hipoteze H1: rūkymo žalos vertinimas sveikatai priklauso nuo lyties.

Tyrimui reikiami duomenys buvo surinkti apklausus 40 atsitiktinai parinktų vyrų ir 40 atsi-
tiktinai parinktų moterų (stebėjimų skaičius 80>30). Visi respondentai atsakė į pateiktą klausi-
mą ir nurodė savo lytį. Anketos pavyzdys pateiktas 7.7 lentelėje. Tyrimą atliksime SPSS pro-
gramų paketu. Pirma, aprašysime kintamuosius Variable View lange, tada įrašysime duome-
nis duomenų redaktoriaus lange Data View ir atliksime tyrimą pasirinkę pagrindiniame meniu  
Analyze->Descriptive Statistics->Crosstabs.

7.1 pav. SPSS programų paketo Variable View lange aprašyti kintamieji.

7.2 pav. SPSS programų paketo Data View lange surašyti duomenys.
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7.3 pav. SPSS programų paketo pagrindiniame meniu pasirinkę  
Analyze->Descriptive Statistics->Crosstabs atidarome Crosstabs langą.

Įkelsime į laukelį Colum(s) kintamąjį Klausimas (atsakymų į klausimą duomenis), o į laukelį 
Row(s) – kintamąjį lytis, nurodantį respondentų priklausomybę konkrečiai populiacijai. Galima 
ir atvirkščiai, bet nurodytas variantas yra įprastas. Į laukelius Colum(s) ir Row(s) galima iškart 
įkelti po kelis kintamuosius, t. y. grupuojant juos pagal populiacijas ir kintamųjų stebėjimus po-
puliacijose. 

Kiekvienam dviejų kintamųjų deriniui bus sukurta atskira dažnių lentelė. Pavyzdžiui, jeigu 
Row(s) sąraše yra du kintamieji, o Colum(s) sąraše – trys kintamieji, tai gausime 3*2 = 6 dažnių 
lenteles. Šiuo konkrečiu atveju šitaip ir bus.

Išdėlioję kintamuosius Crosstabs lange, pasirenkame Statistics. Tai langas, kuriame turė-
sime pasirinkti statistinį kriterijų, kuris padės įvertinti kintamųjų ryšį. Renkamės Chi-square, 
tada Continue.
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7.4 pav. Crosstabs lange pasirenkame Statistics.

Crosstabs: Statistics lange yra ir daugiau numatytų statistinių rodiklių, skirtų požymių pri-
klausomumui įvertinti. Tarkime, nustatėme, kad lytis ir požiūris į rūkymą yra susiję. Natūralus 
klausimas – kaip tvirtai susiję? Kuo kiekvieno rodiklio reikšmė didesnė, tuo priklausomybė stip-
resnė. Vis dėlto šie rodikliai naudojami retai, be to, jų daug, nes nėra vieno geresnio už kitus (visi 
turi trūkumų). Trumpai su jais susipažinkime.

Vardų skalės kintamųjų ryšio tvirtumo matai

l	Phi – φ koeficientas skaičiuojamas  pagrindu eliminuojant imties dydžio įtaką.  
	N audojamas tada, kai duomenys aprašomi keturlaukėmis (2x2) kontingencijos lentelėmis, 
	 t. y. taikomas binariniams kintamiesiems. Jei didesnės lentelės, didžiausia φ reikšmė  
	 priklauso nuo lentelės dydžio ir gali viršyti 1. 

l	Contingency Coefficient – kontingencijos koeficientas yra φ modifikacija, pritaikyta dides- 
	 nėms kontingencijos lentelėms. Kai kurie tyrėjai rekomenduoja šį koeficientą taikyti 5x5 ir 
	 didesnėms lentelėms. 

l	Cramer’s V – Kramerio V koeficientas yra dažniausiai naudojamas vardinių kintamųjų ryšio 
	 matas, skaičiuojamas remiantis . Jis nepriklauso nuo lentelės dydžio, kai eilučių skaičius 
	 lygus stulpelių skaičiui. Keturlaukių lentelių Kramerio V koeficientas sutampa su φ  
	 koeficientu.



S t a t i s t i n i ų  m e t o d ų  p a r i n k i m a s  t y r i m u i 155

Ranginių kintamųjų ryšio matai

SPSS yra pateikiami du Kendallo ranginės koreliacijos koeficiento skaičiavimo variantai:

l	Kendallo tau-b koeficientas dažniausiai naudojamas keturlaukėms (2x2) lentelėms, 

l	Kendallo tau-c koeficientas naudojamas didesnėms negu 2x2 dimensijų lentelėms. 

7.5 pav. SPSS programų paketo langas Crosstabs:Cell Display.

Tęskime tyrimą. Norėčiau atkreipti dėmesį į tai, kad įkėlus į laukelį Row(s) kintamąjį, nuro-
dantį respondentų priklausomybę konkrečiai populiacijai (lytis), paprastai užtenka Crosstabs: 
Cell Display lange pažymėti Row laukelį – turėsime kiekvieno atsakymo procentinę dalį kiek-
vienai populiacijai ir to pakaks aprašomajai analizei atlikti. Po šių žingsnių SPSS išvesties lan-
ge, statistinėse lentelėse, pateiks išsamią informaciją. 

7.8 lentelė. Analizuojamų duomenų suvestinė.

Case Processing Summary
Cases

Valid Missing Total
N Percent N Percent N Percent

lytis * Ar pritariate, kad rukymas kenkia sveikatai? 80 100.0% 0 0.0% 80 100.0%
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Case Processing Summary 7.8 lentelė rodo, kad visi respondentai į klausimą teikėsi atsaky-
ti. Tačiau šitaip būna ne visada. Kai labai daug respondentų neatsako, kyla abejonių apie statis-
tinio tyrimo išvadų teisingumą visai populiacijai. 

7.9 lentelė. Duomenų analizės rezultatas.

lytis * Ar pritariate, kad rukymas kenkia sveikatai? Crosstabulation
Ar pritariate kad rukymas kenkia sveikatai?

Total
visiskai pritariu neturiu nuomones visiskai nepritariu

lytis
vyras

Count 17 12 11 40
% within lytis 42.5 % 30.0 % 27.5 % 100.0 %

moteris
Count 37 3 0 40
% within lytis 92.5 % 7.5 % 0.0 % 100.0 %

Total
Count 54 15 11 80
% within lytis 67.5 % 18.8 % 13.8 % 100.0 %

Crosstabulation lentelė (7.9) padės išsiaiškinti, ar vyrų nuomonė apie rūkymą skiriasi nuo 
moterų. Šios lentelės pradžioje pažiūrime, kaip atsakė vyrai. Visiškai pritaria 42,5 proc., neturi 
nuomonės 30 proc. ir visiškai nepritaria 27,5 proc. vyrų. Taigi kiek mažiau nei pusė vyrų visiš-
kai pritaria teiginiui apie rūkymo žalą.

7.10 lentelė. Tiriamosios statistikos lentelė.

Chi-Square Tests
Value df Asymp. Sig. (2-sided)

Pearson Chi-Square 23.807a 2 .000
Likelihood Ratio 28.618 2 .000
Linear-by-Linear Association 22.656 1 .000
N of Valid Cases 80
a. 0 cells (0.0 %) have expected count less than 5. The minimum expected count is 5.50.

Dabar pažiūrėkime, kaip atsakinėjo moterys. Net 92,5 proc. moterų pritaria teiginiui, kad rū-
kymas kenksmingas, o visiškai nepritariančių iš viso nėra. Skirtumas tarp vyrų ir moterų požiū-
rių akivaizdus. Tai yra požiūris į rūkymą susijęs su atsakinėjusiojo lytimi. Belieka išsiaiškinti, ar 
šis skirtumas yra statistiškai reikšmingas, t. y. ar jis neatsitiktinis.

Lentelėje „Chi-Square Tests“ yra pateiktos  kriterijaus reikšmės (stulpelyje Value) ir ati-
tinkamos p reikšmės (stulpelyje Asymp. Sig.). Tarkime, kad pasirinkome reikšmingumo lygmenį  
α = 0,05, t. y. nusistatėme sau leistiną 5 proc. klaidingų išvadų limitą. Kadangi Pirsono Chi kva-
drato kriterijui suskaičiuota p = 0,000< 0,05, tai darome išvadą, kad vyrų ir moterų požiūris į rūky-
mo žalą skiriasi statistiškai reikšmingai. Rūkymo žalos vertinimas sveikatai priklauso nuo lyties. 
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7.6 pav. Rūkymo žalos vertinimo sveikatai duomenų analizės grafikas.

Kas atsitiktų, jeigu Crosstabs: Cell Display lange (7.5 pav.) vietoje Row pažymėtume 
Column? Tada gautume atsakymą į klausimą, kiek procentų tarp visiškai pritariančių sudaro 
vyrai (31,5 proc.). Kiek procentų tarp neturinčių nuomonės sudaro vyrai (80 proc.) ir kiek pro-
centų tarp visiškai nepritariančių sudaro vyrai (100 proc.).

Šie procentai gali būti nepagrįstai dideli, jeigu imtyje daug vyrų (mūsų atveju taip nėra). 
Įsivaizduokite situaciją, kai imtyje 960 vyrų ir 40 moterų. Tada be vargo įsitikinsime, kad ir 
tarp pritariančių, ir tarp nepritariančių vyrų daugiau. Ir apskritai vyrai sudaro 96 proc. tiria-
mųjų.
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7.11 lentelė. Duomenų analizės rezultatas.

lytis * Ar pritariate kad rukymas kenkia sveikatai? Crosstabulation
Ar pritariate kad rukymas 

kenkia sveikatai?
Total

pilnai 
pritariu

neturiu 
nuomones

visiskai 
nepritariu

lytis

vyras
Count 17 12 11 40
% within 
Ar pritariate, kad rukymas kenkia sveikatai? 31.5 % 80.0 % 100.0 % 50.0 %

moteris
Count 37 3 0 40
% within 
Ar pritariate, kad rukymas kenkia sveikatai? 68.5 % 20.0 % 0.0 % 50.0 %

Total
Count 54 15 11 80
% within 
Ar pritariate, kad rukymas kenkia sveikatai? 100.0 % 100.0 % 100.0 % 100.0 %

Dažnių lentelėje Crosstabulation pagal mūsų nustatymą atsakymai į klausimą įrašyti į ats-
kirus stulpelius, o respondentų populiacijos – į atskiras eilutes. Kiekviename lentelės langelyje 
yra įrašytas stebėjimų skaičius (pasirodymo dažnis) – Count, o Total eilutėje ir stulpelyje – ati-
tinkamai eilučių ir stulpelių reikšmių sumos.

Kadangi pažymėjome dialogo langelio Crosstabs: Cell Display laukelį Column, kiekviena-
me lentelės langelyje yra įrašyta taip pat atsakymų skaičiaus procentinė kiekvienos populiaci-
jos dalis.
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7.4.2. Užduotys 

Išnagrinėkite požymius, kuriuos sudaro daugiau nei dvi kategorijos. 

1 užduotis. Patikrinkite hipotezę, ar šeiminė padėtis turi įtakos patiriant stresą jaunesnio am-
žiaus respondentams. Atsakykite į klausimą: „Ar yra priklausomybė tarp streso patiriamo jau-
nesnio amžiaus lyties ir šeiminės padėties?“ Tyrimui naudokite duomenis Streso tyrimas. sav. 
Naudokite kintamuosius: lytis (išrinkite tyrimui respondentus tik 18–29 amžiaus, panaudokite 
kintamąjį amgr3) ir seima. Pasirinkite reikšmingumo lygmenį α = 0,05.

2 užduotis. Patikrinkite hipotezę, ar amžiaus grupė turi įtakos vaikų skaičiui. Atsakykite 
į klausimą: „Ar vaikų skaičius priklauso nuo amžiaus grupės?“ Tyrimui naudokite duomenis 
Streso tyrimas. sav. Naudokite kintamuosius: vaikai ir amgr5. Pasirinkite reikšmingumo lyg-
menį α = 0,05.

3 užduotis. Patikrinkite hipotezę, ar išsilavinimas turi įtakos vaikų skaičiui. Atsakykite į klau-
simą: „Ar vaikų skaičius priklauso nuo išsilavinimo?“ Tyrimui naudokite duomenis Streso tyri-
mas. sav. Naudokite kintamuosius: vaikai ir mokslai. Pasirinkite reikšmingumo lygmenį α = 0,05.

4 užduotis. Patikrinkite hipotezę, ar šeiminė padėtis turi įtakos išsilavinimui. Atsakykite į 
klausimą: „Ar vaikų skaičius priklauso nuo šeiminės padėties?“ Tyrimui naudokite duomenis 
Streso tyrimas. sav. Naudokite kintamuosius: vaikai ir seima. Pasirinkite reikšmingumo ly-
gmenį α = 0,05.

5 užduotis. Patikrinkite hipotezę, ar amžius turi įtakos bendriems vado gebėjimams. 
Atsakykite į klausimą: „Ar gebėjimų skaičius priklauso nuo amžiaus?“ Tyrimui naudokite duo-
menis Vado vaidmuo. sav. Naudokite kintamuosius: Bvadgeb_K9 ir amzius. Pasirinkite reikš-
mingumo lygmenį α = 0,05.

6 užduotis. Patikrinkite hipotezę, ar išsilavinimas turi įtakos bendriems padalinio tikslams ir 
uždaviniams. Atsakykite į klausimą: „Ar bendri padalinio tikslai priklauso nuo išsilavinimo?“ 
Tyrimui naudokite duomenis Vado vaidmuo. sav. Naudokite kintamuosius: Bpadalinys_K11 ir 
issilavinimas. Pasirinkite reikšmingumo lygmenį α = 0,05.
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7 užduotis. Žemiau pateikti anketos klausimai, į kuriuos atsakė 50 respondentų, o lentelė-
je yra atsakymų suvestinė. Atlikite šių duomenų analizę su SPSS. Atsakykite į šiuos klausimus:

1.	Ar automobilio spalvos pasirinkimas priklauso nuo lyties?

2.	Ar automobilio paieškos būdai priklauso nuo lyties?

3.	Ar automobilio paieškos būdai priklauso nuo amžiaus grupės?

4.	Ar automobilio spalvos pasirinkimas priklauso nuo amžiaus grupės?

Duomenų analizę atlikite tokia tvarka:

l	lentelėje pateiktus duomenis įrašykite į SPSS programų paketo langą ir išsaugokite;

l	kintamąjį amzius suskirstykite į grupes: 1 – nuo 20–30 metų; 2 – nuo 31–50 metų; 3 – 51 
	 metų ir daugiau. Suskirstę visus respondentus į tris vienodo dydžio grupes, sukurkite  
	 naują kintamąjį amgr3;

l	 suformuluokite hipotezes H0 ir H1 bei kintamųjų statistinį ryšį, įvertinkite pagal Chi  
	 kvadrato kriterijų. Pasikliovimo lygmenį pasirinkite α = 0,05;

l	 rezultatus pateikite lentelėse ir pavaizduokite diagramomis;

l	 suformuluokite aprašomąją ir tiriamąją išvadas.

Anketa

K1. Prieš pradėdamas karo tarnybą Jūs: 
(PAŽYMĖKITE ATSAKYMUS KIEKVIENOJE  
EILUTĖJE)

Taip Ne
1.1 Studijavote 1 2
1.2 Dirbote 1 2
1.3 Kita (PARAŠYKITE)

K2. Kada išėjote į atsargą?  
(PARAŠYKITE)

 metais 

K3. Ar sužinojęs, kad būsite išleistas į atsargą,  
ėmėtės kokių nors priemonių darbui susirasti?
¨	 TAIP 
¨	 NE

K4. Jūsų lytis:
¨	 vyras
¨	 moteris
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Tyrimo duomenys

ID K1 K2 K3 K4 ID K1 K2 K3 K4
1. 1.1 2011 TAIP vyras 26. 1.2 2012 NE moteris
2. 1.3 2014 TAIP vyras 27. 1.2 2010 NE moteris
3. 1.3 2012 TAIP vyras 28. 1.1 2015 TAIP vyras
4. 1.3 2011 NE moteris 29. 1.1 2011 TAIP vyras
5. 1.3 2015 NE moteris 30. 1.1 2006 TAIP vyras
6. 1.3 2010 TAIP vyras 31. 1.2 2009 NE vyras
7. 1.3 2012 TAIP vyras 32. 1.2 2008 NE moteris
8. 1.2 2010 TAIP vyras 33. 1.2 2012 NE moteris
9. 1.3 2010 NE moteris 34. 1.2 2012 TAIP vyras
10. 1.3 2011 NE moteris 35. 1.3 2011 TAIP vyras
11. 1.3 2011 NE moteris 36. 1.3 2012 TAIP moteris
12. 1.3 2015 NE moteris 37. 1.3 2014 NE moteris
13. 1.3 2012 TAIP moteris 38. 1.3 2014 TAIP vyras
14. 1.3 2011 TAIP vyras 39. 1.3 2012 NE vyras
15. 1.3 2012 NE moteris 40. 1.3 2012 NE moteris
16. 1.3 2012 NE moteris 41. 1.3 2015 NE moteris
17. 1.3 2014 TAIP moteris 42. 1.1 2010 TAIP moteris
18. 1.3 2012 TAIP vyras 43. 1.1 2011 TAIP vyras
19. 1.2 2011 NE moteris 44. 1.1 2012 NE moteris
20. 1.2 2010 NE moteris 45. 1.2 2015 NE moteris
21. 1.2 2012 TAIP moteris 46. 1.2 2010 TAIP moteris
22. 1.1 2009 TAIP vyras 47. 1.2 2012 TAIP vyras
23. 1.1 2010 NE moteris 48. 1.2 2015 NE moteris
24. 1.1 2011 NE moteris 49. 1.3 2015 NE moteris
25. 1.1 2012 NE vyras 50. 1.3 2014 NE moteris

8 užduotis. Patikrinkite hipotezę, ar išsilavinimas turi įtakos užimamoms pareigoms. 
Atsakykite į klausimą: „Ar užimamos pareigos priklauso nuo išsilavinimo?“ Tyrimui naudokite 
duomenis Vado vaidmuo.sav. Naudokite kintamuosius: issilavinimas ir pareigos. Pasirinkite 
reikšmingumo lygmenį α = 0,05.
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7.4.3. Koreliacijos taikymas

SPSS programų paketas siūlo daug statistinių kintamųjų ryšio matavimo metodų. Pirsono ko-
reliacija yra vienas iš metodų, kuris naudojamas tiesinei priklausomybei tarp dviejų (gali būti ir 
daugiau) intervalinių kintamųjų nustatyti. Koreliacijos koeficientas rodo dvi kintamųjų ryšio sa-
vybes – ryšio stiprumą ir ryšio kryptį. 

Prieš atliekant koreliacinę analizę, pirma, reikia grafiškai pavaizduoti duomenis. Kintamųjų 
reikšmių sklaidos grafikas leidžia patikrinti ryšio tiesiškumo prielaidas tarp kintamųjų. 

Tyrimui pailiustruoti pasinaudosime rinkmena Streso tyrimas.sav, kurios reikšmių kodavi-
mo lentelė ir klausimai pateikti priede. Tyrimo santrauka yra pateikta 7.11 lentelėje.

7.11 lentelė. Pirsono koreliacijos tyrimo santrauka

Kas tiriama? Ar yra ryšys tarp profesionalumo ir patiriamo streso kontrolės?  
Ar profesionalumas padeda kontroliuoti patiriamą stresą?

Kokių duomenų 
reikia?

Du kintamieji, išmatuoti intervalų skalėje: patiriamo streso kontrolė 
(Bstkon) ir profesionalumas (Bprof)

Ką išsiaiškinsime? Pirsono koreliacijos koeficientas parodys patiriamo streso kontrolės ir profe-
sionalumo ryšio tvirtumą ir ryšio kryptį. Paprasčiau tariant, ar galime teigti, 
kad šie kintamieji daro įtaką vienas kitam

Parametriniai kriterijai: Pirsono koreliacijos koeficientas
Neparametriniai kriterijai: Spirmeno koreliacijos koeficientas

Tyrimą padalysime į dvi dalis. Pirma, nubrėšime grafiką, o tada surasime Pirsono koreliaci-
jos koeficientą. 

Sklaidos grafiko braižymas

1 	 Pagrindinėje SPSS programų paketo meniu juostoje pasirinkite Graphs-> Scatter.
2 	 Pasirinkite Simple, tada Define.
3 	V ieną iš kintamųjų priskirkite Y ašiai. Pagal susitarimą kintamasis, priskirtas Y ašiai, 

		  visada bus priklausomas kintamasis. Šiame tyrime tai bus Bprof kintamasis.
4 	V ieną iš kintamųjų priskirkite X ašiai. Pagal susitarimą kintamasis, priskirtas X ašiai,  

		  visada bus nepriklausomas kintamasis. Šiame tyrime tai bus Bstkon kintamasis.
5 	L aukelyje Set Markers by įkelkite kintamąjį lytis, tada vyrų ir moterų duomenys bus  

		  pavaizduoti skirtinga spalva. 
6 	R inkitės Titles, jei norite grafikui suteikti pavadinimą.
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7 	 Pasirinkite Continue ir OK.

Po šios procedūros SPSS programų paketas sugeneruos grafiką, kuris yra parodytas 7.7 pav.
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7.7 pav. Ryšys tarp streso kontrolės ir profesionalumo.

Koreliacijos grafikas yra sklaidos diagrama (7. 7 pav.), kuri parodo kintamųjų skirstinių spe-
cifiką. Grafike galima pamatyti kintamųjų reikšmių išskirtis. Tai reikšmės, kurios yra pavienės, 
nutolusios nuo bendros reikšmių juostos. Kadangi tiriama Pirsono koreliacija, tiriamas tiesinis 
ryšys, tad reikia įsitikinti, ar galime nubrėžti tiesę per reikšmių klasterį. Jei per reikšmių klaste-
rį labiau tiktų nubrėžti lenktą liniją, tai tokiems duomenims Pirsono koreliacijos koeficientas ne-
skaičiuojamas, nes jie nėra susieti tiesiniu ryšiu. 

Sklaidos diagrama atskleidžia informaciją ir apie koreliacinio ryšio kryptį (neigiamas ar tei-
giamas). Taigi, jei nubrėžtumėte tiesę sklaidos diagramoje (7.7 pav.), ji iš kairės į dešinę kiltų 
aukštyn ir tai rodytų esant teigiamą ryšį tarp tiriamų kintamųjų. Paprasčiau tariant, kuo didesnės 
(mažesnės) reikšmės X ašyje tuo jas atitinka didesnės reikšmės (mažesnės) Y ašyje. Diagramoje 
(7.7 pav.) yra pavaizduotas tiesinis ryšys, o reikšmių išsidėstymas yra vidutinio pločio juostoje, 
kuri rodo ryšio stiprumą (nuo juostos pločio priklauso ryšio stiprumas). Kuo juosta siauresnė, 
tuo stipresnis ryšys (artėja prie 1 arba -1).

Įvertinę kintamųjų skirstinius pagal sklaidos diagramą (7.7 pav.), galime tikėtis, kad jie yra 
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susieti tiesinio teigiamo ir vidutinio stiprumo ryšiu, todėl galime apskaičiuoti Pirsono koreliaci-
jos koeficientą, kuris padės atsakyti į tyrimo klausimą „Ar profesionalumas padeda kontroliuo-
ti patiriamą stresą?“

Pirsono koreliacijos koeficiento skaičiavimas

1 	 Pagrindinėje SPSS programų paketo meniu juostoje pasirinkite 
		  Analyze->Correlate->Bivariate.
2 	 Pasirinkite du kintamuosius, išmatuotus intervalų skalėje Bstkon (patiriamo streso kontrolė)  

	 ir Bprof (profesionalumas), ir įkelkite juos į Variables langą. Kaip jau supratote, galima  
	 apskaičiuoti Pirsono koreliacijos koeficientą ir daugiau nei dviejų kintamųjų. Jei norėtumėte  
	 tirti tiesinį ryšį tarp daugiau kintamųjų, juos visus reikėtų sukelti į Variables langą. 

3 	 Pasirinkite Pearson ir Two tailed. Pasirinkus One-tailed tyrimą, įvertinama tik vienpusė 
 		  hipotezė.

4 	 Pasirinkite Options, tada bloke Statistics rinkitės Means and standard deviations;  
		  bloke For Missing Values rinkitės Exclude cases pairwise.

5 	 Pasirinkite Continue ir OK.

Po šios procedūros SPSS programų paketo išvesties lange bus pateikta statistinių reikšmių 
lentelė (7.13 lentelė.), kurioje Pirsono koreliacijos koeficientai išvardyti tarp kiekvienos kinta-
mųjų poros.

7.13 lentelė. Pirsono koreliacijos koeficientai.

Correlations
Bendras profesionalumas Bendra streso kontrolė

Bendras profesionalumas Pearson Correlation 1 ,521**

Sig. (2-tailed) ,000
N 436 429

Bendra streso kontrolė Pearson Correlation ,521** 1
Sig. (2-tailed) ,000
N 429 430

**. Correlation is significant at the 0.01 level (2-tailed).

Koreliacijos lentelė gali būti ir daug didesnė, jei pasirinksite ne du, bet keletą kintamųjų iš są-
rašo. Taip atsitinka dėl to, kad kiekvienai kintamųjų porai lentelėje surašoma: koreliacijos koe-
ficiento vertė, p reikšmė ir atvejų skaičius. 
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Kai SPSS programų paketo išvesties lange bus pateikta statistinių reikšmių lentelė (7.13 len-
telė), pirma, į ką reikia atkreipti dėmesį Correlations lentelėje (7.13 lentelė), yra p reikšmė 
(ji yra eilutėje Sig). p reikšmės dydis rodo, ar koreliacija statistiškai reikšminga (p < 0,05), 
ar nereikšminga (p >= 0,05). Jeigu koreliacija nėra reikšminga (priklausomybės neradome), 
tolesnis tyrimas nerekomenduotinas (nereikia aptarti nesamo ryšio). Iš lentelės matome, kad  
p = 0,000...<0,05. Todėl galime teigti, kad Btskon ir Bprof koreliuoja statistiškai reikšmingai.

Correlations lentelėje reikia atkreipti dėmesį į N reikšmę, kuri priklauso nuo to, ką pažymė-
jome Options lange. Jei būtume pasirinkę Exclude cases listwise, tai skaičiuojant Pirsono kore-
liacijos koeficientą visi (neporiniai) atvejai, kuriuose yra praleistų atsakymų, būtų išimti iš ana-
lizės, o tai, žinoma, iškraipytų tyrimo rezultatą.

Antra, į ką reikia atkreipti dėmesį Correlations lentelėje (7.13 lentelė), yra koreliacijos 
koeficiento ženklo reikšmė. Prieš interpretuodami gautą rezultatą, dar kartą patikrinkite, ku-
rioje skalėje (nuo visiškai teigiamos iki visiškai neigiamos ar atvirkščiai) buvo įvertinti kin-
tamieji. Pavyzdyje koreliacijos koeficientas yra teigiamas (0,521**) ir rodo, kad profesiona-
lumas padeda kontroliuoti patiriamą stresą, nes didėjant profesionalumui pakeliamas dides-
nis stresas.

Trečia, į ką reikia atkreipti dėmesį Correlations lentelėje (7.13 lentelė), yra koreliacijos koe-
ficiento reikšmė (0,521), kuri rodo, kad yra vidutinio stiprumo ryšys (Williams, Monge, 2001).

Po šios analizės būtų galima padaryti išvadą, kad Pirsono koreliacijos ryšio tarp dviejų kin-
tamųjų, išmatuotų intervalų skalėje (patiriamo streso kontrolė (Bstkon) ir profesionalumas 
(Bprof)), analizė parodė, kad egzistuoja vidutinis ryšys. Koreliacijos koeficientas r = 0,521, kai 
n = 429 ir p < α. Taigi galime teigti, kad tarp Btskon ir Bprof egzistuoja statistiškai reikšmingas 
tiesinis teigiamas vidutinio stiprumo ryšys didėjant profesionalumui pakeliamas didesnis stresas.

Pastaba. Kai tiriamųjų labai daug, statistiškai reikšmingos yra net ir labai silpnos kore-
liacijos (r< 0,2). Tokiais atvejais rekomenduojama rašyti, kad nors koreliacija ir statistiškai 
reikšminga, ji yra labai silpna.

7.4.4. Tiesinė regresinė analizė

Tiesinė regresinė analizė yra vienas iš daugiamatės statistinės analizės metodų, naudojamų 
ryšiais susietiems kintamiesiems tirti. Regresinė analizė tiria vieno priklausomo kintamojo ryšį 
su vienu nepriklausomu kintamuoju.

Regresine analize surandama regresijos lygtis, geriausiai nusakanti priklausomo ir nepri-
klausomo kintamųjų ryšį. Ši lygtis nenaudojama priklausomo kintamojo reikšmėms apskaičiuo-
ti (prognozėms). Tiesinės regresijos modelyje priklausomą kintamąjį su nepriklausomais sieja  
tiesinis ryšys, išreiškiamas lygtimi 
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 ;

čia  − konstanta,  – koeficientas (krypties koeficientas), e – atsitiktinė paklaida. Dėl reg-
resijos paklaidos tik dalis y dispersijos priklauso nuo x reikšmių.

Pirsono koreliacijos koeficientas ir tiesinė regresinė analizė yra glaudžiai susiję. Pagrindinės 
prielaidos, kuriomis ji remiasi, būtų šios:

l	 kintamųjų ryšys – tiesinis;

l	 kintamieji išmatuoti intervalų skalėje;

l	 kintamųjų skirstiniai – normalieji.

Taikant tiesinės regresijos modelį, reikia nepamiršti šių pagrindinių reikalavimų ir būtinai pa-
tikrinti kintamųjų tinkamumą jam. 

Šiam modeliui sudaryti ir įvertinti pasirinksime kintamuosius iš rinkmenos amzius.sav, ku-
rios kintamųjų reikšmių kodavimo lentelė ir klausimai pateikti priede. Tyrimo santrauka yra pa-
teikta 7.14 lentelėje.

7.14 lentelė. Tiesinės regresinės analizės tyrimo santrauka

Kas tiriama? Tiriama, kaip pasitenkinimą gyvenimu lemia amžius? 
Ką galime prognozuoti apie pasitenkinimą gyvenimu 30-mečiams?

Kokių duomenų reikia? Reikės dviejų kintamųjų:
l	 vieno priklausomo intervalų skalėje išmatuoto kintamojo pasitenkinimas 

gyvenimu (Bpasgiv);
l	 vieno nepriklausomo intervalų skalėje išmatuoto kintamojo amzius

Ką išsiaiškinsime? Ar tiriamas ryšys yra statistiškai reikšmingas ir koks to ryšio stiprumas. Taip 
pat sužinosime, kokią priklausomo kintamojo dispersijos dalį paaiškina ne-
priklausomas kintamasis.
Surasime regresijos lygtį, geriausiai nusakančią priklausomo ir nepriklauso-
mo kintamųjų ryšį.
Atsakysime į tyrime iškeltą klausimą ir galėsime prognozuoti apie 30‑mečių 
pasitenkinimą gyvenimu

Parametriniai kriterijai: Tiesinė regresinė analizė
Neparametriniai kriterijai: Nėra

Tyrimą padalysime į dvi dalis. Pirma, atliksime grafinę analizę ir ištirsime kintamojo pasi-
tenkinimo gyvenimu skirstinį, po to atliksime tiesinę regresinę analizę. 
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Bpasgiv skirstinio normalumo tikrinimas

1 	 Pagrindinėje SPSS programų paketo meniu juostoje pasirinkite: 
		  Analyze -> Descriptive Statistics ->Explore. 
2 	L ange Explore intervalų skalėje išmatuotą kintamąjį Bpasgiv įkelkite į Dependent List; 
3 	L ange Explore kategorinį kintamąjį lytis įkelkite į Factor List;
4 	 Pasirinkite Plots, atvertame lange pažymėkite Normality plots with tests ir Histogram.
5 	R inkitės OK.

Informacija po šios procedūros yra SPSS programų paketo išvesties lange. Pradėsime 
nuo asimetrijos ir eksceso koeficientų, kurių absoliutinės reikšmės yra arti nulio tiek vyrų  
(asim. = -0,11; eksc. = -0.222), tiek moterų (asim. = -0,006; eksc. = -0.314) imtyje, todėl galime 
daryti išvadą, kad abu skirstiniai yra artimi normaliesiems.

Pagal Shapiro–Wilko kriterijų, kintamojo Bpasgiv skirstinys abiejose populiacijose statistiš-
kai reikšmingai nesiskiria nuo normaliojo, nes p > α ir vyrų (p = 0,397), ir moterų (p = 0,068).

7.15 lentelė. Kintamojo pasitenkinimas gyvenimu normalumo testas.

Tests of Normality

Lytis
Kolmogorov-Smirnova Shapiro-Wilk

Statistic df Sig. Statistic df Sig.

pasitenkinimas gyvenimu
1 ,075 185 ,013 ,992 185 ,397
2 ,060 254 ,028 ,990 254 ,068

a. Lilliefors Significance Correction

Pagal vyrams ir moterims nubraižytas kintamojo pasitenkinimas gyvenimu stačiakampes 
diagramas (7.8 pav.) matome, kad vyrų grupėje yra išskirtis, kurios eilės numeris 27. Tai sąlygi-
nė išskirtis, kurią reikia pašalinti. 
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7.8 pav. Kintamojo pasitenkinimas gyvenimu stačiakampės diagramos.

Išskirčių šalinimas

1 	I šskirčių atvejų (eilučių) numeriams išrinkti reikia pagrindinėje SPSS programų paketo  
		  meniu juostoje pasirinkti Data -> Select Cases -> If ...

2 	T ada Select Cases -> If ... lange įrašyti informaciją ($Casenum ~=27). 
3 	R inkitės OK.

Pašalinę išskirtis, turime atlikti pakartotinį hipotezės tyrimą apie kintamojo Bpats skirstinio 
normalumą. Pasinaudokite jau aprašyta „Procedūra skirstinio normalumui patikrinti“. 

Atlikę skirstinio analizę, nubraižysime kintamųjų Bpats ir amzius sklaidos diagramą. sklai-
dos diagramos brėžimas yra aprašyta 7.3.2 skyriuje, tad pasinaudokite juo. Kintamasis Bpats yra 
priklausomas, tad bus pavaizduotas Y ašyje, o amzius yra nepriklausomas – X ašyje. Iš diagra-
mos, pavaizduotos 7.9 pav., matyti, kad kintamųjų tarpusavio priklausomybė yra vidutinė, nes 
duomenys grupuojami į juostą, kuri nėra labai siaura. Jei ta juosta labai plati, tai statistikai sako, 
kad yra heteroskedastiškumo problema, ir regresijos netaiko. Panašu, kad tai yra tiesinis ryšys, 
todėl galime taikyti tiesinę regresinę analizę.
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7.9 pav. Kintamųjų Bpats ir amzius sklaidos diagrama.

tiesinės regresinės analizės modeliui įvertinti ir regresinei lygčiai sudaryti atlikite procedū-
rą, kuri yra aprašyta toliau.

Tiesinės regresinės analizės modelio procedūra

1 	 Pagrindinėje SPSS programų paketo meniu juostoje pasirinkite 
		  Analyze->Regression -> Linear.

2 	 Pasirinkite Linear Regresion lange priklausomą kintamąjį Bpasgiv, įkelkite į Dependent 
	 	 langelį, o nepriklausomą kintamąjį amzius – į Independent(s) langelį.

3 	 Pasirinkite Linear Regresion lange Statistics, tada Descriptives.

4 	G aliausiai Continue ir OK.

Po šios procedūros SPSS programų paketo išvesties lange bus pateiktos statistinių reikšmių 
lentelės (7.16–7.18 lentelės), kuriose yra visa reikalinga informacija, tad išanalizuokime jas.
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7.16 lentelė. Regresinio modelio tinkamumo analizė.

Model Summary
Model R R Square Adjusted R Square Std. Error of the Estimate

1 ,535a ,286 ,284 4,678
a. Predictors: (Constant), amzius

7.17 lentelė. Kintamųjų ryšio statistinis reikšmingumas.

ANOVAb

Model Sum of Squares df Mean Square F Sig.
1 Regression 3829,760 1 3829,760 175,035 ,000a

Residual 9561,539 437 21,880
Total 13391,298 438

a. Predictors: (Constant), amzius
b. Dependent Variable: pasitenkinimas gyvenimu

7.18 lentelė. Regresinio modelio koeficientai.

Coefficientsa

Model
Unstandardized Coefficients Standardized Coefficients

t Sig.
B Std. Error Beta

1 (Constant) 14,827 ,672 22,066 ,000
amzius ,224 ,017 ,535 13,230 ,000

a. Dependent Variable: pasitenkinimas gyvenimu

Nubrėžę kintamųjų Bpats ir amzius sklaidos diagramą, pamatėme, kad egzistuoja ryšys tarp 
šių kintamųjų, bet ar tiriamas ryšys yra statistiškai reikšmingas, atsako SPSS pateikta ANOVA 
lentelė, kurioje apskaičiuotas šio ryšio statistinis reikšmingumas. Regresijos modelis statistiškai 
reikšmingas, nes F kriterijaus p = 0,000 (7.18 lentelė). kintamojo pasitenkinimas gyvenimu 
koeficientas regresijos modelyje statistiškai reikšmingai skiriasi nuo nulio, p = 0,0001.

Model Summary lentelėje yra determinacijos koeficientas R Square=0,286, kuris rodo, 
kad nepriklausomas kintamasis paaiškina priklausomo kintamojo dispersijos tik 28,6 proc. 
Determinacijos koeficientas yra variacijos dalis, kurią paaiškina modelis. Šiuo atveju determi-
nacijos koeficientas rodo, kad 28 proc. pasitenkinimą gyvenimu nulemia respondento amžius. 
Visuotinai priimta regresijos modelius, kuriems R2< 0,25, laikyti netinkamais. Remiantis vien 
tik determinacijos koeficientu, dar negalima pasakyti, ar tiesinės regresijos modelis turimiems 
duomenims tinka. Tačiau kuo didesnis determinacijos koeficientas (maksimali jo reikšmė 1), 
tuo tiksliau galima apskaičiuoti priklausomą kintamąjį iš nepriklausomo. Didesnis determinaci-
jos koeficientas reiškia, kad stebėjimai yra labiau koncentruoti apie mažiausiųjų kvadratų meto-
du gautą tiesę.
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Coefficients lentelėje esantys koeficientai Constant = 14,827 ir amzius = 0,224 yra statistiš-
kai reikšmingi, nes p = 0,0001. Taigi užrašykime regresijos lygtį: , kuri ge-
riausiai nusakys priklausomo ir nepriklausomo kintamųjų ryšį. Norėdami atsakyti į tyrime iškel-
tą klausimą ir prognozuoti 30-mečių pasitenkinimą gyvenimu, vietoje x reikšmės į gautą lygtį 
įrašome 30, o gautas rezultatas (22) bus atsakymas. 22 reiškia, kad 30-mečių pasitenkinimas gy-
venimu, vertinat skalėje nuo 5 iki 35, bus geresnis nei vidutinis. Pagal šią regresijos lygtį galime 
teigti, kad kasmet pasitenkinimas gyvenimu pakils apie 0,224, o 14,827 yra pasitenkinimo gyve-
nimu vertė, kuri nepriklauso nuo žmonių amžiaus.

Žinoma, reikia nepamiršti, kad prognozės daromos tik tai žmonių amžiaus grupei, kuriai ir 
buvo surinkti modelio duomenys. Jeigu tyrėme žmones iki 50 m. amžiaus, tai daryti prognozę, 
kad šimtametis sprogs iš laimės, yra neleistina.

7.4.5. Daugialypė regresinė analizė

Tiesinė regresinė analizė tiria vieno priklausomo kintamojo ryšį su vienu nepriklausomu kin-
tamuoju, o daugialypės tiesinės regresinės analizės modelis tiria vieno priklausomo ir dviejų ar 
daugiau nepriklausomų kintamųjų ryšį. Trijų nepriklausomų kintamųjų atveju daugialypės tiesi-
nės regresijos lygtis bus užrašoma:

;

čia − konstanta,  – koeficientai (daugialypis koreliacijos koeficientas), e – at-
sitiktinė paklaida. Dėl regresijos paklaidos tik dalis y dispersijos priklauso nuo  reikšmių. 
Daugialypis koreliacijos koeficientas matuoja priklausomo kintamojo ryšį su visais nepriklauso-
mais kintamaisiais. Taikant tiesinės regresinės analizės modelį, reikia atkreipti dėmesį į determi-
nacijos koeficientą, kuris turi būti didesnis už 0,25 (Čekanavičius ir Murauskas, 2002, p. 138). 

Šis metodas netaikomas mažoms imtims, nes yra jautrus jų dydžiui, kurį galite apskaičiuo-
ti pagal formulę N > 50 + 8m, čia m – nepriklausomų kintamųjų skaičius (Tabachnik & Fidell, 
1996, p. 132). Jei pasirinktumėte penkis nepriklausomus kintamuosius, tai daugialypės tiesi-
nės regresinės analizės modelio rinkmenos dydis turėtų būti didesnis nei 90 atvejų, o jei pri-
klausomojo kintamojo skirstinys būtų asimetrinis, tai imties dydis turėtų būti dar didinamas. 
Daugialypė tiesinė regresinė analizė yra jautri ir kitiems labai svarbiems rodikliams, kuriuos rei-
kia nepamiršti patikrinti, tai:

l	 multikolinearumo;

l	 liekamųjų paklaidų;

l	 jeigu tiriami vadinamieji laikiniai (t. y. stebimi bėgant laikui) duomenys, dar tikrinama au-
tokoreliacija, t. y. ar stebėjimas yra paveiktas prieš tai buvusio (pavyzdžiui, ar per egzaminą stu-
dentai nusirašinėja vieni nuo kitų). Mūsų kurse tokie duomenys nebus tiriami. 



Duomenų analizės SPSS pagrindai172

Šiam modeliui sudaryti ir įvertinti pasirinksime kintamuosius iš rinkmenos amzius3gr.sav, 
kurios kintamųjų reikšmių kodavimo lentelė ir klausimai pateikti priede. Tyrimo santrauka yra 
pateikta 7.19 lentelėje.

7.19 lentelė. Tiesinės regresinės analizės tyrimo santrauka.

Kas tiriama? Tiriama: Ar profesionalumui daro įtaką amžius, optimizmas ir 
savigarba? 

Kokių duomenų reikia? Reikės keturių kintamųjų:
l	 vieno priklausomo intervalų skalėje išmatuoto kintamojo profesionalumas 

(Bprof);
l	 trijų nepriklausomų intervalų skalėje išmatuotų kintamųjų amzius, Bpr, 

Bpats
Ką išsiaiškinsime? Ar tiriamas ryšys yra statistiškai reikšmingas ir koks to ryšio stiprumas. Taip 

pat sužinosime, kokią priklausomo kintamojo dispersijos dalį paaiškina ne-
priklausomi kintamieji.
Surasime regresijos lygtį, geriausiai nusakančią priklausomo ir nepriklauso-
mų kintamųjų ryšį.
Atsakysime į tyrime iškeltą klausimą ir galėsime prognozuoti apie pasitenki-
nimą gyvenimu net pagal tris parametrus

Parametriniai kriterijai: Daugialypė tiesinė regresinė analizė
Neparametriniai kriterijai: Nėra

Daugialypės tiesinės regresijos modeliui sudaryti atlikite tokią procedūrą. 

Daugialypės tiesinės regresijos modelio sudarymas

1 	 Pagrindiniame SPSS programų paketo lango meniu juostoje parinkite: 
		  Analyze ->Regression ->Linear. 
2 	 Linear Regresion lange įkelkite priklausomą kintamąjį Bprof į Dependent langą, o  

		  nepriklausomus kintamuosius (amzius, Boptim, Bsav) įkelkite į Independent(s) langą.
3 	 Linear Regresion lange rinkitės mygtuką Statistics ir atvertame lange: 
	 	l	pasirinkite Descriptives, Collinearity diagnostics, Estimates, Model fit;
	 	l	 Residuals bloke rinkitės Casewise diagnostics ir Outliers outside 3 standard  

			   deviations. Tada Continue.
4 	 Linear Regresion lange rinkitės mygtuką Options ir atvertame lange Missing Values 

	 	 bloke rinkitės Exclude cases pairwise.
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7.10 pav. Daugialypės tiesinės regresijos modelio Statistics langas.

5 	 Linear Regresion lange rinkitės mygtuką Plots, tada:
	 	l	Y priskirkite *ZRESID;
	 	l	X priskirkite *ZPRED;
	 	l	bloke Standardized Residual Plots pažymėkite Normal probability plot optikon;
	 	l	 rinkitės Continue.

6 	 Linear Regresion lange rinkitės mygtuką Save ir atverto lango, bloke Distances, pažy- 
		  mėkite Mahalanobis (tikrinsime dėl multikolinearumo išskirčių).

7 	G aliausiai rinkitės Continue ir OK.

SPSS programų paketo išvesties lange pateiktos statistinės lentelės bei grafikai padės at-
skleisti labai daug svarbios informacijos apie kintamuosius ir atsakyti į tyrimo pradžioje iškeltą 
klausimą. Statistinės lentelės yra pateiktos toliau, tad pasiaiškinkime, ką jos rodo. 

Analizę pradėsime nuo lentelės Correlation, kurioje yra informacija apie koreliaciją tarp 
kintamųjų. Įsitikinsime, kad nepriklausomų kintamųjų koreliacijos koeficientai su priklausomu 
kintamuoju turi ryšį (jei ryšys yra, koeficientai turėtų būti apie 0,3). Šiuo atveju du nepriklau-
somi kintamieji Bendras Optimizmas ir Bendra savigarba (atitinkamai: 0,549 ir 0,533) kore-
liuoja vidutiniškai, o nepriklausomas kintamasis amzius (-0,027) absoliučiuoju dydžiu neturi jo-
kio ryšio su priklausomu kintamuoju Bendras profesionalumas. 
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7.20 lentelė. Koreliaciją tarp kintamųjų.

Correlations
Bendras  

profesionalumas amzius Bendras 
Optimizmas

Bendra 
savigarba

Pearson 
Correlation

Bendras profesionalumas 1,000 -,027 ,549 ,533
amzius -,027 1,000 ,179 ,156
Bendras Optimizmas ,549 ,179 1,000 ,562
Bendra savigarba ,533 ,156 ,562 1,000

Sig. (1-tailed) Bendras profesionalumas . ,291 ,000 ,000
amzius ,291 . ,000 ,001
Bendras Optimizmas ,000 ,000 . ,000
Bendra savigarba ,000 ,001 ,000 .

N Bendras profesionalumas 420 420 419 418
amzius 420 423 419 420
Bendras Optimizmas 419 419 419 417
Bendra savigarba 418 420 417 420

7.21 lentelė. Regresinio modelio tinkamumo analizė.

Model Summaryb

Model R R Square Adjusted R Square Std. Error of the Estimate
1 ,629a ,396 ,392 3,103

a. Predictors: (Constant), Bendra savigarba, amzius, Bendras Optimizmas
b. Dependent Variable: Bendras profesionalumas

Lentelėje Model Summary reikia patikrinti determinacijos koeficiento (R Square) reikš-
mę, kuri rodo, kiek priklausomo kintamojo Bendras profesionalumas paaiškina modelis, ku-
ris jungia nepriklausomus kintamuosius amzius, Bendras Optimizmas ir Bendra savigarba. 
Ši reikšmė yra lygi 0,396, tai reiškia, kad modelis paaiškina 39,6 proc. profesionalumo disper-
sijos. SPSS taip pat pateikia koreguotą determinacijos koeficiento (Ajusted R Square = 0,392) 
vertę. Adjusted R Square aktualus (patikslina paprastą R Square) tik tada, kai nepriklausomų 
kintamųjų daug (pvz., 11), o stebėjimų mažai (pvz., 20), nes tada paprastas R Square prade-
da „meluoti“ – būna nepagrįstai didelis. Kai nepriklausomas kintamasis 1 (ar jų 2–3), šio koefi- 
ciento analizuoti nereikia.

Įvertinti šio modelio statistinį reikšmingumą padės informacija, kurią rasime lentelėje 
ANOVA. Šiame pavyzdyje F kriterijaus statistikos reikšmė yra 90,229 ir modelis pasiekia sta-
tistinį reikšmingumą su Sig. = 0,000, tai galime tvirtinti, kad p < 0,0005. Šis regresijos modelis 
tikrai yra statistiškai reikšmingas. Paprastai šnekant, yra bent vienas nepriklausomas kintama-
sis, kuris modelyje reikalingas. Ar reikalingi visi kintamieji, jau kitas klausimas, į kurį bandysi-
me atsakyti toliau.
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7.22 lentelė. Modelio statistinio reikšmingumo įvertinimas.

ANOVAb

Model Sum of Squares df Mean Square F Sig.
1 Regression 2606,459 3 868,820 90,229 ,000a

Residual 3976,777 413 9,629

Total 6583,237 416

a. Predictors: (Constant), Bendra savigarba, amzius, Bendras Optimizmas
b. Dependent Variable: Bendras profesionalumas

Atlikę daugialypę tiesinę regresiją, galime sužinoti, kuris iš kintamųjų, įtrauktų į modelį, pri-
sidėjo prie priklausomo kintamojo prognozavimo. Tam reikia įvertinti kiekvieną iš nepriklauso-
mų kintamųjų. Visą reikalingą informaciją randame lentelėje Coefficients. Šios lentelės stulpe-
lyje Beta yra pateikiamos standartizuotos koreliacijos koeficientų reikšmės. 

Norėdami palyginti skirtingus kintamuosius, pažvelkite į standartizuotus koeficientus 
(ignoruokite neigiamą ženklą). Šiuo atveju didžiausias beta koeficientas yra 0,384 (Bendras 
Optimizmas), tai reiškia, kad šis kintamasis paaiškina daugiausiai priklausomo kintamojo dis-
persijos, nei visi kiti kintamieji modelyje. Bendra savigarba paaiškina šiek tiek mažiau (0,340), 
o kintamasis amzius visiškai nedaug (-0,149).

7.23 lentelė. Šio modelio koeficientai.

Coefficientsa

Model
Unstandardized 

Coefficients
Standardized 
Coefficients t Sig.

Collinearity Statistics

B Std. Error Beta Tolerance VIF
1 (Constant) 7,526 1,033 7,288 ,000

amzius -,048 ,013 -,149  -3,822 ,000 ,963 1,038
Bendras Optimizmas ,347 ,042 ,384 8,261 ,000 ,675 1,480
Bendra savigarba ,250 ,034 ,340 7,330 ,000 ,681 1,469

a. Dependent Variable: Bendras profesionalumas

Kiekvieno iš šių kintamųjų vertės yra įvertintos Sig. stulpelyje, kur pagal p reikšmes galime 
daryti išvadą, ar kintamieji yra statistiškai reikšmingi, ir priimti sprendimą, ar įtraukti juos į lyg-
tį. Kaip matote, visų kintamųjų p = 0,000, tai reiškia visi nepriklausomi kintamieji yra statistiš-
kai reikšmingi ir juos visus galime įtraukti į lygtį.

Pastaba. Tradiciškai konstantai p reikšmė nežiūrima. Konstanta paliekama modelyje net 
tada, kai jos p > 0,05.
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7.24 lentelė. Regresinio modelio išskirtys.

Casewise Diagnosticsa

Case Number Std. Residual Bendras profesionalumas Predicted Value Residual
295 3,219 28 18,01 9,990
396 -3,686 9 20,44 -11,437
411 -3,427 10 20,63 -10,635

a. Dependent Variable: Bendras profesionalumas

Regresijos modelis jautrus išskirtims. Kai imties dydis nedidelis, reikia atkreipti dėmesį į labai 
nuo kitų besiskiriančias reikšmes, kurios gali statistiškai reikšmingai pakeisti regresijos lygties koe- 
ficientų vertes. Šio modelio duomenų išskirtis galime rasti 7.24 lentelėje, kurioje matome, kad yra 
3 išskirtys. Tai respondentai, kurių duomenys pateikti duomenų matricos eilutėse: 295; 396; 411.

7.25 lentelė. Liekamųjų paklaidų statistika.

Residuals Statisticsa

Minimum Maximum Mean Std. Deviation N
Predicted Value 13,32 26,86 21,77 2,505 417
Std. Predicted Value -3,373 2,039 ,005 1,001 417
Standard Error of Predicted Value ,153 ,593 ,292 ,084 417
Adjusted Predicted Value 13,46 27,01 21,77 2,506 417
Residual -11,437 9,990 ,018 3,070 417
Std. Residual -3,686 3,219 ,006 ,989 417
Stud. Residual -3,700 3,271 ,006 ,995 417
Deleted Residual -11,526 10,310 ,019 3,107 417
Stud. Deleted Residual -3,758 3,310 ,006 ,998 417
Mahal. Distance ,016 14,211 2,991 2,470 417
Cook‘s Distance ,000 ,086 ,003 ,007 417
Centered Leverage Value ,000 ,034 ,007 ,006 417
a. Dependent Variable: Bendras profesionalumas

Toliau patikrinsime, ar nėra multikolinearumo grėsmės, ar koreliacija tarp kiekvieno iš ne-
priklausomų kintamųjų yra ne per didelė. Multikolinearumas reiškia, kad kintamieji taip stip-
riai koreliuoja, jog modelyje pradeda vienas kitam kliudyti (pvz., septyni kariai vienu automa-
tu nešaudys septynis kartus greičiau). Į šį klausimą galėsime atsakyti pažiūrėję į 7.23 lentelę 
Coefficients, kurios Collinearity Statistics stulpelyje Tolerance yra suskaičiuotos kiekvieno 
kintamojo reikšmės (skaičiuojama 1-R2), kurios parodo tarpusavio ryšį tarp kintamųjų. Jei šios 
reikšmės yra labai artimos nuliui, jos parodo, kad tarp kintamųjų yra multikolinearumas. Šioje 
analizėje kintamųjų amžius, Bendras Optimizmas ir Bendra savigarba (atitinkamai: 0,963; 
0,675; 0,681) įverčiai yra pakankamai dideli, tad nerimauti dėl multikolinearumo nereikia.
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7.11 pav. Daugialypės dispersijos modelio grafinė analizė. Standartizuotų paklaidų sklaidos diagrama.
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7.12 pav. Daugialypės dispersijos modelio grafinė analizė. Standartizuotų paklaidų reikšmių P-P normalumo grafikas.
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Standartizuotų paklaidų sklaidos diagramoje (7.11 pav.) paklaidų reikšmės yra pasiskirs-
čiusios maždaug statmenai Y ašiai, esančiai 0 reikšmei, su koncentruotu išsibarstymu centre. 
Sklaidos diagrama gali padėti išsiaiškinti, ar yra išskirčių. Standartizuota paklaida galime laiky-
ti tą reikšmę, kuri yra didesnė nei 3,3 arba mažesnė negu -3,3. Nagrinėjamame sklaidos grafiko 
pavyzdyje taškų, artimų išskirtims, yra tik keli, tad jokių pakeitimų daryti nereikia. 

Grafinė analizė leidžia įvertinti: išskirtis, normalumą, tiesiškumą bei homoskedastiškumą. 
Standartizuotų paklaidų reikšmių P-P normalumo grafikas (7.12 pav. ) rodo, kad paklaidos iš-
sidėsčiusios apie tiesę labai glaudžiai, o tai reiškia, kad jokių esminių nukrypimų nuo normalu-
mo nebus.

Išskirtys taip pat gali būti tikrinamos Mahalanobio atstumu, kuris yra skaičiuojamas ir patei-
kiamas duomenų rinkmenoje kaip papildomas kintamasis (Mah_1). Norėdami nustatyti, kurie 
atvejai yra išskirtys, jums reikės nustatyti kritinę chi kvadrato reikšmę naudojant nepriklausomų 
kintamųjų skaičių kaip laisvės laipsnių skaičių. 

7.26 lentelė. Kritinės reikšmės Mahalanobio atstumui įvertinti.

Nepriklausomų 
kintamųjų skaičius

Kritinė 
reikšmė

Nepriklausomų 
kintamųjų skaičius

Kritinė 
reikšmė

Nepriklausomų 
kintamųjų skaičius

Kritinė 
reikšmė

2 13.82 4 18.47 6 22.46
3 16.27 5 20.52 7 24.32

Kadangi kritinėms reikšmėms tikrinti jau galima rasti paruoštų lentelių, tad šiam modeliui 
patikrinti dėl išskirčių pasirinksime Tabachnick & Fidell, 1996, lentelę C.4. 7.26 lentelė sudary-
ta, kai pasikliovimo lygmuo α = 0,001. 

Trumpai paaiškinsime, kaip reikia ja naudotis. Šiame pavyzdyje turime tris nepriklausomus 
kintamuosius, todėl kritinė reikšmė yra 16.27. Kaip matote, labai paprasta, bet dar ne viskas. 
Norėdami sužinoti, ar yra atvejų, kurių vertė sutampa su Mahalanobio atstumo kritine verte, rei-
kės atlikti tyrimą. 

Išskirčių tikrinimas

1 	 Pagrindinėje SPSS programų paketo meniu juostoje pasirinkite 
		  Analyze -> Descriptive Statistics ->Explore (žr. 7.13 pav.); 
2 	L ange Explore intervalų skalėje išmatuotą kintamąjį Mah_1 įkelkite į Dependent List; 
3 	L ange Explore kategorinį kintamąjį id įkelkite į Label Cases by;
4 	 Pasirinkite Statistics, atvertame lange pažymėkite Outliers.
5 	R inkitės OK.
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7.13 pav. Kintamojo Mah_1 tikrinimas dėl išskirčių.

Informacija po šios procedūros yra SPSS paketo išvesties lange, tad reikia išanalizuoti ją. Iš 
lentelės Extreme Values matyti, kad kintamasis Mah_1 turi ekstremalių reikšmių. Ar šios reikš-
mės yra kritinės daugialypės regresijos modeliui? Didžiausia reikšmė yra 14,21, šioje lentelėje 
yra ir dar keletą pakankamai įtartinų reikšmių, tad ką daryti? 

7.27 lentelė. Kintamojo Mah_1 ekstremalios vertės.

Extreme Values
Case Number id Value

Mahalanobis Distance

Highest

1 208 461 14,21145
2 418 180 12,91026
3 365 507 12,51885
4 183 513 12,46762
5 217 308 12,15898

Lowest

1 98 357 ,01640
2 310 156 ,10881
3 324 140 ,11532
4 101 540 ,12052
5 82 211 ,18154

Analizuojamo atvejo kritinių reikšmių Mahalanobio atstumui įvertinti 7.26 lentelė, kai turi-
me tris nepriklausomus kintamuosius, siūlo ieškoti kritinių reikšmių lygių 16.27. Tokio dydžio 
kritinių reikšmių nėra, todėl galime nesijaudinti (7.27 lentelė.).
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Išanalizavę visą SPSS programų paketo pateiktą informaciją, galime grįžti prie tyrimo klausi-
mo. Kadangi daugialypės regresinės analizės metodu ištyrėme, kaip profesionalumui daro įtaką 
amžius, optimizmas ir savigarba, tai galime užrašyti regresijos lygtį, geriausiai nusakančią pri-
klausomo ir nepriklausomų kintamųjų ryšį. Analizuotų nepriklausomų kintamųjų atveju daugia-
lypės tiesinės regresijos lygtis bus:

;

čia 7,526 − konstanta,  – koeficientai (daugialypis koreliaci-
jos koeficientas), x1 – amžius, x2 – optimizmas ir x3 – savigarba, y – profesionalumas.

Daugialype regresine analize nepriklausomo kintamojo ryšys su priklausomu kintamuoju 
įvertinamas atsižvelgiant į nepriklausomų kintamųjų tarpusavio ryšius. Nepriklausomo kinta-
mojo regresijos koeficientas įvertina tiesioginį to kintamojo ryšį su priklausomu kintamuoju. 

Kaip matote, nepriklausomi kintamieji (x1, x2, x3) gali kisti. Tai reiškia, kad padidinę vienetu 
x3 reikšmę, y reikšmę padidinsime per 0,25. Taigi jeigu x1 ir x2 bus fiksuoti kiekvienas papildo-
mas savigarbos balas, profesionalumą padidins 0,25 balo. 

Kadangi sudarėme regresinį modelį, galime prognozuoti. Prognozuojant konkrečios nepri-
klausomų kintamųjų reikšmės tiesiog įrašomos į gautą lygtį. Pavyzdžiui, mus domina profesio-
nalumo lygis, kai: x1 = 30 (amžius), x2 = 6 (optimizmas) ir x3 = 10 (savigarba). Abiem atvejais 
tai bus pradiniai lygmenys, nes optimizmo skalė nuo 6 iki 30, o savigarbos skalė nuo 10 iki 40. 
Žiūrėkite į lygtį:

.

Turėdami pradines skalių reikšmes, galime teigti, kad optimizmas ir savigarba profesionalu-
mą pakelia apie keturis balus. 

Kaip jau supratote, regresinis modelis leidžia prognozuoti, ir būtent tuo regresinė analizė ski-
riasi nuo paprastos koreliacinės analizės. Taip pat svarbu yra ir tai, kad didėjant teigiamam ne-
priklausomam kintamajam, regresijos koeficientas didėja ir, žinoma, didėja priklausomas kin-
tamasis. Tačiau kai didinamas neigiamas nepriklausomo kintamojo koeficientas, priklausomas 
kintamasis mažėja. 

Pastaba. Nereikėtų pamiršti, kad prognozės daromos tik tokioms nepriklausomų kintamų-
jų (x1, x2, x3) reikšmėms, kurios nedaug gali kisti nuo turimų imties reikšmių. Neturėtumėte pa-
sikliauti regresijos modeliu prognozuodami 120 mm minosvaidžio naikinamąją jėgą 3 km ats-
tumu, jei regresinis modelis sudarytas pagal šaudymų bandymų rezultatus tik 1 km atstumu.
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7.4.6. Užduotys

I. Užduotims atlikti naudosime penkis kintamuosius iš regresija.sav:
1 	 Darbo stažą nusakantį kintamąjį darbas;
2 	 Profesionalumą apibūdinantį kintamąjį Bprof; 
3 	O ptimizmą apibūdinantį kintamąjį Boptim; 
4 	R ūkymo dažnumą nusakantį kintamąjį rukymodaz; 
5 	S avigarba apibūdinantį kintamąjį Bsav.

1 užduotis. Ištirkite profesionalumo ir darbo stažo ryšį. Naudodami kintamuosius darbas 
(darbo stažas) ir Bprof (profesionalumas): 

l	sudarykite tiesinės regresijos modelį, kai priklausomas kintamasis yra profesionalumas, o 
	 nepriklausomas – darbo stažas; 

l	analizuokite tik vyrus. 

Pasirinkite statistinio reikšmingumo lygmenį α = 0,05.

2 užduotis. Ištirkite profesionalumo, optimizmo ir darbo stažo ryšį. Naudodami kintamuo-
sius darbas (darbo stažas), Bprof (profesionalumas) ir Boptim (optimizmas): 

l	sudarykite tiesinės regresijos modelį, kai priklausomas kintamasis yra profesionalumas, o 
	 nepriklausomi – darbo stažas, optimizmas; 

l	analizuokite vyrus ir moteris kartu. 

Pasirinkite statistinio reikšmingumo lygmenį α = 0,05.

3 užduotis. Ištirkite profesionalumo, optimizmo ir darbo stažo ryšį. Naudodami kintamuo-
sius darbas (darbo stažas), Bprof (profesionalumas) ir Boptim (optimizmas): 

l	sudarykite tiesinės regresijos modelį, kai priklausomas kintamasis yra profesionalumas, o 
	 nepriklausomi – darbo stažas, optimizmas; 

l	analizuokite tik nuo 29 iki 42 metų amžiaus (kintamojo amgr3 antra grupė) moteris. 

Pasirinkite statistinio reikšmingumo lygmenį α = 0,05.
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4 užduotis. Ištirkite surūkytų cigarečių skaičių per savaitę, optimizmo ir savigarbos ryšį. 
Naudodami kintamuosius rukymodaz (rūkymo dažnumas), Bsav (savigarba) ir Boptim (opti-
mizmas): 

l	sudarykite tiesinės regresijos modelį, kai priklausomas kintamasis yra rūkymo dažnumas, 
	 o nepriklausomi – savigarba, optimizmas; 

l	analizuokite tik moteris. 

Pasirinkite statistinio reikšmingumo lygmenį α = 0,05.

II. Užduotims atlikti naudosime penkis vado vaidmuo.sav kintamuosius:
1 	V ado įtaką nusakantį kintamąjį Vado_itaka_K14; 
2 	 Bendrą administravimo gebėjimu tobulinimą apibūdinantį kintamąjį BadmGeb_K13; 
3 	 Bendrus padalinio tikslus ir uždavinius nusakantį kintamąjį Padalinys_K11; 
4 	 Bendrus vado gebėjimus nusakantį kintamąjį Bvadgeb_K9; 
5 	 Bendrą savęs vertinimo kintamąjį Bsav_vert_K12. 

1 užduotis. Ištirkite vado įtakos ir administravimo gebėjimų ryšį. Naudodami kintamuosius 
BadmGeb_K13 ir Vado_itaka_K14 atlikite tokias užduotis:

l	nubrėžkite sklaidos grafiką;

l	paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai;

l	ištirkite duomenų skirstinių normalumą;

l	sudarykite tiesinės regresijos modelį, kai priklausomas kintamasis yra vado įtaka, o nepri- 
	 klausomas – bendri administravimo gebėjimai. 

Pasirinkite statistinio reikšmingumo lygmenį α = 0,05.

2 užduotis. Ištirkite padalinio tikslų ir administravimo gebėjimų ryšį. Naudodami kintamuo-
sius BadmGeb_K13 ir Padalinys_K11 atlikite tokias užduotis:

l	nubrėžkite sklaidos grafiką;

l	paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai;

l	ištirkite duomenų skirstinių normalumą;
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l	sudarykite tiesinės regresijos modelį, kai priklausomas kintamasis yra padalinio tikslai, o  
	 nepriklausomas – bendri administravimo gebėjimai. 

Pasirinkite statistinio reikšmingumo lygmenį α = 0,05.

3 užduotis. Ištirkite vado gebėjimų ir bendro administravimo gebėjimų ryšį. Naudodami kin-
tamuosius BadmGeb_K13 ir Bvadgeb_K9 atlikite tokias užduotis:

l	nubrėžkite sklaidos grafiką;

l	paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai;

l	ištirkite duomenų skirstinių normalumą;

l	sudarykite tiesinės regresijos modelį, kai priklausomas kintamasis yra administravimo  
	 gebėjimų tobulinimas, o nepriklausomas – bendri vado gebėjimai. 

Pasirinkite statistinio reikšmingumo lygmenį α = 0,05.

4 užduotis. Ištirkite padalinio tikslų ir savęs vertinimo ryšį. Naudodami kintamuosius Bsav_
vert_K12 ir Bpadalinys_K11 atlikite tokias užduotis: 

l	nubrėžkite sklaidos grafiką;

l	paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai;

l	ištirkite duomenų skirstinių normalumą;

l	sudarykite tiesinės regresijos modelį, kai priklausomas kintamasis yra padalinio tikslai, o  
	 nepriklausomas – bendri savęs vertinimai. 

Pasirinkite statistinio reikšmingumo lygmenį α = 0,05.

III. Užduotims atlikti naudosime keturis kompetencijos.sav kintamuosius:
1 	 Bendras asmenines kompetencijas nusakantį kintamąjį Basmen; 
2 	 Bendrus komunikacinius gebėjimus apibūdinantį kintamąjį Bkomunik; 
3 	 Bendrus profesinius gebėjimus nusakantį kintamąjį Bprofes;
4 	 Bendrus socialinius gebėjimus nusakantį kintamąjį Bsocialin. 
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1 užduotis. Ištirkite asmeninių kompetencijų ir profesinių gebėjimų ryšį. Naudodami kinta-
muosius Basmen ir Bprofes atlikite tokias užduotis:

l	nubrėžkite sklaidos grafiką;

l	paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai;

l	ištirkite duomenų skirstinių normalumą;

l	sudarykite tiesinės regresijos modelį, kai priklausomas kintamasis yra asmeninės kompe- 
	 tencijos, o nepriklausomas – bendri profesiniai gebėjimai. 

Pasirinkite statistinio reikšmingumo lygmenį α = 0,05.

2 užduotis. Ištirkite komunikacinių gebėjimų ir socialinių gebėjimų ryšį. Naudodami kinta-
muosius Bkomunik ir Bsolialin atlikite tokias užduotis:

l	nubrėžkite sklaidos grafiką;

l	paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai;

l	ištirkite duomenų skirstinių normalumą;

l	sudarykite tiesinės regresijos modelį, kai priklausomas kintamasis yra socialiniai gebėji- 
	 mai, o nepriklausomas – bendri komunikaciniai gebėjimai. 

Pasirinkite statistinio reikšmingumo lygmenį α = 0,05.
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7.4.7. Stjudento t kriterijaus taikymas nepriklausomoms imtims

SPSS programų paketas siūlo daug skirtingų statistinių analizių, kurios remiasi t kriterijaus 
statistika. Šiame skyriuje nagrinėsime tik Stjudento t kriterijų dviejų nepriklausomų imčių vi-
durkiams lyginti.

Tyrimui pailiustruoti pasinaudosime rinkmena Streso tyrimas.sav, kurios reikšmių kodavi-
mo lentelė ir klausimai pateikti priede. Tyrimo santrauka yra pateikta 7.28 lentelėje.

7.28 lentelė. Stjudento t kriterijaus taikymo nepriklausomoms imtims tyrimo santrauka

Kas tiriama? Tiriama, ar vyrai patiria daugiau streso nei moterys?
Kokių duomenų 
reikia?

Du kintamieji:
l	 vienas nepriklausomas kategorinis lytis (tik dvi grupės; vyrai / moterys);
l	 vienas priklausomas intervalų skalėje išmatuotas kintamasis bendras patiriamas 

stresas Bpats
Ką 
išsiaiškinsime?

Taikydami nepriklausomoms imtims Stjudento t kriterijų, gausime atsakymą į 
klausimą, ar vyrų ir moterų patiriamo streso vidurkiai statistiškai reikšmingai skiriasi 
ar ne. Paprasčiau tariant, ar vyrai ir moterys skirtingai vertina patiriamą stresą.
Statistine prasme patvirtinsime arba paneigsime hipotezę , kai pasirinktas 
reikšmingumo lygmuo . SPSS programų paketas pateiks dvi statistines 
analizes: kai grupių dispersijos lygios ir kai ne. Tad priimant sprendimą, kurią iš „Sig. 
(2-tailed) p reikšmių rinktis, atkreipsime dėmesį į dispersijų įvertinimą.
Hipotezę  priimsime, jei .

Tyrimą padalysime į dvi dalis:

l	I dalis: tirsime hipotezę apie kintamojo skirstinio normalumą, kai pasirinktas reikšmingu- 
	 mo lygmuo .

l	II dalis: patvirtinsime arba paneigsime hipotezę , kai pasirinktas reikšmingu- 
	 mo lygmuo .

I dalis

Prieš taikant statistinius kriterijus ir taikant sudėtingesnius statistinius metodus, būtina išsi-
aiškinti informaciją apie turimus duomenis. Taikant Stjudento t kriterijų, taip pat labai svarbu 
patikrinti, ar tyrimui naudosime duomenis, kurių skirstinys yra normalus. Į šį klausimą atsakys 
Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijai, kurie naudojami hipotezei apie kintamojo 
skirstinio normalumą patikrinti.
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Hipotezę apie kintamojo Bpats skirstinio normalumą patikrinsime pagal aprašytą procedūrą, 
naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijus.

Skirstinio normalumo patikrinimas

1 	 Pagrindinėje SPSS programų paketo meniu juostoje pasirinkite
		  Analyze -> Descriptive Statistics ->Explore 
2 	L ange Explore intervalų skalėje išmatuotą kintamąjį Bpats įkelkite į Dependent List; 
3 	L ange Explore kategorinį kintamąjį lytis įkelkite į Factor List;
4 	 Pasirinkite Plots, atvertame lange pažymėkite Normality plots with tests ir Histogram.
5 	R inkitės OK.

Informacija po šios procedūros yra SPSS programų paketo išvesties lange, tad belieka išana-
lizuoti ją. Matyti, kad pagal Shapiro–Wilko okriterijų kintamojo Bpats skirstinys abiejose popu-
liacijose statistiškai reikšmingai nesiskiria nuo normaliojo, nes p > α tiek vyrų (p = 0,096), tiek 
moterų (p = 0,176). Kolmogorovo–Smirnovo kriterijui vyrų ir moterų imtyse p- reikšmės su-
tampa (p = 0,015) ir p < α, tad būtų negalima teigti, kad skirstinys yra normalusis (7.29 lentelė). 

7.29 lentelė. Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų rezultatai.

Tests of Normality

Lytis
Kolmogorov-Smirnova Shapiro-Wilk

Statistic df Sig. Statistic Df Sig.

Bendras patiriamas stresas
1 ,074 184 ,015 ,987 184 ,096
2 ,064 249 ,015 ,992 249 ,176

a. Lilliefors Significance Correction

Taigi abiejų kriterijų išvados nesutampa, tačiau atsižvelgus į tai, kad turimos imtys nėra ma-
žos, galima remtis Shapiro–Wilko kriterijumi (jis galingesnis) ir teigti, kad skirstinių nuokry-
piai nuo normaliojo nėra dideli. Shapiro–Wilko kriterijaus statistika kiekybiškai įvertina skirsti-
nio nuokrypį nuo normaliojo, tai yra jei kriterijaus statistika arti vieneto, tai skirstinys yra arti-
mas normaliajam.

Asimetrijos ir eksceso koeficientų absoliutinės reikšmės yra arti nulio tiek vyrų  
(asim. = 0,271; eksc. = 0.393), tiek moterų (asim. = 0,271; eksc. = 0.393) imtyje, todėl galime 
daryti išvadą, kad abu skirstiniai yra artimi normaliesiems.

Taip pat reikia nustatyti pagal stačiakampę diagramą išskirtis, kurios gali turėti įtakos gau-
namiems rezultatams. Pagal stačiakampę diagramą, kurią matote 7.14 pav., galime teigti, kad 
yra tik sąlyginių išskirčių abiejose grupėse. Kadangi imtys nėra mažos, tai šios išskirtys ypa-
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tingai rezultatų nepaveiks. Tačiau galima jas eliminuoti iš skaičiavimų Select Cases procedūra.  
Pvz., įvedant „$Casenum ~= 24“ bus pašalinta (laikinai nenaudosime) 24 duomenų rinkmenos 
eilutė. Norėdami eliminuoti ne vieną, o daugiau išskirčių, reikėtų sujungti jas operatoriumi „&“. 
Šiam tyrimui visi veiksmai yra paaiškinti procedūra.

Be
nd

ra
s p

at
ir

ia
m

as
 st

re
sa

s

10

Vyrai Moterys
Lytis

20

30

40

50

7.14 pav. Kintamojo Bpats stačiakampės diagramos pagal kategorinį kintamąjį lytis.

Išskirčių šalinimas

1 	I šskirčių atvejų (eilučių) numeriams išrinkti reikia pagrindinėje SPSS programų paketo 
meniu juostoje pasirinkti Data -> Select Cases -> If ...

2 	T ada Select Cases -> If ... lange surinkti informaciją
	 ($Casenum ~=5) & ($Casenum ~= 24) & ($Casenum ~= 55) & ($Casenum ~=124 ) &  
		  ($Casenum ~= 263) & ($Casenum ~= 103) & ($Casenum ~= 311) & ($Casenum ~= 106)

3 	R inkitės OK.

Pašalinę išskirtis, turime atlikti pakartotinį hipotezės tyrimą apie kintamojo Bpats skirstinio 
normalumą. Šį tyrimą atlikite pasinaudodami jau aprašyta „Skirstinio normalumo tikrinimas“ 
veiksmų seka.

SPSS programų paketo išvesties lange vėl patikrinkite Kolmogorovo–Smirnovo ir Shapiro–
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Wilko kriterijų reikšmes. Po pakartotinio tyrimo gauti rezultatai yra pateikti 7.30 lentelėje.
Pašalinus išskirtis, rezultatai Kolmogorovo–Smirnovo kriterijui pasikeitė, bet išliko p < α, 

tad negalima būtų teigti, kad skirstinys yra normalusis. Todėl galime teigti, kad pašalintos sąly-
ginės išskirtys nebuvo esminės. Shapiro–Wilko kriterijaus statistika yra labai arti vieneto ir p > 
α, vadinasi, skirstiniai nėra labai skirtingi nuo normaliojo ir galima taikyti Stjudento t kriterijų 
populiacijų vidurkių skirtumui nustatyti, tai bus atlikta II dalyje.

7.30 lentelė. Pakartotini Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų rezultatai.

Tests of Normality

Lytis
Kolmogorov–Smirnova Shapiro–Wilk

Statistic df Sig. Statistic df Sig.
Bendras patiriamas 
stresas

1 ,069 182 ,034 ,990 182 ,263
2 ,069 240 ,007 ,990 240 ,104

a. Lilliefors Significance Correction

II dalis

Patikrinsime hipotezę , kai pasirinktas reikšmingumo lygmuo . 
Tirsime, ar vyrai ir moterys patiria vienodai streso, ar kintamojo Bpats vidurkiai abiejose popu-
liacijose skiriasi. Naudosime nepriklausomoms imtims Stjudento t kriterijų.

Stjudento t kriterijaus taikymas nepriklausomoms imtims

1 	S PSS programų paketo pagrindinio meniu juostoje pasirinkite
		  Analyze -> Compare Means-> Independent Samples->T−Test;
2 	L ange Independent Samples->T−Test intervalų skalėje išmatuotą kintamąjį Bpats įkel- 

		  kite į Test Variable(s) laukelį, o kategorinį kintamąjį lytis įkelkite į Grouping Variable 
	  	laukelį (žr. 7.15 pav.);

3 	 Paspauskite mygtuką Define Groups ir įrašykite grupių kodus. Vyrų grupė koduojama 1, 
		  moterų – 2;

4 	G aliausiai rinkitės Continue ir OK.
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7.15 pav. Procedūros 2-as, 3-ias ir 4-as žingsniai.

SPSS programų paketas išvesties lange pateikia išsamią informaciją (7.31 ir 7.32 lentelės), 
pagal kurią priimsime sprendimą. Pirma, nustatysime, ar grupių dispersijos yra lygios kaip 7.32 
lentelės stulpelyje „Levene’s Test for Equality of Variances“. Kadangi „Equal variances as-
sumed“ eilutėje p = 0,579 > α, tai dispersijos statistiškai reikšmingai nesiskiria. Jei būtų p < α, 
sprendimą apie grupių vidurkių lygybę priimti reikėtų pagal eilutę „Equal variances not assu-
med“.

7.31 lentelė. Kintamojo Bpats apibūdinimas vyrų ir moterų grupėms.

Group Statistics

Lytis N Mean Std. Deviation Std. Error Mean

Bendras patiriamas stresas 1 182 25,69 5,228 ,388
2 240 27,35 5,442 ,351
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7.32 lentelė. Stjudento t kriterijaus taikymo nepriklausomoms imtims rezultatai.

Independent Samples Test
Levene‘s 
Test for 

Equality of 
Variances

t-test for Equality of Means

F Sig. t df Sig. 
(2-tailed)

Mean 
Diffe-
rence

Std. 
Error 
Diffe- 
rence

95% 
Confidence 

Interval of the 
Difference

Lower Upper
Bendras 
patiriamas 
stresas

Equal variances 
assumed

,308 ,579 -3,160 420 ,002 -1,662 ,526 -2,696 -,628

Equal variances 
not assumed

-3,177 397,429 ,002 -1,662 ,523 -2,690 -,634

7.32 lentelės „t-test for Equality of Means“ stulpelpelyje „Sig. (2-tailed) pasitikrinsime p 
reikšmę t kriterijui. Matome, kad p < 0,002. 

Galime daryti išvadą, kad kintamojo Bpats vidurkiai vyrų ir moterų grupėse statistiškai reikš-
mingai skiriasi. Vyrų patiriamo streso vidurkis (25,69) yra statistiškai reikšmingai mažesnis už 
moterų (27,35). Atsakydami į tyrimo klausimą „Ar vyrai patiria daugiau streso nei moterys?“, 
galime pasakyti, kad vyrai patiria statistiškai mažiau streso nei moterys.
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7.4.8. Užduotys

Užduotims atlikti naudokite duomenis iš Streso tyrimas.sav.

1 užduotis. Patikrinkite hipotezę: Ar tie, kurie turi vaikų, patiria didesnį stresą nei bevaikiai?
Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendras patiriamas stre-

sas (Bpats) vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo vaikai (tik dvi grupės;  
Taip / Ne) skiriasi. Naudokite nepriklausomoms imtims Stjudento t kriterijų, kai reikšmingu-
mo lygmuo α = 0,05.

Tyrimo tvarka:

1.	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamųjų 
	 skirstinys artimas normaliajam.

2.	Paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai.

3.	Pašalinkite išskirtis (sąlygines taip pat), jei tokių yra, ir pakartokite normalumo testą.

4.	Patikrinkite hipotezę: Ar žmonės, kurie turi vaikų, ir žmonės, kurie jų neturi, patiria streso  
	 skirtingai? 

5. 	Parašykite išvadas. Paaiškinkite apie žmonių, kurie turi vaikų, gyvenimo kokybę.

Užduotims atlikti naudokite duomenis iš Streso tyrimas.sav.

2 užduotis. Patikrinkite hipotezę: Ar tie, kurie turi vaikų, yra labiau optimistiški nei bevaikiai?
Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendras optimizmas (Bopt) 

vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo vaikai (tik dvi grupės; Taip / Ne) skiria-
si. Naudokite nepriklausomoms imtims Stjudento t kriterijų, kai reikšmingumo lygmuo α = 0,05.

Tyrimo tvarka:

1.	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamųjų 
	 skirstinys artimas normaliajam.

2.	Paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai.

3.	Pašalinkite išskirtis (sąlygines taip pat), jei tokių yra, ir pakartokite normalumo testą.

4.	Patikrinkite hipotezę: Ar žmonių, kurie turi vaikų, ir žmonių, kurie jų neturi, optimizmas 
	 skiriasi? 

5.	Parašykite išvadas. Paaiškinkite apie žmonių, kurie turi vaikų, gyvenimo kokybę.
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Užduotims atlikti naudokite duomenis iš Streso tyrimas.sav.

3 užduotis. Patikrinkite hipotezę: Ar tie, kurie turi vaikų, yra labiau save gerbiantys nei be-
vaikiai?

Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendra savigarba (Bsav) vi-
durkiai atžvilgiu nepriklausomo kategorinio kintamojo vaikai (tik dvi grupės; Taip / Ne) skiriasi. 
Naudokite nepriklausomoms imtims Stjudento t kriterijų, kai reikšmingumo lygmuo α = 0,05.

Tyrimo tvarka:

1.	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamųjų 
	 skirstinys artimas normaliajam.

2.	Paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai.

3	 Pašalinkite išskirtis (sąlygines taip pat), jei tokių yra, ir pakartokite normalumo testą.

4.	Patikrinkite hipotezę: Ar žmonių, kurie turi vaik,ų ir žmonių, kurie jų neturi, savigarba 
		  skiriasi? 

5.	Parašykite išvadas. Paaiškinkite apie žmonių, kurie turi vaikų, gyvenimo kokybę.

Užduotims atlikti naudokite duomenis iš Streso tyrimas.sav.

4 užduotis. Patikrinkite hipotezę: Ar tie, kurie turi vaikų, turi daugiau socialinių poreikių 
nei bevaikiai?

Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendri socialiniai porei-
kiai (Bsocp) vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo vaikai (tik dvi grupės;  
Taip / Ne) skiriasi. Naudokite nepriklausomoms imtims Stjudento t kriterijų, kai reikšmingu-
mo lygmuo α = 0,01.

Tyrimo tvarka:

1.	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamųjų 
	 skirstinys artimas normaliajam.

2.	Paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai.

3.	Pašalinkite išskirtis (sąlygines taip pat), jei tokių yra, ir pakartokite normalumo testą.

4.	Patikrinkite hipotezę: Ar žmonių, kurie turi vaikų, ir žmonių, kurie jų neturi, socialiniai  
	 poreikiai skiriasi? 

5.	Parašykite išvadas. Paaiškinkite apie žmonių, kurie turi vaikų, gyvenimo kokybę.
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Užduotims atlikti naudokite duomenis iš Streso tyrimas.sav.

5 užduotis. Patikrinkite hipotezę: Ar tie, kurie rūko, patiria didesnį stresą nei nerūkantys?
Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendras patiriamas stre-

sas Bpats vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo rukymas (tik dvi grupės;  
Taip / Ne) skiriasi. Naudokite nepriklausomoms imtims Stjudento t kriterijų, kai reikšmingu-
mo lygmuo α = 0,05.

Tyrimo tvarka:

1.	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamųjų  
	 skirstinys artimas normaliajam.

2.	Paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai.

3.	Pašalinkite išskirtis (sąlygines taip pat), jei tokių yra, ir pakartokite normalumo testą.

4.	Patikrinkite hipotezę: Žmonės, kurie rūko ir kurie nerūko, streso patiria skirtingai. 

5.	Parašykite išvadas. Ką galite pasakyti apie nerūkančiųjų gyvenimo kokybę?

Užduotims atlikti naudokite duomenis iš Streso tyrimas.sav.

6 užduotis. Patikrinkite hipotezę: Ar tie, kurie turi mokslų daktaro laipsnį, patiria mažiau 
streso nei žmonės su aukštuoju išsilavinimu?

Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendras patiriamas stre-
sas Bpats vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo mokslai (tik dvi grupės;  
3 / 6) skiriasi. Naudokite nepriklausomoms imtims Stjudento t kriterijų, kai reikšmingumo lyg-
muo α = 0,05.

Tyrimo tvarka:

1.	Kategorinis kintamasis mokslai turi šešias kategorijas, todėl prieš tyrimą atlikite duomenų  
	 filtravimą, tai yra eliminuokite iš tyrimo nereikalingus duomenis, pasirinkdami tik dvi  
	 kategorijas 3 – aukštasis bakalauras ir 6 – mokslų daktaras. Select Cases -> If ... lange  
	 įrašykite informaciją: (mokslai = 3) | (mokslai = 6).

2.	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamųjų 
	 skirstinys artimas normaliajam.

3.	Paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai.

4.	Pašalinkite išskirtis (sąlygines taip pat), jei tokių yra, ir pakartokite normalumo testą.

5.	Patikrinkite hipotezę: Skirtingo išsilavinimo žmonės streso patiria skirtingai (ar jų gyvenimo 
	 kokybė skiriasi).
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6.	Parašykite išvadas. Ką galite pasakyti apie mokslinį laipsnį įgijusių patiriamą stresą?

Užduotims atlikti naudokite duomenis iš Streso tyrimas.sav.

7 užduotis. Patikrinkite hipotezę: Ar tie, kurie oficialiai išsiskyrę, patiria mažiau streso nei 
našliai?

Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendras patiriamas stre-
sas Bpats vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo seima (tik dvi grupės; 4 (su-
situokę pirmą kartą) / 5 (pakartotinai susituokę)) skiriasi. Naudokite nepriklausomoms imtims 
Stjudento t kriterijų, kai reikšmingumo lygmuo α = 0,05.

Tyrimo tvarka:

1.	Kategorinis kintamasis seimai turi penkias kategorijas, todėl prieš tyrimą atlikite duome- 
	 nų filtravimą, tai yra eliminuokite iš tyrimo nereikalingus duomenis. Select Cases -> If ... 
	 lange surinkite informaciją: (seima = 4) | (seima = 5).

2.	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamųjų  
	 skirstinys artimas normaliajam.

3.	Paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai.

4.	Pašalinkite išskirtis (sąlygines taip pat), jei tokių yra, ir pakartokite normalumo testą.

5.	Patikrinkite hipotezę: Ar skirtingai patiria streso žmonės, kurie susituokę pirmą kartą ir 
	 kurie yra pakartotinai susituokę. 

6.	Parašykite išvadas. Ką galite pasakyti apie pakartotinai susituokusiųjų patiriamą stresą?

Užduotims atlikti naudokite duomenis iš Streso tyrimas.sav.

8 užduotis. Patikrinkite hipotezę: Ar tie, kurie niekada nebuvę santuokoje, patiria mažiau 
streso nei našliai?

Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendras patiriamas stresas 
Bpats vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo seima (tik dvi grupės; 1 (vieni-
ši) / 5 (pakartotinai susituokę)) skiriasi. Naudokite nepriklausomoms imtims Stjudento t krite-
rijų, kai reikšmingumo lygmuo α = 0,05.

Tyrimo tvarka:

1.	Kategorinis kintamasis seima turi penkias kategorijas, todėl prieš tyrimą atlikite duomenų 
	 filtravimą, tai yra eliminuokite iš tyrimo nereikalingus duomenis. Select Cases -> If ...  
	 lange suraškite informaciją: (seima = 1) | (seima = 5).
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2.	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamųjų  
	 skirstinys artimas normaliajam.

3.	Paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai.

4.	Pašalinkite išskirtis (sąlygines taip pat), jei tokių yra, ir pakartokite normalumo testą.

5.	Patikrinkite hipotezę: Ar skirtingai patiria streso žmonės, kurie vieniši ir kurie yra pakar- 
	 totinai susituokę. 

6.	Parašykite išvadas. Ką galite pasakyti apie vienišių patiriamą stresą?

Užduotims atlikti naudokite duomenis iš kompetencijos.sav.

9 užduotis. Patikrinkite hipotezę: Ar pirminės grandies pareigūnai mažiau skiria dėmesio 
asmeninių kompetencijų ugdymui nei karininkai?

Reikės tirti ar priklausomo intervalų skalėje išmatuoto kintamojo Basmen (bendros asmeni-
nės kompetencijos) vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo pareigos (tik dvi 
grupės; 0 (pirminės grandies pareigūnai) / 1 (karininkai) skiriasi. Naudokite nepriklausomoms 
imtims Stjudento t kriterijų, kai reikšmingumo lygmuo α = 0,05.

Tyrimo tvarka:

1.	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų nustatykite, ar kintamųjų  
	 skirstinys artimas normaliajam.

2. 	Paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai.

3. 	Pašalinkite išskirtis (sąlygines taip pat), jei tokių yra, ir pakartokite normalumo testą.

4. 	Patikrinkite hipotezę: Ar pirminės grandies pareigūnų ir karininkų bendros asmeninės  
	 kompetencijos skiriasi? 

5. 	Parašykite išvadas. Ką galite pasakyti apie vienišių patiriamą stresą?

Užduotims atlikti naudokite duomenis iš Vado vaidmuo.sav.

10 užduotis. Patikrinkite hipotezę: Ar tie kariškiai, kurie turi aukštąjį išsilavinimą, save la-
biau gerbia nei turintys vidurinį?

Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendro savęs vertinimo 
(Bsav_vert_K12) vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo issilavinimas (tik 
dvi grupės; 0 (vidurinis) / 1 (aukštasis) skiriasi. Naudokite nepriklausomoms imtims Stjudento 
t kriterijų, kai reikšmingumo lygmuo α = 0,05.



Duomenų analizės SPSS pagrindai196

Tyrimo tvarka:

1. 	Kategorinis kintamasis issilavinimas turi 6 kategorijas, todėl prieš tyrimą filtruokite duo- 
	 menis, tai yra eliminuokite iš tyrimo nereikalingus duomenis. Select Cases -> If ... lange 
	 įrašykite informaciją: (issilavinimas = 1) | (issilavinimas = 6).

2. 	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų nustatykite, ar kintamųjų 
	 skirstinys artimas normaliajam.

3. 	Paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai.

4. 	Pašalinkite išskirtis (sąlygines taip pat), jei tokių yra, ir pakartokite normalumo testą.

5. 	Patikrinkite hipotezę: Ar skirtingai save vertina skirtingą išsilavinimą turintys kariškiai? 

6. 	Parašykite išvadas. Ką galite pasakyti apie kariškius su viduriniu išsilavinimu?

Užduotims atlikti naudokite duomenis iš Vado vaidmuo. sav.
11 užduotis. Patikrinkite hipotezę: Ar tie kariškiai, kurie ilgiau tarnauja, yra labiau save 

gerbiantys?
Reikės tirti ar priklausomo intervalų skalėje išmatuoto kintamojo bendras savęs vertinimas 

(Bsav_vert_K12) vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo tarn_stazas (tik dvi 
grupės; 1 (iki 5 metų) / 4 (16–20 metų)) skiriasi. Naudokite nepriklausomoms imtims Stjudento 
t kriterijų, kai reikšmingumo lygmuo α = 0,01.

Tyrimą vykdykite tokia tvarka:

1.	Kategorinis kintamasis tarn_stazas turi 5-ias kategorijas, todėl prieš tyrimą atlikite duome-  
	 nų filtravimą, tai yra eliminuokite iš tyrimo nereikalingus duomenis. Select Cases -> If ...  
	 lange įrašykite informaciją: (tarn_stazas = 1) | (tarn_stazas = 4).

2.	Naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite ar kintamųjų  
	 skirstinys artimas normaliajam.

3. 	Paaiškinkite ką rodo asimetrijos ir eksceso koeficientai.

4. 	Pašalinkite išskirtis (sąlygines taip pat) jei tokių yra ir pakartokite normalumo testą.

5. 	Patikrinkite hipotezę: Ar skirtingai save vertina sikrtingą tarnybos patirtį turintys kariškiai? 

6. 	Parašykite išvadas. Ką galite pasakyti apie kariškius, kurių stažas iki 5 metų?
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7.4.9. Vienfaktorinė dispersinė analizė ANOVA

Šiame skyriuje paaiškinsime vieno faktoriaus dispersinės analizės (ANOVA) taikymą. 
ANOVA yra Stjudento t kriterijaus apibendrinimas kelių vidurkių lygybei tikrinti. Kai vidur-
kiai tik du, tai ANOVA sutampa su Stjudento t testu. Tad kodėl reikia ANOVA, jeigu visus gru-
pių vidurkius galima palyginti poromis Stjudento t testu? Problema ta, kad visos statistinės išva-
dos nėra šimtaprocentinės, o tik labai (95 proc.) tikėtinos. Taigi atliekant kiekvieną tyrimą, visa-
da yra nedidelis šansas apsirikti. Kai tyrimų daug, galimos klaidos, tikimybės kaupiasi ir šansas 
bent kartą priimti klaidingą sprendimą didėja. Todėl geriau viena ANOVA penkiems vidurkiams 
palyginti, nei 9 lyginimai Stjudento t testu.

Laikysimės ANOVA metodui keliamų reikalavimų:
l	priklausomas kintamasis yra išmatuotas santykių arba intervalų skalėje (čia tas kintamasis, 

kurio vidurkis mus domina);
l	faktorius – išmatuotas vardinėje arba ranginėje skalėje, turintis du ar daugiau grupių. 

Sugrupavus intervalinį kintamąjį, jis gali būti naudojamas kaip faktorius (jame nurodomas gru-
pės kodas);

l	priklausomas kintamasis negali turėti esminių išskirčių ir privalo tenkinti normalumo sąlygą.
Tyrimui pailiustruoti pasinaudosime rinkmena Streso tyrimas.sav, kurios reikšmių kodavi-

mo lentelė ir klausimai pateikti priede. Tyrimo santrauka yra pateikta 7.33 lentelėje.

7.33 ANOVA tyrimo santrauka.

Kas tiriama? Tiriama, ar patiriamo streso kontrolė yra skirtinga trijose amžiaus grupėse 
(jaunimas, vidutinio amžiaus ir pagyvenę)?

Pasirinkti 
duomenys tyrimui

Du kintamieji:
l	 vienas nepriklausomas kategorinis kintamasis (faktorius) amgr3 (iki 29;  

30-44; 45>=), kuris yra sugrupuotas intervalinis kintamasis; 
l	 vienas priklausomas intervalų skalėje išmatuotas kintamasis Bstkon (bendra 

streso kontrolė)
Ką išsiaiškinsime? ANOVA parodys, ar skirtumai tarp grupių yra statistiškai reikšmingi. Jei taip, tada 

gali būti panaudotas post-hoc testas nustatyti, kurių grupių vidurkiai statistiškai 
reikšmingai skiriasi.

Tyrimą pradėsime nuo patikrinimo, ar duomenys tenkina ANOVA prielaidas: ar patiriamo 
streso kontrolės kintamasis yra apytiksliai pasiskirstęs pagal normalųjį dėsnį visose trijose gru-
pėse; taip pat įvertinsime asimetrijos bei eksceso koeficientus ir patikrinsime, ar nėra išskirčių.
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Patikrinsime, ar nėra išskirčių:

1 	 Pagrindinėje SPSS programų paketo meniu juostoje pasirinkite 
		  Analyze->Descriptive Statistics->Explore;
2 	 Įkelkite kintamąjį Bstkon (bendra streso kontrolė) į laukelį Dependent List, įkelkite  

		  kintamąjį amgr3 į Factor List, o į Label Cases by įkelkite kintamąjį id OK.

Po šios procedūros SPSS išvesties lange bus pateikta užtektinai informacijos, kad galėtume 
priimti sprendimą apie kintamojo Bstkon (bendra streso kontrolė) tinkamumą tirti ANOVA ana-
lizės metodu.

7.34 lentelė. Kolmogorovo–Smirnovo kriterijų ir Shapiro–Wilko kriterijų rezultatai.

Tests of Normality
3 amziaus 

grupes
Kolmogorov-Smirnova Shapiro-Wilk

Statistic df Sig. Statistic df Sig.

Bendra streso kontrolė
1 ,072 146 ,058 ,975 146 ,008
2 ,107 151 ,000 ,975 151 ,007
3 ,054 133 ,200* ,983 133 ,086

a. Lilliefors Significance Correction
*. This is a lower bound of the true significance.

3 amziaus grupes
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7.16 pav. Kintamojo amgr3 stačiakampės diagramos.
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7.34 lentelėje. („Tests of Normality“) galima pamatyti kintamojo Bstkon skirstinio vertinimą 
pagal du kriterijus, tai Kolmogorovo–Smirnovo kriterijų ir Shapiro–Wilko kriterijų, kuris rodo, 
kad kintamojo Bstkon skirstinys statistiškai reikšmingai skiriasi nuo normaliojo tik trečiojoje 
amžiaus grupėje.

Stačiakampės diagramos rodo sąlygines išskirtis (7.16 pav.). Taip pat pateikia papildomą in-
formaciją, nes diagramose šalia išskirčių yra nurodyti id numeriai: 538, 61, 442, 24, 507. Šias 
išskirtis reikia pašalinti. Išrinkite tuos atvejus, kurių id numeriai yra nurodyti grafike. Tam rei-
kės atlikti tokius žingsnius. 

Išskirčių šalinimas

1 	I šskirčių id numeriams išrinkti reikia pagrindinėje SPSS programų paketo meniu juosto- 
		  je pasirinkti Data -> Select Cases -> If ...

2 	T ada Select Cases -> If ... lange surinkti informaciją: 
		  (id ~= 24) & (id ~= 538) & (id ~= 61) & (id ~= 442) & (id ~= 507)

Pašalinus išskirtis, kintamojo Bstkon skirstinys statistiškai reikšmingai skiriasi nuo norma-
liojo tik 2-os grupės imtyje pagal Shapiro–Wilko kriterijų, p < α (7.35 lentelė), tačiau šis skirtu-
mas nėra didelis, Shapiro–Wilko kriterijaus statistika yra labai arti vieneto.

7.35 lentelė. Normalumo testo rezultatai po išskirčių pašalinimo.

Tests of Normality
3 amziaus 

grupes
Kolmogorov-Smirnova Shapiro-Wilk

Statistic df Sig. Statistic df Sig.

Bendra streso kontrolė
1 ,067 142 ,200* ,992 142 ,569
2 ,107 151 ,000 ,975 151 ,007
3 ,056 132 ,200* ,984 132 ,122

a. Lilliefors Significance Correction
*. This is a lower bound of the true significance.

Kaip matote, duomenys nėra labai tinkami ANOVA modeliui, bet tęsime savo tyrimą toliau 
ir atliksime vienfaktorinę dispersinę analizę su post-hoc testu.
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ANOVA su post-hoc testu atlikimas

1 	 Pagrindiniame SPSS programų paketo meniu renkamės 
		  Analyze->Compare Means->One-way ANOVA.
2 	 Priklausomą intervalų skalėje išmatuotą kintamąjį (pvz., pasitenkinimas gyvenimu) 

	  	perkelkite į Dependent List laukelį.
3 	N epriklausomą kategorinį kintamąjį (faktorių) amgr3 (iki 29; 30–44; 45>=), kuris yra  

		  sugrupuotas intervalinis kintamasis, perkelkite į Factor langą.
4 	 Pasirinkite Options. Atsidariusiame One-Way ANOVA: Options lange pasirinkite

		  Descriptive, Homogeneity-of-Variance ir Means Plot.
5 	 Pasirinkite Exclude cases analysis by analysis.
6 	 Pasirinkite Post Hoc, šiame lange pasirinkite Tukey.
7 	G aliausiai rinkitės Continue ir OK.

Po šios procedūros SPSS programų paketo išvesties lange pamatysite lenteles ir grafiką. 7.36 
lentelėje Descriptives yra pateikta informacija apie kiekvieną grupę atskirai grupės dydis, vidur-
kis, standartinis nuokrypis, minimumas ir maksimumas, ir kita informacija). Visada susipažin-
kite su informacija, pateikta šioje lentelėje. Kaip matote, grupių dydis nėra vienodas, o tai daro 
įtaką ANOVA modelio rezultatams.

7.36 lentelė. Pagrindinės grupių charakteristikos.

Descriptives
Bendra streso kontrolė

N Mean Std. 
Deviation

Std. 
Error

95% Confidence Interval for Mean
Minimum Maximum

Lower Bound Upper Bound
1 146 58,46 11,147 ,923 56,64 60,28 20 86
2 151 59,56 12,214 ,994 57,60 61,53 24 86
3 133 64,21 11,890 1,031 62,17 66,25 23 88

Total 430 60,63 11,985 ,578 59,49 61,76 20 88

Homogeniškumo testo rezultatas yra pateiktas 7.37 lentelėje. („Test of homogeneity of vari-
ances“). 

Livyno (Levene Statistic) kriterijaus statistika rodo, kad visos dispersijos yra lygios. Šį 
sprendimą priimame remdamiesi pasirinktu reikšmingumo lygmeniu α = 0.05 ir p reikšme, esan-
čia „Sig.“ stulpelyje (p = 0,118 > α).
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7.37 lentelė. Homogeniškumo testas.

Test of Homogeneity of Variances
Bendra streso kontrolė

Levene Statistic df1 df2 Sig.
2,146 2 427 ,118

Pastaba. Beje, Livyno testas, kitaip nei ANOVA, labai jautrus kintamųjų normalumui. 
Todėl pasaulyje itin dažnai jokiais Livyno testais nesiremiama, o tiesiog pažiūrima, ar lente-
lėje Descriptives pateiktas didžiausias standartinis nuokrypis (mūsų atveju 11,985) nevirši-
ja mažiausiojo (mūsų atveju 11,147) daugiau kaip dukart. Jeigu neviršija (mūsų atveju taip ir 
yra), tai tariama, kad taikant ANOVA dėl dispersijų nelygybės problemų nekils.

7.38 lentelė. ANOVA tyrimų rezultatas.

ANOVA
Bendra streso kontrolė

Sum of Squares df Mean Square F Sig.
Between Groups 2565,208 2 1282,604 9,274 ,000
Within Groups 59057,511 427 138,308
Total 61622,719 429

7.38 lentelė ANOVA, kurioje yra pateiktas ANOVA metodo tyrimų rezultatas suteikia iš-
samią informaciją. Čia rasite: grupių kvadratų sumą, vidinę kvadratų sumą, laisvės laipsnius 
ir kitą informaciją. Šią lentelę SPSS programų paketas pateikia labai panašiai kaip ir daugu-
ma statistikos knygų, tad bus labai paprasta ją analizuoti. Tačiau norint priimti sprendimą, ar 
yra skirtumų tarp grupių ar ne, reikės tik p reikšmės, esančios „Sig.“ stulpelyje. Kadangi su 
pasirinktu reikšmingumo lygmeniu α = 0,05 gavome p = 0,000 reikšmę, tai hipotezę apie vi-
durkių lygybę atmetame. Skirtingo amžiaus respondentų streso kontrolės vidutiniai vertini-
mai skiriasi. Galime pasakyti, kad patiriamo streso kontrolė ir respondentų amžius yra tarpu-
savyje susiję.

Kadangi ANOVA nenurodo, kurių imčių vidurkiai statistiškai reikšmingai skiriasi, reikia tai-
kyti post-hoc kriterijų, kuris padės tai nustatyti. 7.39 lentelėje Multiple Comparisons kaip tik 
yra pateiktas pasirinkto Tjukio HSD (Tukey HSD) kriterijaus testo rezultatas. SPSS progra-
mų paketo lentelėse statistiškai reikšmingi vidurkių skirtumai pažymimi žvaigždute. Stulpelyje 
Sig. yra pateikiamos p reikšmės. 7.39 lentelės apačioje nurodomas reikšmingumo lygmuo  
α = 0,05, kuriuo remiantis buvo atliktas tyrimas. 
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7.39 lentelė. Tjukio HSD (Tukey HSD) kriterijaus testo rezultatas.

Multiple Comparisons
Bendra streso kontrolė
Tukey HSD

(I) 3 amziaus 
grupes

(J) 3 amziaus 
 grupes

Mean Difference 
(I-J)

Std. 
Error Sig.

95% Confidence Interval
Lower Bound Upper Bound

1 2 -1,104 1,365 ,698 -4,31 2,11
3 -5,752* 1,410 ,000 -9,07 -2,44

2 1 1,104 1,365 ,698 -2,11 4,31
3 -4,648* 1,399 ,003 -7,94 -1,36

3 1 5,752* 1,410 ,000 2,44 9,07
2 4,648* 1,399 ,003 1,36 7,94

*. The mean difference is significant at the 0.05 level.

Darome išvadą. Kad p < 0,05 lygmenyje reikšmingai skiriasi 3-ia amžiaus grupė nuo 1-os ir 
2-os grupių. Sprendimą darome remdamiesi reikšmėmis, esančiomis „Sig.“ stulpelyje, čia lygi-
nant 1-ą ir 3-ią grupes p reikšmė yra 0,001 ir 2-ą ir 3-ią grupes p reikšmė yra 0,003. Tai reiškia, 
kad kalbant apie šių grupių streso kontrolės vertinimus, 18–29 amžiaus ir 30–44 amžiaus grupės 
gerokai skiriasi nuo 45+ amžiaus grupės.

7.40 lentelė. Homogeniškų grupių vidurkių lentelė.

Bendra streso kontrolė
Tukey HSDa,,b

3 amziaus  
grupes N

Subset for alpha = 0.05
1 2

1 146 58,46
2 151 59,56
3 133 64,21

Sig. ,707 1,000
Means for groups in homogeneous subsets are displayed.
a. Uses Harmonic Mean Sample Size = 142,921.
b. The group sizes are unequal. The harmonic mean of the group sizes is used. Type I error levels are not guaranteed.

SPSS programų paketas, remdamasis Tjuko HSD kriterijumi, sudarė homogeniškų grupių 
vidurkių lentelę (7.40) „Bendra streso kontrolė“. Kadangi trijų grupių vidurkiai skyrėsi, tai šio-
je lentelėje yra dar kartą nurodyta, kurių grupių vidurkiai skiriasi. Po lentele yra pateikiama pa-
pildoma statistinių skaičiavimų informacija.
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7.17 pav. Kintamojo bendra streso kontrolė vidurkių trendas.

Vidurkių trendas

Šis grafikas leidžia lengvai palyginti tris grupes. Aiškiai matome, kad 18–29 amžiaus gru-
pės streso kontrolės vertinimas yra žemiausias, o 45+ amžiaus grupės yra aukščiausias. Galime 
daryti išvada, kad didėjant amžiui patiriama daugiau streso. Priklausomai nuo Y ašies (ši ašis 
parodo streso kontrolės reikšmes) skalės net labai maži skirtumai gali atrodyti labai dideliais. 
Grafike, kuris yra parodytas 7.17 pav., skirtumai tarp grupių vidurkių skaitine išraiška yra nedi-
deli ( 58,46; 59,56; 64,21), tačiau jie atrodo labai dideli dėl Y ašies. Todėl nereikėtų per daug jau-
dintis dėl šio grafiko, nes Y ašies skalė iškraipo pateikiamų rezultatų vaizdą. Geriau reikėtų pa-
sitikrinti informaciją, pateikiamą lentelėse, ir, žinoma, galite pakeisti Y ašies skalės pradžią, kad 
pamatytumėte aiškesnį vaizdą.  
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7.4.10. Užduotys

1 užduotis. Užduočiai atlikti atidarykite SPSS programų paketo lange hipotetinių duomenų 
rinkmeną Lpratybos_4gr.sav. Patikrinkite hipotezę: Kariūnų lauko pratybų metu patiriamo 
streso vidurkiai visų kursų (I; II; III; IV) grupėse (populiacijose) skiriasi. Naudokite kinta-
muosius stresas ir 4gr. 

Tyrimo tvarka:

1.	Patikrinkite dispersinės analizės taikymo prielaidas:

	 l	nustatykite, ar priklausomas kintamasis pasiskirstęs normaliuoju dėsniu visose tiriamose  
		  grupėse, patikrinkite asimetrijos, eksceso koeficientus; 

	 l	ištirkite, ar nėra išskirčių, jei yra, jas pašalinkite ir pakartokite normalumo testą;

	 l	nustatykite, ar priklausomo kintamojo dispersijos populiacijose lygios. 

2.	Nustatykite, kokių grupių vidurkiai skiriasi statistiškai reikšmingai. Pasirinkite reikšmin- 
	 gumo lygmenį α = 0,05.

3.	Parašykite išvadas. Paaiškinkite, ar kariūnų lauko pratybų metu patiriamas stresas yra su- 
	 sijęs su mokymosi trukme?

2 užduotis. Užduočiai atlikti atidarykite SPSS programų paketo lange hipotetinių duomenų 
rinkmeną Laisvalaikis_5gr.sav. Patikrinkite hipotezę: Laisvalaikio skalės reikšmių vidurkiai 
skiriasi penkiose grupėse. Naudokite kintamuosius pasirinkimas ir 5gr. 

Tyrimo tvarka:

1.	Patikrinkite dispersinės analizės taikymo prielaidas:

	 l	nustatykite, ar priklausomas kintamasis pasiskirstęs normaliuoju dėsniu visose tiriamose  
		  grupėse, patikrinkite asimetrijos, eksceso koeficientus; 

	 l	ištirkite, ar nėra išskirčių, jei yra, jas pašalinkite ir pakartokite normalumo testą;

	 l	nustatykite, ar priklausomo kintamojo dispersijos populiacijose lygios. 

2.	Nustatykite, kokių grupių vidurkiai skiriasi statistiškai reikšmingai. Pasirinkite reikšmin- 
	 gumo lygmenį α= 0,05.

3.	Parašykite išvadas. Paaiškinkite, ar laisvalaikio praleidimo pasirinkimas yra susijęs su  
	 siūlomomis penkiomis galimybėmis?
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3 užduotis. Norėdami sužinoti kariūnų nuomonę apie lauko pratybų metu patiriamą stresą 
apklausėme 28 kariūnus. Didesnis balas žymi nuomonę apie didesnį stresą. Atsižvelgiant į ka-
riūnų amžių, visi jie suskirstyti į keturias grupes (1 kursas, 2 kursas, 3 kursas ir 4 kursas). Ar ga-
lima teigti, kad požiūris į patiriamą stresą pratybų metu ir kariūnų mokymosi laikotarpiu yra su-
siję dalykai? 

Reikšmingumo lygmuo α = 0,05. Duomenys pateikti lentelėje:

kursas Patiriamas stresas
1 78 81 79 80 74 81 80 77 88 75 80 74 81 80
2 75 77 73 69 78 74 75 75 77 73 69 78 74 75
3 71 69 62 69 68 71 70 71 69 62 68 70 78 79
4 63 61 67 65 80 64 63 63 61 71 65 70 64 63

4 užduotis. Užduočiai atlikti atidarykite SPSS programų paketo lange hipotetinių duomenų 
rinkmeną dvdplayer.sav. Tai duomenys, susiję su naujo DVD grotuvo tobulinimu prieš siūlant 
jį pirkėjams. Tyrimui naudodama sukurtą DVD prototipą, rinkodaros komanda apklausė respon-
dentus. Šioje rinkmenoje kiekvienas atvejis atitinka atskirai apklaustą vartotoją. Tyrimui surink-
ta tam tikra demografinė informacija apie respondentus ir jų atsakymai į klausimus apie siūlomą 
rinkai naują DVD prototipą.

Patikrinkite hipotezę: 
DVD vertinimas yra skirtingas trijose amžiaus grupėse (jaunimas, vidutinio amžiaus ir pa-

gyvenę).
Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendras DVD vertinimas 

(DVDscore) vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo amgr3 skiriasi. Tyrimui 
naudokite nepriklausomoms imtims ANOVA, kai reikšmingumo lygmuo α = 0,05.

Tyrimo tvarka:

1.	Patikrinkite dispersinės analizės taikymo prielaidas:

	 l		naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamojo  
			  skirstinys artimas normaliajam;

	 l		paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai;

	 l		ištirkite, ar nėra išskirčių.

2. 	Atlikite ANOVA su post-hoc:

	 l		nustatykite, ar priklausomo kintamojo dispersijos populiacijose lygios;
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	 l		ar kategorinio kintamojo amgr3 grupių vidurkiai skiriasi statistiškai reikšmingai;

	 l		jei skiriasi, nustatykite, kurių grupių vidurkiai skiriasi statistiškai reikšmingai. Tyrimui atlikti  
			  taikykite Bonferroni arba Tukey kriterijus. Pasirinkite reikšmingumo lygmenį α = 0,05;

	 l		tyrimo rezultatą vaizduokite grafiškai (nubrėžkite vidurkių trendą).

3.	Parašykite išvadas. Paaiškinkite, ar DVD vertinimas yra susijęs su amžiaus grupe?

5 užduotis. Užduočiai atlikti atidarykite SPSS programų paketo lange hipotetinių duomenų 
rinkmeną salesperformance.sav. Tai hipotetiniai duomenys, susiję su dviejų naujų pardavimų 
mokymo kursų vertinimu. Šešiasdešimt darbuotojų buvo suskirstyti į tris grupes, visiems buvo 
vesti standartiniai mokymai. Papildomai 2-a grupė buvo apmokoma pasitelkiant spec. technines 
galimybes; 3-ia grupė atliko papildomas užduotis be techninių priemonių. Po kursų visos gru-
pės buvo egzaminuojamos ir įvertintos. Šioje rinkmenoje kiekvienas atvejis atitinka skirtingą 
respondentą su fiksuota mokymo grupe, kuriai jie buvo paskirti, ir jų gautą egzamino vertinimą.

Patikrinkite hipotezę: 
Mokymų vertinimas yra skirtingas trijose mokymų grupėse.
Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo egzamino rezultatai (per-

form) vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo group skiriasi. Tyrimui naudo-
kite nepriklausomoms imtims ANOVA, kai reikšmingumo lygmuo α = 0,05.

Tyrimo tvarka:

1.	Patikrinkite dispersinės analizės taikymo prielaidas:

	 l		naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamojo  
			  skirstinys artimas normaliajam;

	 l		paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai;

	 l		ištirkite, ar nėra išskirčių.

2.	Atlikite ANOVA su post-hoc:

	 l		nustatykite, ar priklausomo kintamojo dispersijos populiacijose lygios;

	 l		ar kategorinio kintamojo group grupių vidurkiai skiriasi statistiškai reikšmingai;

	 l		jei skiriasi, nustatykite, kurių grupių vidurkiai skiriasi statistiškai reikšmingai. Tyrimui  
			  atlikti taikykite Bonferroni arba Tukey kriterijus. Pasirinkite reikšmingumo lygmenį  
			  α = 0,05;

	 l		tyrimo rezultatą vaizduokite grafiškai (nubrėžkite vidurkių trendą).
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3. Parašykite išvadas. Paaiškinkite, ar mokymų vertinimas yra susijęs su mokymų metodu?

6 užduotis. Užduočiai atlikti atidarykite SPSS programų paketo lange hipotetinių duomenų 
rinkmeną waittimes.sav. Tai hipotetiniai duomenys, susiję su banko klientų praleistu laiku tvar-
kant finansinius verslo reikalus trijuose skirtinguose banko filialuose. Šioje rinkmenoje kiek-
vienas atvejis atitinka skirtingą banko klientą ir banko filiale sugaištą laiką tvarkant finansinius 
savo verslo reikalus.

Patikrinkite hipotezę: 
Banko kliento praleistas laikas tvarkant finansinius verslo reikalus yra skirtingas trijose 

banko filialuose.
Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo banko kliento praleistas 

laikas tvarkant finansinius verslo reikalus (wait) vidurkiai atžvilgiu nepriklausomo kategorinio 
kintamojo branch skiriasi. Tyrimui naudokite nepriklausomoms imtims ANOVA, kai reikšmin-
gumo lygmuo α = 0,05.

Tyrimo tvarka:

1.	Patikrinkite dispersinės analizės taikymo prielaidas:

	 l		naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų, nustatykite, ar kintamojo  
			  skirstinys artimas normaliajam;

	 l		paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai;

	 l		ištirkite, ar nėra išskirčių.

2.	Atlikite ANOVA su post-hoc:

	 l		nustatykite, ar priklausomo kintamojo dispersijos populiacijose lygios;

	 l		ar kategorinio kintamojo group grupių vidurkiai skiriasi statistiškai reikšmingai;

	 l		jei skiriasi, nustatykite, kurių grupių vidurkiai skiriasi statistiškai reikšmingai. Tyrimui atlikti  
			  taikykite Bonferroni arba Tukey kriterijus. Pasirinkite reikšmingumo lygmenį α = 0,05;

	 l		tyrimo rezultatą vaizduokite grafiškai (nubrėžkite vidurkių trendą).

3.	Parašykite išvadas. Paaiškinkite, ar banko kliento praleistas laikas tvarkant finansinius  
	 verslo reikalus yra susijęs su banko filialu?
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7 užduotis. Užduočiai atlikti atidarykite SPSS programų paketo lange hipotetinių duomenų 
rinkmeną Vado vaidmuo.sav. Tai duomenys, susiję su taikomu tiksliniu vadovavimo stiliumi 
Lietuvos kariuomenėje, kuris leidžia viduriniosios ir žemesniosios grandies vadams savarankiš-
kai priimti sprendimus ir prisiimti atsakomybę už rezultatus.

Tyrimas atliktas viename iš karinių vienetų, siekiant nustatyti, kiek šis vadovavimo stilius  
plačiai ir efektyviai yra taikomas. Šioje rinkmenoje kiekvienas atvejis atitinka individualiai ap-
klaustą respondentą. 

Patikrinkite hipotezę: 
Bendri padalinio tikslai ir uždaviniai skirtingai vertinami trijų grupių (skyriaus vadas, bū-

rio vadas, kuopos vadas).
Reikės tirti, ar priklausomo intervalų skalėje išmatuoto kintamojo bendrų padalinio tikslų ir už-

davinių (Bpadalinys_K11) vidurkiai atžvilgiu nepriklausomo kategorinio kintamojo pareigos ski-
riasi. Tyrimui naudokite nepriklausomoms imtims ANOVA, kai reikšmingumo lygmuo α = 0,05.

Tyrimą atlikite tokia tvarka:

1.	Patikrinkite dispersinės analizės taikymo prielaidas:

	 l		naudodami Kolmogorovo–Smirnovo ir Shapiro–Wilko kriterijų nustatykite, ar kintamojo  
		  skirstinys artimas normaliajam;

	 l		paaiškinkite, ką rodo asimetrijos ir eksceso koeficientai;

	 l		ištirkite, ar nėra išskirčių.

2. Atlikite ANOVA su posthoc:

	 l		nustatykite, ar priklausomo kintamojo dispersijos populiacijose lygios;

	 l		ar kategorinio kintamojo pareigos grupių vidurkiai skiriasi statistiškai reikšmingai;

	 l		jei skiriasi, nustatykite, kurių grupių vidurkiai skiriasi statistiškai reikšmingai. Tyrimui at- 
		  likti taikykite Bonferroni arba Tukey kriterijus. Pasirinkite reikšmingumo lygmenį  
		  α = 0,05;

	 l		tyrimo rezultatą pavaizduokite grafiškai (nubrėžkite vidurkių trendą).

3. 	Parašykite išvadas. Paaiškinkite, ar bendrų padalinio tikslų ir uždavinių vertinimas yra su-
sijęs su užimamomis pareigomis?
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PRIEDAI

Streso tyrimas.sav

Tai hipotetinių duomenų rinkmena, sukurta pailiustruoti statistinės analizės tyrimo ypatu-
mus, kai tyrimui naudojamas SPSS programų paketas. Šioje rinkmenoje naudojami specialis-
tų patikrinti ir pripažinti tinkamais klausimų blokai. Šie klausimai matuoja: savigarbą, optimiz-
mą, patiriamą kontrolės lygį, pasitenkinimą gyvenimu, profesionalumą, socialinius poreikius. 
Rinkmenos dydis 439 respondentai, iš jų 42 proc. vyrai, 58 proc. moterys.

Anketa

Šioje anketoje yra klausimai, kurie matuoja jūsų nuomonę, viltis ir elgseną. Prašome atsaky-
ti į pateiktus klausimus kiek galima nuoširdžiau. Negalvokite per daug rinkdamiesi atsakymą. 
Pirmas, kas šauna jums į galvą, yra tas tikrasis atsakymas, kurį reikėtų pažymėti anketoje. Prie 
kiekvieno klausimo yra instrukcija, kaip reikėtų į jį atsakyti. atsakydami į klausimus, kurie ne-
siūlo jokio pasirinkimo, turite pateikti savo mintis, o klausimai, kurie prašo išreikšti jūsų nuomo-
nę, įvairiose skalėse reikalauja atidumo, tad nesupainiokite pateiktų skalių reikšmių.

1. Lytis:  vyras  moteris (pažymėkite tinkamą)

2.	Amžius:  (metais)

3.	Kokia jūsų šeiminė padėtis? (pažymėkite tinkamą)
1.	Viengungis
2.	Gyvenantys poroje
3.	Vedęs (-usi)
4.	Išsituokęs (-usi)
5.	Gyvenantys atskirai
6.	Našlys (-ė)

4.	Ar gyvente su vaikais? (pažymėkite tinkamą)
1.	Taip
2.	Ne

5.	Koks jūsų aukščiausias išsilavinimo laipsnis? (pažymėkite tinkamą)
1.	Pradinis
2.	Vidurinis 
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3.	Profesinis vidurinis
4.	Aukštasis bakalauras
5.	Aukštasis magistras
6.	Mokslų daktaras

6.	Kokie yra pagrindiniai streso šaltiniai jūsų gyvenime?

7.	Ar rūkote? (pažymėkite tinkamą)
1.	Taip
2.	Ne
Jei taip, kiek cigarečių surūkote per savaitę? 

8.	Perskaitykite jums pateiktus teiginius ir nuspręskite. kaip labai su jais sutinkate arbe ne. 
Savo sprendimą pažymėkite: 1 – visiškai nesutinku, 2 3 4 5 – visiškai sutinku.
Kiekvienas teiginys turi būti įvertintas skaičiumi nuo 1 iki 5.

Teiginiai nuomonė
1 Kaip įprastai, aš visada patiriu tik geriausia
2 Jei kas nors gali atsitikti bloga, tai man būtinai nutiks
3 Aš visada optimistiškai mąstau apie ateitį
4 Labai retai įvykiai klostosi man palankiai
5 Apskritai gyvenime patiriu daugiau gerų dalykų nei blogų
6 Labai retai kas nors gera nutinka man

Šaltinis: sudaryta autorės, remiantis Scheier, M. F.,Carver, C. S., & Bridges, M. W. 1994.

9.	Perskaitykite jums pateiktus teiginius ir nuspręskite, kaip labai su jais sutinkate arbe ne. 
Savo sprendimą pažymėkite: 1 – griežtai sutinku, 2   3   4 – visiškai nesutinku.
Kiekvienas teiginys turi būti įvertintas skaičiumi nuo 1 iki 4.

Teiginiai nuomonė
1 Negaliu kontroliuoti to, kas man nutinka
2 Tikrai negaliu išspręsti kai kurių savo problemų
3 Tikrai mažai ką galiu padaryti, kad pakeisčiau labai 

svarbius dalykus savo gyvenime
4 Visad jaučiuosi bejėgis susidūręs su problemomis
5 Kartais jaučiuosi, kad aplinka man daro poveikį
6* Mano ateitis priklauso nuo manęs
7* Vos tik kas šauna į galvą, viską galiu padaryti

Šaltinis: sudaryta autorės, remiantis Pearlin, L., & Schooler, C. 1978.
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10. Perskaitykite jums pateiktus teiginius ir nuspręskite, kaip labai su jais sutinkate arba ne. 
Savo sprendimą pažymėkite: 1 – Taip, 2 – Ne.

Teiginiai Taip Ne
1 Yra tik keli žmonės pasaulyje, kuriais galiu pasikliauti kai reikia 
2 Kas atsitinka mano gyvenime, tai tik atsitiktinumas
3 Jei likimas nusistatęs prieš, tai niekada nebūsi pirmas
4 Labai mažai galiu daryti įtakos tam, kas man nutinka
5 Kartais jaučiuosi bejėgis pakeisti tai, kas vyksta mano gyvenime 
6* Šių dienų gyvenimas reikalauja viską atiduoti šiandienai, o rytdiena tegul pasirūpina 

kas kitas
7* Turėjau daug daugiau poreikių, nei pasidalyti rūpesčiais
8 Man visos dienos labai skiriasi viena nuo kitos
9 Pasaulis yra per sudėtingas, kad suprasčiau jį
10 Apgailestauju, kad praleidau daug šansų savo gyvenime
11 Neteisinga susilaukti vaikų galvojant tik apie savo ateitį
12 Ateitis yra tokia nenuspėjama, kad neįmanoma jos suplanuoti
13 Šiais laikais labai sunku būti optimistiškam
14 Nėra teisingo ar neteisingo būdo uždirbti pinigus. Yra tik sunkus ir lengvas būdai

Šaltinis: sudaryta autorės, remiantis John P., Phillip R. Shaver, Lawrence S. Wrightsman. 2013.

11. Streso skalė
Perskaitykite jums pateiktus teiginius ir nuspręskite, kaip dažnai jūs taip jaučiatės. 
Savo atsakymą pažymėkite: 1 – niekada, 2 – beveik niekada; 3 – kartais; 4 – gana dažnai; 5 – 

labai dažnai.
Kiekvienas teiginys turi būti įvertintas skaičiumi nuo 1 iki 5.
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Teiginiai nuomonė
1 Kaip dažnai paskutinį mėnesį jautėtės prislėgtas, nes kažkas 

nepasisekė 
2 Kaip dažnai paskutinį mėnesį jautėtės taip, tarsi negalite 

kontroliuoti svarbių įvykių, vykstančių jūsų gyvenime
3 Kaip dažnai paskutinį mėnesį jautėtės susinervinęs ir 

stresuojantis
4* Kaip dažnai paskutinį mėnesį teko pakliūti į nemalonius 

kivirčus  
5* Kaip dažnai paskutinį mėnesį jautėtės, jog esate apsaugotas 

nuo svarbių pokyčių jūsų gyvenime
6* Kaip dažnai paskutinį mėnesį jautėtės pasitikintis savo jėgomis 

išspręsti iškilusias problemas
7* Kaip dažnai paskutinį mėnesį jautėtės, kad naktys prabėga 

akimirksniu
8 Kaip dažnai paskutinį mėnesį jautėtės, jog negalite susidoroti 

su visomis iškylančiomis problemomis
9* Kaip dažnai paskutinį mėnesį sugebėjote sutvardyti kylantį 

pyktį
10* Kaip dažnai paskutinį mėnesį jautėtės taip, tarsi viskas yra 

jums įmanoma
Šaltinis: sudaryta autorės, remiantis Cohen, S., Kamarck, T. & Mermelstein, R. 1983

12. Perskaitykite jums pateiktus teiginius ir nuspręskite, kaip labai su jais sutinkate arbe ne. 
Savo sprendimą pažymėkite: 1 – visiškai nesutinku, 2 3 4 7 – visiškai sutinku.
Kiekvienas teiginys turi būti įvertintas skaičius nuo 1 iki 7.

Teiginiai nuomonė
1 Daugeliu atveju mano gyvenimas yra idealus
2 Mano gyvenimo kokybė yra puiki
3 Aš esu patenkintas savo gyvenimu
4 Labai senai iš gyvenimo gavau to, ko norėjau
5 Jei galėčiau nugyventi savo gyvenimą iš naujo nieko nekeisčiau

Šaltinis: sudaryta autorės, remiantis Diener, E., Emmons, R. A., Larson, R. J. & Griffin, S. 1985
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Rinkmenos Streso tyrimas.sav kodavimo aprašas

Kintamasis Kintamojo vardas  
SPSS faile Kodavimo instrukcijos

Identifikacijos 
numeris

ID Skaičių kodai, priskiriami respondentams

Lytis lytis 1 = Vyras
2 = Moteris

Amžius amzius Amžius metais

Šeiminė padėtis seima 1 = niekada nebuvęs santuokoje;
2 = gyvena santuokoje;
3 = išsiskyręs (-usi), oficialiai;
4 = oficialiai neišsiskyrę, bet gyvena atskirai; 
5 = gyvenantys atskirai;
6 = našlys (-ė).

Ar gyvenate su 
vaikais?

vaikai 1 = Taip; 2 = Ne

Aukščiausias 
pasiektas išsilavinimo 
laipsnis

mokslai 1 = pradinis
2 = vidurinis 
3 = profesinis vidurinis
4 = aukštasis bakalauras
5 = aukštasis magistras
6 = mokslų daktaras

Patiriamo streso 
pobūdis

priezastys 1 = darbe
2 = sutuoktinis ar partneris
3 = santykiai
4 = vaikai
5 = šeima 
6 = sveikata / ligos
7 = gyvenimas 
8 = finansinės problemos 
9 = per daug užduočių

Ar rūkote? rukymas 1 = Taip; 2 = Ne

Per savaitę surūkytos 
cigaretės

rukymodazn Per savaitę surūkytų cigarečių skaičius

Profesionalumo skalė prof1 iki prof7 Įrašomi skaičiai nuo 1 (kategoriškai nesutinku) iki 4 
(visiškai pritariu)

Pasitenkinimas 
gyvenimu

pgyv1 iki pgyv5 Įrašomi skaičiai nuo 1 (visiškai nesutinku) iki 7 (visiškai 
pritariu)
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Patiriamas stresas pats1 iki pats10 Įrašomi skaičiai nuo 1 (niekada) iki 5 (labai dažnai)

Optimizmo skalė 
nuo 1 iki 6

opt1 iki opt6 Įrašomi skaičiai nuo 1 (kategoriškai nesutinku) iki 5 
(visiškai pritariu)

Socialiniai poreikiai socp1 iki socp10 1 = Taip; 2 = Ne

Streso kontrolė stkon1 iki stkon18 Įrašomi skaičiai nuo 1 (kategoriškai nesutinku) iki 5 
(visiškai pritariu)

Savigarba sav1 iki sav10 Įrašomi skaičiai nuo 1 (kategoriškai nesutinku) iki 4 
(visiškai pritariu)

Kintamieji sukurti sujungus klausimų bloką

Bendras optimizmas Bopt kintamieji opt2, opt4, opt6 perkoduoti; 
įtraukti opt1 iki opt6; 
matavimų skalė nuo 6 iki 30

Bendras 
profesionalumas

Bprof kintamieji prof1, prof3, prof4, prof6, prof7 perkoduoti;  
įtraukti prof1 iki prof7; matavimų skalė nuo 7 iki 28

Bendras 
pasitenkinimas 
gyvenimu

Bpasgiv įtraukti kintamieji: pgyv1 iki pgyv5; 
matavimų skalė nuo 5 iki 35

Bendras patiriamas 
stresas

Bpats kintamieji pats4, pats5, pats7, pats8 perkoduoti;  
įtraukti pats1 iki pats10;  
matavimų skalė nuo 10 iki 50

Bendra savigarba Bsav kintamieji sav3, sav5, sav7, sav9, sav10 perkoduoti;  
įtraukti sav1 iki sav10; 
matavimų skalė nuo 10 iki 40

Bendri socialiniai 
poreikiai

Bsocp kintamieji socp6, socp10 perkoduoti (Taip = 1; Ne = 0)
įtraukti socp1 iki socp10; 
matavimų skalė nuo 0 iki 10

Bendra streso 
kontrolė

Bstkon kintamieji stkon1, stkon2, stkon7, stkon11, stkon15,  
tkon16 perkoduoti;  
įtraukti stkon1 iki stkon18; 
matavimų skalė nuo 18 iki 90

3 amžiaus grupės amgr3 1 = 18–29; 2 = 30–44; 3 = 45+

5 amžiaus grupės amgr5 1 = 18–24; 2 = 25–32; 3 = 33–40; 4 = 41–49; 5 = 50+
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Vartojamų terminų anglų–lietuvių kalbų žodynėlis

adjusted coefficient of determination – patai-
sytasis determinacijos koeficientas

bar graph – stulpelių diagrama

box-and-whiskers plot – stačiakampė diagra-
ma

categorical variable – kategorinis kintama-
sis

chi-square goodness-of-fit test – X2 suderi-
namumo kriterijus

chi-square test of homogeneity – X2 homo-
geniškumo kriterijus

chi-square test of independence – X2 nepri-
klausomumo kriterijus

coefficient of determination – determinacijos 
koeficientas

coefficient of variation (CV) – kitimo koefi-
cientas

confidence interval – pasikliautinasis inter-
valas

confidence level – pasikliovimo lygmuo

contingency coefficient – kontingencijos koe- 
ficientas

continuous variable – tolydusis kintamasis

correlation coefficient – koreliacijos koefi-
cientas

cumulative frequency – sukauptasis dažnis

data set – duomenų aibė

degrees of freedom – laisvės laipsniai

density – tankis

descriptive statistics – aprašomoji statistika

dependent variable – priklausomasis kinta-
masis

dichotomious variable – dvireikšmis kinta-
masis

discrete variable – diskretusis kintamasis

distribution – skirstinys

distribution function – pasiskirstymo funk-
cija

first quartile(Q1) – pirmas kvartilis

frequency – dažnis

frequency table – dažnių lentelė

grouped data – grupuotieji duomenys

heteroscedasticity – heteroskedastiškumas

homoscedasticity – homoskedastiškumas

independent variable – nepriklausomas kin-
tamasis

interval scale – intervalų skalė

kurtosis – eksceso koeficientas

level of significance (α) – reikšmingumo lyg-
muo

measures of dispersion – sklaidos charakte-
ristikos

measures of location – padėties charakteris-
tikos

median – mediana
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mode – moda

multicolinearity – multikolinerumas

nominal scale – pavadinimų skalė

normal curve – normalioji kreivė

null hypothesis – nulinė hipotezė

outlier – išskirtis

one way analysis of variance – vienfaktorinė 
dispersinė analizė

pie chart – skritulinė diagrama

prediction interval – prognozės intervalas

range – duomenų aibės plotis

ranking – rangavimas

ratio scale – santykių skalė

regression line – regresijos tiesė

residual – liekamoji paklaida

skewness – asimetrijos koeficientas

standard deviation – standartinis nuokrypis

standardized coefficients – standartizuotieji  
koeficientai

standardized residual – standartizuotoji lie-
kana

standard normal distribution – standartinis 
normalusis skirstinys

standard score – standartizuotoji reikšmė

test statistic – kriterijaus statistika

trend – trendas

variable – kintamasis

variance – dispersija

p-value – p reikšmė

test – t kriterijus
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Dalykinė rodyklė

anketavimas   11

anketos pavyzdys   13

aprašomoji statistika   85

analizė

	 kategorinių kintamųjų   87

	 kintamųjų dažnių   86

	 klausimų pažymėkite tik vieną   91

	 klausimų pažymėkite visus tinkamus   94

	 neparametrinių kintamųjų bloko   88

	 parametrinių kintamųjų   100

	 ranginių kintamųjų bloko   98

ANOVA   197

chi kvadrato kriterijus   144, 151

determinacijos koeficientas   170, 174

dydžių priskyrimas kintamajam   47

duomenų normalumo tikrinimas   102, 

duomenų surinkimo procedūra   62

išskirčių tyrimas   106, 178, 198

išskirčių šalinimas   168, 187, 199

histograma

	 braižymas   111

	 interpretavimas   113

	 sklaidos diagrama

	 braižymas   117, 162

	 interpretavimas   119

stačiakampė diagrama

	 braižymas   121

	 interpretavimas   122

stulpelinė diagrama

	 braižymas   113

	 interpretavimas   116

kelių kintamųjų 

	 aprašymas   58

	 automatinio kūrimo procedūra   59

kintamųjų ryšio matai

	 vardų skalės   154

	 rangų skalės   155

kodavimas 

	 atsakymų   22

	 atvirų klausimų   23

	 informacijos   18

kodavimo aprašo pavyzdys   20

koreliacija   144, 162
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linijinė diagrama

	 braižymas   123

	 interpretavimas   124

Livyno testas   200

Mahalanobio atstumai   178

multikolinerumas   176

normalumo tikrinimas   167, 186

Pirsono koreliacijos koeficiento  
skaičiavimas   164

post-hoc testas   200

P-P grafikas   177

ranginių kintamųjų jungimas į vieną    
rinkmenos kūrimas   37

rinkmenos modifikavimas

	 atvejų išrinkimo pavyzdžiai   81

	 atvejo pašalinimas   69

	 atvejų papildymas po sukūrimo   70

	 duomenų struktūros atstatymas   81

	 duomenų rūšiavimas   73

	 duomenų išskyrimas   77

	 kintamųjų papildymas   71

	 kintamųjų šalinimas   43

	 kintamųjų vietos keitimas   72

	 rinkmenos padalijimas   75

	 regresinė analizė   145, 146, 165, 169, 172, 

regresijos modelio sudarymas   169, 172

skalė

	 intervalų   49

	 pavadinimų   48

	 rangų   49

	 santykių   50

skalės kodo pakeitimas   131

Stjudento t kriterijus   147, 185

Tjukio kriterijus   202

tolydaus kintamojo skaidymas lygiomis da-
limis   134, 136

vidurkių trendas   203
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Statistinių metodų taikymų apibendrinimas

Ketinimai Statistiniai  
metodai

Kintamieji
intervaliniai ranginiai vardiniai

Kintamųjų ryšio 
tyrimas

Dviejų kintamųjų ryšio 
vertinimas Pirsono koreliacija TAIP NE NE

Kintamojo reikšmių 
prognozavimas pagal 
vieną kintamąjį

Tiesinė regresinė 
analizė TAIP NE

Kintamojo reikšmių 
prognozavimas pagal 
keletą kintamųjų Daugialypė regresija TAIP NE

Požymių 
nepriklausomumo 
tikrinimas

Chi kvadrato 
kriterijus NE NE TAIP

Grupių skirtumo 
tyrimas

Dviejų nepriklausomų 
imčių lyginimas Stjudento t kriterijus TAIP NE NE

Trijų ir daugiau  
nepriklausomų imčių 
lyginimas

Vienfaktorinė 
dispersinė analizė 

ANOVA
TAIP NE NE
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